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QUESTION 1:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
consists of a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run

either Windows XP Professional or Windows 98.

A Certkiller .com user named Kara Lang uses a Windows XP Professional client
computer named Certkiller -WS030. Kara Lang uses Outlook to send e-mail
messages. Kara Lang wants Certkiller -WS030 to be configured to view Outlook
shortcuts on the left side of the Outlook window when ever she is busy with e-mail
messages.

Which option should be used on the View menu of Outlook?

A. Kara Lang should use the Outlook Bar option.
B. Kara Lang should use the Folder List option.
C. Kara Lang should use the Preview Pane option.
D. Kara Lang should use the Auto Preview option.

Answer: A

Explanation: The Outlook Bar option in the View menu will display Outlook

shortcuts on the left side when creating an e-mail message.

Incorrect Answers:

B: The Folder List option controls whether the Folder List is displayed in Outlook.

C: The Preview Pane option shows the content of the e-mail messages that will appear at
the bottom of the Outlook screen.

D: The Auto Preview option controls what kind of view you want, maybe a small
preview of each e-mail message.

QUESTION 2:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
consists of a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run

either Windows XP Professional. All client computers have Microsoft Office XP
installed.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com user named Ally Wagner has contacted you. Ally Wagner needs to
add a new personal folder to her installation of Outlook 2002.

What should Ally Wagner do?

A. In the View menu, click View and then click Outlook Bar.

B. Click File and click Data File Management and then click the Close button.

C. Click File, click New, click Outlook data file and then click the OK button twice.
D. Click File, click Open, click Outlook data file and then click the file in the Open
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Outlook Data File window and click OK twice.
Answer: C

Explanation: If Ally Wagner click File, click New, click Outlook data file and then
click the OK button twice; it will create a new Outlook personal folder file.

Incorrect Answers:

A: Click View and then click Outlook Bar in the View menu; will not create a new
Outlook personal folder file.

B: Click File and click Data File Management and then click the Close button, will not
create a new Outlook personal folder file.

D: Click File, click Open, click Outlook data file and then click the file in the Open
Outlook Data File window and click OK twice; will not create a new Outlook personal
folder file.

QUESTION 3:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Exchange Server 2000 Server and all client
computers run either Windows XP Professional. All client computers have
Microsoft Office XP installed.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com manager named Andy Reid works in the Sales department. Andy
Reid needs to send encrypted e-mail messages to some of the employees in the
department. After sending the messages he discovered that the messages are not
encrypted.

What should Andy Reid obtain from the Exchange server to send encrypted e-mail
messages?

A. A digital ID

B. A security update

C. A blank e-mail message
D. An encryption algorithm

Answer: A

Explanation: For Andy Reid to send encrypted e-mail messages, he should get a
digital ID from the Exchange server.

Incorrect Answers:

B: An Exchange server does not provide security dates. For security updates he should
go to the Windows Update Web site.

C: A blank e-mail message will not set the messages as encrypted.

D: Andy Reid does not need a encryption algorithm to send encrypted messages.
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QUESTION 4:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers
run either Windows XP Professional or Windows 2000 Professional.

A Certkiller .com user named Andy Booth uses a client computer named

Certkiller -wWS010. Andy Booth uses Outlook on Certkiller -WS010 to send

e-mail messages. Some of the messages Andy Booth sends contain critical
information which should not be read by illicit recipients. Andy Booth wants the
receivers of the e-mail messages to determine if the messages were tempered during
transit and he want to ensure that the e-mail messages are not read by illicit
recipients.

What method should Andy Booth use to protect his e-mail messages? (Select two)

A. Encryption

B. File compression
C. Antivirus software
D. Digital signatures

Answer: A, D

Explanation: Andy Booth should use encryption and digital signatures. Encryption
is used to encrypt the messages and the digital signatures are used to allow the
receiver to read the content.

Incorrect Answers:

B: File compression allows a computer to remove redundant bits from a file.

C: The scenario does not need antivirus software.

QUESTION 5:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner has
upgraded her computer from Microsoft Windows 98 to Microsoft Windows XP
Professional. Ally Wagner has now a problem; she cannot run the accounting
application that she used before the upgrade. You tell Ally Wagner to run the
application in Windows 98 mode, but she does not know how to implement the
change.

In the exhibit, what should Ally Wagner do?
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it22Zenu.exe Properties

General | Yersion | Compaibility | Archive | Security | Summary|

@ | it e, exe

Type of file:  Application

Description:
Location: C:AProgram Shartcuts
Size: 4.22 ME [4,423,533 butes]

Size oh disk:  4.22 MB [£.431.872 bytes)

Created: Today, March 09, 2004, 10:04:24 AM
Modified: Today, March 09, 2004, 10:04:24 Ak
Ancessed Today, March 03, 2004, 10:07:28 Ak

Aftributes: ] Readonly [ Hidden

)4 ][ Cancel J Epply

Answer:
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it222enu.exe Properties @

General | Yersion|| Compaibility || Archive | Security | Summary.

@ . it222enu. exe y

Typeof file:  Application

Drezcription;
Location: C:AProgram Shortcuts
Size: 4,22 ME [4,423.533 bytes)

Size on dik: 422 MB [£.431 872 butes)

Created: Today, March 09, 2004, 10:04: 24 Ak
b adified: Today, March 03, 2004, 10:04: 24 Ak
Arccezzed Today, karch 09, 2004, 10:07:23 Ak

Attibutes: | Read-orly [ ] Hidden

[ OF. ][ Cancel ]

Explanation:
On the application Property dialog box, the Compatibility tab is used to select the
operating mode.

QUESTION 6:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. Kara Lang has
upgraded her second computer from Microsoft Windows 98 to Microsoft Windows
XP Home. She needs to use a financial application that does not run on Windows
XP Home. On her other computer she used to configure the application to run on
Windows XP in Windows 98 mode. Kara Lang cannot remember how to invoke the
necessary tool.

What should you tell Kara Lang to do?
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A. Open Component Services

B. Open Computer Management

C. Open the executable's Properties dialog box
D. Run Upgrade Advisor

Answer: C

Explanation: The executable's Properties dialog box will allow Kara Lang to choose
the operating system for the financing application to run.

Incorrect Answers:

A: The Component Services will allow the user to configure software component, not
application compatibility settings.

B: The Computer Management will allow the user to configure device drivers, format
hard drives etc.

D: The Upgrade Advisor is run before an upgrade.

QUESTION 7:

DRAG DROP

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Rory Allen has contacted you. Rory Allen is running
a legacy application on his client computer named Certkiller -WS007. Rory Allen
has just upgraded a Windows 98 client computer to Windows XP Home. After the
upgrade the legacy application does not want to work. A fellow worker also run the
same legacy application on his Windows XP Home client computer, without any
problems.

You need to fax Rory Allen the correct instructions. Choose from the list on the left
the correct procedure to over come this problem.

Steps, Select from these Steps, place here
Downgrade to Microsoft Windows 98. | Place here. ‘
Upgrade to Microsoft Windows XP Home Place here, if any. ‘
Run the Upgrade Advisor utility. ‘ | Place here, if any. ‘
Run the Program Compatibility Wizard. Place here, if any. ‘
Open Help ancéglrjtp;t:'rl‘ferter from the Pleice:bare, I any. ‘

Answer:

Actualtests.com - The Power of Knowing




070-272

Steps, Select from these Steps, place here
Downgrade to Microsoft Windows 98. Spenbainand Siinpdd Carteniomilio
Start menu.

Upgrade to Microsoft Windows XP Home Run the Program Compatibility Wizard.
| Run the Upgrade Advisor utility. I | Place here, if any. ‘
| Place here, if any. ‘
‘ ‘ | Place here, if any. ‘

Explanation:

Rory Allen should run the Program Compatibility Wizard from the Help and support
Center that will gather a list of programs installed on Certk LING-WS007. Rory Allen
can also choose the operating system under which the application should run.

Incorrect Options:

The Upgrade Advisor should be run before an upgrade.

There is no need to down grade the operating system.

QUESTION 8:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Walsh has contacted you. Amy Walsh has just
upgraded a Windows 98 client computer named Certkiller -WS020 to Windows

XP Home. Before the upgrading she installed a graphics application, which worked
fine. After the upgrade she received a dialog box stating that she should set the
display to 640x480 in 256 color mode.

What should Amy Walsh do?

A. Run the graphics application with a second hardware profile.

B. Configure the compatibility settings for the graphics application's executables

C. When the graphics application is running she should change the display settings to the
values needed.

D. Down grade to Microsoft Windows 98

Answer: B

Explanation: Amy Walsh should configure the compatibility settings for the

graphics application's executables in the Properties dialog box.

Incorrect Answers:

A: You can setup a second hardware profile to support multiple device configurations,
not to run the graphics application.

C: There is no need to display settings to the values which is needed to run the graphics
application.

D: Amy Walsh does not need to down grade the operating system. She should configure
the compatibility settings.
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QUESTION 9:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Finance department. A Certkiller .com employee named
Mia Hamm works in the Finance department. Certkiller .com contains a Windows
XP Professional workstation named Certkiller -WS111. Mia Hamm is using this
computer. Mia Hamm has contacted you to report the invoice management
application has problems. During the questioning you learned that Mia Hamm has
installed a customer relationship management application on Certkiller -WS111.
Before the installation of the customer relationship management application, the
invoice management application worked without any problems. Mia Hamm needs
her invoice management application.

What should you do?

A. Find out if the two applications can coexist by using the Program Compatibility
Wizard.

B. Use the Upgrade Advisor to find out the source of the problem.

C. Find out if the registry keys are overwritten, in the registry.

D. Find out if the Windows system dynamic link libraries (DLLS) were overwritten
during the installation process

Answer: C

Explanation: You should check the registry and find out if the registry keys were

not overwritten.

Incorrect Answers:

A: To find out if the two applications can coexist, you should not use the Program
Compatibility Wizard.

B: You should have use the Upgrade Advisor to see if the two applications can coexist
before installing it.

D: Windows XP does not allow the Windows system DLLs to be overwritten.

QUESTION 10:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers

run either Windows XP Professional or Windows 98.

A Certkiller .com user named

Kara Lang uses a Windows XP Professional client computer named

Certkiller -wS008. Kara Lang has installed a new software development
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framework on Certkiller -WS008. When Kara Lang needs to use the Windows
Explorer, the computer hangs. You need to find out if any components were
overwritten when installing the framework.

What toll should you use?

A. Dr. Watson

B. File Signature Verification
C. Regedit

D. Scandisk

Answer: B

Explanation: You should use the File Signature Verification to find out if the
correct versions of the system files are installed.

Incorrect Answers:

A: The Dr. Watson is used to log errors if application errors occur.

C: The Regedit is used to view and edit the system registry.

D: The Scandisk is used to check for hard disk errors.

QUESTION 11:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com.

A Certkiller .com user named Kara Lang uses a Windows XP Professional computer
named Certkiller -WS170 that has two hard disks. Drive C: has 200 MB of free
space and has the Windows 95 operating system installed on it. Drive D: has 2 GB of
free disk space and has the Windows XP Professional operating system installed on
it and secure data files and other information which is encrypted. Kara Lang has
contacted you because she cannot install an accounting application on

Certkiller -WS170. She received the following error: "Disk requirement not been
met. Please adhere to the disk requirement before proceeding with the installation".
Kara Lang installed the accounting application on drive D: which has 2 GB of
memory and the accounting application only needs 500 MB of free space for
installation. Kara Lang needs to install the accounting application.

What should Kara Lang do?

A. On Drive C, free up disk space
B. On Drive D, free up disk space
C. Format drive C with NTFS

D. Format drive D with FAT

Answer: A
Explanation: Kara Lang should free space in drive C. you do get applications that

need temporary disk space. Other applications do need disk space on drive C.
Although drive C has only 200 MB; she should free the disk space on drive C.
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Incorrect Answers:

B: Kara Lang does not need disk space on drive D. drive D has enough disk space. Some
applications need disk space that requires drive C.

C: Drive C contains Windows 95. Windows 95 does not support NTFS.

D: Formatting drive D to FAT is not an option because Kara Lang has encrypted files on
that drive. Files can only be encrypted on drive which is formatted with NTFS.

QUESTION 12:

DRAG DROP

You work as a helpdesk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server.

Certkiller .com contains a Research department and a Sales department. The
Research department does research on and software where the Sales department
sells the applications, software and computers. Certkiller .com also has a help desk
team which helps the customers which has problems with there software or
computers that was bought at Certkiller .com.

A Certkiller .com customer named Dean Austin which has a Windows XP
Professional computer has contacted you. Dean Austin has bought a 16-bit
accounting application at your company. He has problems with the 16-bit
accounting application which is d designed for Windows XP Professional. When
ever Dean Austin runs Microsoft FrontPage the 16-bit accounting application
crashes.

From the list on the left, select the steps to troubleshoot the problem.

Steps, Select from these Steps, place here

Install Windows XP Home on the test

computer Place here.

Install a copy of the application on the test

computer. Place here, if any.

Have the user open the log file and read its

5 Place here, if any.
entries to you.

Have the user send you the log file. Place here, if any.

Escalate the issue to a software developer. Place here, if any.

Have the user locate the Dr. Watson file. Place here, if any.

Have the user open the registry. Place here, if any.

Try to reproduce the problem. Place here, if any.
Answer:
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Steps, Select from these Steps, place here

Install Windows XP Home on the test

computer. Have the user locate the Dr. Watson file.

Install a copy of the application on the test

computar. Have the user send you the log file.

Have the user open the log file and read its

entries to youl, Escalate the issue to a software developer.

Place here, if any.

Place here, if any.

Place here, if any.

Have the user open the registry. Place here, if any.
Try to reproduce the problem. Place here, if any.
Explanation:

Dean Austin should send the Dr. Watson log file. This file contains the information
needed for a higher-level technician. If the developer discovers the cause of the problem,
he could fix the 16-bit accounting application.

Incorrect Options:

Dean Austin should not alter anything in the registry. Any changes that are made to the
registry are permanent.

You should not use a test computer and install the 16-bit accounting application to
reproduce the problem. You should have the software developer debug the application.
Reading the DR. Watson log files is impossible. The debug symbols are not
human-readable.

QUESTION 13:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Clive Wilson has contacted you. Clive Wilson works
for a company named Acme.com. One of the managers of Acme.com was trying to
configure Outlook Express to connect to their company's e-mail server. After hours
of struggling he configures most of the properties of the account. Almost finished he
got stuck with the ports. Clive Wilson cannot remember which ports to use for the
incoming and outgoing mail servers.

What should Clive Wilson do?

A. For incoming and outgoing mail, Clive Wilson should use port 25.
B. Specify port 110 for outgoing mail and port 25 for incoming mail.
C. For incoming and outgoing mail, Clive Wilson should use port 110.
D. Specify port 25 for outgoing mail and port 110 for incoming mail.

Actualtests.com - The Power of Knowing




070-272

Answer: D

Explanation: Clive Wilson should use port 25 for outgoing mail. With this port you
can connect to the Simple Mail Transfer Protocol (SMTP) server. The SMTP server
is use to deliver mail. Clive Wilson should use port 110 for incoming mail. With this
port you can connect to the Post Office Protocol 3 (POP3) server. The POP3 server
is used to download messages.

Incorrect Answers:

A: Clive Wilson should use port 25 for outgoing mail.

B: Clive Wilson should specify port 25 for outgoing mail and port 110 for incoming
mail.

C: Clive Wilson should use port 110 for incoming mail.

QUESTION 14:

DRAG DROP

You work as a help desk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.
A Certkiller .com customer named Mia Hamm has contacted you. Mia Hamm works
from home for her company. Mia Hamm has a laptop that is running Microsoft
Windows 2000 Professional. She uses her laptop to access her company's network,
which contains a virtual private connection. The laptop connects to the network
with a maximum speed of 1.5 Mbps.

Mia Hamm needs to connect to his e-mail by using his company's Exchange server.
She needs to use a protocol that allows e-mail messages. She also wants the messages
to remain on the server after she downloads the messages, which will be used for
future use. You need to give Mia Hamm instructions.

From the list on the left you can select the instructions.

Steps, Select from these Steps, place here
Choose the HTTP e-mail server type. Place here.
Click the E-mail Accounts button, Place here, if any.
Open the Mail Control Panel applet. Place here, if any.
Choose the IMAP4 e-mail server type. Place here, if any.

Choose E-mail Accounts from the Tools

)l if any.
i Flace here, if any

Choose the Add a E-mail Account option. Place here, if any.

Open Qutlook Fiace here, if any.

Choose the Microsoft Exchange Server

; Place here, if any.
e-mail server type.

Choose the POP3 e-mail server type. Place here, if any.
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Answer:
Steps, Select from these Steps, place here
Choose the HTTP e-mail server type. Open the Mail Control Panel applet.

Click the E-mail Accounts button.

Choose the Add a E-mail Account option.

Choose the Microsoft Exchange Server

Choose the IMAP4 e-mail server type. e-mail sorver type

Choose E-mail Accounts from the Tools

Place here, if any.
menu.

Place here, if any.

Open Outlock Place here, if any.

Place here, if any.

Choose the POP3 e-mail server type. Place here, if any.

Explanation:

Mia Hamm should open the Mail Control Panel applet and click the E-mail Accounts and
choose the Add a New E-mail Account option. After that, she should choose the
Exchange Server e-mail server type.

Incorrect Options:

Mia Hamm cannot create a new Exchange e-mail account from within Outlook.

Mia Hamm messages are stored on the Exchange server. She should not use POP3,
IMAP4 or HTTP.

Mia Hamm cannot add Exchange Server accounts while Outlook is running.

QUESTION 15:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner has a
computer that is running Microsoft Windows 2000 Professional. Ally Wagner has
problems setting up her Home page in the Internet Explorer. She claims that she
cannot find any settings that allow her to set the Home page, in the Internet Option
dialog box.

Which of the following questions should you asked?

A. Ask Ally Wagner if she is the administrator of the computer.

B. Ask Ally Wagner which version of the Internet Explorer is on the computer.
C. Ask Ally Wagner if the computer is a member of a workgroup or domain.
D. Ask Ally Wagner if she checked every tab page in Internet Options.

Answer: C
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Explanation: If the computer is a member of the domain, then probably a Group

Policy object stops you from changing the Internet Explorer settings. If the

computer is a member of a workgroup, then maybe local policies stops you from
changing the Internet Explorer settings.

Incorrect Answers:

A: You do not have to be an administrator to set the Home page, unless it is prevented
with a Group Policy or Local Policy.

B: There is no need to ask this question. All versions of Internet Explorer allow a user to
define Home pages.

D: There is no need to ask the customer if she is confident.

QUESTION 16:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Andy Reid has contacted you. Andy Reid wants to
also Internet Explorer to remember passwords for Web sites that he has visit.

In the exhibit, what should Andy Reid do?

Internet Options E]

| General | SE.'C_I.:Ir_ilt_!,-!“: Frivacy | Content | Connections | Programs | Advanced |

Content Sdvizor

3 R atings help you control the Internet content that can be
@' viewed on thiz computer,

Certificates
% |lze certificates to positively identify poursell, certification
@l authorities. and publizhers,

[ Clear SSL State H Certificates... H Publizhers. .. I

Perzonal information

= AutoComplete stores previous enties AutoComplete
\% ahd sugaests matches for you,

Microsoft Profile Assistant stores your My Profile...
perzonal infarmation.

Ok, ] | Cancel

Answer:
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Internet Options @

General | Security | Privacy | Content | Connections || Programs || fidvanced

Content Sdvwizor

2 R atings help you control the Internet content that can be
m’ wigwed on this computer,

Certificates
% Ilze certificates to pozitively identify yourselt, certification
@l authorbies. and publizhers,
[ Clear S5L State I[ Certificates... H Publizhers. .. I

Perzonal information

and zuggest: matches for you,

;E AutoComplele shores previous entries l.-'-‘-.utuEumpIete... I

Micrusoﬂ_F‘mee .%‘-.ssistant stores pour My Prafile...
perzonal infarmation.

I ok ]| Carcel ]

Explanation:

He should click the Auto Complete button on the Content tab of the Internet Options.
When doing this the Auto Complete Settings dialog box will appear. It will allow Andy
Reid to specify whether Internet Explorer should remember field values and password on
forms.

QUESTION 17:

HOTSPOT

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. The
Certkiller .com network contains three Windows 2000 Server computers and 50
Windows XP Professional client computers. The Certkiller .com network is not
connected to the Internet.

A user named Andy Booth works in the Marketing department. Andy Booth is
using a Windows XP Professional computer named Certkiller -WS050 that was
used by a different user. Whenever Andy Booth views Web sites in Internet
Explorer, the font that is used are Times New Roman. On the other computers in
the Marketing department, the same Web sites have different fonts.

Andy Booth wants the original font of the Web page that is displayed. In the exhibit,
what should Andy Booth do?

Actualtests.com - The Power of Knowing




Internet Options

070-272

General | Security | Privacy | Content| Connections | Programs | Advanced |

Home page

% Y'ou can change which page to uge for pour home page
Address:

apifredi . dl?prd=ietpyer=afar=msnhome |

[ |Jze Current J [ |Jze Drefault ] [ |ze Blank J

Temporary Internet files

il Fages you view on the Internet are stored in a special folder
f &Y for quick viewing later.

[Delete Eu:u:ukies...] [Delete Files... ] [ Settings... J

Higtay

The Higtory lolder containg links to pages you've vizited, for
quick. acces: to recently vizwed pages.

[rayz to keep pages in hiztony:

20 2| | Clear History |

[ Calars... _H_

J [ Languages .. J [.ﬁ.ccessibiliw... ]

][ Cancel J Spply

Answer:
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Internet Options

General | Security :__F'rivac_l,l I Eu:-ntent___Eu:unneu:tiu:un_s I F'ru:ugramg _ﬁ.dvanced.__

Home page
E! Y'ou zan change which page ta uze for your home page

e SN - = i = it dll prd=iefpver=6&ar=msnhome

I |Jze Current | |ze Drefault H Uze Blank, |

Temporary Internet files

i Pages vou view on the Internet are stored in a special folder
@& Y for quick viesing later. |

[Delete Eu:u:ukies...] | Delete Files... I [ Settings... J

Hiztary

The Hiztory folder contains links to pages vou've wisited, for
quick acces: to recently viewed pages.

Drays to keep pages in history: 20 : | clear Histaory

[ Colorz. .. l | Fonts... I [ Languages... ] I.-’-‘-.u:u:essil:uility...]

[ ok, ][ Cancel I

Explanation:

Andy Booth must use the Accessibility button and turn off the Ignore font style that is
specified on Web pages options.

Incorrect Options:

If you change the Fonts settings without changing the Accessibility settings, will only
changes the font oh the Web page that did not specify a font.

QUESTION 18:

HOTSPOT

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers
run either Windows XP Professional or Windows 98.

A Certkiller .com customer named Amy Walsh uses a Windows XP Professional
client computer. Amy Walsh works as a secretary in their company. Amy Walsh has
contacted you to discuss her problem with regards to sending e-mail. Whenever she
is sending an e-mail message and clicks the e-mail address links, the Microsoft
Outlook Express starts. She can use the Outlook Express but it is not configured.
Now she rather wants to use her Hotmail account. You need to associate e-mail
address links to her Hotmail account.

In the exhibit below, which tab should Amy Walsh use?
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General |-5:El3urit_|,| (i Privacy ( Content | Cannections :E-F'rcugrams H—'-.u:lvanu:ed'

Home page

% “'ou can change which page to uge for pour home page,
Addrezs:

apifredi . diyprd=ietpyer=68ar=msnhome |

[ [Jze Current J l |ze Drefault ] [ I1ze Blank J

Temporary Intermet files

il Fages vou view on the Internet are stored in a special falder
f & Y for quick viewing later,

[Delete Eu:u:ukies...] [Delete Filez... ] [ Settings... J

Higtory

The Hiztom folder containg links to pages you've vizited, for
quick access o recently viewed pages.

Drays to keep pages in histony:

20 2| | Cleat History |

[ Colars... J|_

J [ Languages .. J [.ﬁ.ccessibility... ]

][ Cancel J Spply

Answer:

Actualtests.com - The Power of Knowing




070-272

Internet Options

General Security || Privacy | Content || Connections| Programs ﬁ.dvanced.

Home page
E! Y'ou zan change which page to use for vour home page
Address: l'i::a ifrediv, di?prd=ietpyver=6&ar=msnhome

I |lze Current ] | |Jze Drefault I [ |ze Blank,

Temporan Internet files

b Pages vou view on the Internet are stored in a special folder

L@ N for quick vieming later, |

[Delete E-:u:ukies...] | Delete Files.. I [ Settings... J

Higtom

The History lolder containz links to pages vou've vizited, for
quick acces: to recently viewed pages.

[Dravz to keep pages in histony: (20 = || Clear Hiztomn

[ Colors. .. l | Fonts... I [ Languages .. ] [.ﬁ.ccessibility...]

[ ok, ][ Cancel J

Explanation:
The Program tab will allow Amy Walsh to specify the e-mail application that is
invoked when she clicks on an e-mail address that is liked on the Web page.

QUESTION 19:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers
run Windows XP Professional.

A Certkiller .com user, named Dean Austin, has asked you to assists him with his
Internet Explorer toolbars. One of the users in his department has used Dean
Austin's computer. Now Dean Austin cannot find the buttons that are on the
Internet Explorer toolbars. Dean Austin wants his Internet Explorer to be the way it
was before.

What should Dean Austin do to get the Internet Explorer toolbar the way it was
with the least amount of administrative effort?

A. Click the Tools menu, then the Internet Options and then click the Settings.

B. Click the File menu and then the Properties.

C. Click the View menu and point to the Toolbars and click Customize and then click
Reset.
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D. Click the View menu and point to the Toolbars and click Customize and then
rearrange the buttons.

Answer: C

Explanation: If Dean Austin click the View menu and point to the Toolbars and

click Customize and then click Reset, it will return the Internet Explorer toolbar to

the default state.

Incorrect Answers:

A: If he clicks the Tools menu, then the Internet Options and then clicks the Settings
Local Policy. It will result in controlling the settings for the temporary files.

B: Clicking the Properties will display the current Web page.

D: Dean Austin can click the View menu and point to the Toolbars and click Customize
and then rearrange the buttons. This will take much longer where he could have just reset
it.

QUESTION 20:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Kara Lang has contacted you. Whenever Kara Lang
uses the Internet Explorer, she keeps getting prompt to accept cookies. Kara Lang
does not want to be prompt about cookies when she is busy on the Internet.

What should she do on the Internet Options dialog box? (Select two)

A. On the Privacy tab, click the Default button.

B. Change the Privacy settings to Low.

C. Change the Privacy settings to Accept All Cookies.

D. Click the Advance button on the Privacy tab and clear the Override automatic cookie
handling option.

Answer: A, D

Explanation: If Kara Lang click the Default button On the Privacy tab and click
Advance button on the Privacy tab and clear the Override automatic cookie
handling option, it will override the cookie handling option. This action will also
allow her to accept, block etc. cookies.

Incorrect Answers:

B: Kara Lang should not change the Privacy settings to Low. This will override
automatic cookie handling and it will be set to prompt.

C: Kara Lang should not change the Privacy settings to Accept All Cookies. She is
prompt for cookies, so the Private settings is not available.
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QUESTION 21:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Research department. A Certkiller .com user named Amy
Wilson who works in the Research department has contacted you. Amy Wilson uses
the Internet Explorer to do more research for her department on the Internet. Amy
Wilson does not want these sites to place cookies that have personal information of
his computer.

Which tab in the exhibit should Amy Wilson click to block and restrict cookies?

Internet Options

General | Security | Privacy | Content | Connections | Programs | Advanced

Home page
| E! fou can change which page to uge for wour home page
Address: i::a i fredir . dil? rr'n:|=|'n3E el =Har=msnhoms .

I Ilze Current ] | Idze Default J [ Idze Blank.

Temporany Intermet files

= Fages pou view on the |nternet are stored in a zpecial folder
@& Y for quick viewing later,

[Delete Eu:u:ukies...] | Delete Files. . J [ Settings... J

Higton,

The Histom tolder containz links to pages you've vizited, for
quick access to recently viswed pages.

Days to keep pages in hiztony: 2IJ : Clear Hiztary |

[ Colorz... ] I Faontz. . ] [ Languages .. ] I.ﬁ.ccessibility...]

[ ak. ][ Cancel I oply

Answer:
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Internet Options

Gereral | Security I Frivacy "_I:l:untent_"I:Dnnecti-:un_s" F'n:ngramg .n'f-.dvan-:ed_.

Home page
E! “'ou can change which page to use for your horme page

Eatelu - i o edit . dll2prd=iedpver=62ar=msnhome

I |lze Current ] | Idze Default I [ IJze Blank

Tempoany Internet files

g FPages vou view on the Internet are stored in a special folder

V@Y for quick viewing later.

[Delete Ennkies...] | Delete Files... I [ Settings... J

Hiztory |

The Hiztory folder containg links to pages poutve vigited, for
quick access o recently viewed pages.

Days to keep pages in histon: EIEI : 1 Clear Hiztoryp

[ Colarz... ] | Faontz... ] [ Languages .. ] [.ﬁ.ccessibility... ]

I k. H Cancel I pply

Explanation:

Amy Wilson has to use the Privacy tab. With this tab she can set the general policy as
well as to set policies for specific Web sites.

Incorrect Options:

The Security tab is used t define the security settings for each Web content zone. It is
also use add sites to each zone.

The Content tab is used to manage Content Advisor settings and certificates.

The Connection tab is used to manage dial-up networking and virtual private
connections, proxy server setting, etc.

The Program tab is used for internet services, e.g. e-mail, calendars etc.

The Advance tab is used to define settings related to accessibility.

QUESTION 22:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com user named Andy Booth has contacted you. Andy Booth has a
Windows 98 computer which was upgraded to Windows XP Home. Andy Booth said
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that when he uses the Internet Explorer to view Web pages, three buttons are
displayed on certain parts of the page. The exhibit show one of the popup.

wadmes GWUESTIONS
. @ END ANSWERS

oF WITH EXPLANATIONS
ra Cert Killer Cluestions and Answers provide you the

complete coverage of the cerification exams. Qur testing
§ Rillaos guestions and answers have the most accurate and
precise explanations as every training kit was prepared
by veteran Cerified Experis at Cert Killer. Each
preparation exam will make yvou feel like vou're taking the
actual exam!

LEARN MORE L)

Andy Booth does not want these popup ads to interfere with the Web page
screening.
What should Andy Booth do?

A. Andy Booth should associate images with Microsoft Paint rather then using a graphics
program.

B. Andy Booth should specify the Windows Firewall to block harmful images.

C. Andy Booth should disable the image toolbar.

D. Show image download placeholders.

Answer: C

Explanation: Andy Booth should disable the image bar. This will then stop the ads
from popping up.

Incorrect Answers:

A: Andy Booth should associate images with Paint or any other program that he uses to
view images.

B: Andy Booth cannot block certain kinds of images.

D: This action will not prevent the toolbar from being shown.

QUESTION 23:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers

run Windows XP Professional.

A Certkiller .com user named Clive Wilson has a Windows XP Professional
computer with Service Pack 2. Clive Wilson is using Internet Explorer to access

Web sites. Clive Wilson has added many Web pages to his Favorites in Internet
Explorer. Clive Wilson now finds it difficult to find certain items in the Favorite
menu. He would like the Favorite to be alphabetically arranged.

What should you do?
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A. Right-click on an item in the Favorites menu and specify Sort by Name.

B. You should click the Tool menu, the Internet Options and then the Settings button.

C. Right-click on an item in the Organize Favorites dialog box and specify Sort by Name.
D. Click on the Tools menu and click Synchronize.

Answer: A

Explanation: When you right-click on an item in the Favorites menu and specify

Sort by Name, it will arrange the items in alphabetical order.

Incorrect Answers:

B: You should not click the Tool menu, the Internet Options and then the Settings button.
This will control the settings for your temporary Internet files.

C: In the Organize Favorites dialog box, the Sort by Name is not available.

D: The Synchronize option is used to update the Web pages that were saved.

QUESTION 24:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Walsh has contacted you. Amy Walsh works in
the Marketing department of her company. The Web site, at the sister company,

that Amy Walsh connects to regularly do not keep her information and does not
seem to be fully functional. Amy Walsh needs to use the features of the Web site but
does not want to compromise security when she visits other sites.

What should you do?

A. Modify the Security Settings for the Internet zone to Enable.
B. Add the Web site to the Internet zone.

C. Add the Web site to the Trusted Sites zone.

D. Disable the Windows Firewall.

Answer: C

Explanation: To ensure that the user has all the functionality of the trusted Web

site, she should add the Web site to the Trusted Sites zone.

Incorrect Answers:

A: If you enable the security settings for the Internet zone, then you will open the
computer to dangerous content from the Web sites that was not even added to your sites.
B: The Internet zone contains all the Web sites that have not been added to one on the
other zones. You can only add Web sites to the Local Intranet zone.

D: You should not disable the Web site.
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QUESTION 25:

DRAG DROP

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner has a
computer that is running Microsoft Windows 2000 Professional. Ally Wagner
complains that her Home page in Internet Explorer has changed. She claims that
she cannot find uniform resource locator of the previous Home page but knows
where the Favorites menu is. Ally Wagner needs instructions to reset her Home

page.
From the list, select the instructions.
Steps, Select from these Steps, place here
Click the Web site link on the Favorites
Place here.
menu.
Click the Use Current button Piace second step here, if any.
Open Internet Explorer. Place third step here, if any.
Open Internet Options on the Tools menu. Place fourth step here, if any.

Copy the 'Web site URL from the Address

el Place fifth step here, if any.

Past the Web site URL into the Address

i Place sixth step here, if any.

Open Outlook Place seventh step here, if any.

Open the Internet Options applet in Contral

Flace eighth st here, ifany.
Panel. Heaigiian ; V.

Answer:
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Steps, Select from these Steps, place here

Open Internet Explorer.

Click the Web site link on the Favorites
menu.

Open Internet Options on the Tools menu.

Click the Use Current button.

Copy the Web site URL from the Address

Kar Place fifth step here_if any.

Past the Web site URL into the Address

tast b Place sixth step here, if any.

Open Outlook Pilace seventh step here, if any.

Open the Internet Options applet in Control
Panel.

Place eighth step hers, if any.

Explanation:

Ally Wagner should open the Website link and then open the Internet Options and click
the Use Current button to set the Home page to the viewed page.

Incorrect Options:

There is no need to copy the and past the Web site URL. The Use Current button is used
to allow users to set a Home page, so that the users don't have to remember the URL.
The Options Control Panel applet is not used to access the Favorite menu.

QUESTION 26:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Marketing department. A Certkiller .com employee named
Mia Hamm works in the Marketing department. Due to the strain of the work, Mia
Hamm uses her laptop to check the listings on a Web page which is added to her
Favorite folder. At home she does not connect to the Internet or network. Mia

Hamm would like to view the Web site from home.

What should she do?

A. Click the File menu and click Import and Export.

B. Click the Favorite item for the Web site and then click the refresh button.

C. Right-click the Favorite item for the Web site and then "Make available offline™.
D. Click the Tools menu and click Synchronize.

Answer: C

Explanation: The "Make available offline” will bring up the Offline Favorite
Wizard. With this she can specify the amount of links she wants on the page.
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Incorrect Answers:

A: You should not click Import and Export. This will result in copying cookies and
Favorites to a file. It can then also import it to Internet Explorer from a file.

B: This action will reload the page if you are connected. It can also fail to find the page if
not connected.

D: You should not click the Tools menu and click Synchronize. You should Right-click
the Favorite item for the Web site and then "Make available offline".

QUESTION 27:

You work as a help desk support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers
run Windows XP Professional.

A Certkiller .com user named Andy Reid works on a Windows XP Professional
computer named Certkiller -WS109. The new Certkiller .com policy states that
Internet Explorer should not allow storage of cookies which has can be personally
recognized to users without there permission. The other Certkiller .com policy states
that the users should not download signed or unsigned ActiveX controls from Web
site on the Internet. You need to configure Certkiller -WS109 not to violate the
security policies of Certkiller .com.

Which security settings should you use?

A. Specify the security for the Internet zone to Low and setup the privacy to Low.

B. Specify the security for the Internet zone to Medium and setup the privacy to Medium.
C. Specify the security for the Internet zone to High and setup the privacy to High.

D. Specify the security for the Internet zone to Low.

Answer: C

Explanation: You should setup the security to High and setup the privacy to High.

The High security setting will prevent the users from down loading signed or

unsigned ActiveX controls. The High privacy setting will prevent the users from

storing cookies.

Incorrect Answers:

A: If you setup the security to Low and the privacy to Low, it will allow the users to
down loading signed or unsigned ActiveX controls and to allow the users to storing
cookies.

B: If you setup the security to Medium and the privacy to Medium, the Medium security
will allow the user to download signed ActiveX but not unsigned ActiveX. The Medium
privacy will prevent the user to download cookies.

D: If you setup the security to Low, it will allow the users to down loading signed or
unsigned ActiveX controls.

QUESTION 28:
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You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Ally Wagner who is the manageress has contacted
you. All the client computers at Ally Wagner's company run Windows XP
Professional with Internet Explorer 6 as the default browser. Ally Wagner needs to
prevent the users in her company to download ActiveX controls from the Internet.
Which settings in Internet Explorer should Ally Wagner apply?

A. Privacy settings

B. Content Advisor settings

C. Security settings for the Internet zone.
D. Security settings for the Local Intranet.

Answer: C

Explanation: Ally Wagner should setup the security settings for the Internet zone. If
it is on High, it will prevent the users from download ActiveX controls.

Incorrect Answers:

A: Privacy settings have to do with cookies that can be stored if not set to High.

B: Content Advisor is used to specify whether Internet Explorer blocks Web sites that
have offensive content.

D: The Local Intranet includes Web sites on the company's intranet not the Internet.

QUESTION 29:

You work as a help desk support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers

run Windows XP Professional.

A Certkiller .com user named Andy Reid works on a Windows XP Professional
computer named Certkiller -WS109. The new Certkiller .com policy states that
Internet Explorer can be specified to automatically download signed ActiveX

controls from Web site or to prompt the users to download unsigned ActiveX

controls from Web site.

Which Internet Explorer security settings should you use?

A. Specify the security for the Internet zone to Low.
B. Specify privacy to Low.

C. Specify privacy to Medium.

D. Specify the security for the Internet zone to High.

Answer: A
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Explanation: If you specify the security for the Internet zone to Low, it will allow
downloading signed ActiveX controls automatically.

Incorrect Answers:

B: If the privacy setting is on Low, it will enable Internet Explorer to store cookies that
identify a user without his or her consent.

C: If you setup the privacy to Medium privacy will prevent the user to download
cookies.

D: If you should setup the security to High it will prevent the users from down loading
signed or unsigned ActiveX controls.

QUESTION 30:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Ally Wagner is a member of the Sales department.
One morning Ally Wagner complains that she visited a Web site three days ago.
Ally Wagner does not remember the exact address of the Web site. She wants to
find out which Web site she previously visited.

What should do to ensure that Ally Wagner can return to the Web site she visited
three days ago by using the least amount of effort?

A. Click the History button on Internet Explorer toolbar.

B. View the contents of the Internet Temporary Files folder by date.

C. View the list of Web sites in the Trusted sites security zone in Internet Options in
Control Panel.

D. Sort the objects in her Internet Explorer Downloaded Program Files folder by the last
accessed date.

Answer: A

Explanation: Using History is a way to review sites that were visited anywhere from
today to two weeks in the past. Click the History button to open Internet History,

then select the day (or week) you wish to review. If the History button does not exist,
right click anywhere in the button bar, and click Customize. Click the History

button on the left, and add it to the right. Click Ok.

Incorrect Answers:

B: You can sort the contents of the IE Temporary Files by date, but the temp files do not
contain web sites, and as such would not help to retrieve a site visited four days ago.

C: Viewing the sites in the Trusted Sites zone will not retrieve any history for a web site.
It will only contain sites that you have added that are trusted by you. Trusted sites only
allow for relaxed security.

D: Since the question does not state that the user downloaded any files, but instead only
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searched, this is not an option. In addition, the downloaded program files folder by
default is the IE temporary files location, so attempting this would result in the same
problems as answer "B".

QUESTION 31:

DRAG DROP

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

Certkiller .com has its headquarters in Chicago and a branch office in Dallas.
Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com user named Ally Wagner works in the Dallas branch office. She has
contacted you. Ally Wagner is work on a client computer named

Certkiller -WS035 which is running Windows XP Professional. Ally Wagner
wants to setup Outlook Express. She wants to connect to the
Microsoft.private.windows.longhorn.general newsgroup. Ally Wagner only
observed how a college of her connected to
Microsoft.private.windows.longhorn.general newsgroup, and wants also to connect
to this newsgroup.

After a few unsuccessful attempts, she contacts you because she does not know the
steps. Ally Wagner received the following steps from Microsoft with the following
information.

Server: privatenews.microsoft.com

Userid: privatenews\tester

Password: abc123

From the list below, select the steps Ally Wagner should used, in correct order.

Steps, Select from these Steps, place here
Choose Accounts from the Tools menu Flace here.
Subscribe to the desired newsgroup. Place second step here.
Choose Newsgroups from the Tools menu. Flace third step here.
Add a new News account. Place fourth step here.
_Enter your personal information and_ the Place fifth step hers.
information that the newsgroup provided.

Answer:
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Steps, Select from these Steps, place here

Choose Accounts from the Tools menu.

Add a new News account.

Enter your personal information and the
information that the newsgroup provided.

Choose Newsgroups from the Tools menu.

Subscribe to the desired newsgroup.

Explanation:

Ally Wagner should create an account for the Microsoft's newsgroup server. She can do
this by choosing the Accounts from the Tool menu and a new News account.

Incorrect Options:

If Ally Wagner chooses the "add a new News account, the Internet Connecting Wizard
will be invoked. She should enter her name and e-mail address and the information she
received from Microsoft.

Only if Ally Wagner has completed the Wizard, she will have the option to download
newsgroups from the server.

QUESTION 32:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Mia Hamm has contacted you. Mia Hamm works
for a company named testlabs.com and her e-mail address is
miahamm@testlabs.com. Mia Hamm complaints that she receives a large amount of
junk e-mail, after she has joined an Internet newsgroup. Mia Hamm wants to
received less junk e-mail, but wants lawful newsgroup subscribers to send messages.
What should Mia Hamm do?

A. Do not use the E-mail address or Reply address field to specify an e-mail address. She
should specify miahamm@testlabs.com in the Form field when posting messages.

B. Specify miahamm@NOSPAMtestlabs.com in the E-mail address field.

C. Do not use the E-mail address or Reply address field to specify an e-mail address. She
should specify miahamm@testlabs.com as a signature on all messages.

D. Specify miahamm@testlabs.com in the Reply address field. She should not specify an
e-mail address in the E-mail address field.

Answer: B

Explanation: If she specifies miahamm@NOSPAMtestlabs.com in the E-mail
address field, the newsgroup knows not to send NOSPAM for this address.
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Incorrect Answers:

A: She must specify miahamm@NOSPAMtestlabs.com in the E-mail address field. This
is required for news accounts.

C: She should not specify miahamm@testlabs.com as a signature on all messages. The
automatic programs will locate the e-mail address.

D: She cannot use the Reply address field only. News account requires an e-mail address
in the E-mail address field.

QUESTION 33:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

A user, named Andy Reid, reports that he is unable to connect to one of Microsoft's
newsgroup servers. When Andy Reid connects to the server, he is prompts with the
following error message:

Outlook Express

& IInable to connect tothe server.

ok | [ <<Detais |
| Configuratian: Al
Aocount; manews. microzoftcom il
Server: manews. microzoft. com
Frotocol; HMTF
Fort: 120 .

What could cause the problem?

A. The Microsoft newsgroup server does not exist.

B. There is no username or password.

C. The wrong protocol is used to connect to the Microsoft newsgroup server.
D. The port in incorrect.

Answer: D

Explanation: The default Network News Transfer Protocol (NNTP) port is 119.
Andy Reid is using port 120.

Incorrect Answers:

A: The Microsoft newsgroup server does exist because the error said that it cannot
connect.
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B: The message says that it cannot connect. There is no sign in the error messages that
the wrong password or username was used.
C: Outlook uses NNTP, so did not use the wrong protocol.

QUESTION 34:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

A customer, named Rory Allen, reports that he is having problems downloading
newsgroups from the Microsoft's newsgroup servers. When Andy Reid clicks on
privatenews.microsoft.com account name in Outlook Express, he is prompted with
the following error message:

Outlook Express

& Unable to connect to the server.

ok | [ << Details ]
I4B|:I LD;DIHIHEQLI,I{TEEI |
. Configuration:
| Account: privatensws. microzoft.com
Server privatenews. microzo’t com |

What could cause the problem?

A. An incorrectly configured news account.

B. There is no account in the news server.

C. In the user field account is privatenews.microsoft.com.
D. The server does not exist.

Answer: A

Explanation: The problem is that the news account is wrongly configured. No
account was specified and the server requires it.

Incorrect Answers:

B: If there was no account, Outlook Express will prompt for account information.

C: The message states that the account has the problem. There is no sign of
privatenews.microsoft.com that does not exist.

D: The Microsoft newsgroup server does exist because the error said that it cannot be
found.
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QUESTION 35:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers

run either Windows XP Professional or Windows 98.

A Certkiller .com customer named Amy Walsh uses a Windows XP Professional
client computer. She has reported that she is trying to use Outlook Express to read

her e-mail messages. The Web host company has told her to use mail.testlabs.com as
the mail server. She has received a username and password, but cannot send

messages to anyone. Amy Walsh has configured POP3 as the mail server type.

What should Amy Walsh do?

A. Use the IP address as a replacement for of the domain name.

B. Make sure that mail.testlabs.com is a Simple Mail Transfer Protocol (SMTP) server
for outgoing mail.

C. Use Hypertext Transfer Protocol (HTTP) rather than Post Office Protocol 3 (POP3).
D. Make sure that outgoing mail server account information is specified to use Internet
Message Access Protocol (IMAP).

Answer: B

Explanation: Amy Walsh should make sure that mail.testlabs.com is a Simple Mail
Transfer Protocol (SMTP) server for outgoing mail. Outlook Express requires an
SMTP server to deliver mail.

Incorrect Answers:

A: If there was a domain problem, she would not have received incoming messages.
C: Amy Walsh should not use Hypertext Transfer Protocol (HTTP). This is used with
incoming mail servers only.

D: Amy Walsh should not use Internet Message Access Protocol (IMAP). This is used
with incoming mail servers only.

QUESTION 36:

HOTSPOT

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers

run Windows XP Professional.

Certkiller .com hires a sales consultant named Kara Lang. One morning she has
contacted you and wants to move the contact information from Microsoft Outlook
Express information to her Microsoft Office Outlook 2003 Contacts folder.

As seen on the exhibit, what actions should Kara Lang performs?
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Import and Export Wizard

Choose an ackon ko perfarm:

Expork booa filz
| Import & WCARD File | weF)
!Impu:urt an iCaendar ar wiZalendar File {ves)
EImpu:urt from another program or file
iIm|:u:urt Internzt Mail Account Settings
| Impart Internzt Mail and Addresses

| Description

Export Cutlook information ko a file For use in other
programs.,

= Back [ Mext = ] [ Cancel ]

Answer:

Import and Export Wizard

Choose an ackon ko perfarm:

| Export: to a filz

!Impart aWCARD file {,wef)

| Import an iCaendar or wiZalendar File {.ves)
| Import From another program or il

Aail -;ru:l Addresses

Descripkion

Import mail and addresses From Outlonk Express
and EudoraLight and Pro,

aick: [ Mexk = ] [ Cancel ]

Explanation:

To import the Microsoft Outlook Express information, she must click the Import Internet
Mail and Addresses. This will allow her to Microsoft Outlook Express information to her
Microsoft Office Outlook 2003 Contacts folder.

QUESTION 37:

HOTSPOT

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers

run either Windows XP Professional or Windows 98.

A Certkiller .com Representative named Andy Reid uses a Windows XP Professional
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laptop computer named Certkiller -WS001. Due to his work, Andy Reid travels a

lot. Certkiller .com uses Microsoft Exchange Server 2003 to provide messaging and
collaboration. All the Certkiller .com users are using Microsoft Outlook 2003.

Andy Reid would like to access his e-mail messages when his laptop is not connected
to Certkiller .com's network. In the exhibit, which control should Andy Reid click?

E-mail Accounts @

E-mail Accounts
ou can select an account and change its setkings or remove it,

Cigtlook processes e-mail For these accounts in the Following order:

Mame Twpe | Change. ..
Micrasaft Exchange Server Exchange (Defallt) |

Deliver new e-mail ko the Following location:
Mailbse - Andy Reid | | Mew Outiook Data File...

l < Back ][ Finish ]l Cancel ]

Answer:

E-mail Accounts E

E-mail Accounts
ou can select an account and change its sebtings or remove it

Qutlook processes e-mail For these accounts in the Following order;

Mame Type | Changg...

Micrasaft Exchange Server Exchange (DefaLlt)

Remove
Sek as Default
1

Deliver new e-mail ko the Following lacation:
Mailbas: - Andy Reid + || | mew Outlook Data File...

< Back ][ Finish l[ Cancel

Explanation:
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Andy Reid should choose the option to deliver messages to his personal folder. He then
can access his messages when the laptop is not connected to the network.

QUESTION 38:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Mia Hamm has contacted you about her problems
with her Internet e-mail account. Mia Hamm is accessing her Internet e-mail using
Post Office Protocol 3 (POP3). Mia Hamm uses Microsoft Outlook 2003 to access
their company's Microsoft Exchange Server 2003 business. Mia Hamm has also
permission to access his personal account while at his work. Mia Hamm can access
his Internet e-mail successful. Whenever Mia Hamm wants to access her already
read e-mail messages at home, it is not available.

What could be the problem?

A. The messages go to the Exchange mailbox instead of her personal folder.
B. Outlook is not specified to leave messages on the POP3 server.

C. POP3 server is not part of their company's network.

D. Messages are delivered to a personal folder than the Exchange mailbox.

Answer: B

Explanation: It can be that Outlook is not specified to leave messages on the POP3
server.

Incorrect Answers:

A: The problem is not that the messages go to the Exchange mailbox instead of her
personal folder. The problem is a POP3 configuration issue.

C: Itis not necessary that the company is part of the POP3 server. Outlook does not need
to use POP3 to access messages.

D: The problem is not that the messages go to the personal folder instead of her
Exchange mailbox. The problem is a POP3 configuration issue.

QUESTION 39:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com manager named Rory Allen has contacted you. He would like to use
Outlook Express to read the company's e-mail. Rory Allen also wants to know if he
could use Outlook Express for his Hotmail account.
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What should you tell him?

A. Hotmail is Internet mail which cannot be used with Outlook Express.
B. Change the Properties of the current e-mail account to use Hotmail.
C. Create a new profile using the Mail Control Panel applet.

D. Create an extra Mail account in Outlook Express.

Answer: D

Explanation: Rory Allen should create an extra mail account in Outlook Express.

She can the define Hotmail as the service provider.

Incorrect answers:

A: You can use the Outlook to connect to the Hotmail. The only change is that he should
choose HTTP as the incoming mail server type instead of the POP3.

B: Rory Allen should not change the Properties of the current e-mail account to use
Hotmail. He needs to download messages from the company and Hotmail.

C: Rory Allen is using the Outlook Express. By creating a new profile using the Mail
Control Panel applet will result in a Microsoft Outlook profile.

QUESTION 40:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Finance department. A Certkiller .com employee named
Amy Wilson works in the Finance department. Certkiller .com contains a Windows
XP Professional workstation named Certkiller -WS009. Amy Wilson is using this
computer. Amy Wilson is using Outlook Express on Certkiller -WS009. You then
installed Outlook 2002 on Certkiller -WS009 that can be used for contacts and
e-mail messages. After the installation Amy Wilson contacts you to complain that
her list of contacts are not available in Outlook. You need to solve the problem with
the least amount of administrative effort.

What should you do?

A. Import Outlook contacts into Outlook Express.

B. Import Outlook Express contacts into Outlook.

C. Uninstall Outlook Express from Certkiller -WS009.

D. Enter Amy Wilson's contacts from Outlook Express into Outlook, manually.

Answer: B
Explanation: You should import Outlook Express contacts into Outlook.

Incorrect answers:
A: You should not import Outlook contacts into Outlook Express. You should import
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Outlook Express contacts into Outlook.

C: To uninstall Outlook Express, will not result in the contacts to transfer to Outlook
2002.

D: To manually enter the contact will result in a lot of time. The scenario states with the
least amount of administrative effort.

QUESTION 41:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Server 2003 and all client computers run
Windows 2000 Professional.

Certkiller .com has its headquarters in Chicago and a branch office in Dallas.
Certkiller .com contains a Finance department and a Research department. You are
the desktop technician in the Chicago branch. A Certkiller .com user named Andy
Reid is a member of the Research department which is in the Dallas branch office.
Andy Reid has a laptop named Certkiller -WS002 that runs Windows XP
Professional.

Certkiller -WSO002 is attached to a docking station at the office. This provides him
with access to the LAN and the Internet. When Andy Reid is at home, he uses a
dial-up modem to connect to the ISP. Andy Reid uses Outlook Express for all e-mail
activities and uses two separate POP3 accounts to use at home and at work. These
two POP3 accounts have an entry in the Internet Accounts dialog box. Andy Reid
has contacted you about a problem he has. He complains that him home e-mail
messages and his office e-mail messages are mixed together. Andy Reid needs to
keep separate the office messages from the home messages.

What should he do?

A. Specify Outlook Express to use offline files.

B. Create an identity for the home and for the office.

C. Use the Secure Password Authentication to log on to the office account.

D. Specify each Outlook Express mail server account to authenticate outgoing mail with
the appropriate POP3 credentials.

Answer: B

Explanation: Andy Reid should create an identity for the home and for the office
contacts. An Outlook Express has its own e-mail folders, Internet access accounts

and address book.

Incorrect answers:

A: The use of offline files will not separate his messages.

C: Andy Reid will only use the Secure Password Authentication if asked by the
administrator to log onto his office account. This will not separate the messages.

D: It would be good for Andy Reid to specify each Outlook Express mail server account
to authenticate outgoing mail with the appropriate POP3 credentials. This would reduce
spam.
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QUESTION 42:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers
run either Windows XP Professional or Windows 98.

A Certkiller .com user named Kara Lang works as a secretary. She uses a Windows
XP Professional client computer named Certkiller -WS008. Kara Lang is creating

a Word 2003 document to be used as a letterhead. She also designed a header that
contains the Certkiller .com logo. Kara Lang does not know how to add a double
underline the logo text.

Where is the tool in Word 2003 that will allow Kara Lang to add a double
underline?

A. On the Forms toolbar.

B. On the Drawing toolbar.
C. On the WordArt toolbar.
D. On the Reviewing toolbar.

Answer: B

Explanation: The lines tool is found on the Drawing toolbar.

Incorrect answers:

A: The Forms toolbar is used to add form fields, table etc.

C: The Drawing toolbar is used to add lines, arrows WordArt text, etc.
D: The Reviewing toolbar provides a text highlighting tool.

QUESTION 43:

DRAG DROP

You work as a helpdesk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server.

Certkiller .com contains a Research department, Sales department and a Quality
Assurance department. You have received instruction from the CIO to prepare a
computer for a tester. The tester is responsible for testing the latest version of a
product that was developed in the Research department, which works on Windows
XP Professional and Windows XP Home. The computer will be accessible from the
network and will house encrypted files. These files must be accessible only to the
tester. You need to prepare the hard disk for the two operating systems.

From the list on the left, select the tasks.
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Steps, place here

Install Windows XP Professional on an
NTFS partition.

Place here.

Create two partitions.

Place here, if any

Format one partition with FAT32.

Place here, if any.

Install Wndows XP Home on an NTFS
partition.

Place here, if any.

Format one partition with NTFS.

Place hare, if any.

Install Windows XP Home on a FAT32
partition.

Place here, if any.

Create one partition.

Place here, if any.

Farma: both partitions with FAT32,

Place here, if any.

Install Windows XP Professional on a
FAT32 partition.

Place here, if any.

Format both partitions with NTFS.

Place here, if any.

Answer:
Steps, Select from these

Steps, place here

Create two partitions.

Format both partitions with NTFS.

Format ore partition with FAT32.

Install Windows XP Home on an NTFS
partition,

Install Windows XP Professional on an
NTFS partition.

Format one partition with NTFS.

Place here, if any.

Install Windows XP Home on a FAT32
partition,

Place here, if any.

Create one partition.

Place here, if any.

Format both partitions with FAT32.

Place hers, if any.

Install Windows XP Professional on a
FAT32 partition.

Place here, if any.

Place here, if any.

Explanation:

You should create two partitions. You then can run both operating systems, each on a

partition. You also need to format the partitions with NTFS.

Incorrect Options:

You should not partition a partition with FAT. FAT does not support encryption.
Windows XP Home supports NTFS but not Encrypted File System (EFS). EFS is

supported with Windows XP Professional.

Actualtests.com - The Power of Knowing




070-272

QUESTION 44:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 98 client computers.

Certkiller .com contains a Marketing department. A Certkiller .com employee named
Mia Hamm works in the Marketing department. Certkiller .com contains a Windows
98 workstation named Certkiller -WS011. Mia Hamm is working on

Certkiller -WS011. Certkiller -WS011 contains a third party accounting application
named CK_Acc. During the previous month a beta version of the third party
accounting application which is compatible with its predecessor and it was available
to the public which runs on Windows XP Professional. These two versions run
different user interfaces (Uls). Mia Hamm needs the latter version for

Certkiller .com. Your administrator partitions the hard drive into two drives named
C and D and installs Windows XP Professional on one of the partitions. When Mia
Hamm starts Windows XP Professional and CK_Acc, she created a test account
application and exports it to the file. She then reboots in Windows 98 and starts
TerstAcc to import the files, but she was not successful. She cannot access the files.
What could be the problem?

A. The new data files were stored on an NTFS partition.

B. The beta version of CK_Acc is not compatible with the former version.
C. Mia Hamm imported by using the beta version of CK_Acc.

D. Mia Hamm exported by using the former version of CK_Acc.

Answer: A

Explanation:

The administrator format the second partition with NTFS. Windows 98 does not
support NTFS, only FAT.

Incorrect answers:

B: The beta version is not incompatible. The scenario states that the two is compatible.
C: The importing is not the problem. The versions have Uls that differs them.

D: The exporting is not the problem. The versions have Uls that differs them.

QUESTION 45:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner's
computer is running Microsoft Windows 98 on dive C and Microsoft Windows XP
Professional on drive D: Ally Wagner did move the confidential encrypted files from
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drive D to drive C. Ally Wagner's computer is part of a workgroup. She now has a
security problem. The other users in the workgroup can access and read the
encrypted files. Ally Wagner wants to know what is the problem.

What should you tell Ally Wagner?

A. Windows 98 can be installed on FAT16 and FAT32. FAT16 and FAT32 do not
support encryption.

B. When folders are moves to another, they forfeits there permissions.

C. You are not the owner of the file. Another user has changed the permissions.

D. When encrypted files are always decrypted when they are moving.

Answer: A

Explanation: It is true that FAT16 and FAT32 do not support encryption. Ally

Wagner did move the files from NTFS to a FAT partition.

Incorrect answers:

B:The statement in B: is misleading. It is only true if the destination folder resides on a
different partition from the source folder.

C: This is not true. If a user moves a folder, he will still be the owner of the folder.

D: Moving files will not decrypt it. It will only become decrypted if it is moved fro
NTFS to FAT.

QUESTION 46:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Rory Allen has contacted you. Rory Allen has a
laptop that is running Windows 98. He wants to install another operating system,
Windows XP Home on the laptop. He wants to know if should be aware of anything.
What should you tell Rory Allen?

A. You cannot install service packs on Windows XP Home because it will affect
Windows98.

B. Make sure that all files that need to access from Windows 98 remains on the FAT
partition.

C. Windows 98 will become unstable due to registry merging.

D. Windows XP Home should be installed on a separate partition.

Answer: B, D
Explanation: Rory Allen should know that all files that need to access from

Windows 98 remains on the FAT partition. He should also know that Windows 98
cannot read files on NTFS.

Actualtests.com - The Power of Knowing




070-272

Incorrect answers:
A: Windows XP Home is on a separate partition. It cannot affect Windows 98.
C: The two operating systems is on separate partitions, so it cannot become unstable.

QUESTION 47:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner is the
administrator of her computer which is running Windows XP Home. Ally Wagner
has a third party graphics application, which she wants to share with a co-worker.
Ally Wagner and the co-worker have different user accounts to log on to the
computer. The third party graphics application resides in a folder on drive C and
copies the application's executables from a CD-ROM disk. The problem is that the
shortcut of the third party graphics application is not available to her brother. The
theme of both desktops is different. Ally Wagner needs her co-worker to also use
third party graphics application.

What should you do?

A. Change the co-worker's user account type to Computer Administrator.

B. Copy the third party graphics application’s shortcut to the Desktop folder in the All
Users profile.

C. The third party graphics application should be reinstalled for all users.

D. Configure the co-workers Theme the same as yours.

Answer: B

Explanation: When copying the third party graphics application’s shortcut to the
Desktop folder in the All Users profile will allow the shortcut to be available for the
co-worker.

Incorrect answers:

A: By changing the account type of the co-worker to Computer Administrator, will not
make the third party graphics application available on the desktop.

C: Ally Wagner does not need to reinstall the third party graphics application. She
already copy the executable files.

D: Even if you change the Desktop Theme, it will not make the shortcut available.

QUESTION 48:
DRAG DROP
You work as a desktop support technician at Certkiller .com. The Certkiller .com

network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers
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run either Windows XP Professional or Windows 98.

A Certkiller .com customer named Kara Lang has contacted you. Kara Lang is
employed by a small company named Contoso.com that contains a 10 employees.
Contoso.com contains two computers running Windows XP Home. Contoso.com
contains a Sales department. Five of the employees share one computer. Kara Lang
the manager of their company also shares the computer with 5 employees. She
installed an application to track customer related issues. Kara Lang did install the
application executables from the Internet and it was saves on drive D. The shortcut
for the application in on the Desktop. Kara Lang starts the application by clicking
Start, All Programs and then the shortcut.

The employees of their company are complaining that they cannot locate the
shortcut when they log o to the computer. Kara Lang than make sure that the
executables is still existing. Kara Lang needs application to be available to the
employees of their company.

What should you do? (From the list on the left, select the instructions)

Steps, Select from these Steps, place here

Choose Paste from the Edit menu in

Windows Explorer. Flaos nere:

Open the Add or Remove Programs applet

R Place here, if any.

Navigate to C:\Documents and Settings!

klang\Start Menu Programs. Pace hiers ifany.

Qpen Windows Explorer. Place here, if any.

Reinslall the applivalion. Place here, if any.

Right-click the shortcut and choose Cut

from the context menu. Feaon ors, any,

Right-click the application and click

Remove from the context menu. Place oy, £ any:

Mavigate to C:\Documents and Setings\
All Users\Start Menu Programs.

Answer:

Place here, if any.
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Steps, Select from these Steps, place here

Open Windows Explorer.

Open the Add or Remove Programs applet Navigate to C:\Documents and Setings\
in Control Panel. klang\Start Menu Programs.

Right-click the shortcut and choose Cut
from the context menu.

Navigate to C:\Documents and Settings\
klang\Start Menu Programs.

Choose Paste from the Edit menu in

Reinstall the application. Windows Explorer.

Place here, if any.

Right-click the application and click

Remove from the context menu. Expre e, # a0y,

Place here, if any.

Explanation:

The shortcut of the application exists on Kara Lang's Start Menu folder. She needs to put
it in the All Users folder. This will make it available to the other users.

Incorrect Options:

There is no need to reinstall the application. Kara Lang did copy the executable to the
computer.

You should not use the Add and Remove Programs applet and click the application and
click remove. This action will remove the application from the computer.

QUESTION 49:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

A Certkiller .com user named Rory Allen works in the Marketing department. Rory
Allen works on a client computer named Certkiller -WS004 has an

uninterruptible power supply (UPS) attached and installed. Rory Allen runs an
accounting application that was installed by one of the managers. Rory Allen has
problems running the application. During the investigation you discover that the
manager has logged onto the computer and install the accounting application. As
soon as Rory Allen runs the accounting application he receives the following error
message. "The Software/TestDev/DocumentGenerator registry subkey is missing".
If the manager runs the program, there is not problem with the accounting
application. You then log on with Rory Allen username and run the REGEDIT.
Which registry key should you examine?

A. HKEY_USERS

B. HKEY_LOCAL_MACHINE
C. HKEY_CURRENT_USER
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D. HKEY_CLASSES ROOT
Answer: A

Explanation: The HKEY_USERS contains all the subkeys for all the users of the
computer system. You should locate the user's security identifier for the
Software/TestDev/DocumentGenerator subkey. The key is created for the manager

and not for Rory Allen.

Incorrect answers:

B: The HKEY_LOCAL_MACHINE contains the computer-specific information. It is not
necessary to examine this, if the subkey was in here, the application should have worked
for Rory Allen.

C: The HKEY_CURRENT _USER contains registry entries for the current logged user. It
is not necessary to examine this, if the subkey was in here, the application should have
worked for Rory Allen.

D: The HKEY_CLASSES _ROOT contains registry entries for the registered dynamic link
libraries and the Component Object Model objects. It is not necessary to examine this, if
the subkey was in here, the application should have worked for Rory Allen.

QUESTION 50:

You work as a helpdesk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server.

Certkiller .com contains a Research department and a Sales department. The
Research department does research on and software where the Sales department
sells the applications, software and computers. Certkiller .com also has a help desk
team which helps the customers which has problems with there software or
computers that was bought at Certkiller .com.

A Certkiller .com customer named Dean Austin has contacted you. Dean Austin and
his brother are doing auditing for companies from there home. Dean Austin has
problem with there accounting application. He said he is shown a splash screen but
the accounting application does not run. You then go out to do the house call. Dean
Austin contains a computer running Windows XP Home. Dean Austin said the
program did work an half an hour ago. He also said that his brother also used the
program before the he used the computer. You need to troubleshoot the problem.
What should you do?

A. Make sure that the brother did not change the NTFS permissions on the application's
executables.

B. Make sure that Dean Austin's brother did not change his account to a
non-administrative account.

C. Make sure that the compatibility mode of the application is configured for Windows
XP.

D. Verify if Fast Switching is enabled.
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Answer: D

Explanation:

Fast Switching allows a user to run an application in a user's session while the other
one is logged on. You do get applications and programs that do not allow multiple
instances. It can be that Dean Austin's brother has switch back to Dean Austin
account without logging off.

Incorrect answers:

A, B: You should not check for permissions. The program did run and it showed Dean
Austin a splashed screen.

C: The program did work an half an hour ago. Incompatibility is not the issue.

QUESTION 51:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner's
computer at work has a dual boot configuration with Windows XP Professional and
Windows 2000 Professional. Ally Wagner shares the computer with another
employee named Mia Hamm. Ally Wagner and Mia Hamm are working shifts. Ally
Wagner uses Windows XP Professional and Mia Hamm uses Windows 2000
Professional. Mia Hamm has installed an accounting application that should be used
by Ally Wagner and her self. Mia Hamm did register the accounting application
using one license.

Whenever Ally Wagner runs the accounting application, she receives an error, that
the accounting application is not registered.

What should you do to troubleshoot the problem?

A. The Program Compatibility Wizard should be run.

B. Copy the database registry from Windows 2000 Professional to Windows XP
Professional.

C. The Upgrade Advisor should be run.

D. Reinstall the application under Windows XP Professional.

Answer: D

Explanation: You should reinstall the application in Windows XP Professional.
There are two operating systems. Each of them has their own database registry, and
each operating system is on a partition.

Incorrect answers:

A: This will allow the application to run in a specific operating system mode.

B: Copy the database registry to Windows XP Professional will make the operating
system unstable.
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C: Thy should run the Upgrade Advisor before upgrading to Windows XP Professional
to see if the program is compatible with the operating system.

QUESTION 52:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

Certkiller .com contains a Research department, Sales department and a Quality
Assurance department. You have received instruction from the CIO to prepare a
computer for a tester. The tester is responsible for testing the latest version of a
product that was developed in the Research department, which works on Windows
2000 Professional. The Quality Assurance department contains a computer to run
the new applications. The manager wants all the testers to run the application. The
Quality Assurance department's manager has installed a 16-bit graphics application
on the computer in the Quality Assurance department, but no te4ster can run the
16-bit graphics application. They received the following error message: "The
Software/TestDev/DocumentGenerator registry subkey is missing”. You then
connect to the registry on the computer remotely.

In the exhibit, what registry key should you examine?

= B My Computer

-] HKEY_CLASSES_ROOT

+-[_] HKEY_CURRENT_UISER
|1 HKEY_LOWCAL_MACHINE
J-[_] HKEY_LISERS

1] HEEY_CURRENT_CONFIG

Answer:

= =} My Computer
-] HEEY_CLASSES_ROCT
-] HKEY CURRENT LSER
(5 [] HKEY_LOCAL_MACHINE]
[ HKEY USERS
-] HKEY_CURRENT _COMFIG

[ B

I+ [+

-

Explanation:

You should examine the HKEY_LOCAL_MACHINE key. This key has the
computer-specific information. If the subkey is there, it will be available to the other
users.

Incorrect Options:

There is no need to examine the HKEY_CURRENT_USER key. When you connect
remotely, the key will not be available. The HKEY_CURRENT_USER key contains the
registry entries that are specific to a user that is currently logged on.

There is no need to examine the HKEY_CURRENT_CONFIG key. When you connect
remotely, the key will not be available. The HKEY_CURRENT_CONFIG key contains
the settings for the current loaded hardware profile.

There is no need to examine the HKEY_CURRENT_ROOT key. When you connect
remotely, the key will not be available. The HKEY_CURRENT_ROOT key contains
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registry entries for the registered dynamic link libraries and the Component Object
Model objects.

There is no need to examine the HKEY _USER key. When you connect remotely, the key
will not be available. The HKEY _USER key contains all the subkeys for all the users of
the computer system.

QUESTION 53:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Sales department. The Certkiller .com users named Mia
Hammand Kara Lang works in the Sales department. Due to the long hours, these
two employees work shifts. They both share a computer named Certkiller -WS050
which runs Windows XP Professional. Mia Hamm has contacted you because she
cannot access the application which they both use. Mia Hamm use to access the
application by clicking the shortcut on the Desktop. When she aces the application is
produces a Missing Shortcut error. Kara Lang does not have this problem. She
activates the application the same way Mia Hamm does.

What could cause the problem?

A. The application is still running in Kara Lang's session with Fast User Switching.
B. Kara Lang is the administrator and not Mia Hamm.

C. The executable of the application was moved from it location.

D. You cannot create two shortcuts for the same application.

Answer: C

Explanation: Mia Hamm and Kara Lang has there own separate Desktop. Kara

Lang can successfully access the application, which means she must have move the
executable and configure the shortcut to point to the new lactation. .

Incorrect answers:

A: It cannot be Fast Switching. Mia Hamm received a Missing Shortcut error.

B: This is not the issue here. Both of them did run the application.

D: You can create two shortcuts for one application. One shortcut cannot point to more
that one application.

QUESTION 54:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of.
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Certkiller .com contains a Graphics department. A Certkiller .com user named Mia
Hammwho works in the Graphics department has contacted you. Mia Hamm has a
meeting with there superiors and she uses a computer named Certkiller -WS020 to
do her presentation. Always during the presentation the computer's screen becomes
corrupt. She wants you to troubleshoot the problem. When you switch on the
computer, everything was normal. Mia Hamm then said the problem occurs
regularly.

What should you do?

A. Replace the CRT of Certkiller -WS020.

B. Update the video driver of Certkiller -WS020.

C. On Certkiller -WS020, reinstall Windows XP Professional.
D. Make sure that the video card is fully seated in the slot.

Answer: B

Explanation: The screen becomes disrupted during the presentation. Mia Hamm

also said that it occurs frequently. It can be that the video driver is not compatible

with the application. If she upgrades the video card, the problem will be rectified.
Incorrect answers:

A: You switch on the computer and there was nothing wrong. If it was the CRT, then the
problem will persist.

C: Reinstalling Windows XP Professional would not solve the problem.

D: If the video card was not properly seated then the screen would have stayed black.

QUESTION 55:

You work as a helpdesk support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Rory Allen has contacted you. Rory Allen reports
that he cannot open Microsoft Office Word 2003. Rory Allen said that he used
Microsoft Office Word 2003 the day before.

How can Rory Allen repair Word?

A. Rory Allen should use the Performance and Maintenance.

B. Rory Allen should use the Add or Remove Programs.

C. Rory Allen should use the Help and Support.

D. Rory Allen should use the Microsoft Office Application Recovery.
Answer: B

Explanation: There is a ways to repair Word. Rory Allen should use the Add or
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Remove Programs, and click reinstall or repair. The next thing is to click Detect and
Repair Errors in My Office Installation.

Incorrect answers:

A: Rory Allen should not use the Performance and Maintenance. You can use the
Performance and Maintenance to view and change the System Properties.

C: Rory Allen should not use the Help and Support. You cannot use the Help and
Support to repair any functions.

D: Rory Allen should not use the Microsoft Office Application Recovery. The Microsoft
Office Application Recovery allows you to recover documents from Office applications.

QUESTION 56:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Marketing department. You were authorized by the CEO
to purchase Microsoft Office 2003. Three Certkiller .com employees named Mia
Hamm, Amy Walsh and Amy Wilson work in the Marketing department. All three
of the employees have installed Microsoft Office 2003 on their computers. They used
the same CD-ROM and product key. After three days the manager named Andy

Reid from the Marketing department has contacted you. He is worried because all
three of the employees are running Microsoft Office 2003 and are using it.

What should you tell Andy Reid?

A. Microsoft Office 2003 is not activated.

B. The three employees have tampered with the registry.
C. Microsoft Office 2003 will uninstall after 50 launches.
D. Microsoft Office 2003 does not enforce licensing.

Answer: A

Explanation: It can be that the application is not activated. The user can start the
application 50 times before he or she will be prompt for an activation key.

Incorrect answers:

B: It does not state that the activation code is stored on the computer.

C: Microsoft Office 2003 will not uninstall after 50 launches. The users will not be able
to save any documents.

D: On all versions of Office, there is a product license.

QUESTION 57:
You work as a desktop technician at Certkiller .com. The Certkiller .com network

contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
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either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. Kara Lang is
complaining that she cannot make create or make changes to any document.
What should you ask Kara Lang? (Select all that apply)

A. Is Microsoft Office installed on more than one computer?
B. Are the documents created from a template?

C. Which version of Microsoft Office are you using?

D. Have you activated Microsoft Office?

Answer: C, D

Explanation: Some of the versions of Microsoft Office need an activation key. If so,
activations is needed after you start the application more than 50 times.

Incorrect answers:

A: It depends on the particular product key. Activation will fail if it is used on more than
one computer.

B: Template make easy document. You do not need to ask this question.

QUESTION 58:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Clive Wilson has contacted you. He wants the latest
Microsoft Office XP update. Clive Wilson does not know where he could get the
updates.

What should Clive Wilson do?

A. Clive Wilson should use the Office Tools on the Web option, which resides in the
Help menu of Microsoft Word.

B. Clive Wilson should use Microsoft Office Tools and then Activate Product.

C. Clive Wilson should use the Help and Support.

D. Clive Wilson should use the Windows Update

Answer: A

Explanation: Clive Wilson should use the Office Tools on the Web option. The Web
browser would navigate him or he can do it manually.

Incorrect answers:

B: Clive Wilson should not use Microsoft Office Tools and then Activate Product. This
is used to activate Office.

C: Clive Wilson should not use the Help and Support. This is used to troubleshoot
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operating system issues.
D: Clive Wilson should not use the Windows Update. This is used to update the
operating system and not to update Microsoft Office.

QUESTION 59:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Mia Hamm has contacted you. Mia Hamm is
working for a printing company. She is busy doing research for her book. Mia
Hamm uses a laptop and connects by modem to his personal Internet Service
Provider (ISP). She uses the company's network to access the Internet. When Mia
Hamm is at her home with the laptop, the laptop still wants to the Internet and
attempts to dial the ISP instead of using the network connection.

What should Mia Hamm do?

A. Select the Dial whenever a network connection is not present.

B. Run from the command prompt the ipconfig /renew.

C. Select the Never dial a connection option, which resides in the Internet Connections
dialog box.

D. Use the Alternate Configuration tab, which is on the Internet Protocol (TCP/IP)
Properties dialog box.

Answer: A

Explanation: Mia Hamm should use the Select the Dial whenever a network

connection is not present. When she is then at work, it would use there Internet
connection and when she is at home it would use her own Internet connection.

Incorrect answers:

B: This command will let Mia Hamm renew the computer lease on the IP address.

C: This option will allow Mia Hamm to only use the network at her office and not the
one at home.

D: The Alternate Configuration tab is used for correct TCP/IP configuration on different
networks that does not use Dynamic Host Configuration Protocol to assign TCP/IP
configuration parameters.

QUESTION 60:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
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Certkiller .com customer named Kara Lang has contacted you. Kara Lang is visiting
a Web site regularly, but she is always presented with a page that indicates that she
should enable cookies before she can brows the site as seen on the exhibit.

What tab should Kara Lang click to visit those sites?

Internet Options

| General |E;ec:urit_l,ll;§l_F'rivacy | Content | Conmections :EIF'rcngrams Advanced |

Home page
| % You can change which page to uze for your home page

Address: } fisapifredir, dI?

rd=iepver=62ar=msnhomel

[ Usze Current J | Uz Default ] [ Iz Blank ]

Temporary [ntemet files
b Fages vou view on the Internet are stored in a special folder
L@ ¥ for quick viewing later,

[Delete Cou:ukies...] [ Delete Files... ] [ Settings... J

Hiztom

The Histom lolder containz links to pages pou've wisited, for
quick access to recently viswed pages.

[rays to keep pages in histony: 26_:' Clear Histomy

[_ Colors... J I Fonts. .. J [ Lahguages.. ] [Accessibilit}l... ]

I DF. ][ Cancel J Apply

Answer:
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Internet Options @@
General Securit_l,lEDntent | Connections | Programs | Advanced |
Home page

Eﬁ r'ou can change which page to use for your home page

Address: |'i~:-a ifredir . dl?prd=iefpyer=68ar=msnhome

[ Uze Current ] | Usze Default | [ Uze Blank

Temporamy Intemet files

i Pages you view an the Intermet are stored in a special folder
V@ Y for guick viewing later.

[Delete D:uokies...] | Delete Files... I [ Settings... J

Hiztary

The Hiztom lolder containg links to pages you've vizited, for
quick, access to recently vizwed pages.

Draps to keep pages in histony: 2I:I : | Clear History

[ Colorz. .. ] | Fonts... J [ Languages.. ] [Accessibility...]

[ QF. ][ Cancel J

Explanation:
The Private tab will allow her to set the default handling of cookies.

QUESTION 61:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Sales department. A Certkiller .com user named Dean
Austin works in the Sales department. Dean Austin visits a lot of Web pages to do
research in the cost price of products. Dean Austin wants to remove some of the
Web pages that he's not visiting regularly. He needs to access the most needed site
quickly.

What should you tell Dean Austin to do?

A. Increase the number of days to keep pages in history.

B. Add the pages that are visited often to the Favorites menu.
C. Store cookies for the pages that it regularly visits.

D. Decrease the number of days to keep pages in history.
Answer: B

Explanation: Dean Austin should add the pages that he visited regularly, to the
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Favorites menu.

Incorrect answers:

A, C: Increase or Decrease the number of days will not help. If the settings for the days
are over, he still then needs to access these pages.

D: This is not a cookies related issue.

QUESTION 62:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner has a
Windows XP Home computer and wants to configure the launching programs and
files in an IFRAME. Ally Wagner wants to know why this setting is disabled on her
computer.

What explanation can you give Ally Wagner?

A. This will prevent you from accessing the Internet from Windows Explorer.

B. This prevents a Web page from invisibly loading Web content from another site onto
the same page.

C. This will prevent Internet Explorer from using scrollbars so that Web pages are more
viewable.

D. It has no effect on Windows XP because of its security enhancements.

Answer: B

Explanation: The IFRAME is an invisible section of a Web page that contains

content from another location. If the setting is disabled, it will not load other content

of other invisible Web site.

Incorrect answers:

A: Windows Explorer and Internet Explorer use the same object model. Internet cannot
be browse from the Windows Explorer. This setting will not prevent you from accessing
the Internet from Windows Explorer.

C: This setting does not have an effect on the scroll bar.

D: This is effective in Windows XP Professional. it is set to be prompt.

QUESTION 63:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Actualtests.com - The Power of Knowing




070-272

Certkiller .com customer named Amy Wilson has contacted you. Amy Wilson is
working as a journalist. She sometimes needs to send messages to a colleague which
is sensitive. She is scared that the messages can be intercepted. Amy Wilson needs
Outlook Express to be configured so that only the intended person can access the
messages.
In the exhibit, what should Amy Wilson click?

Send / Receive Mezsages

Default Mezzaging Programs

-

- Spe:ll.ing_ [ S.eu_:urit__lr_l_ Cornection l .M.aintenance ;
General ! Read Receiptz Send | Compoze Sighatures
General

[]*when starting, go directly bo my Tnbox’ folder
Matify me if there are any new newsgroups
Automatically display folders with unread messages
Automatically log on to windows Messenger

Play zound when new meszages arive
. Send and receive meszages at startup

Check for new messages every (30 3, rninLte(z] |

IF ry computer iz hot connected at thiz time:

Thiz application iz MOT the default Mail handler t ake Default ‘
LY

Thiz application iz the default Hews handler

o

] % ][ Cancel l

Answer:
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- Spell{ng_ | Security Cormection Maintenance
General | Read Receiptz Send Compoze Signatures
General

ﬁ []'when starting, go directly ta my ‘Inbox’ folder
— . .

Matify me if there are any new newsgroups
Automatically display folders with unread meszages

Autamatically log on to Windows Messenger

Send / Receive Messages
= Play zound when new meszages arive
= Send and receive meszages at startup
Check for new messages every §3EI $ rninLite ]
If ry computer iz hot connected at thIS ti-r-ne: .
E-DD Aot conect ~
Default Mezsaging Programs

Thiz application iz HOT the default kail handler Make Default

Thiz application iz the default Hews handler

[ Ok, ][ Cancel l

Explanation:

Amy Wilson should use the security tab. She can encrypt the messages and use a digital
signature. Amy Wilson then should use a public key, while the recipient uses a private
key.

QUESTION 64:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Wilson has contacted you. Amy Wilson is
working as a journalist. She always sends her messages via Outlook Express to their
main office. Today she needs to send the picture which will accompany the report of
a news event with My newsgroups post. When Amy Wilson access Outlook Express
there was no Picture option on the Insert menu.

What should Amy Wilson do?

A. For security reasons, pictures cannot be sent with Outlook Express newsgroup post.
B. Picture options for a newsgroup reside in the Insert menu of the e-mail messages. The
picture can be copies and past into the message.

C. Pictures can be inserted by using the message signatures.
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D. The default format for Outlook Express newsgroups messages is text. You need to
choose the Hypertext Markup Language (HTML). It supports inserting pictures from the
Insert menu.

Answer: D

Explanation: Amy Wilson can only send pictures from the Insert menu if the

HTML format is used.

Incorrect answers:

A: Security settings do not stop the sending of picture in Outlook Express.

B: Amy Wilson does not need to copy and past messages. Amy Wilson can only send
pictures from the Insert menu if the HTML format is used.

C: You do not need message signatures to insert pictures. If so, you need a signature for
each picture that is posted to a newsgroup.

QUESTION 65:

You work as a helpdesk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server.

Certkiller .com contains a Sales department. A Certkiller .com customer named Rory
Allen has contacted you. Rory Allen is conversing to the customers via e-mail. When
Rory Allen is advertising a new product he uses Outlook Express, but now he want
to his contact information as an attachment to new customers.

What should Rory Allen do?

A. When creating a new message, choose My Business Card from the Insert menu which
resides in the New Message window.

B. In the Outlook Express Tools menu, choose Option and click the Signature tab and
specify a signature for outgoing messages.

C. In the Outlook Express Tools menu, choose Option and click the Compose tab and
check the Mail option in the Business Card section.

D. Create a new mail messages rule to specify that your contact information is
automatically sent to the chosen member or customer.

Answer: A

Explanation: Rory Allen should choose My Business Card from the Insert menu.

This will allow him to send his contact information to the customer.

Incorrect answers:

B: The Signature tab cannot send attachments.

C: The Compose tab will allow for every message to have an attachment. He only wants
it for new customers.

D: Messages rule do not support attachment configuration.
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QUESTION 66:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Mia Hamm has contacted you. Mia Hamm works
for a company named Acme.com and works on a Windows XP Professional
computer. Mia Hamm wants to burn a file which contains a business presentation to
colleagues in another country. The burning process failed. Mia Hamm is concerned
because the file is still visible in the D: drive and there is no CD-R disc in her
computer. She wants to know what is now wrong with her system.

A. There is a virus that targets only Windows XP family operating systems.

B. Before the files can be deleted, you should burn the files to a usable CD-R disc.
C. The files are stored on the hard drive in the profile folder.

D. Reboot the computer to clear the CD-R drive's memory.

Answer: C

Explanation: These files are stored in the user's profile folder. This will then allow

the user to again burn a CD-R disc then the user does not need to copy the files

again.

Incorrect answers:

A: This is not a virus problem. It is a feature of Windows XP.

B: If the user wants to delete the files he or she can just open ht D: drive and delete the
temporary files.

D: There is no need that Mia Hamm should delete the files. it is not stored on the CD-R
drive's memory but on the hard drive.

QUESTION 67:

DRAG DROP

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Kara Lang has contacted you. Kara Lang has
problems to locate the Control Panel applet. Kara Lang likes the new look, but
would like to revert to the old look of the Control Panel.

In the exhibit, select the instructions for Kara Lang.
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Steps, place here

Choose Windows Classic from the Themes
list on the Theme tab.

Place here.

Open Windows Explorer.

Place here, if any.

Right-click the desktop end choose
Properties from the coniext menu.

Place here, if any.

Choaose Folder Options from the Tools
menu.

Place here, if any.

Right-click the Start menu and choose
Properties from the context menu.

Place here, if any.

Choose Use Windows Classic folders on
the General tab.

Place here, if any.

Choose the Classic Start menu option on
the Start menu tab.

Place here, if any.

Click the Switch to Classic View link.

Place here, if any.

Open the Control Panel.

Place here, if any.

Answer:

Steps, Select from these

Choose Windows Classic from the Themes
list on the Theme tab.

Steps, place here

Open the Control Panel.

Open Windows Explorer.

Click the Switch to Classic View link.

Right-click the desktop and choose
Properties from the context menu.

Place here, if any.

Choose Folder Options from the Tools
menu.

Place here, if any.

Right-click the Start menu and choose
Properties from the context menu.

Place here, if any.

Choose Use Windows Classic folders on
the General tab.

Place here, if any.

Choose the Classic Start menu option on
the Start menu tab

Place hers, if any.

Place hers, if any.

Place here, if any.

Explanation:

Kara Lang should switch to the Classic view. She should open the Control Panel and

click the Switch to Classic View link.

Incorrect Options:

If Kara Lang chooses the Use Windows Classic folders, it would change the view of the

other windows such as My Documents, My Computer etc.

Kara Lang should not select the Windows Classic, she still likes the new look.
Kara Lang should not select the Classic Start menu, she still likes the new look.

The Windows Explorer is used to manage files and folders.

QUESTION 68:
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You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server. All client computers run
Windows XP Professional and Office XP.

A Certkiller .com user named Mia Hamm uses a client computer named

Certkiller -WS001. Mia Hamm works as a secretary at Certkiller .com. Mia Hamm
writes project management reports for Certkiller .com.

Mia Hamm was instructed to use the Reports template with Microsoft Word 2002.
She then realizes that the Reports template is not installed on Certkiller -WSQ01.
What should Mia Hamm do to have Reports template on Certkiller -WS001?

A. Deploy Microsoft Access

B. Reinstall Office XP, using the default settings.

C. Install the latest patch for Office XP

D. Use the Add/Remove Programs Wizard and the Office XP installation CD disk to
install the template.

Answer: D

Explanation: To install the template she should use the Add/Remove Programs

Wizard and the Office XP installation CD disk.

Incorrect Answers:

A: Installing Microsoft Access will not help. Microsoft Access is a database program.
B: To reinstall Office XP, using the default settings will not help. She should use the
Add/Remove Programs Wizard and the Office XP installation CD disk to install the
template.

C: If she installs the latest patch, it would not enable the Reports template. She should
use the Add/Remove Programs Wizard and the Office XP installation CD disk to install
the template.

QUESTION 69:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Ally Wagner has contacted you. She is the
administrator of their company. Ally Wagner has downloaded an Excel spreadsheet
from the Internet to perform a lot of calculations. When Ally Wagner opens the
Excel spreadsheet, it automatically runs a Macro virus. Ally Wagner wants to
ensure that only signed macros from trusted sources are allowed to run in Excel
spreadsheet. Ally Wagner does not want the other users to modify or change the list
of trusted sources.

What should you advice Ally Wagner to do on the Security dialog box in Excel?
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A. Select a security level of High.

B. Select a security level of Medium.

C. Select a security level of High and establish a computer policy that blocks changes to
the Trusted Sources list.

D. Select a security level of Medium and establish a computer policy that blocks changes
to the Trusted Sources list.

Answer: C

Explanation: If you set the security level of High, it will disable all macros except

the ones that are from a trusted source. By blocking the changes will prevent the

user from adding or deleting the list of resources that is in the trusted sources list.
Incorrect Answers:

A: If you set the security level of High, it will disable all macros except the ones that are
from a trusted source. However, this is not enough because the user can still add or
change the list of resources that is in the trusted sources list.

B: A security level of Medium will still allow the user to open even when the Trusted
Sources list is blocked.

D: A security level of Medium will still allow the user to open even when the Trusted
Sources list is blocked. By blocking the changes, it will prevent the user from adding or
deleting the list of resources that is in the trusted sources list.

QUESTION 70:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server. All client computers run
Windows XP Professional and Office XP.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com user named Andy Reid works in the Sales department. He is still new
in the department and is not familiar with Microsoft Excel. Andy Reid has

contacted you to use Microsoft Excel with help readily available. You then tell for
Andy Reid to open Microsoft Excel.

What should you tell him to do next?

A. Click Help and then click Detect and Repair.

B. Click Help and then click Show Office Assistant.

C. Click Help and then click Microsoft Office Online.

D. Click Tools and then click Customize and enable the Office Assistant.

Answer: B
Explanation:
Andy Reid has to click Help and then click Show Office Assistant. Click Help and

then click Show Office Assistant will allow for help to be available when he is using
Excel.
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Incorrect Answers:

A: When he clicks the Detect and Repair, it will repair any errors that are happening in
the Office programs.

C: When he clicks the Microsoft Office Online, it will launch the Microsoft Office Web
page. This action will not enable the Office assistant.

D: By clicking the Tools, will not make help available. He should click Help.

QUESTION 71:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server. All client computers run
Windows XP Professional and Office XP.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner has a
client computer running Windows XP Professional and Microsoft Office 2003 is
installed in the computer. Ally Wagner complains that when she uses Microsoft
Word 2003, the Picture toolbar is displayed. Ally Wagner wants to remove the
Picture toolbar with the least amount of administrative effort.

What should you instruct Ally Wagner to do?

A. In the Help menu in Word, select Detect and Repair.

B. Delete the .dot files and restart Microsoft Word 2003.

C. Right-click any toolbar in Microsoft Word 2003 and clear the Picture selection.
D. Open the Add/Remove Programs Wizard and reinstall the Microsoft Word 2003.

Answer: C

Explanation: Andy Reid should be able to open or close the toolbar, if he right-click
the toolbar in Microsoft Word.

Incorrect Answers:

A: When Andy Reid clicks the Detect and Repair, it will reinstall the Office 2003. This
means there will be no toolbar. This will lead to more administrative effort.

B: When he deletes the .dot files it will delete all the Microsoft Word templates.

D: Reinstalling Microsoft Word 2003 will allow him to revert to the default settings
without the toolbars. This will lead to more administrative effort.

QUESTION 72:

DRAG DROP

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Kara Lang has contacted you. Kara Lang works for
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a book company. They bind and publish books. There company has open a new
department where poetry would be written and published. Kara Lang is part of the
poetry department and wants to write five poems which must be in the same format.
A week before she used to past a poem to the text to get the format. Kara Lang
wants to know if there is a way in Word that she can use without pasting an example
poem to get the format. According to Kara Lang, her colleague uses a button in
Word.

How would you allow Kara Lang to create a button in Word? (In the exhibit below,
list the correct order of the instructions)

Steps, Select from these Steps, place here
Drag the Auto Text entry to the toolbar. Piace first step here,
Type the frequently used text. Place second step here.

Insert the Auto Text entry and give ita

Place third step here.
name.

Click the named of the Auto Text entry in

‘e Commands window. Place fourth step nere.

Highlight the text and click Auto Text on the

Pt Place fifth step hare.

Click the Auto Text category on the

e raeaE Place sixth step tere.

Click Customize on the Tools menu. Place seventh step here.
Answer:
Steps, Select from these Steps, place here

Type the frequently used text.

Highlight the text and click Auto Text on the
Insert menu.

Insert the Auto Text entry and give ita
name.

Click Customize on the Tools menu.

Click the Auto Text category on the
Commands tab.

Click the named of the Auto Text entry in
the Commands window.

Drag the Auto Text entry to the toolbar.

Explanation:

Kara Lang should use AutoText and customize the toolbar. The text that is used should
be highlighted. He then should click insert, AutoText and again AutoText again. This
action will invoke the AutoText tab. Kara Lang should give the AutoText entry a name
and pick Add. This action will add the entry tot the AutoText entry list.

QUESTION 73:
You work as a desktop technician at Certkiller .com. The Certkiller .com network

contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
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either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Amy Walsh has contacted you. Amy Walsh is
complaining that there are too much buttons on her Micro Word toolbar. Amy
Walsh wants to remove the buttons that she is not using.

What should Amy Walsh do?

A. Amy Walsh should drag the button from the toolbar to the documented area.

B. Amy Walsh should right-click the toolbar area, click Customize and uncheck the
toolbar on the toolbars tab.

C. Amy Walsh should right-click the button and select Delete from the context menu.
D. Amy Walsh should right-click the toolbar area, click Customize and drag the button
from the toolbar to the document area.

Answer: D

Explanation: Amy Walsh should right-click the toolbar area, click Customize and
drag the button from the toolbar to the document area. If the Customize dialog box

is displayed, Amy Walsh can do the following: she can drag the unwanted button
from the toolbar or right-click the button and click Delete.

Incorrect Answers:

A: Amy Walsh must drag the button from the toolbar to the documented area, but she
needs to right-click the toolbar area and click Customize dialog box.

B: When Amy Walsh clears the toolbar on the toolbars tab, it will remove the entire
toolbar.

C: Right-click the button and select Delete from the context menu, will not remove the
unwanted buttons.

QUESTION 74:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Amy Wilson has contacted you. Amy Wilson has a
client computer hat is running Windows XP Professional. Amy Wilson has created
quite a few toolbars in Excel to help with the calculations of there company income.
Now Amy Wilson wants to remove the standard toolbar, but there is no Delete
button available.

What advice can you give Amy Wilson?

A. The standard toolbar must be available.

B. Right-click the standard toolbar, and select Delete.

C. The standard toolbar can be hidden, not deleted.

D. Drag the standard toolbar from the toolbar area to the document area.
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Answer: C

Explanation: The standard toolbar cannot be deleted, but it can be hidden.
Incorrect Answers:

A: It is not a must that the toolbar should be available, it can be hidden.

B: You cannot delete a toolbar; however, you can delete the buttons.

D: Dragging the standard toolbar from the toolbar area, will not delete the toolbar.

QUESTION 75:

HOTSPOT

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers
run either Windows XP Professional or Windows 98.

A Certkiller .com user named Andy Reid uses a Windows XP Professional client
computer named Certkiller -WS002. Andy Reid has a project that he is in the
graphics business as a part time income. He has a project where he must design a
menu for a hotel. Andy Reid is using the tables, borders and shadings from the
menu for the designs. Andy Reid wants the buttons available without going to the
menu of Word.

In the exhibit, what menu option should Andy Reid use?
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| Iu:u:uls-| Table  Window  Help

| 3peling and Grammar... F7

. 4 Research.., Alb+Click.
Language b
Word Count, .

i f__f] Auktosummarize. ..

Shared Workspace, .,
! __J} Track Changes Ctrl4+-5hift+E
Compare and Merge Documents, .,

Prokect Document. ..

2nline Collaborakon 3
Letters and Mailirmgs F
Macro 3

Templates and Add-Ins...

i AutoCorrect Options...

Cuskomize. .,

cpkicns. ..

Answer:
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Il:n:nls | Table  Window  Help

=" speling and Grammar. .. F7

3;5 Research. ., ale+Click.
Language 3
Word Countk, ..

[ f] AukoSummarize, ..

Shared Warkspaoe, ..
: ___}' Track Changes Ckrl+5hift+E
. Campare and Merge Documents,

Protect Docurent. ..

-

Cnling Collabor atian

Lekters and Mailirgs

b

Macro k
Templates and Add-Ins. ..

“5 AutoCorrect Cpkions...

| Customize. .. |

Options...

Explanation:

Andy Reid should use the Customize option. This option will allow Andy Reid to modify
and define the toolbars. He should click the Toolbar tab and check the Tables and
Borders option.

QUESTION 76:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers

run either Windows XP Professional or Windows 98.

A Certkiller .com user named Mia Hamm uses a Windows XP Professional client
computer named Certkiller -WS003. Mia Hamm works as a secretary for

Certkiller .com. Mia Hamm complains anything she types on Certkiller -WS003 is
incorrect when she uses the Microsoft Word.

What should Mia Hamm do?

A. Find out if grammar is checked with spelling.

B. Find out if another language is set as the default language.
C. Make sure that Word is not specified to check spelling.
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D. Make sure that the default custom dictionary is activated.
Answer: B

Explanation: If another language is selected that every word would be wrong. She

has to check if another language is selected. If so she should set the default language.
Incorrect Answers:

A: There is no need to do this. If it is specified to check the grammar and spelling, Mia
Hamm can check both the grammar and the spelling.

C: It is best for Word to check spelling will the user is typing.

D: The custom dictionary contains a words that are not available in the predefined
dictionary.

QUESTION 77:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server. All client computers run
Windows XP Professional and Office XP.

Certkiller .com contains a Research department and a Sales department. The
Research department does research on topics while some of the employees in the
Research department compile the research in a book form. A Certkiller .com
employee named Clive Wilson has contacted you. He is busy compiling the book,
but most of the words in the topic only exit in the topic and Word does not recognize
the word. Clive Wilson did add the word to the dictionary, word does recognize the
word. As soon as word is exited and restarted, Word does not recognize it.

Clive Wilson wants to know what could be the problem.

A. The activation of the custom dictionary should be done.

B. The dictionary file is missing.

C. During the typing, the Spelling and Grammar is not specified.

D. Dictionary entries are not designed to be saves across Word sessions.

Answer: A

Explanation: The problem is that the custom dictionary is not activated. Clive
Wilson should activate the custom dictionary.

Incorrect Answers:

B: The dictionary files are not missing, because Clive Wilson did put entries in the
dictionary.

C: This has nothing to o with Spelling and Grammar. It is a dictionary problem.

D: All entries are saved to a dictionary file.

QUESTION 78:

You work as a help desk technician at Certkiller .com. The Certkiller .com network
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contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

A Certkiller .com customer named Mia Hamm has contacted you. Mia Hamm works
from home for her company. Mia Hamm said that she used to use the "(c)" and

"(r)" and Word would correct the copyright and trademark symbols. Mia Hamm

said that it does not happen any more.

What proofing tool should Mia Hamm use?

A. AutoText
B. AutoCorrect
C. AutoFormat
D. Smart Tags

Answer: B

Explanation: The AutoCorrect proofing tool will allow Word to automatically

replace the incorrect text with the correct text.

Incorrect Answers:

A: The AutoText allows the user to type the first few letters of the word and Word will
complete the word.

C: The AutoFormat will allow Word to change the format of the text.

D: The Smart Tags will allow the user to define text that Word should recognize. It will
then allow the user to perform some action on the text.

QUESTION 79:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner wants
to specify Word to provide suggestions for her documents. Usually when Ally
Wagpner is finished with a paragraph she need to manually runs the Spelling and
grammar. Ally Wagner wants Word to check if her grammar and spelling is correct
while she is busy building the sentence.

Which option in the exhibit should she use?
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Options

view |

Asian Typography

| General | Edi Print | Save | Security |

Spelling & Grammar | Track Changes || User Infornation || Compatil:uilit';.-'_;

Filz Locations |

speling
[ ] check spelling as vou bype

|:| Always suggest correckions

[ tgnore words in UPFERCASE
[] 1gnore words with numbers

[ Custom Dictionaries.. .

Srarmmar

Proofing Tools

[] suaaest From main dickionary anly

[] 1gniore Internet and file addresses

[] check grammar as you type

[] check grammar with spelling

Writing skyle:

iGrammar oy » |

[ Setkings... ]

[ Check Document ]

[ Ck ][ Cancel ]

Answer:
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Options @

Aisian Typagrq:nh\,-' ) _ Fih_a Locations .
Yiew | General | Edt | Print | Save | Security
Speling & Grammar | Track Changes || UserInformation || Compatibilty |

spelling
[ check spelling as wou tvpe

D Always suggest corrections

[ suggsst From main dickionary anly
[] Ignote words in UPFERCASE

[] 1gnaore words with rumbers

[ 1gnore Internet andfile addresses

[ Cuskorn Dickionaries...

| Erammar
- 1chak dhermimat s sou e writngstyle:
lmeate i L Hel i i ot |irarrnar Only v
[] check grammar with spelling —_— —_—
: AN |[ Settings. .. |

| ‘Proofing Tools

[ Check Documer: ]

[ Ok ][ Cancel ]

Explanation:
Ally Wagner should use the Settings button in the Grammar section.

QUESTION 80:

HOTSPOT

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers

run either Windows XP Professional or Windows 98.

A Certkiller .com user named Andy Reid uses a Windows XP Professional client
computer named Certkiller -WS006. Andy Reid wants to add an executive

summary to Certkiller .com's budget document. Andy Reid wants to use Word to
create the summery.

In the exhibit, which option should Andy Reid use?
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, Iu:n:uls-| Table  Window Help

' ? Spelling and Grammar. .. F7

, 3._:5 Research.., alk+Click
Language 3
wiard Count, ..

' ﬁ Autosummarize, ..

Shared Workspace, ..
[ __J} Track Changes Ctrl+3hift+E
Compare and Merge Documents, .,

Prokect Docurment. ..

Online Callabaration 3
Letters and Mailirags F
Macro 3

Termplates and Add-Ins. ..
“r | AutoCorrect Cpkions...
Cusktomize. ..
Cpkions. ..
Answer:
, Iu:n:uls-| Table  Window  Help
' “5" Speling and Grammat. ., F7
.3-_:5 Research.., Al+Click.

Language: 3

\iard Caurnk, ..

| | [Autosummarize. . |

Shared Workspace, ..
| 4| Track Changes Ctrl+3hift+E

Compare and Merge Documents, .,

Protect Docurment. ..

nling Collaboration 3
Letters and Mailirags F
Macro 3

Templates and Add-Ins. ..
i AutoCorrect Cpkions...
Cuskomize. ..

Options...

'Explanation:
Andy Reid should use the AutoSummarize menu option. This will allow him to select
how the summary should be added to the document.
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QUESTION 81:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server domain controllers, 20 Windows 2000
Server member servers and 500 Windows XP Professional client computers. The
Windows XP Professional client computers have Microsoft Outlook 2002 deployed
on them.

Certkiller .com contains a server named Certkiller -SR01, which acts as an
Exchange server. The 500 client computers have an e-mail address on

Certkiller -SRO1 where the users can check their e-mail that is stored on the

server.

The Certkiller .com users can send messages which are secured, and the manager
wants the intended receiver to be able to read the messages.

What should you do on the Security tab of the Option sheet in Microsoft Outlook?

A. Pick the Encrypted content and attachments for outgoing messages.

B. Pick the Send clear text signed message when sending signed messages.

C. Specify the Out of Office Assistant and pick the Add digital signature to outgoing
messages.

D. Specify the Out of Office Assistant and pick the Request secure receipt for all
S/MIME signed messages.

Answer: A

Explanation: If this setting is used, it will encrypt messages. This will prevent the

others from reading the messages, except the recipient.

Incorrect Answers:

B: This setting will allow user who do not have S/IMIME to read e-mail without verifying
the digital signature on the e-mail messages.

C: Out of Office Assistant needs that user's access an Exchange e-mail account will
Outlook. It is not needed in this scenario.

D: Out of Office Assistant needs that user's access an Exchange e-mail account will
Outlook. It is not needed in this scenario.

QUESTION 82:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers and 1,500 Windows XP
Professional client computers. Microsoft Outlook 2002 is installed on the client
computers, which is used for messaging on the network.

Certkiller .com contains a Sales department. Most of the clients use e-mail to
converse, but there computers do not support S/IMIME digital signatures. The
manager of the Sales department wants the clients to read signed e-mail messages.
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What option should you select in Outlook?

A. Default reminder

B. Send immediately when connected

C. Request secure receipt for all SIMIME signed messages

D. Send clear text signed messages when sending signed messages

Answer: D

Explanation: This setting will allow user who do not have SIMIME to read e-mail
without verifying the digital signature on the e-mail messages.

Incorrect Answers:

A: This option is used to specify the default amount of time prior to an appointment.
B: This option will specify Outlook to send if the computers are connected to the
Internet.

C: This option will request that the receiver send a digitally signed S/IMIME receipt to
the sender when the messages are opened.

QUESTION 83:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com user named Andy Reid is working in the Sales department. Andy
Reid is working as a sales representative for Certkiller .com. He is conversing with
the customers via Microsoft Outlook. Due to his traveling, he has asked you to
create a backup folder for all the messages he received from Microsoft Outlook.
What should you do?

A. Copy the folder
B. Archive the folder
C. Move the folder
D. Export the folder

Answer: D

Explanation: If Andy Reid exports the folder, he should choose the source folder

and the destination folder. Even when the Exchange server is not available he can

still use Outlook to open the .PST file

Incorrect Answers:

A: If Andy Reid wants to copy the folder, then it will not make the folder available
automatically.

B: Andy Reid wants to export the folder. If he archive the folder it would be deleted it
after the archive.
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C: If Andy Reid wants to move the folder, then it will not make the folder available
automatically.

QUESTION 84:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Mia Hamm has contacted you. She said that her
e-mail messages are disappearing from the Sent Item folder. Most of the messages
are important deals for the company. The recent messages do not disappear in the
Sent Item folder. Mia Hamm wants to know why this is happening.

What should you tell her?

A. The Microsoft Outlook rule is specified to delete old messages.

B. The size limit of the Sent Items is reached.

C. AutoArchive is activated

D. The messages are not opened in a certain period of time, it will be deleted.

Answer: C

Explanation: The problem is that the AutoArchive is activated. She should look on

the Sent Items folder's of the properties dialog box and go into the AutoArchive tab.
Incorrect Answers:

A: If that would have been on, the user would have known about it. You need to update
the rule to let the old messages be deleted.

B: This is not the case. The user said that she can see the new messages and not the old
messages.

D: Outlook cannot delete the messages be cause of this.

QUESTION 85:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. The communication
of their company to their clients is via Microsoft Office Outlook 2003. The
Microsoft Outlook of their company is configured to use Post Office Protocol 3.
Kara Lang is complaining that she cannot find her e-mail messages. Kara Lang said
that when she receives a message, it appears in the Inbox and Sent Items folder. If
Kara Lang opens the folder it has no messages. Kara Lang needs the messages that
were sent to her a few months ago.
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What should Kara Lang do?

A. Compact Outlook.pst

B. Open Outlook.pst

C. Switch off AutoArchiveing of the Sent items folder
D. Open Archive.pst

Answer: D

Explanation: The messages are obviously archived. If Kara Lang opens the

Archive.pst, the messages will appear in the Folder list.

Incorrect Answers:

A: Compact Outlook.pst will not restore the messages. You will not find any messages in
this personal folder.

B: You will not find any messages in this personal folder.

C: If she switches off the AutoArchiveing of the Sent items folder, she will not receive
any messages.

QUESTION 86:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

A Certkiller .com user named Amy Walsh uses a Windows XP Professional client
computer named Certkiller -WS030. Amy Walsh uses Microsoft Outlook 2003 to
send and to access e-mail messages. Amy Walsh has contacted you because she
believes that a user has gained unauthorized access to her Outlook.pst file. Amy
Walsh wants to secure her folders so that no one can access the messages.

In the exhibit, which button should Amy Walsh click?
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Options

[ Freferences | Mail Setup iMEII|F-D;ﬂElt S.pnﬂi.l.ﬂ-g Secu;ilz;-'-_;iot.l'_er-:

E-mail Accounts

Sy Getup z-mail accounts and directories,

o=
S

E-mail Accounks,. . ]

Send/Receive

—#>  Setserd and receive settings for e-mail messages and docurments,
e

[ 5end immediately when connected [ Serd/Receive. .. ]

Data Files

and documents,

Jy #  Change settings for the files Outlook uses to store e-mail messages

[ Data Files... I

Dial-up

@ Contral how Cutlook connects to vour dial-up accounts,
(%) Warn befare switching an existing dial-up connetion
) Aways use an existing dial-up connection
[] aatomatically dial during a background Send/Receive

[]Hang up when finished with a manual SendjReceive

(a4 I [ Cancel annl

Answer:
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Options

E-mail Accounts

3 Setupz-mail accounts and directories,

i [ E-mzil ficcounts, .. ]
Send/Receive

= -|-_ Set serd and receive settings for e-mail messages and documents,

=2 [ 5end immediately when connected [ SendjReceive, ., ]
Draka Files

& Change settings for the files Outlook uses to stare e-mail messages
&é and documents,

I Diata Files. .. I

Dial-up

@ Zontrol how Outlook connects to wour dial-up accounts,

: {31 Warn befare switching an existing dial-up connection
) Bways use an existing dial-up conneckion
[] astomatically dial during a background SendiReceive

[ 1Hang up when finished with & manual Send/Receive

I 0] 4 H Cancel |

Explanation:
Amy Walsh should use the Data Files button. With this action Amy Walsh can secure the
personal folder. She can assign a password to her items.

QUESTION 87:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional. All client computers have Microsoft Office XP
installed.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com user named Ally Wagner has contacted you. Ally Wagner wants to
move the messages that have references of other company's new merchandises to be
moved to another folder.

In the exhibit, which tool should Ally Wagner use?
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Tools | Actions Help  Adobe PDF

SerdfReceive 2

Find r

il Adoress Book,.,  Chrl+Shift+6
S Croanize
|74 Rules and Alerts, .,

Maiboy CleanuD, ..
-'E? Empty "Deleted Ikems" Folder
Forms F

Macro r

E-mail Accounts. ..

Customize, ..
Ophbons, ..

Answer:

Tools | Actions Help Adobe PDF
SendiReceive 3
Find ]

[l Adoress Book...  Chrl+Shift+B

S Organize
|=,_; Rules and Alerts, .,
Maiboy Cleanugp. ..

fal | Empty "Deleted Items" Folder
Forms 4

Macro k

E-rnail Accounks. ..

Cusamize. ..

opbons, .,

Explanation:
Ally Wagner should use Rules and Alerts. With this she can create a rule that move
messages.

QUESTION 88:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server. All client computers run
Windows XP Professional and Office XP are installed on the client computers.

A Certkiller .com user named Mia Hamm uses a client computer named

Certkiller -WS009. Mia Hamm works as a secretary at Certkiller .com. Mia Hamm
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did make changes to Microsoft Word, but she does not want the changes anymore.
Mia Hamm wants to have the original Microsoft Word settings.
What should Mia Hamm do?

A. Use the Windows Update Web site

B. Specify Automatic Updates on Certkiller -WS009.

C. Run the Detect and Repair Wizard, in the Office XP

D. Use the Add/Remove Programs and reinstall Office XP

Answer: C

Explanation: Mia Hamm should run the Detect and Repair Wizard, in the Office

XP. The Wizard can also be used to restore shortcuts.

Incorrect Answers:

A: The Windows Update Web site is used to install update. This will not allow Word to
have the default or original settings.

B: The Automatic Updates will automatically download updates and install the updates.
D: She should not use the Add/Remove Programs; instead she should use the Detect and
Repair Wizard, in the Office XP.

QUESTION 89:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98. All client computers have
Microsoft Office 2003 installed on it.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Sales department. A Certkiller .com Sales Representative
named Dean Austin is going to travel from his office in New York to Hamburg,
Germany. Dean Austin wants to do a spelling check on a text written document
which is in English and German.

With the least amount of administrative effort, what actions should Dean Austin
perform?

A. Select Spelling and Grammar from the Tools menu.

B. Select AutoFormat from the Format menu, select Autoformat now and press F7.
C. Select the Language from the Language option and check Detect language
automatically and press F7

D. Open Regional and Language Options, click the Language tab, click Detail, click
Advance and select Extend support of advanced text services to all programs and then
press F7.

Answer: C

Explanation: Dean Austin must select the Language from the Language option and
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check Detect language automatically and press F7 in Word. This will allow him to

check the spelling and grammar in both languages.

Incorrect Answers:

A: This is the same as pressing F7. The document will only check the German. It will not
check the English.

B: AutoFormat will format the document.

D: This will allow the user to apply certain tools. The tolls will include handwriting
recognition, but it will not include spelling and grammar.

QUESTION 90:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Mia Hamm has contacted you. Mia Hamm is
complaining about the number of folders that is listed on the left side of the
Microsoft Word XP Open dialog box.

In the exhibit, which folder can be removed from the Look in list?

Loak in: | i My Computer b | @ ~ [ | '(1, < | j ™ Todls =
Ny S 314 Floppy (8:)
i 2@ ocal Disk (C:)
My Recent “e@Data ()
Documents || 2 bvD Drive (E:)
= “# Marketing on 'CER TKILLER-SR22' (Z)
"
Deskkop
My Documents
Marketing
‘é File: name: v-l Spen
My Metwark _ —— —
Places Files of type: E.ﬁ.ll Word Documents (*.doc; *.dot; *.htm; ®.html; *.url; * s | Cancel
. — - .".
Answer:
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Open @@
Loak in: |-i My Compuker v| @-Q X - B~ Tocs~

S 3% Flappy (a:)
ng “e# Local Disk ()

My Recent | |aesData (D:)

Documents || 4 pyp prive (E:)
= S Marketing on 'CERTKILLER-SR22' (3
Deskkop

My Documents

&

Mar

Ling

‘fg File name; v|

Ml Metwork, _ _— - f
Places Files of bype: E.ﬁ.ll word Documents (%, doc; *,dot; *.him; * html; *url; * | [ Cancel ]
1 s - | /.

Explanation:
Mia Hamm can remove the Marketing folder from the list. All the other folders are there
by default.

QUESTION 91:

DRAG DROP

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Rory Allen has contacted you. Rory Allen works for
a book company. They bind and publish books. Rory Allen is writing articles that
are used for several publications. Each publication has its own folder. All of the
publication folders reside in a folder named MyBooks. Rory Allen wants to click on
the books on the Look In side of the dialog box to see the folders of each of the
publishers.

From the list on the left, what instructions should Rory Allen follow?

Actualtests.com - The Power of Knowing




070-272

Steps, Select from these Steps, place here
Click Add to My Places on the Tools menu Place here.
Map a drive for each folder. Place hers, if any.
Open Microsoft Ward. [ Place here, if any.
Click Open on the File menu. Place here, if any.

Right click My Network Places and choose ‘ [

Map Network Drive on the context menu Place frere, if any

Browse to and select the MyBooks folder in

the Open dialog box. Place here, if any.

Browse to My Network Places in Windows
Explorer.

Place here, if any.

Answer:

Steps, Select from these Steps, place here

Open Microsoft Word. |

Open Windows Explorer. Click Open on the File menu. |

Browse to and select the MyBooks folder in
the Open dialog box.

Right-click the Start menu and choose

Properties from the Context menu Flace here, ifany.

|
|
|
|
|
|

Choose the Classic Start menu option on

the Start menu tab. Place here, if any.

|
|
|
|
|
|
|

| Click Add to My Places on the Tools menu.

Place here, if any. |

Explanation:

Rory Allen should select the new folders to this list. He should select the folder in the
Open dialog box and pick Add to My Places which resides on the Tools menu.

Incorrect Option:

Rory Allen should not use the My Network Places by, right-click My Network Places
and choose Map Network Drive for each folder. This will not add the folders to the Look
In side of the Open dialog box.

QUESTION 92:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. She complains that
her computers toolbar looks the same as that of her company. The difference is that
there are no buttons for Word, PowerPoint, Outlook etc. Kara Lang also said the
there is QuickShelf there as a title. Kara Lang wants to know what is wrong with
her computer.

What should you inform Kara Lang?

A. The toolbar is not supported by Office.

Actualtests.com - The Power of Knowing




070-272

B. From your computer, uninstall QuickShelf.
C. Make sure that Auto Hide is not checked, by right-clicking the toolbar.
D. Make sure that Office is checked, by right-clicking the toolbar.

Answer: D

Explanation: The Office Shortcut Bar contains a multiple toolbars, where

QuickShelf is one. She should right-clicking the toolbar and make sure that Office is
checked.

Incorrect Answers:

A: This is incorrect. The Office Shortcut Bar contains a multiple toolbars.

B: Kara Lang should not uninstall QuickShelf. This represents the Microsoft BookShelf.
C: This will allow the Office Shortcut Bar to be visible when she moves the mouse to the
bar's desktop area.

QUESTION 93:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. The
technicians do sometimes on-site work for your clients. A desktop technician named
Andy Reid has trouble reconfiguring Microsoft Office on his computer at the
client's location. Andy Reid has asked you to simplify the Office configuration.
What should Andy Reid do?

A. Save the settings to a floppy disk with a Briefcase tool and import it to the each new
computer.

B. Save the Office settings to a public Web server with the Save My Settings Wizard.
C. Download and run Office Internet Free/Busy Service.

D. Create a roaming user profile; store it on a public File Transfer Protocol server.

Answer: B

Explanation: Doing this will allow the settings to be available when he has access to
the Web server.

Incorrect Answers:

A: Andy Reid should not do this. Be maybe will not find the folder location for the
settings.

C: This tool is an add-on feature of Outlook. It allows schedules to be available on the
Internet.

D: Andy Reid cannot use a roaming profile. It is specified to an Active Directory forest.

QUESTION 94:
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technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the

Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional.
Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Walsh has contacted you. She has created a
new folder with a lot of Word templates. Amy Walsh wants to know how she can get

Word to recognize the new folder for the templates.
In the exhibit, what should Amy Walsh do?

Options @
Speling B Grammar T_r_au:k Changes Lser InFu:um_'!atipn Il Compatibility
Asian Typagrephy _ File Locations
View | General | Edt | Prnt || save | Secury |
Shiow
[#] Startup Task Pane  [#] Smart tags [+] windows n Taskbar
Highlight Animated kexk [ 1 Field codes
[ ] Bookmarks Horizontal scrall bar Field shading;
[«] Statie bar [+] wertical ecroll bar :":'"1”]'?” :E_ElF'I:tEd_NtI
ScreenTips [] picture placehalders
Formatting marks
[ ]Tab characters [ ] Hidden text [ ] optional breaks
[ 5paces [ optional hyphens
[ ] Paragraph marks ] al

Drawings
[ ] obiject anchaors
[ ] Text boundaries

Cwiktline and Marral opkions
[ ] wirap to window
[] oraft Fant:

Print and Web Layout options

White space between pages (Print wigw only)
[ ] Background colors and images (Prink wview only)
Wertical ruler (Print viess anly)

Style area width: ':' e

[ ok ] [ Zancel

Answer:
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Options E]

Speling & Grammar Track Changes || Llser InFu:umjatiu:un Compatibility |

Azian T':.-'pn:ngra:nh_':.f | File Ln:u:ai:in:-ns

view | General | Edt | Print [ save [ Security |
Shiow

[+] Startup Task Pane  [+] Smart tags [+] Windows n Taskbar

Highlight Animated bexk [ Field codes

[ ] Bookmarks Horizontal scrall bar Field shading:

Stakis har [w] Wertical erall har |When selected W

ScreenTips [ picture placeholders Sl
Formatting marks

[ ] Tab characters [ ] Hidden ket [ ] optional breaks

[ ] spaces [ ] optional hyphens

[ ] Paragraph marks [ al

Print and Web Lavout options
Drawings Wehite space bebween pages (Prink wview only)
[ ] object anchors [] Background colors and images (Print vizw anly)
[ ] Text boundaries wertical ruler (Print wigww only)

Dutline and Mormal options : —
[ wrap to window Style argawidthy 0" =
[] oraft Fant: i 5 1

[ 8] 4 ][ Cancel ]

Explanation:

Amy Walsh should click the File Locations tab. It has various file types, which contains a
documents and templates. Amy Walsh must just highlight the User templates files type
and click the Modify button.

QUESTION 95:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains two subnets named SubnetA and SubnetB. SubnetA has an
address range of 192.168.5.33 through 192.168.5.42 and SubnetB has an address
range of 192.168.100.33 through 192.168.100.60. Internet Explorer Web of

Certkiller .com is using a proxy server to connect to the Internet. SubnetB is specified
so that you can get resources on it without authenticating yourself. You want to
specify the browser to bypass the proxy server to connect to a Web site named

www. Certkiller .com on the local intranet. You also want to make a direct connection.
What should you do?
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A. Add www. Certkiller .com to the Restricted zone on the Security page.

B. Add www. Certkiller .com to the Trusted Sites zone on the Security page.

C. Specify Automatically detect settings on the Local Area Network Settings page.

D. Add www. Certkiller .com to the Exceptions box on the Advanced page of the Local
Area Network Settings page.

Answer: D

Explanation: Doing this will allow you to specify the local intranet Web address to
connect to you directly.

Incorrect Answers:

A: If you add the Web address to the Restricted zone on the Security page, it will add
a higher level of security which will disable the access to the site altogether.

B: If you add the Web address to the Trusted Sites zone on the Security page, it will
add a lower level of security and you still need to access the proxy server.

C: This will allow Internet Explorer to try to find the proxy server settings, when the
browser is started.

QUESTION 96:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

A Certkiller .com user named Rory Allen works in the Development department.
Rory Allen has created a Web site on the local intranet which is used for testing
unsigned ActiveX controls manufactured in the development department. Before
the dispatch of the ActiveX controls, you test it with a client computer named
Certkiller -wS010. Certkiller -WS010 is located on the local network. You need
to browser to download ActiveX controls without prompting when you browse to
the test site.

What browser specifications should you make?

A. Add the internal Web site to the Local intranet zone and change the security settings.
B. Add the internal Web site to the trusted site zone and use the default security settings.
C. Add the internal Web site to the Local intranet zone and use the default security
settings.

D. Add the internal Web site to the trusted site zone and use the default security settings,
clear the require server verification for all sites in this zone option.

Answer: A
Explanation: You should add the internal Web site to the Local intranet zone and

change the security settings this will allow you to specify the local intranet Web
address to connect to you directly. When creating unmarked ActiveX scripts, you
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should enable the Initialize and script ActiveX controls not marked as safe option.
Incorrect Answers:

B: The default security level in the trusted site zone is low. This will allow downloading
of ActiveX and asks for unsigned ActiveX controls and the initialization of and scripting
of ActiveX controls marked as safe.

C: The default security level in the Local intranet zone is Medium-low. This disables the
downloading of ActiveX controls and disables the initialization of and scripting of
ActiveX controls marked as safe.

D:The default security level in the trusted site zone is low. This will allow downloading of
ActiveX and asks for unsigned ActiveX controls and the initialization of and scripting of
ActiveX controls marked as safe. Because of the low security, the require server
verification for all sites in this zone option is checked.

QUESTION 97:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

A Certkiller .com user named Rory Allen works in the Development department.
Rory Allen works on a client computer named Certkiller -WS002.

Certkiller -WS002 uses Internet Explorer 6.0 to browse the Internet. Rory Allen

has a lot of Web sites in his Favorites folder. He would like to organize the items in
the Favorites folder to make it easier for him to find.

What should you do? (Select two)

A. Delete any unused Web sites from the Favorites menu.

B. Add spacers to the Favorites menu which resides in the Organize Favorites dialog box.
C. Open the Organize Favorites dialog box and arrange the Web sites in alphabetical
order.

D. Create folders in the Favorites menu and move the Web sites to their matching folders.

Answer: A, D

Explanation: You should create folder in the Favorites menu and move the Web
sites to their matching folders and delete the Web site that Rory does not used.
Incorrect Answers:

B: You cannot add spacers to the Favorites menu.

C: It will take a lot of time to place the Web site in alphabetical order.

QUESTION 98:
You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the

Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. All the client computers use Internet Explorer as the
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default browser and Microsoft Office 2003 installed on them.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Marketing department. A Certkiller .com user named Dean
Austin works in the Marketing department as a Representative. Dean Austin uses a
laptop named Certkiller -WS030, which he uses to travel to client, connect to their
Internet, and give a presentation of Certkiller .com's marketing products. One day
Dean Austin went to testlabs.com to show a presentation of the marketing
department'’s products. When he tried to connect to the Internet to get the price
information, he cannot access Certkiller .com's Web site.

Dean Austin then contacts you and states his dilemma. You then find out that his
TCP/IP settings are specified automatically by the DHCP. Dean Austin needs to
access Certkiller .com's network.

What should Dean Austin do?

A. Enable automatic proxy detection in Internet Explorer.

B. Execute the ipconfig /all command on Certkiller -WS030.

C. Configure Certkiller -WS030 with an IP address of 192.168.0.10.
D. Assign the Allow- Read share permissions to Dean Austin for the
C:\Inetpub\wwwroot folder on the Web server.

Answer: A

Explanation: Proxy servers are used to provide Internet service for the LAN. If the
Proxy server used a specific LAN, then users that use the Web browsers should
configure the appropriate settings to use that the proxy server access the Internet

Web sites.

Incorrect Answers:

B: Executing the ipconfig /all command, will not allow him to access the Certkiller .com's
Web site.

C: He should not configure Certkiller -WS030 with an IP address of 192.168.0.10. This
would not work.

D: Web content folders do not need to share, for users to access a Web site using the
browser.

QUESTION 99:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. All the client computers use Internet Explorer as the
default browser and Microsoft Office 2003 installed on them.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Rory Allen has contacted you. He is complaining
about the pop-up advertisements when visiting sites. Rory Allen said the he must
view all the pop-up messages when visiting the site. You need to provide a solution
so that Rory Allen only picks the useful pop-up messages.
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What should you do?

A. Enable active scripting for the Internet zone.

B. Disable active scripting for the Internet zone.

C. Disable active scripting for the Restricted sites zone.

D. Configure Internet Explorer to ask users when active scripting is accruing for the
Internet zone.

Answer: D

Explanation: You should configure Internet Explorer to ask users when active

scripting is accruing for the Internet zone. These pop-up messages are produced

through scrip code. If you want to stop the pop-up messages, you should disable

active scripting for the Internet zone.

Incorrect Answers:

A: Enable active scripting will result in pop-up messages on all the Web sites. This is not
needed.

B: Disable active scripting will prevent pop-up messages on all the Web sites. This is not
needed.

C: Disable active scripting will prevent pop-up messages on all the Web sites. This is not
needed.

QUESTION 100:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner needs
your assistance with her Internet Explorer. She states, when typing the Web page,
which she visited frequently, Internet Explorer does not automatically complete the
address. Ally Wagner also cannot find the address in the drop-down list. Ally
Wagner needs Internet Explorer to automatically complete the address.

What should she do?

A. The disk space that is set aside for the temporary Internet files should be increased.
B. Specify the Privacy settings to accept all cookies.

C. Add the Web page to the Trusted Sites zone.

D. Increase the days to keep the page in history.

Answer: D
Explanation: The default history settings are 20 days. You can set it over 31 days.

Incorrect Answers:
A: Internet Explorer does not use temporary Internet files for the list of Web addresses.
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B: Internet Explorer does not use cookies for the list of Web addresses. Cookies is used
to store customize content.

C: If you add a Web site to the Trusted Sites zone, it will allow ActiveX controls and
scripting that you might not allow for sites that you do not trust.

QUESTION 101:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Finance department. A Certkiller .com employee named
Mia Hamm works in the Finance department. Certkiller .com contains a Windows
XP Professional workstation named Certkiller -WS111. Mia Hamm is using this
computer. Certkiller -WS111 has Windows XP Professional with Service Pack 2.
One of the support technicians has installed a pop-up blocker on

Certkiller -WS111. Mia Hamm has contacted you to report the she still receives
pop-up advertisements that impede her work. Mia Hamm would like the Flash to be
removed from Certkiller -WS111.

What should you do?

A. In Internet Explorer Tools menu, select the Internet Options.
B. In Internet Explorer Tools menu, select the Pop-up Blocker.
C. In Internet Explorer Tools menu, select the Manage Add-ons.
D. In Internet Explorer Tools menu, select the Windows Update.

Answer: C

Explanation: The Manage Add-ons is used to disable the Flash add-on.

Incorrect Answers:

A: The Internet Option displays the Settings dialog box. This will then allow you to
move temporary Internet files. It can also be used to download ActiveX objects.

B: This will allow you to enable the pop-up blocker and to change the settings.

D: This will allow you to open the Windows Update Web site.

QUESTION 102:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Wilson has contacted you. Amy Wilson uses a
computer which she used for doing research about on an important project. A
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friend of her has visited her and accesses the Web to her favorite Web site. When
Amy Wilson left, she does not know which links she has visited on her Web pages.
She needs to finish her project. You then told Amy Wilson to click the History
button, where Internet Explorer displays a listing of Web sites that was visited by

her.
In the exhibit, which button should she use?

Internet Options

| General [ Security | Privacy | Content| Conmections | Programs | Advanced |

Home page
% You can change which page to uze for your home page
Address: l lisapi/redit.dli?prd=ietpver=c&ar=msnhomcl

[ Use Current J i Usge Default ] [ Uze Blank. J

Temporan |nternet files

i FPages you view on the [nternet are stored in a special falder
L@ Y for quick viewing later,

[Delete I:::u:-kies...] [Delete Files. . ] [ Settings.. ]

Higtary

The Histary lolder containg links to pages you've visited, for
quick acces: o recently viswed pages.

Dravz to keep pages in histong: -ZIEI_:_I Clear Higtan

[ Colors... J l Fants. .. ] [ Languages... J [.ﬁ.ccessibility...]

l ok ][ Cancel J

Answer:
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Internet Options

General Security | Privacy || Content| Connections || Programs | Advanced

Haorme page
E! "ol can change which page to uze for your home page
P =N = i el I pr d=iefprer=Fi:ar=msnhome _

I |lze Current ] | Ilze Default I [ I1ze Blank

Temporary Intermet files

g Fages vou view on the Internet are stored in a special falder
V@ % for quick wiewing later, |

[Delete I:-:ucukies...] | Delete Files.. I [ Settings... J

Higtary

The History lolder containg link s to pages vau've wisited, far
quick acces: o recently viewed pages.

Drayz to keep pages in hizton: 2III : 1 Clear Histary

I Colarz... I | Fontz... I [ Languages .. ] [.-'-‘-.u:u:essibility...]

[ OF. ][ Cancel I

Explanation:
Amy Wilson should use the Colors button. This will allow her to customize the colors for
visited and unvisite4d links.

QUESTION 103:

DRAG DROP

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com employee named Mia Hamm has a Windows XP computer named
Certkiller -WS001 at home. She then acquires a second a Windows XP computer
named Certkiller -WS002. She is going to connect the two computers to the same
network. Certkiller -WS001 has all the Web site links that she visited, saved in
Internet Explorer Favorites folder. Mia Hamm wants the links to be available on
Certkiller -WS002. Mia Hamm does not know how to copy the Web site links.

In the attachment, select the instructions to copy the links.
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Steps, Select from these Steps, place here

Start Windows Explorer on

CERTKILLER- WS001 Place here.

Save or export the favorites from

CERTHILLER-WS00Z to a floppy disk. Bigceiheng ihany,

Load or import the Favorites from the floppy

disk to CERTKILLER-WS002. Place here, if any.

Start Internet Explorer on

CERTKILLER-WS002 Peseinets. fany,

Browse top the favotire folder on

CERTKILLER-WS002. Place:frere, ffany.

Save or export the Favorites from

CERTKILLER-WS001 to a floppy disk. RiaRR afe, 1 a0,

Start Windows Explorer on

CERTKILLER - WS002 Paceiers, rany.

Browse top the favotire folder on

CERTKILLER -WS001. Prace here, if any.

Load or import the Favarites from the floppy

disk to CERTKILLER-WS001, Place here, if any.

Start Internet Explorer on

CERTKILLER- WS001 Place here, if any.

Choose Import and Export from the hle

mernu on CERTKILLER-WS001. Place.hers. ifany.

Choose Import and Export from the file

menu on CERTKILLER-WS002. Fiace fhiote, any:

Answer:
Steps, Select from these Steps, place here
Start Windows Explorer on Start Internet Explorer on
CERTKILLER-WS001 CERTKILLER-WS001
Save or export the Favorites from Chocse Impart and Export from the file
CERTKILLER-WS002 to a floppy disk. menu on CERTKILLER-WS001
Save or export the Favorites from
CERTKILLER-WS001 to a floppy disk.
Start Internet Explorer on Start Windows Explorer on
CERTKILLER-WS002 CERTKILLER -WS002.
Browss top the Favorites folder on Chocse Import and Export from the file
CERTKILLER-WS002 menu on CERTKILLER -WSD02.

Load or import the Favorites from the floppy
disk to CERTKILLER -WS002.

Place here, if any.

Browssa top the Favorites folder on

CERTKILLER-WS001. FraceHere it aiy

Load or import the Favorites from the floppy

disk to CERTKILLER-WS001. Prace hare, if any.

Piace here, if any.

Place here. if any.

Place hers, if any.

Explanation:

Mia Hamm should import and export the links with Internet Explorer. To do this she
should start Certkiller -WS001 and access Internet Explorer and pick import and export
from the files menu. The Wizard will then ask Mia Hamm to select the links that she
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want to import. The computers are not connected to the network, so she needs to use a
floppy disk.

Incorrect Options:

In Internet Explorer she could use the Import and Export Wizard.

She should not use the Windows Explorer. There is no need to browse the Favorites
subfolder from the Documents and Settings. She should use the Import and Export
Wizard of Internet Explorer

QUESTION 104:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. Kara Lang uses a
computer for doing research about an important project. She browses the Internet
frequently to gather information. A friend of hers has visited her and changes her
Internet Explorer setting a few weeks before she started with her research. Kara
Lang's computer is starting to run low on disk space.

Which object in Internet Explorer is causing the problem?

A. Temporary Internet files

B. Cookies

C. Digital certificates

D. Downloaded ActiveX controls

Answer: A

Explanation: The problems are lying in the configurations of the Temporary

Internet files. Each time she visited a Web site, the page is downloaded to the

computer. She needs to customize the amount of disk space.

Incorrect Answers:

B: Cookies is not the problem. Cookies do not take more the 2 KB.

C: Digital certificates are not the problem. Digital certificates do not take more the 2 KB.
D: ActiveX controls vary from size. They are small to ensure fast download.

QUESTION 105:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Kara Lang has contacted you. Kara Lang needs
your help with her Internet Explorer. She states, when typing the Web page, which
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she visited frequently, Internet Explorer does not automatically complete the
address in the Address bar. Kara Lang also cannot find the address in the
drop-down list. When Kara Lang goes into the History button, she notices that there
are entries for the a few weeks ago. Kara Lang needs Internet Explorer to
automatically complete the address she visits frequently.

What should she do?

A. The disk space that is set aside for the temporary Internet files should be increased.
B. Modify the Privacy settings to accept all cookies.

C. Add the Web page to the Trusted Sites zone.

D. Use the AutoComplete Settings dialog box and enable AutoComplete for Web
address.

Answer: D

Explanation: Kara Lang should use the AutoComplete Settings dialog box and

enable AutoComplete for Web address.

Incorrect Answers:

A: Internet Explorer does not use temporary Internet files for the list of Web addresses.
B: Internet Explorer does not use cookies for the list of Web addresses. Cookies is used
to store customize content.

C: If you add a Web site to the Trusted Sites zone, it will allow ActiveX controls and
scripting that you might not allow for sites that you do not trust.

QUESTION 106:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Finance department. A Certkiller .com employee named
Clive Wilson works in the Marketing department. Certkiller .com contains a
Windows XP Professional workstation named Certkiller -WS040. Clive Wilson is
using this computer. Certkiller -WS040 has the Windows XP Professional with
Service Pack 2. Clive Wilson wants to delete the temporary files and clean up the
history. Clive Wilson did notice a setting that allows you to view objects. If Clive
Wilson deletes these objects, what would be the result?

A. All the downloaded images will be removed from Certkiller -WS040.

B. All cached Web pages will be removed from Certkiller -WS040's Internet Explorer
history.

C. All cookies will be removed from Certkiller -WS040.

D. All the downloaded ActiveX will be removed from Certkiller -WS040.

Answer: D
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Explanation: The objects that Clive Wilson see is the ActiveX controls. If you delete

the objects, then all the ActiveX will be removed from Certkiller -WS040.

Incorrect Answers:

A: The downloaded images can only be removes when you delete the temporary Internet
files.

B: You can remove the Web pages by clicking the Delete Files button.

C: Internet Explorer does not use cookies for the list of Web addresses. Cookies is used
to store customize content.

QUESTION 107:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. All client computers have Microsoft Office XP installed.
The client computers use Outlook Express to send messages.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com user named Amy Wilson has contacted you. She received a message
from her colleague which had a colorful background. Amy Wilson also wants that
kind of background for her messages.

What should she do in the Options from the Tools menu? (Select two)

A. Pick the Compose tab and set the message sending format to text.

B. Pick the Send tab and set the message sending format to text.

C. Pick the Compose tab and check in the Stationary section and make your selection.

D. Pick the Send tab and set the message sending format to Hypertext Markup Language.

Answer: C, D

Explanation: The HTML is used in the message to include the colorful background.
The user can also use the Stationary section to choose the setting to specify the
stationary.

Incorrect Answers:

A: The test format does not support the color background.

B: You cannot pick the Send tab to adjust the stationary. This is done in the Compose
tab.

QUESTION 108:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Exchange Server 2000 Server and all client
computers run either Windows XP Professional. All client computers have
Microsoft Office XP installed.

Certkiller .com contains a Desktop Support team which you are part of. A
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Certkiller .com employee named Clive Wilson works in the Sales department. The
Sales department is very big and the staff works round the clock to keep up with the
sales. Clive Wilson has learned that his colleagues have sent him some instant
messages. Clive Wilson then claims that he did not receive it. His colleagues said
that it looks like that he is not online. You then open the Outlook Express and find
Clive Wilson's name is red like the other contacts. You then see that Clive Wilson is
online, but does not receive any messages.

What could be the problem?

A. Windows Firewall is enabled

B. The co-workers are on the block list.

C. Clive Wilson's online status is Invisible.

D. Clive Wilson is not logged on to Windows Messenger.

Answer: C

Explanation: The status of Clive Wilson is Invisible. For the co-worker it would

seem that Clive Wilson is online, because of the red icon.

Incorrect Answers:

A: The red icon proves that the user in online. So you not check the Firewall.

B: This would only be if the co-workers online status is set to Online, which is presented
with a green icon.

D: Clive Wilson is online, because he can see the Windows Messenger icons.

QUESTION 109:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Walsh has contacted you. Amy Walsh is
working for Acme.com and her manager has asked her to configure Outlook
Express to stop the Web beacons to reduce spam.

What should Amy Walsh do?

A. Additional characters should be added to the e-mail.

B. Use digital signatures to secure the messages.

C. Set the message receiving format to text.

D. For the receiving messages, should not be sending a read receipt.

Answer: C
Explanation: The Web beacons are actually images with added parameters to

inform the sender that the message was read. In the case of e-mail messages the
image is named shop.gif. If he changes the format to text, the Web beacons cannot
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be embedded in messages.

Incorrect Answers:

A: This is only necessary when sending messages to a newsgroup. The automated
programs will remove the characters and will send spam to the wrong address.

B: This will not stop the Web beacons. Digital signatures are there to make sue that a
message comes from the user.

D: This will not stop the Web beacons. Some spammers don not read receipts.

QUESTION 110:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Kara Lang has contacted you. She just has used
Outlook Express. She complains that when she types, it will tell her that the word is
wrongly spelled. She needs to send the messages urgently to the COE. She also states
that when she is using the uppercase letters, that there is not problems.

What could be the problem?

A. The wrong dictionary is used.

B. Uppercase words are not recognized by Outlook Express.

C. Uppercase words are not specified in the spelling checker tool.
D. Grammar is not checked with spelling.

Answer: A

Explanation: The wrongly spelled word is defined by the dictionary. If a word is not

in the dictionary, then it marked as an incorrect spelling error.

Incorrect Answers:

B: Outlook Express does recognize uppercase words. It can also be specified to skip the
uppercase words.

C: This is not the problem. The user would have been informed of any spelling errors.
D: Outlook Express only checks spelling, not grammar.

QUESTION 111:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Finance department. A Certkiller .com employee named
Mia Hamm works in the Finance department. Mia Hamm sometimes works from

her home and uses her computer at home to access her e-mail messages at work.
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Mia Hamm is complaining that when she wants to check the messages at her work
place, the messages are gone.
Mia Hamm wants to know what the problem could be.

A. Mia Hamm's computer is not specified to leave a copy of the messages on the e-mail
server.

B. A filter on the e-mail server automatically deletes the messages.

C. A rule is configures to delete messages from the Outlook Express of the computer at
home after a period of time.

D. Only one computer can receive e-mail messages sent to a certain addressee.

Answer: A

Explanation: The problem is that the computer at home is specified not to leave a
copy of the messages on the server. You should use the advance button in the
properties dialog box and activate the "Leave a copy of messages on the server

option.

Incorrect Answers:

B: Server filter will not delete messages. It will only do so if it is specifies as junk mail
senders.

C: This is not case. The user would have known of the rule.

D: More than one computer can receive e-mail messages.

QUESTION 112:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers

run either Windows XP Professional or Windows 98.

A Certkiller .com user named Andy Reid uses a Windows XP Professional client
computer named Certkiller -WS008. Andy Reid is complaining that his files have
been deleted without his awareness. During the investigations you determine that

the files is replaces with a file a name gotche.doc. You also noticed that the files can
still open.

What is the problem?

A. A virus

B. Defective RAM

C. Faulty BIOS configuration
D. Defective hard disk platter

Answer: A
Explanation: The problem is caused by a virus. The virus is designed to destroy

resources or to disrupt their use.
Incorrect Answers:
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B: RAM can cause problems, but do not cause a program to be deleted.
C: A faulty BIOS configuration does not cause a file to be deleted.
D: If itis a hard disk platter, then the computer would not have restart.

QUESTION 113:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. Kara Lang has a
computer that is running Microsoft Windows XP Professional. Kara Lang has
noticed that her fellow colleague's computer does not display a taskbar on the
screen, but could retrieve the taskbar when it is needed. Kara Lang would like this
feature on her computer. You then open the Taskbar and Start Menu Properties.
What should be done next?

A. You should clear the Lock the taskbar option

B. You should select the Show Quick Launch option

C. You should select eh Auto-hide the taskbar option

D. You should select the Group similar taskbar buttons option.

Answer: C

Explanation: The Auto-hide option will cause the taskbar to disappear.

Incorrect Answers:

A: The Lock the taskbar option is used to enable the taskbar to be moved from its place.
B: This will allow you to display a customize toolbar that has the programs shortcuts.

D: The Group similar taskbar buttons option will enable to group buttons for files to open
with a singular program.

QUESTION 114:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com user named Andy Reid is working in the Sales department. Andy
Reid is working as a sales representative for Certkiller .com. He is conversing with
the customers who request product information via e-mail. The replies of Andy Reid
are linked to pages on the corporate Web site and he usually tests the link before
sending the responds.

Andy Reid has a problem, because every time he uses a link then a new browser
windows opens. His desktop is now full of the open browser windows. He would like
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to minimize the number of open browsers.
What should Andy Reid do?

A. Use inline AutoComplete

B. Enable Always send URLs as UTF-8

C. Enable Reuse windows for launching shortcuts

D. Enable Close unused folders in History and Favorites.

Answer: C

Explanation:

When the reuse windows for launching shortcuts are enabled and a link is activated
from within an Internet-aware program, the Web page will appear in the Internet
browser that is already opened.

Incorrect Answers:

A: Inline AutoComplete will fill in an URL address when typing the address.

B: Always send URLs as UTF-8 will allow you to use a Unicode transformation format
that supports extended ASCII characters.

D: This will cause a folder to close when another folder is opened.

QUESTION 115:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server. All client computers run
Windows XP Professional and Office XP.

A Certkiller .com user named Ally Wagner uses a client computer named

Certkiller -WS001. Ally Wagner works as a secretary at Certkiller .com. Ally
Wagner has contacted you to request a shortcut of Microsoft Word on

Certkiller -wS001's desktop.

What should you do?

A. Select Past Shortcut, by right-clicking the desktop.

B. Use the Add/Remove Programs to create a shortcut

C. Select Microsoft Office Tools and click Activate Product.

D. Right-click the desktop, select new and select Shortcut, use the resulting Wizard to
create the shortcut.

Answer: D

Explanation: You must do the following: Right-click the desktop, select new and
select Shortcut, use the resulting Wizard to create the shortcut. You should also use
the Word executable and name the shortcut and select finished.

Incorrect Answers:

A: This is only done when you have a shortcut. The user does not have one yet.
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B: Add/Remove Programs is not used to create shortcuts.
C: Activating a product will not create a shortcut.

QUESTION 116:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Rory Allen has contacted you. He complains that
there are a lot of programs next to the clock on the desktop. He would like to hide
these programs.

How can Rory Allen configure the Taskbar and Start Menu Properties?

A. Check Auto-hide the taskbar.

B. Check Hide inactive icons.

C. Clear Keep the taskbar on top of other windows.
D. Clear Show Quick Launch.

Answer: B

Explanation: Where the items are, next to the clock is the notification area. Rory
Allen should hide the inactive icons that are not active.

Incorrect Answers:

A: This action will hide the task bar, not the icons on the taskbar.

C: This will allow the windows to hide the complete taskbar.

D: This will not let the taskbar displayed.

QUESTION 117:

DRAG DROP

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Finance department. A Certkiller .com employee named
Mia Hamm works in the Finance department. Certkiller .com contains a Windows
XP Professional workstation named Certkiller -WS111. Mia Hamm is using this
computer. Certkiller -WS111 was upgraded from Windows 2000 Professional to
Windows XP Professional.

Mia Hamm would like to know if she can drag icons to the Start menu. She used to
do this with the former operating system. How can she do this with Windows XP
Professional?

In the exhibit, select the steps that she should follow.
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Steps, Select from these Steps, place here

Choose Start menu and click Customize. Place here.

Select the Enable dragging and dropping

checkbox. Piace here, if any.

Click the Advanced tab on the Customize

Start Menu dialog box. face fers; any,

Choose Classic Start menu and click

Customize. Piace here, if any.

Choose the Windows XP theme. Place here, if any.

Right-click the desktop and choose

Properties from the context menu. Rletefisr, it any.

Right-click the Start menu and choose
Properties from the context menu.

Answer:
Steps, Select from these

Place here, if any.

Steps, place here

Right-click the Start menu and choose
Properties from the context menu.

Choose Start menu and click the
Customize button.

Click the Advanced tab on the Customize
Start Menu dialog box.

Choose Classic Start menu and click the
Customize button.

Select the Enable dragging and dropping
checkbox.

Choose the Windows XP theme.

Place here, if any.

Right-click the desktop and choose
Properties from the context menu.

Place here, if any.

Place here, if any.

Explanation:

Mia Hamm should rightOclick the Start menu and select Properties. She should then
select the Start menu and click Customize. This action will bring into play the Advance
tab, which should be clicked. She should also check the Enable dragging and dropping
option.

Incorrect Options:

Right-click the desktop and choose properties will bring into play the Display Properties
dialog box. She likes the new look, so this will allow her to change the theme.

The Classic Startup menu will reset the Start menu to the previous look. She likes the
new look.

QUESTION 118:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
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on the Certkiller .com network run Windows 2000 Server and all client computers
run Windows XP Professional.

A Certkiller .com user named Clive Wilson informs you that he wants to move a
shortcut from his desktop to the Start menu.

What should Clive Wilson do?

A. Drag and drop the shortcut to the Start menu.

B. Switch the Start menu to the Classic Start menu.

C. Increase the number of programs available on the Start menu.
D. Ensure that the recently used programs list is disabled.

Answer: A

Explanation: Drag and drop the shortcut is one way to move it.

Incorrect Answers:

B: Using the Classic Start Menu will not change shortcuts from the desktop in any way.
Using this in conjunction with dragging and dropping would work, but is not necessary.
C: Increasing the number of programs available on the start menu would only increase
the number of recently used programs, but would not add any shortcuts to it. By double
clicking a shortcut, Recently Used Programs will display the actual program, not the
shortcut, and only if the application is written correctly. (Not all applications will make
use of the Recently Used Programs.)

D: Disabling the recently used programs is the opposite of "C", but incorrect for the same
reason. Simply changing this will not add or remove shortcuts from the Start Menu.

QUESTION 119:

HOTSPOT

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. The
Certkiller .com network contains three Windows 2000 Server computers and 50
Windows XP Professional client computers. The Certkiller .com network is not
connected to the Internet.

A user named Andy Booth works in the Graphics department. Andy Booth is using
a Windows 2000 Professional computer named Certkiller -WS050 which was
upgraded to Windows XP Professional. Andy Booth is using Microsoft Visual
Studio .NET to do his graphics, which he activated with an icon on the taskbar next
to the Start menu. Andy Booth is complaining that after the upgrade the icon has
disappeared.

In the exhibit, which option should be checked to place the icon back?
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Taskbar and Start Menu Properties E|E|

Taskbar | Start Mery |

Taskbar appearance

fl.’ Etén‘ = €& % . 2Internet..r | M Fold

[ Lock the taskhar

[ &suto-hide the taskbar

[ Keep the tazkbar on bop of other windows
[ Group similar taskbar buttons

[ 5how Quick Launch

Matifization area

[ Shows the clock

Y'ou can keep the notification area unclutiered by hiding icons that pou
hawe not clicked recently.

[] Hide inactive cons

L Ok, I[ Cancel _H_ Apply J

Answer:

Taskbar and Start Menu Properties E|E|

Taskbar | Start Mery |

T azkbar appearance

J'I.' Efaﬂ = @& G . 2Internet..r | fm fold

[ Lock the taskhar
[] Awusto-hide the taskbar
[ keep the taskbar on top of other windaws
[ Growp similar taskbar buttons
I Show Guick Launch

Motification area

[ Show the clock

Y'ou can keep the notification area uncluttered by hiding icons that pou
have not clicked recently.

[ ] Hide inactive cons

L Ok I[ Cancel ][ Apply J
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Explanation:
This is a Quick Launch toolbar. The user should click the Show Quick Launch. This will
allow the icon to be there as it was before.

QUESTION 120:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers
run either Windows XP Professional or Windows 98.

A Certkiller .com customer named Amy Walsh uses a Windows XP Professional
client computer. Amy Walsh works as a secretary in their company. Amy Walsh
needs to type documents for her COE that travels frequently. Amy Walsh has
contacted you because she needs to type some of the documents in French. Amy
Walsh wants to check the spelling of what she typed in French in the Microsoft
Office Word 2003.

What should you advice her?

A. Specify the settings in the Regional and Language Option dialog box to French.

B. Install the French language files and dictionary.

C. Install the French language pack with the Microsoft Office 2003 Multilingual User
Interface (MUI) Pack.

D. Word will recognize the word if she types in French.

Answer: B

Explanation: Amy Walsh should install the French language files and dictionary.
Word will prompt you if the spelling and grammar files have not been installed.
Incorrect Answers:

A: Changing this will change the way Windows formats numbers, currency, times and
dates.

C: This will allow her to use the English version, but the menu items, Help files etc. in
French.

D: This will not work. She needs to install the spelling and grammar files for that
language.

QUESTION 121:

SIMULATION

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98. All client computers have
Microsoft Office 2003 installed on it.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Sales department. A Certkiller .com Sales Representative
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named Dean Austin is going to travel to Canada. Dean Austin is going to use his
computer named Certkiller -WS030, running Windows XP Professional, to

manage billing and invoice in connection with Certkiller .com. You need to customize
the current format on Certkiller -WS030 to stick to the French Canadian

standard. Dean Austin does not want to change the language. You open the
Customize Regional Options to configure the following format to meet Dean

Austin's requirements.

* Positive: 123456789, 00 $

* Negative: (123456789, 00 $)

In the exhibit, configure the appropriate values in the correct places.

Customize Regional Options

Numbsrs | Currency | Tme | Dats |

Sample

Postive [12345678900% | Negative (123456 789.00%) |
Currency symbol: . ‘-’-E
Fozitive currency format;: I w
Megative currency format: i v;.
Decimal spmbal: = _V'
Ma. of digits after decimal: iy -v_;
Dhigit grouping symbal; :r
Digit grouping: l vl

0k ] [ Cancel Apply

Answer:
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Customize Regional Options

| Numbers | Burency | Tme | Date |

Sample

Positive |123456783.00 8 | Megative: |[123 456 789,00 3]
Currency symbal: $ v-E
Fazitive currency farmat: ' 11% W
Megative currency farmat: [ v.:
Decimal symbol: _V 5
Mo, of digits after decimal; 2 v
Digit grouping symbol: ZS"pac:e W |
Diigit grouping: l u

[ K ] I Cancel ]

Explanation: To use the French Canadian currency, you should change the format
language on the Regional Options tab.

The Currency symbol setting shows the symbol that will be used to identify the
currencies which will be the (3$) sign.

The Positive currency format setting shows how positive the numbers should be. The
symbol should appear after the value, in this scenario.

The Negative currency format setting shows how negative the numbers should be. The
symbol should appear after the value, in this scenario.

The decimal symbol setting is used to separate the whole number from the decimal part.
The No. of digits after the decimal setting shows the number of digits.

The Digit grouping symbol setting specifies the symbol to use to group digits.

The Digit grouping setting specifies how the digit group symbol is placed in a currency
value.

QUESTION 122:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner is
working in the Finance department of Acme.com. Ally Wagner has installed a
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finance application. The finance application uses the date setting specified in
Regional and Language Options to interpret two-digit years.

Ally Wagner has entered 2000 in the drop-down list in the Calendar section. Ally
Wagner wants to enter a date and wants to know what will happen if she enters a
date as 10/15/05.

What should your reply be?

A. A System dialog box will prompt you to choose the desired year.
B. The end year is set to 2000; the date will not be valid.

C. The date will be interpret as 10/15/1905.

D. The date will be interpret as 10/15/2005.

Answer: C

Explanation: The beginning and end year settings shows that all the years between
them will be used to interpret two-digit years. You should use a 100-year span,
because it is always used to configure the beginning and end years. The year 2000
means the beginning of 1901.

Incorrect Answers:

A: The System dialog box will not appear. The year will be interpreted automatically.
B: The end year does not specify the latest year that it is valid.

D: This will only happen when the date was set to 2004 or later.

QUESTION 123:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Mia Hamm has contacted you. Mia Hamm has
borrowed a laptop which shows the clock as follows: "Army time is: 13:00". Mia
Hamm would like to set the clock of her computer also as that. You then told Mia
Hamm to open the Time tab which is on the Customize Regional Options dialog box.
Which of the following formats should she use?

A. Army time is: HH:mm:ss
B. "Army time is: '"HH:mm:ss'
C. "Army time is: "HH:mm:ss
D. 'Army time is: 'HH:mm:ss

Answer: D
Explanation: The text that is inside the single quotes will appear as is. The text

outside the quotes is then used to define the time format.
Incorrect Answers:
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A: This will be interpreted as a time format. It is not accepted.
B: You should not place the text in double quotes. It must be single quotes.
C: The time format should not be placed in quotes.

QUESTION 124:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. Kara Lang usually
accompanies the CEO to the meeting get have the minute of the meeting for their
next general meeting. Kara Lang has lent her laptop to her colleague. After
receiving the laptop, the time only shows two and three digit numbers. The example
she gave was the following. 2 30, when it was 2:30 in the morning; 8 1 when it was
8:01 in the morning. The evening the laptop will show 16 8 when it was 4:08 in the
afternoon. Kara Lang wants her time normal again for example: 2:00 AM or 2:00
PM.

What should Kara Lang do?

A. H:mm:ss t
B. h:mm:ss tt
C. hh:mm:ss t
D.Hm

Answer: B

Explanation: This format, h:mm:ss tt, will display the time in 12-hour format with

no leading zero for the hour. It wll also show the AM and the PM symbols.

Incorrect Answers:

A: This format: H:mm:ss t will display a 24-hour format with no leading zero for the
hour. A and P will be displayed in the place of AM and PM.

C: This format: hh:mm:ss t will display a 24-hour format with leading zero for the hour.
A and P will be displayed in the place of AM and PM.

D: This format: H m is the format the laptop is using.

QUESTION 125:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Walsh has contacted you. Amy Walsh wants to
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change the way the number are formatted. Amy Walsh does not want to use
commas to separate the thousand numbers.
In the exhibit, which of the following setting should be changed?

Customize Regional 0 ptions

Mumbers Cumency | Tme | Date |

Sample

Pasitive: i123,455,?35.un | Negative: |-123455,789.00 |
Decimal symbol: ! L |
Mo, of digitz after decimal: i 2 ~ I
Diigit grouping swmbal: | ~ |
Digit grouping: 123,456,789 v
Meqgative sign spmbal: | L7 |
Megative number format: | 11 “ i
Dizplay leading zeros: | 0.7 w !
Lizt separator: | w |
Measurement spstem: [U.s, o |
Diigit substitution: | Mane - |

[ ] ] [ Cancel ] Apply
Answer:
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Customize Regional Options

Mumbers __Eurrenu:_l,l_:_ Tine | Date |

Sample

Positive: |123,456,783.00 | Negative: |-123.456,733.00
Drecimal symbal: !.. mv .
Mo, of digits after decimal: 5 ¥ [
Drigit grouping symbal: [ v-i
Digit grouping: 123458709 B
Meqgative sign spmbol: . v
Megative number farmat: E 11 e |
Dizplay leading zeros: :-EI_? v/
Ligt separator: e
teazurement spstem: (U5 b .
Digit subshitution: E-hi-una V

[ ] 4 ][ Cancel ]

Explanation:
The digit group settings define how the digit grouping symbol is placed in a number.
Amy Walsh should choose the 123456789 format.

QUESTION 126:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Clive Wilson has contacted you. Clive Wilson has
acquired a computer that is running Windows 2000 Professional. After a year he
upgraded his computer to Windows XP Professional. Clive Wilson would like to
change his dialog box to use the Garamond Bold font. Clive Wilson does not know
how to specify the font in the Display Properties.

In the exhibit, which tab or control should be used?
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Display Properties

Inactive Window: i E@|
s DEX
Message Box El ~

Calor zchems:

| Default blue) v
Font size: Effects...
[Nomal ]

Ok _][ Cancel l Spply

Answer:
Display Properties

Inactive Window. [ | EE|
Active Window |Z| |,E rgl
L

Windows and buttons:

| Windomas XP style

Calar scheme:

| Default [blue) v
Font size: Effects...
[Homs vl

[ ok _][ Cancel ] Spply

Explanation:
Clive Wilson should use the Advance button. This will allow Clive Wilson to change the
fonts of the windows objects, dialog boxes, title bars etc.
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QUESTION 127:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Wilson has contacted you. Amy Wilson wants
the text on her computer to look crispier; she then referred to the Web pages. You
then instruct Amy Wilson to open the Display Properties.

In the exhibit, which tab or control will satisfy Amy Wilson?

Display Properties

| Themes | Deskiop | Scieen Saver | 4ppearance | Seftings |

Anactive Window [

. Active Window E“E[EJ

Windows and buttons:

WWindows =P style

Calar zcheme:

' Defaul blue) v/

Font size
(o ]
0k J [ Cancel ] &pply

Answer:
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Display Properties

Windows and buttons:

i WWindow

Calar scheme:

Defaul [blue] <]
Fartt size: ’ Effects... J
|N0rmal vi
ok | [ Cancel ]
Explanation:

This is done on the Effects button. With this she can choose the edges and the screen
fonts. Amy Wilson should use the Clear Type from the drop-down list.

QUESTION 128:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Development department. A Certkiller .com employee
named Mia Hamm works as a secretary in the Development department.

Certkiller .com contains a workstation named Certkiller -WS007. Certkiller -WS007
was running Windows 2000 Professional, and was upgraded to Windows XP
Professional. Mia Hamm is using this computer. Mia Hamm usually used the
Control Panel in the Windows 2000 Professional to change the font of her
workstation. Mia Hamm would like to know where she could change the font of the
Certkiller -WS007.

In the exhibit, which category should be chosen?
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Pick a category

| %® Appearance and Themes Printers and Other Hardware

o

_n'i x
‘._-1 MNetwork and Internet Connections A User Accounts
- -

i add oF Remove Progranis R Date, Time, Language, and Regional
4 Options

. j Sounds, Speech, and Audio Devices { Accessibility Dptions

_', Performance and Maintenance

Answer:

Pick a category
""& Appearance and Themes 9 Printers and Dther Hardware
@ N~

e
Y-‘ Network and Internet Connections . User Accounts

-
i 7 Add o Remove Programs o Datfa, Time, Language, and Regional
p Options

|\ e i i hili .
. ‘}) Sounds, Speech, and Audio Devices Accessibility Options

y Performance and Maintenance

Explanation:

Mia Hamm must use the Appearance and Themes. Here she will be able to access the
Font applet. If she is not satisfied with the location, she can always use the Switch to
Classic View link. When doing so she will find the fonts in the Control Panel.

QUESTION 129:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Walsh has contacted you. Amy Walsh works
for a company named Acme.com. Amy Walsh wants to use a new font for his
window titles. Amy Walsh saved the font to the My Documents folder, but the font is
not showing Display Properties. Amy Walsh would like to use the font on her
computer.

What should Amy Walsh do?

A. Delete the font; it is not a True Type font.
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B. Reboot the computer and the computer would search the font on the hard drive
automatically.

C. Open the Fonts Control Panel applet and install the font.

D. The font is only a read only file.

Answer: C

Explanation: The fonts that is copied to the hard drive, is not automatically

installed. She needs to install the font. If the font is installed, it would be available in
the drop down list in the Advance Appearance dialog box.

Incorrect Answers:

A: She should not delete the font. True Type fonts and Printer font are displayed in the
drop down list.

B: An operating system will not look for fonts. The fonts must be installed.

D: Even if the font is a read only file; it will not stop it from displaying.

QUESTION 130:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. The
Certkiller .com network contains three Windows 2000 Server computers and 50
Windows XP Professional client computers. The Certkiller .com network is not
connected to the Internet.

A user named Ally Wagner works in the Marketing department. Ally Wagner is
using a Windows XP Professional computer named Certkiller -WS050.
Certkiller -WSO050 is configured to display a task list. The task list is located in a
folder window to the left of the files and folders list.

Ally Wagner want to know which radio button she should use?

A. In the Folders Options dialog box, use the Use Windows classic folders radio button.
B. In the Folders Options dialog box, use the Show common task in the folders radio
button.

C. In the Folders Options dialog box, use the Single-click to open an item radio button.
D. In the Folders Options dialog box, use the Double-click to open an item radio button.

Answer: B

Explanation: If Ally Wagner uses the Show common task in the folders radio

button, it will display a task list in a folder window to the left of the files and folders
list.

Incorrect Answers:

A: The Use Windows classic folders radio button will configure the operating system to
display only the folder list to the left of the files and folders list.

C: The Single-click to open an item radio button, will only allow the user to click once,
and the item in the folder would open.
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D: The Double-click to open an item radio button, will only allow the user to click twice,
and the item in the folder would open.

QUESTION 131:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. The
Certkiller .com network contains three Windows 2000 Server computers and 50
Windows XP Professional client computers.

A user named Kara Lang works in the Finance department. Kara Lang is using a
Windows XP Professional computer named Certkiller -WS009. Kara Lang wants
to configure folders to display only the folder list to the left of the files and folders
list. She does not want to have a view at the task list.

Kara Lang wants to know which radio button she should use?

A. In the Folders Options dialog box, use the Use Windows classic folders radio button.
B. In the Folders Options dialog box, use the Show common task in the folders radio
button.

C. In the Folders Options dialog box, use the Open each folder in its own window radio
button.

D. In the Folders Options dialog box, use the Open each folder in the same window radio
button.

Answer: A

Explanation: If Kara Lang uses the Use Windows classic folders radio button will
configure the operating system to display only the folder list to the left of the files

and folders list t.

Incorrect Answers:

A: The Show common task in the folders radio button, it will display a task list in a
folder window to the left of the files and folders list.

C: The Open each folder in its own window radio button, will cause the window to open
in a new window.

D: The Open each folder in the same window radio button, will cause open folders to
display in the current window.

QUESTION 132:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. All client computers have Microsoft Office XP installed.
Certkiller .com contains a DNS server named Certkiller -SR10.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a two departments named the Research department and the
Development department. A Certkiller .com computer named Certkiller -WS010
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has been moved from the Research department to the Development department. A
Certkiller .com user named Ally Wagner is now working with Certkiller -WS010.
Ally Wagner has submitted a complaint that she cannot connect via the Internet to
the resources that she needs to do her daily tasks. Ally Wagner also complains that
she cannot connect to the Web sites by name. During the investigation you
determine that she can connect to the other computers in their department and the
other computers in the department can connect to Web sites. For a solution, you
provide Ally Wagner with an IP address of the Web sites where packages are
tracked. She now can connect to the site.

Why cannot Ally Wagner connect to the Web sites by name?

A. Certkiller -SR10 is offline.

B. Certkiller -WS010 has an incorrect IP address for a WINS server.

C. Certkiller -WS010 has an incorrect IP address for a DNS server.

D. Certkiller -WS010 has an incorrect IP address for the default gateway.

Answer: C

Explanation: The problem is that Certkiller -WS010 has an incorrect IP address.

The DNS server must resolve qualified domain names to IP addresses.

Incorrect Answers:

A: Certkiller -SR10 is not offline because the other computers in the department can
connect to the Web sites.

B: This is not a WINS issue. A WINS server provides NetBIOS name resolution and not
DNS name resolution.

D: If this was an incorrect IP address for the default gateway, then the computer,
Certkiller -WS010 would not be able to connect to the Web sites or the Internet.

QUESTION 133:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. All client computers have Microsoft Office XP installed.
Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com user named Amy Wilson has contacted you. Amy Wilson is unable to
browse some Internet Web sites. During the investigation you determine that her
colleagues do not have that problem. You then log on to Amy Wilson's computer

and have the same problem.

What could cause the problem?

A. An Lmhost file

B. Windows Internet Naming Service (WINS)
C. A Host file

D. Domain Name System (DNS)
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Answer: C

Explanation: The function of the Host file is to resolve Fully Qualified Domain
Names to Internet Protocol (IP) addresses. This can be an incorrect Host file what
causes the problem.

Incorrect Answers:

A: Lmhost files resolves NetBIOS names to IP addresses. Amy Wilson has a problem
resolving an FQDN.

B: This is not a WINS issue. A WINS server provides NetBIOS name resolution.

D: This is not a DNS problem. DNS resolve FQDN to IP addresses. You did discover
that the other users do not have a DNS problem.

QUESTION 134:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Exchange Server 2000 Server and all client
computers run Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com manager named Andy Reid works in the Sales department. Andy
Reid uses a client computer named Certkiller -WS020. Certkiller -WS020 is
configured to run Internet Information Services (11S). The Uniform Resource
Locator that Andy Reid gave the users to access is http://winxpl. Certkiller .com. Andy
Reid's problem is that no one can access a Web site that he is developing. During the
investigation you notice that Andy Reid has the appropriate permissions granted on
the Web site. You also learn that the other employees of the Sales department can
access Certkiller -WS020 and the Web sites by the IP address, but not the domain
name.

What is the cause of the problem?

A. An Lmhost file

B. Windows Internet Naming Service (WINS)
C. A Host file

D. Domain Name System (DNS)

Answer: D

Explanation: The users of the Sales department can access the Web site by its IP
addresses but not the domain name. This is an indication that it is a name related
problem. The DNS resolve FQDN to IP addresses.

Incorrect Answers:

A: Lmhost files resolves NetBIOS names to IP addresses. The Lmhost file is not the
problem here.

B: This is not a WINS issue. A WINS server provides NetBIOS name resolution.

C: This is not a Host file problem. On a computer the Host file resolve FQDNs to IP
addresses.
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QUESTION 135:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. All the client computers are organized as a workgroup.
A Certkiller .com user named Rory Allen works in the Development department.
Rory Allen works on a client computer named Certkiller -WS002. Rory Allen
needs your assistance because he cannot access the shares on the other computers
that are on a separate subnet in Certkiller .com. During the investigation you make
sure that Rory Allen has the appropriate permissions and user rights. You also
confirm that the other computers of the users do not have the same problem.

What could be the problem?

A. An Lmhost file

B. Windows Internet Naming Service (WINS)
C. A Host file

D. Domain Name System (DNS)

Answer: A

Explanation: Lmhost files resolves NetBIOS names to IP addresses. If the
computers are in a workgroup, it will then use NETBIOS to communicate.

Incorrect Answers:

B: This is not a WINS issue. A WINS server provides NetBIOS name resolution.

C: This is not a Host file problem. On a computer the Host file resolve FQDNs to IP
addresses. The other computers do communicate with each other.

D: This is not a DNS problem. The DNS resolve FQDN to IP addresses.

QUESTION 136:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers
run either Windows XP Professional or Windows 98. The Certkiller .com network
uses Dynamic Host Configuration Protocol (DHCP) to assign Transmission Control
Protocol/Internet Protocol (TCP/IP) settings.

Certkiller .com contains a DHCP server named Certkiller -SR20 and a DNS server
named Certkiller -SR21. Certkiller .com also contains a Desktop Support team
which you are part of. A Certkiller .com user named Andy Reid has contacted you.
Andy Reid cannot access the Certkiller .com network. To start with the investigation,
you ping the loopback address which was successful. The result is that the IP
address is 169.254.1.2 and the subnet mask is 255.255.0.0.

Andy Reid wants to know what could be the problem.
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A. Certkiller -SR20 is offline and not working as it should be.
B. Certkiller -SR21 is offline and not working as it should be.
C. The subnet mask is wrong.

D. The network adapter is faulty.

Answer: A

Explanation Certkiller -SR20 is offline and not working. The IP address is 169.254.1.2
shows that the computer cannot get the TCP/IP settings from the DHCP server,
Certkiller -SR20.

Incorrect Answers:

B: This is not a DNS problem. The DNS resolve FQDN to IP addresses.

C: This is a Class B network. The subnet is not the problem.

D: This is not a network adapter problem because you can ping the loopback address.

QUESTION 137:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a WINS server named Certkiller -SR10. Certkiller .com
contains a Sales department. A Certkiller .com employee named Kara Lang works in
the Sales department. During the maintenance process, Certkiller -SR10 was

taken offline and a temporary WINS server was put online. This server is registered
with a DHCP server. Kara Lang uses a client computer named Certkiller -WS001

is complaining that she cannot access the other computers outside her local subnet.
During the investigation you noticed that the Internet access on the Web sites is
working.

What should you do?

A. From the command prompt on Certkiller -WS001, run ipconfig /flushdns

B. From the Network Tasks menu on Network Connections on Certkiller -WS001, run
Repair.

C. From the command prompt on Certkiller -WS001, run nbtstat -RR

D. On the WINS tab of the Advance TCP/IP Settings dialog box on Certkiller -WS001.
Select Enable LMHOSTS lookup.

Answer: B

Explanation Kara Lang should run the Repair. The original WINS server is off line and
a temporary server took its place. When she runs the Repair, she will receive a new
WINS address.

Incorrect Answers:

A: If you run the nbtstat -RR, it will release and refresh NetBIOS name, but the computer
needs a WINS server that should be present.
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C: If you run the ipconfig /flushdns, it will register the DNS resource records on the
computer. The scenario does not have a resolution problem.

D: Selecting this will allow the computer to use an Lmhosts file for NetBIOS name
resolution.

QUESTION 138:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers
run Windows XP Professional.

Certkiller .com has its headquarters in Chicago and a branch office in Dallas. You
are working in the Chicago office as a desktop support technician. The office in
Dallas is connected to the network in a peer-to-peer situation. The Dallas office has
three client computers running Windows XP Professional, which are configured
with static TCP/IP settings. The client computers in the Dallas office are connecting
to a 100 Mbps hub. You then went to the Dallas office and connect a DSL modem
with five RJ-45 ports and a built-in router. The hardware device will be used to
establish a connection to an Internet service provider. A new Certkiller .com security
policy requires that all traffic should pass through a single computer in the Dallas
office network.

How should you connect the client computers and the DSL modem together?

A. Connect the client computers to the ports on the DSL modem.

B. Connect one port of the DSL modem to the central hub to which all computers are
connected.

C. Install a second network adapter in one computer which is connected to the DSL
modem and leave the original network adapter connected to the central hub.

D. Move one of the computer's cable connections from the central hub to one port on the
DSL modem and attached a cable to the central hub to another port on the modem.

Answer: C

Explanation You should configure a multihomed computer. You should do this by
installing a second network adapter. This will allow the Internet traffic to pass only
through the computer.

Incorrect Answers:

A: This will allow all the client computers to connect to the DSL modem directly. The
scenario states that all the traffic should pass through one computer.

B: This will allow all the client computers to connect to the DSL modem directly. The
scenario states that all the traffic should pass through one computer.

D: This will allow all the client computers to connect to the DSL modem directly. The
scenario states that all the traffic should pass through one computer.

QUESTION 139:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
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contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Exchange Server 2000 Server and all client
computers run Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a desktop computer named Certkiller -WS001 which has
the following installed, Internet Connection Sharing (ICS) and Internet Connection
Firewall (ICF). The Internet connection is provided through a cable modem.

A Certkiller .com user named Andy Reid works in the Marketing department as a
Representative. Andy Reid uses a laptop named Certkiller -WS030. You want the
network connection to be secure, due to his traveling to the customers. A Windows
service that provides access to LAN resources to remote users through dial-up or
VPN connections, can establish a secure connection for all types.

What should you put into practice on Certkiller -WS030 to offer a secure
connection? (Select two)

A. Enable MS-CHAP-v2 for logon security.

B. To connect to a RRAS server, create a VPN connection that uses PPTP and MPPE.
C. To connect to a RRAS server, create a VPN connection that uses L2TP and IPSec.
D. Install a CA certificate and enable EAP for logon security.

Answer:CD

Explanation You should connect to a RRAS server, create a VPN connection that uses
L2TP and IPSec. You should install a CA certificate and enable EAP for logon security.
Incorrect Answers:

A: You should not use MS-CHAP-v2. You should connect to a RRAS server; create a
VPN connection that uses L2TP and IPSec. You should install a CA certificate and
enable EAP for logon security.

B: PPTP is not secure as the L2TP.

QUESTION 140:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Exchange Server 2000 Server and all client
computers run Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains an E-mail server named Certkiller -SR14. A Certkiller .com
user named Mia Hamm works in the Development department as a Representative.
Mia Hamm uses a laptop named Certkiller -WS040. Outlook 2003 and Internet
Explorer is installed on Certkiller -WS040. Mia Hamm would like to get her

e-mail messages for offline viewing, but she does not want the messages to be deleted
from her inbox on Certkiller -SR14.

Which e-mail settings are suitable for Mia Hamm?

A. An IMAP4 account that has Outlook Web Access.
B. An IMAP4 account for local use and an IMAP4 for remote use.
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C. An IMAP4 account for local use and a POP3 account for remote use.
D. A POP3 account that does not delete messages after it is down loaded.

Answer: D

Explanation The POP3 account has an option, Leave a copy of messages on the server,
which will leave a copy of the messages on the e-mail server.

Incorrect Answers:

A, B, C: IMAP4 does not support offline viewing of messages.

QUESTION 141:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a server named Certkiller -SR13 which contains files and
folders which are used by the users in Certkiller .com. A Certkiller .com user named
Kara Lang is a member of the Research department. She usually accesses files in a
folder named CK_Research which has a subfolder named ResearchDoc that resides
on Certkiller -SR13. Kara Lang has a network drive which maps to

Certkiller -WS050, with a shortcut to the CK_Research folder.

Kara Lang has contacted you to report that her short does not work. During the
investigation you find out that Certkiller -SR13 was replaced with

Certkiller -SR14, which specs are identical to Certkiller -SR13. You need to let

the shortcut work on Kara Lang computer.

What should you do?

A. Remove the old shortcut and map a new network drive to the ResearchDoc folder on
Certkiller -SR14 and create a new shortcut to the new network drive.

B. Map a new network drive to the ResearchDoc folder on Certkiller -SR14, right-click
the CK_Research shortcut, select the Properties and click Change Icon and then click
OK.

C. Map a new network drive to the ResearchDoc folder on Certkiller -SR14;
double-click the CK_Research shortcut to automatically change the path to the target
folder.

D. Map a new network drive to the ResearchDoc folder on Certkiller -SR14, right-click
the CK_Research shortcut, select the Properties and type the new path to the
CK_Research folder which will be in the Target address box.

Answer: D

Explanation Kara Lang has to Map a new network drive to the ResearchDoc folder on
Certkiller -SR14, right-click the CK_Research shortcut, select the Properties and type
the new path to the CK_Research folder which will be in the Target address box.
Incorrect Answers:

A: Doing this she should also type the path to the object in the Target address box, click
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Browse and browse to the new location.

B: The Change Icon allows Kara Lang to change the appearance of the icon and not the
path.

C: If you double click the shortcut, the shortcut search future will fail because the files
and folders are moved to a new location.

QUESTION 142:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Server 2003 and all client computers run
Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com also contains a Development department. A Certkiller .com customer
named Amy Walsh who worked in the Development department has contacted you
because she cannot access the resources on the network. Amy Walsh works on a
client computer named Certkiller -WS060. During the investigation you determine
that the other users can access the resources. When you ping Certkiller -WS060,
you received a response message. Amy Walsh needs to access the Internet.

What is causing the problem?

A. The DHCP server is not available on the network.

B. Certkiller -WS060 is not configured with TCP/IP.

C. The default gateway is not configured correctly on Certkiller -WS060.
D. The DNS settings are not configured correctly on Certkiller -WS060.

Answer: C

Explanation The default gateway is not configured correctly on Certkiller -WS060.

The default gateway is used to determine the path to follow to reach external networks.
Incorrect Answers:

A: This is not the problem. If it was not available, then she would not have been able to
access any of the resources on the network in the past. The computer will assign itself an
APIPA address

B: This is not the problem because then you would not have a positive ping answer form
her computer.

C: This is not the problem because then she could not log on to the network and any
resources.

QUESTION 143:

You work as the network administrator at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com.
Certkiller .com has its headquarters in Chicago and a branch office in Dallas. All
servers on the Certkiller .com network run Windows 2000 Server and all client
computers run Windows XP Professional. The client computers of Certkiller .com
have an address range from 192.168.0.1 through 192.168.0.154 with a subnet mask
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of 255.255.0.0. All these are done with a DHCP server.

Certkiller .com contains a Sales department. A Certkiller .com user named Andy
Booth is a member of the Sales department. Andy Booth complains that he is unable
to access the resources on the network. During the investigation you determine that
his computer is connected to the network. You also discover that his computer has
an IP address of 169.254.19.76 and a subnet mask of 255.255.0.0. Andy Booth has to
access the resources to complete his work.

What should you do?

A. Reboot the computer.

B. Issue the netsh /dhcp command.

C. Issue the ipconfig /all command.

D. Issue the ipconfig /release command and then use the ipconfig /renew command.

Answer: D

Explanation The address of 169.254.19.76 and a subnet mask of 255.255.0.0 is an
APIPA address. APIPA addresses are assigned to a Windows XP Professional computer
when the DHCP server is not available. He needs to obtain an IP address from the DHCP
server.

Incorrect Answers:

A: Doing this will allow the computer to get an IP address. This will result in to much
effort because you need to restart the computer.

B: The netsh /dhcp command is used to enter into the DHCP mode where you can
administer DHCP server. This will not allow the use to get an IP address.

C: The ipconfig /all command are used to view all of the current IP settings.

QUESTION 144:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. Microsoft Outlook Express is deployed on all the client
computers.

Certkiller .com contains a Finance department. The Certkiller .com network is
configured as a work group. The employees of Certkiller .com have an e-mail account
with an ISP. A Certkiller .com user named Amy Walshis a member of the Finance
department. Amy Walsh works on a client computer named CertK NG-WS070.
Amy Walsh is complaining that she can use Outlook Express to retrieve e-mail
messages from the server at the ISP, but cannot send e-mail messages from Outlook
Express. You have received instructions to short out the problem.

What protocols should you configure on CertkK NG-WS070?

A. POP3
B. SMTP
C. SNMP
D. TCP/IP
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Answer: B

Explanation Simple Mail Transfer Protocol (SMTP) when used in Outlook Express, will
through the e-mail server that the ISP specifies, send e-mail messages.

Incorrect Answers:

A: POP3 allow a user to retrieve messages from the e-mail server.

C: Simple Management Protocol (SNMP) will allow administrators to configure and
monitor SNMP-compatible network hardware.

D: Transmission Control Protocol/Internet Protocol is a data transmission protocol that is
used on the Internet.

QUESTION 145:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. Certkiller .com contains a network-based server named
Certkiller -SR30 that can automatically assign and configure an IP address and
many other network configuration parameters onto a client computer when the
client computer is started up on the network.

Certkiller .com contains a Sales department. A Certkiller .com employee named Mia
Hamm works in the Sales department. She uses a client computer named

Certkiller -WS080. Mia Hamm is complaining that she cannot access the other
computers on the network or the Internet. You then went to her cubical and run the
ipconfig. The result shows that she has an IP address of 169.254.92.192 and a subnet
mask of 255.255.0.0 and the gateway has no entry. You then run the ipconfig
Irelease and there after the ipconfig /renew. The result was a time-out error

message. You also learn that you can successfully ping the loopback address on her
IP address.

What should you next?

A. Reinstall TCP/IP on her network adapter.

B. Configure Certkiller -WS080 with TCP/IP settings.

C. Find out if the DHCP server is online.

D. Configure Certkiller -WS080 with the DNS server's address.

Answer: C

Explanation The IP address and the subnet mask is an indication that this is an APIPI
assignment address. This is obtained by a DHCP server. That's way you should check if
the DHCP server is online.

Incorrect Answers:

A: You do not need to reinstall the TCP/IP on her network adapter. You did receive a
positive answer when you ping the loopback address on her IP address.

B: You should not do this. If the IP address is the same of another computer in the
network, the other computer and your computer will not be able to communicate.
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D: If the DNS address listing was incorrect, then she would not have been able to browse
the local network.

QUESTION 146:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Server 2003 and all client computers run
Windows XP Professional.

Certkiller .com has headquarters in London and branch offices in Paris, Berlin,
Milan and Athens. You are the desktop technician in the London branch. All the
branch offices are configured with a wireless access point, which allow the users to
access the network wirelessly. You have a laptop named Certkiller -WS090 which
is configured with a wireless network adapter. When you are traveling to the
branch offices you need to reconfigure Certkiller -WS090 to access their network.
You do not want to do this anymore.

What should you enable?

A. Installing a WAP at the London head office.

B. Configure the network adapter by clearing the Network access control using IEEE
802.1X option.

C. Configure the network adapter by clearing the Use Windows to configure my wireless
network settings option.

D. Configure the network adapter by selecting the Use Windows to configure my
wireless network settings option.

Answer: D

Explanation You do not want to reconfigure the laptop every time, so you need to select
the Use Windows to configure my wireless network settings option. This will allow the
automatic wireless network adapter to search for an available wireless networks.
Incorrect Answers:

A: Installing WAP would not configure automatic wireless configuration on the wireless
network adapter.

B: Clearing the network access control using IEEE 802.1X option will disable IEEE
802.1X authentication for the connection. Automatic wireless configuration supports
IEEE 802.1X authentication.

C: This option will not work. You need to select the Use Windows to configure my
wireless network settings option. This will allow the automatic wireless network adapter
to search for an available wireless networks.

QUESTION 147:
You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers

on the Certkiller .com network run Windows 2000 Server and all client computers
run Windows XP Professional with Service Pack 2. All the computers in the
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Certkiller .com domain have the Windows Firewall enabled.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Graphics department. A Certkiller .com user named Kara
Langwho works in the Graphics department has contacted you. Kara Lang wants to
establish a Remote Desktop connection from her computer, named

Certkiller -WS010 to another computer in their department. You make sure that

the Remote Desktop exception in Windows Firewall is enabled. When you test it, by
connecting to your computer, it was successful. After awhile she again contacts you
to report that she cannot log on to the remote computer when she uses the Remote
Desktop. You need to fix the connection and still protect her computer.

What should you do?

A. Disable the Windows Firewall on Certkiller -WS010.

B. Disable the Windows Firewall on the other computer.

C. Add Kara Lang's user account to the Remote Desktop Users group.
D. Disable Internet Connection Sharing (ICS) on Certkiller -WS010.

Answer: C

Explanation You should add the user to the Remote Desktop Users group, which will
then allow her to establish a Remote Desktop connection.

Incorrect Answers:

A: Disable the Windows Firewall will leave the computer vulnerable to intruders.

B: Disable the Windows Firewall will leave the computer vulnerable to intruders.

D: The ICS is irrelevant in this case because the computers in this scenario are not
sharing its Internet connection.

QUESTION 148:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner work
for Acme.com which contains a two offices. Ally Wagner said that the employees in
there office cannot connect to the computers in the other offices, but the other
employees in the other office can access there computer. You respond to her by
telling her to connect by name and IP address. Her reply was that it was
unsuccessful. You then tell her to ping the default gateway, which result in the
following: Destination host unreachable error.

What would you tell Ally Wagner?

A. The interface that can give a computer access outside of its own subnet is not
registered in Domain Name System (DNS).

B. The interface that can give a computer access outside of its own subnet is maybe
offline or not the same subnet as your computer.
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C. The interface that can give a computer access outside of its own subnet does not have
bridging enabled.

D. The interface that can give a computer access outside of its own subnet is not
registered in Windows Internet Naming Service (WINS).

Answer: B

Explanation It is that the default gateway can be offline or not have the same subnet as
the computer. If the two computers cannot connect, it will send it to the default gateway,
which will then forward the request.

Incorrect Answers:

A: There is on need for the default gateway to be registered in DNS.

C: Bridging will allow multiple network interface adapters to share a single set of
network settings. The default gateway does not have to be bridged.

D: There is on need for the default gateway to be registered in WINS.

QUESTION 149:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner is
working as a sales representative for her company. Ally Wagner uses a laptop that
accompanies her to where she is traveling. She also uses a desktop computer at her
work which is connected to the Internet and has a public Internet Protocol address.
Both of her systems are running Windows XP Professional. Ally Wagner needs to
ensure that the communication between the computers is safe and secure and wants
to setup the desktop computer as a VPN server.

To provide VPN support, what should Ally Wagner do first?

A. Enable Routing and Remote Access.

B. Use the New Connection Wizard.

C. Install the Point-to-Point Tunneling Protocol.
D. Configure Internet Protocol Security filters.

Answer: B

Explanation Ally Wagner should use the New Connection Wizard. This will create an
incoming connection on the desktop computer.

Incorrect Answers:

A: On a Windows XP Professional computer you do not use Routing and Remote
Access. The New Connection Wizard is used to create incoming and outgoing VPN
connections.

C: You do not install PPTP. It is included with Windows XP Professional.

D: By configuring IPSec, does not enable VPN. IPSec and L2TP provide data encryption
services.
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QUESTION 150:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner is self
employed and work from home. She has four computers, which are connected to the
home network and not to the Internet, which is running Windows XP Professional.
Ally Wagner also states that the computer get IP addresses automatically. Ally
Wagner would like to give one of the computers a static Internet Protocol address
which is needed for a new accounting application that needs to be installed. Ally
Wagner wants this computer to be also part of the network. You also learnt that her
computers does not use the Dynamic Host Configuration Protocol (DHCP). Ally
Wagner needs a subnet mask.

What should she use?

A. 255.0.0.0

B. 255.255.255.0
C. 255.255.255.255
D. 255.255.0.0

Answer: D

Explanation The computers do not use DHCP but APIP

A. APIPA assigns IP addresses

automatically from the 169.254.0.0/16 subnet.

Incorrect Answers:

A: This subnet is used to identify a subnet that uses 8 bits.

B: This subnet is used to identify a subnet that uses 24 bits.

C: This subnet is used to identify a local computer and not a subnet.

QUESTION 151:

You work as a desktop technician at Acme.com. The Acme.com network contains a
single Active Directory domain named acme.com. All servers on the Acme.com
network run Windows 2000 Server and all client computers run either Windows XP
Professional or Windows 98.

Acme.com contains a Desktop Support team which you are part of. An Acme.com
customer named Amy Wilson has contacted you. Amy Wilson is working most of
her time from home and has two computer named Certkiller -WS002 and

Certkiller -WS003 which is on the home network. Certkiller -WS002 is running
Windows XP Home and is connected to the Internet. Certkiller -WS003 is running
Windows XP Professional. Amy Wilson needs to access the Certkiller .com network
from Certkiller -WS003. Amy Wilson needs to create a Virtual Private
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Networking connection and use Internet Connection Sharing on the computers at
home.
How should she configure the computers?

A. On Certkiller -WS003, enable ICS and create the VPN connection.

B. On Certkiller -WS002, enable ICS and on Certkiller -WS003 create a VPN
connection.

C. On Certkiller -wWS003, enable ICS and on Certkiller -WS002 create a VPN
connection.

D. On Certkiller -WS002, enable ICS and create the VPN connection.

Answer: B

Explanation Enable ICS on Certkiller -WS002 will allow the computer to share its
Internet connection with the other computer. VPN should be connecting to the Internet,
that way Certkiller -WS002 will enable Certkiller -WS003 to connect to the Internet.
Incorrect Answers:

A: You cannot enable ICS on Certkiller -WS003 because the computer should be
connected to the Internet.

C: You cannot enable ICS on Certkiller -WS003 because the computer should be
connected to the Internet.

D: The VPN connection should be on Certkiller -WS003 and not Certkiller -WS002.

QUESTION 152:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Server 2003 and all client computers run
Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Mia Hamm has contacted you. Mia Hamm has a
router that she uses to connect her home computer, that is running Windows XP
Professional, to the Internet. Mia Hamm wants all her other computers that are on
the home network to connect to the Internet via the computer that connects to the
Internet. Mia Hamm also installed a second network adapter and creates a
Point-to-Point over Ethernet connection by using the Network Connection Wizard.
Every time she does that, she receives an Error 678. Mia Hamm is also convinced
hat she uses the correct user name and password for the Internet Service Provider
(ISP).

She wants to know what causes the Error 678.

A. The router is connected to the ISP using PPPOE.

B. The two network interface adapter is not bridge.

C. Windows XP Professional does not support PPPOE.

D. PPPOE is not supported on multihomed computers.

Answer: A
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Explanation The router is connected to the ISP using PPPoE. Only one PPPOE
connection can be made for an account.

Incorrect Answers:

B: This is not the cause because the tow adapters should not be bridged. This will allow
the computers on the Internet to access the internal computers.

C: Windows XP Professional does support PPPOE.

D: Multihomed computers do support PPPOE.

QUESTION 153:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a network-based server named Certkiller -SR30 that
dynamically registers IP addresses and NetBIOS names of the computers on their
network and then provides name resolution to them. Certkiller .com contains a
Finance department. A Certkiller .com employee named Mia Hamm works in the
Finance department. During the maintenance process, Certkiller -SR30 was taken
offline and a temporary WINS server was put online to do the functions of WINS.
During the cause of the day Mia Hamm has contacted you to complain that she
cannot contact any computers outside the local subnet. You then went to her
cubical, browse to a Web site and notice that it was function normal.

What should you do that she can contact the other computers outside the local
subnet?

A. From the command prompt, run nbtstat -RR

B. From the command prompt, run ipconfig /flushdns

C. From the Network Tasks menu on Network Connections, run Repair.

D. On the WINS tab of the Advance TCP/IP Settings dialog box. Select Enable
LMHOSTS lookup.

Answer: C

Explanation Mia Hamm should run the Repair. The original WINS server is off line and
a temporary server took its place. When she runs the Repair, she will receive anew WINS
address.

Incorrect Answers:

A: If you run the nbtstat -RR, it will release and refresh NetBIOS name, but the computer
needs a WINS server that should be present.

B: If you run the ipconfig /flushdns, it will register the DNS resource records on the
computer. The scenario does not have a resolution problem.

D: Selecting this will allow the computer to use an Lmhosts file for NetBIOS name
resolution.
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QUESTION 154:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Server 2003 and all client computers run
Windows XP Professional.

Certkiller .com has headquarters in London and branch office in Paris.

You are the desktop technician in the London branch. The client computers in the
Paris office have a peer-to-peer network and the connection to the Internet via cable
modem through one of the client computers named Certkiller -WS008, which runs
Internet Connection Sharing (ICS) and Internet Connection Firewall (ICF). A
Certkiller .com user named Kara Langin the Paris office has a laptop named
Certkiller -WS010. She is complaining that she cannot connect to the LAN, but the
other computers in the branch office do not have the same problem. When she runs
the ipconfig /all command, she received the following:

e EA\WINDOWS\system32\cmd.exe

IC:~>ipconfig ~all
Windows IP Configuration

Host Name . . . . . . . . . . . . &t certkiller-ws010
Primary Dns Buffix H

Mode Type : Unknown

IP Routing Enabled 5

WINE Proxy Enabled

Ethernet adapter Local Area Connection:

Connection—-specific DNS Suffix . :
Description : Intel 8255 PCI Ethernet Adapter (16,168
Physical Address. . . . - - . . . : BAB-B4-23-8B8-5E-CA
DHCP Enabled : No
IP Address. . . . . . . . - . . . = 108.18.168.71
Subnet Mask : 255.255.8.8
: 18.18.18.3
18.18.188.71

Based on the result of the ipconfig /all command, which statement is true?

A. On Certkiller -WS010 is an APIPA address configured.

B. There is no DHCP server available.

C. On Certkiller -WS010 is no automatic IP addressing available.

D. On Certkiller -wS010 is a Class A IP address matched with a Class B IP address.

Answer: C

Explanation There is no automatic IP addressing enabled, that's why

Certkiller -wWS010 cannot connect to the local LAN.

Incorrect Answers:

A: If Certkiller -WS010 has automatic IP addressing enabled, the APIPA will provide

an address.

B: The network is using ICS. The computer that runs ICS will act as a DHCP server.

D: The APIPA's first two octets is 169.254 and the subnet mask is 255.255.0.0, a Class B
mask.
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QUESTION 155:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Exchange Server 2000 Server and all client
computers run Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com manager named Andy Reid works in the Research department. Andy
Reid uses a client computer named Certkiller -WS003. Andy Reid has created a
Web site on Certkiller -WS003, which contains the information of there latest
research they did. Andy Reid can access the Web site, but the other users cannot
access the Web site. You then use your computer and use the ping command on his
computer name and the computer IP address. The result was the following: Request
timed out. During the investigation you learnt that Andy Reid can access his
personal files on the home directory, which is in the files server of there company.
The other users in the Research department need to access the Web site.

What should you do?

A. Assign the NTFS permissions fort he C:\Inetpub\wwwroot folder.

B. Disable the Internet Connection Firewall on Certkiller -WS003.

C. In the System Properties, enable Allow Users to connect remotely to this computer.
D. In the Properties of the Web site, enable Anonymous access in the Internet
Information Services.

Answer: B

Explanation It looks like the Internet Connection Firewall on Certkiller -WS003 in
enabled. This will allow a computer not to respond to any ICMP requests. That is way,
which the ping command there was an error message.

Incorrect Answers:

A: This has nothing to do with this scenario. The users should be first authenticated to
verify NTFS permissions.

C: Remote Desktop uses the Remote Desktop Protocol. This has nothing to do with Web
servers or HTTP.

D: This has nothing to do with this scenario. The users should be first authenticated to
verify I1S authentication.

QUESTION 156:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers and 1500 Windows XP
Professional client computers. All the client computers are using Internet Explorer

as the Internet browser.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Sales department. A new Certkiller .com policy requires
that no users should purchase goods for personal use over the Internet. You need to
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enforce the new company policy.
Which ports should be blocked?

A. 80

B. 443

C. 993
D.20and 21

Answer: B

Explanation Port 443 is used for Secure Sockets Layer connections to Secure HTTP
Web sites. This port should be blocked.

Incorrect Answers:

A: Port 80 is used for HTTP connections. If this is blocked, all attempts to the Internet
will fail.

C: Port 993 is used for connections to IMAP4 to connect to a mail server. With pout this
you cannot retrieve mail.

D: Port 20 and 21 is used for FTP connections and file transfers.

QUESTION 157:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. The client computers use Internet Explorer as the
default browser.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a FTP server named Certkiller -SR23. While you were on
leave for a week, the administrator implemented a new firewall at the company.
You used to access Certkiller -SR23 at a remote office. When you came back from
leave, you cannot access Certkiller -SR23.

What could be the problem?

A. Port 20 is blocked by the firewall
B. Port 80 is blocked by the firewall
C. Port 110 is blocked by the firewall
D. Port 443 is blocked by the firewall

Answer: A

Explanation It is that port 20 is blocked because this is used for used for FTP
connections and file transfers.

Incorrect Answers:

B: Port 80 is used for HTTP connections. If this is blocked, all attempts to the Internet
will fail.

C: Port 110 is used for Post Office Protocol 3 (POP3), this allow for e-mail.

D: Port 443 is used for Secure Sockets Layer connections to Secure HTTP Web sites.
This port should be blocked.
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QUESTION 158:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Amy Wilson has contacted you. All the client
computers in their company are running Windows XP Professional with Service
Pack 2. Amy Wilson said that she installed a printer on her computer, which is
working successfully. She tried to share the printer with the other users in her work
group. The problem is that the work group cannot find the printer on the network.
Amy Wilson wants to share the printer with the work group.

What should be her first step?

A. On all the client computers in the workgroup you should install the printer software.
B. Configure the ICMP options in Windows Firewall.

C. Make sure that the File and Printer Sharing is enabled on the Exception tab of the
Windows Firewall.

D. Specify Don't allow exceptions option in the Windows Firewall

Answer: C

Explanation If the File and Printer Sharing is not enabled, the incoming request will be
blocked by the Windows Firewall.

Incorrect Answers:

A: This is not a print driver problem. The other users cannot find the computer on the
network.

B: They should not configure the ICMP options. This allows a computer to send and
receive error and status information.

D: This will close all the ports.

QUESTION 159:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Andy Reid has contacted you. Andy Reid is a sales
representative for there company and sometimes he access the company network
with his home computer that is running Windows XP Professional with Service
Pack 1. The reason why he contacts you is that he has problems browsing the Web
sites. There administrator has told him to configure the Internet Connection
Firewall and run the ping command against his computer.
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In the Internet Control Message Protocol tab, which option should he check? (Use
the exhibit to click the option to run the ping command)

Advanced 5ettings

Services | ICMP |

Internet Control Meszage Protocol [[CMP] allows the computers on
a hetwork ta share errar ahd statug information. Select the requests
for infarmation from the Inkemet that thiz computer will rezpond to:;

E O Allow incaming echo request

[ &llow incoming timestamp request

: O Allow incoming mask request

! [ Adlows incoming rouker ragquest

!|:| Allov outgoing destination unreachable
!D Allows outgoing zource guench

i|:| Allovw oukgoing parameter problem

| Allow outgoing time efceeded

i O Allow redirect

[ezenphon:

Meszages zent to thiz computer will be repeated back to the
zender. Thiz iz commony used for roubleshoating, for esample,
to ping a machine,

[ QE. ] [ Cancel

Answer:
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Advanced 5ettings

| Services | IChP |

Internet Control Meszage Protocal [ICKP) alloves the computers an
a network to ghare error and status infarmation, S elect the requests
for infarmation from the Internet that this computer will respond ta:

aincoming echorequest

[ oW Incaming bmestamp request
[ Allow incoming mask request

' O Adlows incorning router request

[ Allow outgoing destination unreachable
|:| Allow outgoing zource quench

|0 allow outgaing parameter problem

'|:| Alloww outgoing time elceeded

[T Al redirect

[ezchphon:

M ezzages zent to thiz computer will be iepeated back to the
sender. Thiz iz commanly used for troubleshoating, for esample,
to ping a machine,

[ (] ][ Cancel ]

Explanation:
The "allow incoming echo request™ option will allow him to use the ping command
against his computer.

QUESTION 160:

You work as a helpdesk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Development department and a Sales department. The
Development department does research on software and the Sales department sells
the applications, software and computers. Certkiller .com also has a help desk team
which helps the customers which has problems with there software or computers
that was bought at Certkiller .com.

You are using Windows Messenger to converse with the customers and to receive
Remote Assistance invitations. You have upgraded a Windows XP Professional
computer with Service Pack 2, which belongs to a customer named Rory Allen. You
need to allow Rory Allen to contact you with Windows Messenger to receive Remote
Assistance request because he contacts you frequently for assistance.

What should you do on Rory Allen's computer?

A. Create a Windows Firewall exception for Windows Messenger.
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B. Install Windows Messenger
C. Create a Windows Firewall exception for Remote Assistance.
D. Create a Windows Firewall exception for Remote Desktop.

Answer: A

Explanation For the user to have Remote Assistance, you need to create a Windows
Firewall exception for Windows Messenger.

Incorrect Answers:

B: You do not need to install the Windows Messenger because the user was contact you
before the upgrade.

C: You do not need to create an exception for Remote Assistance because Service Pack 2
is installed and the Windows Firewall will automatically create an exception for Remote
Assistance.

D: You do not need to create an exception for Remote Desktop. The Windows will create
the exception for you when requested.

QUESTION 161:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional with Service pack 2.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Research department. A Certkiller .com user named Dean
Austin is a member of the Research department. Dean Austin works on a client
computer named Certkiller -WS010. Dean Austin has developed a File Transfer
Protocol (FTP) site for the employees in the Research department on

Certkiller -wWS010. Dean Austin is worried because the users in there department
cannot access the FTP server.

Which Windows Firewall setting will allow the FTP server to accept incoming
connections?

A. Exceptions

B. Network Connection Settings
C. Don't allow exceptions

D. ICMP

Answer: A

Explanation The exception option will open the ports for incoming connections.
Incorrect Answers:

B: The Network Connection Settings will disable the Windows Firewall on a specific
connection.

C: The "Don't allow exceptions™ will close the ports that are open, temporary.

D: They should not configure the ICMP options. This allows a computer to send and
receive error and status information.
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QUESTION 162:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional with Service pack 2.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a computer named Certkiller -WS001, which has occasional
networking problems. You want to ping the computer on a regular basis to check it
connectivity. You want to ping Certkiller -WS001 and in the same time protect it
from intruders.

What should you do?

A. Disable the Windows Firewall on your computer.

B. Disable the Windows Firewall on Certkiller -WS001.

C. Enable the "Allow incoming echo request option in Windows Firewall on your
computer.

D. Enable the "Allow incoming echo request option in Windows Firewall on
Certkiller -WS001.

Answer: D

Explanation The settings in the ICMP will allow you to select the Internet Control
Message Protocol to which you want the computer to respond.

Incorrect Answers:

A, B: If you disable the firewall, it will allow intruders to your systems.

C: Doing this will not allow your computer to send a ping.

QUESTION 163:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Clive Wilson has contacted you. All of the desktop
computers in Clive Wilson's company are running Windows XP Professional with
Service Pack 2. One of the computers in their company is connected to the Internet
with a cable modem. The computer is configured with Internet Connection Sharing.
Clive Wilson wants to turn on logging of dropped packets in Windows Firewall. He
has a problem because he does not know where the log is located.

What should you tell him?

A. In the Event Viewer, click on Security

B. Open the C:\Windows\pfirewall.log file.

C. In the Computer Management, click on Alerts which is under the Performance Logs
and Alerts.
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D. View the log by clicking the Settings button in the Security Logging area which
resides in the Advance tab in Windows Firewall.

Answer: B

Explanation The C:\Windows\pfirewall.log file, is the default place for the Windows
Firewall log. You can open the logfile in Notepad.

Incorrect Answers:

A: He should not use the Event Viewer. Windows XP Professional does not record
dropped connections in the Event Viewer.

C: This toll is used when the computer needs performance to meet some specified
threshold.

D: You cannot view the log by clicking the Settings button in the Security Logging area
which resides in the Advance tab in Windows Firewall.

QUESTION 164:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional. All client computers have Microsoft Office XP
installed.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Sales department. A Certkiller .com user named Ally
Wagner who works is the Sales department, was assigned a laptop named
Certkiller -WSO055 that is running Windows XP Professional. Because of the
workload she has to take work home to complete. Ally Wagner uses her domain
user account to create a dial-up connection. She then tries to enable the Internet
Connection Firewall for the connection, but was unsuccessful. The next day when
she sees you at the work, she asked you to enable ICF for the new dial-up
connection.

What should you do?

A. Disable the policy that stops ICF on the DNS network.

B. Enable Allow other network users to control, or disable shared Internet connection.

C. Ally Wagner should used her local user account when dials to the network.

D. Enable Web Server (HTTP) on Advance Settings in the Properties sheet of the dial-up
connection.

Answer: A

Explanation The ICF functions as a packet filter. ICF is controlled by the local Prohibit
use of Internet Connection Firewall on the DNS domain network.

Incorrect Answers:

B: This will allow the users at home or at the office to control ICS. Only Ally Wagner
has the cached domain user credentials on her computer.

C: If she uses her local user account, she would not be able to access any of the resources
on the LAN.
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D: The Web Server (HTTP) on Advance Settings in the Properties sheet of the dial-up
connection is only available when the ICS is enabled.

QUESTION 165:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Dean Austin has contacted you. Dean Austin has his
business at home and works on a Windows XP Professional Home Edition
computer. The computer has a COM port and a LPT port and two build-in USB
ports. The devices that he uses on the computer are the following: USB keyboard
that meets the USB1.1 standard, USB mouse that meets the USB1.1 standard, USB
camera with a USB connection for transferring images that meets the USB2.0
standard, and a USB scanner that meets the USB1.1 standard. Dean Austin will only
use the camera when it is necessary. Dean Austin would like to add a USB capable
DSL modem to his computer and would like your advice of how to connect his
devices.

What should you tell him?

A. Acquire a self-powered 4-port USB hub and connect the USB port to the hub and
connect all the USB devices to the hub.

B. Connect the scanner to one USB port and plug the keyboard into the scanner and the
mouse into the keyboard. Then use the other USB port for the camera.

C. Get two USB-to-PS/2 adapters and attached the mouse and the keyboard to the PS/2
ports. Connect each of the remaining devices to its own USB port on the computer.

D. Get a bus-powered hub and a self-powered hub; connect each to the computer's USB
ports. Connect the keyboard and the mouse to the bus-powered hub and the printer and
camera to the self-powered hub.

Answer: C

Explanation The best method is to get two USB-to-PS/2 adapters and attached the
mouse and the keyboard to the PS/2 ports. Connect each of the remaining devices to its
own USB port on the computer. You should connect the camera to a separate USB port,
because it uses the USB1.1 specification.

Incorrect Answers:

A: This will not meet the requirements. He should to get two USB-to-PS/2 adapters and
attached the mouse and the keyboard to the PS/2 ports. Connect each of the remaining
devices to its own USB port on the computer.

B: The scenario does not state that any of the devices has a pass-through port.

D: A bus-powered hub provides low power. Scanners, cameras, etc uses more power
than, what the bus-powered hub can produce. It needs a self-powered hub.
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QUESTION 166:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers
run Windows XP Professional.

Certkiller .com has its headquarters in Chicago and a branch office in Dallas. You
are working in the Dallas office as a desktop support technician. The office in Dallas
is connected to the network in a peer-to-peer situation. You have installed a print
device named Certkiller -PRO1 to a client computer named Certkiller -WS009,
which is shared to the other users in the Dallas offices. You want the members of the
Creator Owner group to be able to restart the printing of documents on

Certkiller -PRO1.

Which permissions should you grant the Creator Owner?

A. Grant the Print permissions

B. Grant the Manage Printers permissions.

C. Do not grant additional permissions.

D. Grant the Manage Documents permissions.

Answer: C

Explanation You should not grant additional permissions. The Creator Owner group has
by default the Manage Documents permissions.

Incorrect Answers:

A: The Print permissions will aloe the user to print document s to a printer.

B: The Manage Printers permissions allow the user to change the settings of the printer.
D: The Manage Documents permissions are the default by the Creator Owner group.

QUESTION 167:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com user named Andy Reid is working in the Sales department. Andy
Reid is working as a sales representative for Certkiller .com. Andy Reid has a laptop
named Certkiller 011, which he used for traveling. Certkiller 011 has a mouse
attached to the USB 1.1 and a USB printer attached to the USB2.2. Certkiller 011
also has a parallel port connection. Andy Reid is complaining that one of her two
USB 2.0 ports is not working on the computer.

How can Andy Reid connect the mouse and the printer to have the best
performance?

A. Connect the printer and the mouse to a bus-powered USB 2.0 hub.
B. Connect the printer and the mouse to a self-powered USB 2.0 hub.
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C. Connect the printer to the functional USB port and use a USB-to-PS/2 adapter for the
mouse to the PS/2 port.

D. Connect the mouse to the functional USB port and the printer to the LPT1 port using
an IEEE 1284 printer cable.

Answer: C

Explanation To get optimal performance, you should connect the printer to the
functional USB port and use a USB-to-PS/2 adapter for the mouse to the PS/2 port. The
best performance for a printer is to connect to the USB 2.0 port.

Incorrect Answers:

A: This will not supply sufficient power for the two devices.

B: The user can do this. However the mouse conforms to the USB 1.1 standard. This
could result in the computer to perform at USB 1.1 speed.

D: The Manage Documents permissions are the default by the Creator Owner group.

QUESTION 168:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a printer named Certkiller -PR0O5, which is connected to a
client computer named Certkiller -WS022. The manager wants the users in

Certkiller .com to be able to change spooler setting, pause, change permissions etc on
Certkiller -PRO5.

What permissions should be granted?

A. For Certkiller -PR05, deny Print permissions to the Everyone group.

B. For Certkiller -PRO5, grant Print permissions to the Administration group.

C. For Certkiller -PR05, grant Manage Printers permissions to the Everyone group.
D. For Certkiller -PRO5, grant Manage Printers permissions to the Administration

group.

Answer: C

Explanation You should grant Manage Printers permissions to the Everyone group. This
will allow them to change spooler settings, pause printer, restart printer, share the printer
etc.

Incorrect Answers:

A: Denying Print permissions will prevent the users from using the printer.

B: The Administration group by default has the Manage Printers permissions.

D: The Administration group by default has the Manage Printers permissions.

QUESTION 169:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
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contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional. All client computers have Microsoft Office XP
installed.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a computer named Certkiller -WS003 that has two IEEE
1394 ports. An external FireWire CD-RW drive is connected to one of the ports.
You have received instruction from the CIO to connect a digital camera to the
computer. The connection should not affect the CD-RW drive. The FireWire devices
are Bus-powered. You solution should take the least amount of administrative
effort.

What should you do?

A. Use a six-pin cable and connect the digital camera to the available IEEE 1394 port.
B. Use a four-pin cable and connect the digital camera to the available IEEE 1394 port.
C. Acquire a bus-powered IEEE 1394 hub, connect the two external devices to the hub,
and connect the hub to the computer with a six-pin connector.

D. Acquire a bus-powered IEEE 1394 hub, connect the two external devices to the hub,
and connect the hub to the computer with a four-pin connector.

Answer: A

Explanation A four-pin cable will only carry only data and a six-pin cable can supply
bus power to the devices. The digital camera is bus-powered and not self-powered.
Incorrect Answers:

B: A four-pin cable will only carry only data and does not supply bus-power to the
attached devices.

C, D: You do not need to get a bus-power or a self-powered IEEE hub. This will lead to
more administrative duty.

QUESTION 170:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Amy Walsh has contacted you. Amy Walsh has a
Windows XP Professional computer and wants to configure two IEEE 1394
FireWire devices. The one device is an external hard drive with a four-pin cable
connecting to a six-pin port on the computer and uses an external power supply.
The other device is an external DVD-R drive that has a six-pin cable. The computer
of Amy Walsh has one IEEE 1394 port and each of these two devices has a port for
a daisy-chaining IEEE 1394 devices.

How should you configure the devices? (Select all that apply)

A. Plug the external hard drive into the external DVD-R drive.
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B. Plug the external power supply into the external hard drive.

C. Replace the four-pin cable with adapter with a six-pin cable.

D. Plug the external DVD-R drive into the computer's IEEE 1394 port.
E. Plug the external hard drive into the computer's IEEE 1394 port.

Answer: A, B, D

Explanation Only six-pin IEEE 1394 devices can obtain its power from the IEEE 1394
bus. The external DVD-R drive should be plugged into the computer's IEEE 1394 port.
Incorrect Answers:

C: The external hard drive has a four-pin connector, so you should not replace it.

E: This will result in for you to plug the external DVD-R drive into the external hard
drive, because there are no other IEEE 1304 ports available.

QUESTION 171:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Andy Reid has contacted you. Andy Reid has
acquired a personal digital assistant. He would like to connect the PDA to his
computer which has an infrared transceiver. Andy Reid would like to know if the
PDA supports infrared.

What should your answer be?

A. In the Device Manager, see if there is an Infrared Devices node.
B. See if the PDA's documentation refers to a FireWire support.

C. Check the Hardware Compatibility List for the PDA.

D. Look for a small, dark red window on the PDA.

Answer: D

Explanation: Andy Reid should look for a small, dark red window on the PD

A. This

is where the infrared transceiver is located.

Incorrect Answers:

A:Andy Reid cannot look for an infrared device on the computer, if it is not connected to
the computer.

B: FireWire is another named for IEEE 1394 standard. It supports faster data
transmission it also requires a IEEE 1394 cable to support communication between
devices.

C: The PDA will not state a particular model that supports infrared communication.

QUESTION 172:
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You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. Kara Lang has a
laptop that runs Windows XP Professional. The laptop is configured to connect to
an infrared printer that is at her home network. The problem is that the laptop
cannot connect to the infrared printer.

To troubleshoot the problem, what should your first question be?

A. On the home network, do you have radio frequency (RF) Wireless Access Point
(WAP)?

B. Is there a wireless phone that uses a frequency of about 2, 4 GHz?

C. Into the electrical outputs, how many devices are plugged in where the print device
and laptop is plugged?

D. How far away is the laptop from the infrared printer?

Answer: D

Explanation: Infrared devices communicate over a short distance. You have to ask
the distance of the two devices.

Incorrect Answers:

A: Radio frequencies do not interfere with Infrared Data Association devices.

B: Wireless phone do not interfere with Infrared Data Association devices.

C: Electricity does not interfere with Infrared Data Association devices.

QUESTION 173:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. All the client computers use Internet Explorer as the
default browser and have Microsoft Office 2003 installed on them.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Research department. A Certkiller .com user named Dean
Austin works in the Research department. Dean Austin works on a client computer
named Certkiller -WS007 with a USB mouse and keyboard connected to it. You
have received instructions to connect a USB tablet device and a USB scanner to
Certkiller -WS007. They then acquire a bus-powered hub, and you connect the
devices where it was functioning normal. For backup purposes they connect a USB
hard drive to the computer. However, the hard drive does not work. During the
diagnostic you leant that the hard drive works when it is plugged in to

Certkiller -WS007's USB port. The manager wants you to use the USB hub.

What should you do?
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A. Swap the bus-power with a self-power hub.

B. Specify Certkiller -WS007 to operate in Workgroup node and reconnect the USB
hard drive to the USB hub.

C. Connect the printer to the USB port and connect the USB hard drive to the printer's
USB port.

D. Connect the scanner to the USB port and connect the USB hard drive to the scanner’s
USB port.

Answer: A

Explanation: The devices worked correctly. When they connected the external hard

drive, it does not want to work, but it worked when connected to the computers

USB. The hard drive needs more power, which the bus-powered cannot produce.

You have to replace the bus-powered hub with a self-powered hub.

Incorrect Answers:

B: Operating in Workgroup node will help with the lack of power.

C, D:When they connected the external hard drive, it does not want to work, but it worked
when connected to the computers USB. The hard drive needs more power, which the
bus-powered cannot produce. You have to replace the bus-powered hub with a
self-powered hub.

QUESTION 174:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Marketing department. A Certkiller .com user named Mia
Hammis a Representative for the company. Mia Hamm has a laptop named
Certkiller -WS006 which she used at office and at home. Certkiller -WS006
contains a built-in modem. When she is at home she uses a cable modem access the
Internet from home. Every time she tries to connect, a message appears that the
computer cannot establish a connection. At work Mia Hamm does not have that
problem.

What should you do?

A. In the Connections tab of the Internet properties, select Never dial a connection.
B. In the Connections tab of the Internet properties, select Always dial my default
connection.

C. In the Connections tab of the Internet properties, select Dial whenever a network
connection is not present.

D. Remove all entries in the Dial-up and Virtual Private Network settings list box.

Answer: A
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Explanation: According to the problem, the Connections tab of the Internet

properties is Dial whenever a network is not present. The user does not have a home
network.

Incorrect Answers:

B: With this connection she will not be able to dial out using Internet Explorer.

C:

The Dial whenever a network connection is not present, will not work because she does
not have a home network.

D: Doing this will cause the Internet to revert to the default settings, which is Never dial
a connection with no other settings available.

QUESTION 175:

You work as a helpdesk support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows Server 2003and all client computers

run Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Andy Reid has contacted you. Andy Reid reports
that he cannot open Microsoft Office Word 2003. Andy Reid said that he used
Microsoft Office Word 2003 the day before.

How can Andy Reid repair Word?

A. He should use the Performance and Maintenance.

B. He should use the Add or Remove Programs.

C. He should use the Help and Support.

D. He should use the Microsoft Office Application Recovery.

Answer: B

Explanation: There is a ways to repair Word. Rory Allen should use the Add or

Remove Programs, and click reinstall or repair. The next thing is to click Detect and
Repair Errors in My Office Installation.

Incorrect answers:

A: Andy Reid should not use the Performance and Maintenance. You can use the
Performance and Maintenance to view and change the System Properties.

C: Andy Reid should not use the Help and Support. You cannot use the Help and
Support to repair any functions.

D: Andy Reid should not use the Microsoft Office Application Recovery. The Microsoft
Office Application Recovery allows you to recover documents from Office applications.

QUESTION 176:
You work as a desktop technician at Certkiller .com. The Certkiller .com network

contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
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Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Marketing department. You were authorized by the CEO
to purchase Microsoft Office 2003. Three Certkiller .com employees named Mia
Hamm, Amy Walsh and Amy Wilson works in the Marketing department. All three
of the employees has installed Microsoft Office 2003 on there computer. They used
the same CD-ROM and product key. After three day the manager named Andy
Reid from the Marketing department has contacted you. He is worried because all
three of the employees are running Microsoft Office 2003 and are using it.

What should you tell Andy Reid?

A. Microsoft Office 2003 is not activated.

B. The three employees have tampered with the registry.
C. Microsoft Office 2003 will uninstall after 50 launches.
D. Microsoft Office 2003 does not enforce licensing.

Answer: A

Explanation: It can be that the application is not activated. The user can start the
application 50 times before he or she will be prompt for an activation key.

Incorrect answers:

B: It does not state that the activation code is stored on the computer.

C: Microsoft Office 2003 will not uninstall after 50 launches. The users will not be able
to save any documents.

D: On all versions of Office, there is a product license.

QUESTION 177:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Andy Booth has contacted you. He wants the latest
Microsoft Office XP update. Clive Wilson does not know where he could get the
updates.

What should Andy Booth do?

A. He should use the Office Tools on the Web option, which resides in the Help menu of
Microsoft Word.

B. He should use Microsoft Office Tools and then Activate Product.

C. He should use the Help and Support.

D. He should use the Windows Update

Answer: A
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Explanation: Andy Booth should use the Office Tools on the Web option. The Web
browser would navigate him or he can do it manually.

Incorrect answers:

B: Andy Booth should not use Microsoft Office Tools and then Activate Product. This is
used to activate Office.

C: Andy Booth should not use the Help and Support. This is used to troubleshoot
operating system issues.

D: Andy Booth should not use the Windows Update. This is used to update the operating
system and not to update Microsoft Office.

QUESTION 178:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Marketing department and a Sales department. The users
in the Marketing department belong to the Marketing group and the users in the
Sales department belong to the Sales group. A Certkiller .com user named Andy
Reidis a member of the Marketing department. Andy Reid shares a folder named
Market on his client computer named Certkiller -WS001. The Marketing
department users need to have read and write access to the files in the Market
folder. Andy Reid wants the manager who belongs to the Manager group to have
only read access to the files in the Market folder. In order to do this you need to
assign share and NTFS permissions.

Which permissions should you give? (Select two)

A. To the Domain Users group grant the Allow-Read permissions for the Market folder
share.

B. To the Domain Users group grant the Allow-Change permissions for the Market folder
share.

C. To the Marketing Users group grant the Allow-Change permissions for the Market
folder share.

D. To the Marketing Users group grant the Allow-Modify permissions for the Market
folder share and for the Managers group grant the Allow-Read & Execute permissions for
the Market folder share.

Answer: B, D

Explanation: The best in this case is to assign share and NTFS permissions. To

make the administration easy, it is best to grant Change share permissions to the
Domain Users group. This will stop them from controlling permissions. The NTFS
permissions are there to secure the files in the Market folder.

Incorrect Answers:

A: The Domain Users group should have the Allow-Change permissions. This will stop
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them from controlling permissions.
C: Granting the Marketing Users group should have Allow-Modify permissions.

QUESTION 179:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Research department. All of the research data is in a
shared folder named CK_Research which resides on a client computer named
CertK NG-WS002. The Everyone group in Certkiller .com has Full Control share
permissions on CK_Research. You have received instruction from the CIO to enable
auditing in the Local Computer Policy on CertK NG-WS002. The CIO wants to do
this to audit all attempts to delete files and successful attempts to store files in
CK_Research. You need to configure the Auditing Entry for CK_Research for the
Everyone group.

What settings should you configure? (Select three)

A. For the Delete Subfolders and files setting, you should select the Successful check
box.

B. For the Delete settings, you should select the Failed check box.

C. For the Delete Subfolders and files setting, you should select the Failed check box.
D. For the Delete settings, you should select the Successful check box.

E. For the Create Files/Write Data setting, you should select the Successful check box.

Answer: A, C, E

Explanation: To enable auditing, you should enable it in the Group Policy or Local
Computer Policy. The Successful check box and the Failed check box for the Delete
Subfolders and files setting is used to see the attempts for deleted files in the share.
The Create Files/Write Data setting will allow you to see the attempts to create files
in the share.

Incorrect Answers:

B: You can specify this to monitor the attempts to delete files. The scenario does not
need this.

D: You can specify this to monitor the attempts to delete files. The scenario does not
need this.

QUESTION 180:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers runs
Windows XP Professional.

Certkiller .com contains a Graphics department and a Development department. All
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the client computers are allocated to the users in the graphics department. The
users in the Graphics department belong to the CK_Graphics group. The users in
the Graphics department have administrative privileges. A Certkiller .com user
named Rory Allen is a release worker for the Graphics department. He was
assigned to the CK_Graphics groupand client computer named

Certkiller -WS004. You have received instruction from the CIO to create a folder
so that Rory Allen can place his graphical designs in. the CEO want all the
employees to view the new designs and he wants the members of the CK_Graphics
group to be able to modify what ever is needed. You then create a folder named
ReleaseTest in the root folder of Certkiller -WS004.

What is still needed? (Select two)

A. Drag the ReleaseTest folder to the Shared Documents folder.

B. Share the ReleaseTest folder with the default share permissions, on the Security tab
add the CK_Graphics group and grant it the Change share permissions.

C. Assign the Allow-Read and Allow-List Folder Contents NTFS permissions to the
Everyone group.

D. Drag the ReleaseTest folder and add the Allow Network users to change my files.

Answer: B, C

Explanation: The default share permissions are assign Allow-Read to the Everyone
group. This will allow every body to view the content only. You then should use the
NTFS permissions for the CK_Graphics group to control the file access.

Incorrect Answers:

A: You should not drag the folder to the Shared Documents. The permissions of the
folder would inherit the permissions of the Shared Documents folder.

D: These permissions will apply to all the users. Thee other users in the Certkiller .com
domain are only allowed to view the folder.

QUESTION 181:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. All client computers have Microsoft Office XP installed.
Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com user named Ally Wagner is sharing a client computer named
Certkiller -WS004, with a colleague named Mia Hamm. Ally Wagner has
confidential document in a folder named UserDocs on Certkiller -WS004. Ally
Wagner does not want Mia Hamm to access the UserDocs folder on

Certkiller -WS004.

What should you do?

A. Delete the UserDocs folder.
B. Format the hard disk with FAT32 file system.
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C. Explicitly deny the users account of Mia Hamm all permissions to the UserDocs
folder.
D. Move the UserDocs folder to another NTFS hard disk in Certkiller -WS004.

Answer: C

Explanation: If she does not want Mia Hamm to access the folder, she should

explicitly deny the users account of Mia Hamm on all the permissions of the

UserDocs folder.

Incorrect Answers:

A: If you delete the folder, you will loose every thing in that folder.

B: This will only allow you to grant or to deny access to the folder. However, this will
not prevent remote users to access the UserDocs folder.

C: Moving it to another NTFS hard disk will not prevent Mia Hamm from accessing the
folder.

QUESTION 182:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers runs
Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Andy Booth has contacted you. Andy Booth shares a
Windows XP Professional computer with a colleague named Dean Austin. Andy
Booth has a folder named MyDoc which is not accessible to Dean Austin. With the
extent of there work, Dean Austin needs to create and delete files in the MyDoc
folder. You would like Dean Austin to have the least amount of permissions to do
this task.

What permissions should Andy Booth assign Dean Austin on the MyDoc folder?

A. Modify

B. Write

C. Full Control
D. Read

Answer: A

Explanation: With the modify permissions he will be able to read, create delete and
list the contents of the folder. This will not give Dean Austin unnecessary
permissions.

Incorrect Answers:

B: The write permissions will only allow Dean Austin to create files write data append
data and write properties. However, this will not allow him with both the create and
delete writes.

C: Full permissions will give unnecessary permissions which are the ability to delete
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subfolders, take ownership and to change permissions.
D: This will only allow him to read the content.

QUESTION 183:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Finance department. A Certkiller .com employee was
relieved from work. To fill the gap the manager hired a named Mia Hamm. She is
using the same computer as the relieved worker. During the day Mia Hamm has
contacted you to say that he cannot access a Contracts folder on the client
computer. During the investigation you learn that the Finance group has access to
the folder. You are also sure of it that Mia Hamm is a member of this group.
What could cause the problem? (Select two)

A. Mia Hamm is not listed in the permissions list, because she is part of another group.
B. Mia Hamm is explicitly denied access to the folder.

C. Mia Hamm is not listed in the permissions list.

D. Mia Hamm is explicitly denied access to the folder and she belongs to another group.

Answer: B, D

Explanation: It can be that Mia Hamm belongs to another group and is explicitly
denied access to the folder. The Deny permissions overwrite the Allow permissions.
Incorrect Answers:

A: She is listed in the permissions list because she is a member of the Finance group.
C: She is listed in the permissions list because she is a member of the Finance group.

QUESTION 184:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Research department. A Certkiller .com manager named
Clive Wilson that is in the Research department wants to allow a workgroup user to
have access to a folder on a client computer named Certkiller -WS007. Clive
Wilson wants to give the user Read and Execute permissions on the fonder on his
client computer. He is also going to grant permissions on the folder with the 'This
folder only' in the 'Apply onto". Clive Wilson wants to know what the user will be
able to do with this permission.

A. Open and create files within the folder.
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B. Open files within the folder and execute applications.

C. Open files within the folder, view the content of the folder, and run applications stored
in the folder.

D. Open and delete files within the folder, view the content of the folder.

Answer: C

Explanation: The Read and Execute permissions combine the Read permissions and
the List Folder Contents permission. With the Read permissions the user will be

able to open the files.

Incorrect Answers:

A: The user will not be able to create files with in the folder.

B: The user will be able to open files within the folder, view the content of the folder,
and run applications stored in the folder.

D: The user will be able to open files within the folder, view the content of the folder,
and run applications stored in the folder.

QUESTION 185:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server. All client computers run
Windows XP Professional and Office XP.

A Certkiller .com user named Mia Hamm uses a client computer named

Certkiller -WS001. Mia Hamm works as a secretary at Certkiller .com. Mia Hamm
writes project management reports for CertK iong.com.

Mia Hamm was instructed to use the Reports template with Microsoft Word 2002.
She then realizes that the Reports template is not installed on Certkiller -WSQ0L1.
What should Mia Hamm do to have Reports template on Certkiller -WS001?

A. Deploy Microsoft Access

B. Reinstall Office XP, using the default settings.

C. Install the latest patch for Office XP

D. Use the Add/Remove Programs Wizard and the Office XP installation CD disk to
install the template.

Answer: D

Explanation: To install the template she should use the Add/Remove Programs
Wizard and the Office XP installation CD disk.

Incorrect Answers:

A: Installing Microsoft Access will not help. Microsoft Access is a database program.
B: To reinstall Office XP, using the default settings will not help. She should use the
Add/Remove Programs Wizard and the Office XP installation CD disk to install the
template.

C: If she installs the latest patch, it would not enable the Reports template. She should
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use the Add/Remove Programs Wizard and the Office XP installation CD disk to install
the template.

QUESTION 186:

DRAG DROP

You work as a helpdesk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server.

Certkiller .com contains a Research department, Sales department and a Quality
Assurance department. You have received instruction from the CI1O to prepare a
computer for a tester. The tester is responsible for testing the latest version of a
product that was developed in the Research department, which works on Windows
XP Professional and Windows XP Home. The computer will be accessible from the
network and will house encrypted files. These files must be accessible only to the
tester. You need to prepare the hard disk for the two operating systems.

From the list on the left, select the tasks.

Steps, Select from these Steps, place here

Install Windows XP Professional on an

NTFS partition. Place here.

Create two partitions. Place here, if any.

Format one partition with FAT32. Place here, if any.

Install Windows XP Home on an NTFS

partition. Place here, if any.

Format one partition with NTFS. Place here, if any.

Install Windows XP Home on a FAT32

partition Place here, if any.

Create one partition. Place here, if any.

Format both partitions with FAT32. Place here, if any.

Install Windows XP Professional on a

FATS2 partition. Lipcechere) i any:

Format both partitions with NTFS. Place here, if any.

Answer:
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Steps, Select from these Steps, place here

Create two partitions.

Format one partition with NTFS.

Install Windows XP Home on an NTFS

Format ore partition with FAT32. L
partition,

Install Windows XP Professional on an
NTFS partition.

Format one partition with NTFS. Place here, if any.

Install Windows XP Home on a FAT32 Place here, if any.

partition.
Create one partition. Place here, if any.
Format both partitions with FAT32. Place here, if any.

Install Windows XP Professional on a

FAT32 partition. [ace hers, irany

Place here, if any.

Explanation:

You should create two partitions. You then can run both operating systems, each on a
partition. You also need to format the partitions with NTFS.

Incorrect Options:

You should not partition a partition with FAT. FAT does not support encryption.
Windows XP Home supports NTFS but not Encrypted File System (EFS). EFS is
supported with Windows XP Professional.

QUESTION 187:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 98 client computers.

Certkiller .com contains a Marketing department. A Certkiller .com employee named
Mia Hamm works in the Marketing department. Certkiller .com contains a Windows
98 workstation named Certkiller -WS111. Mia Hamm is working on

Certkiller -WS111. Certkiller -WS111 contains a third party accounting application
named CK_Acc. During the previous month a beta version of the third party
accounting application which is compatible with its predecessor and it was available
to the public which runs on Windows XP Professional. These two versions run
different user interfaces (Uls). Mia Hamm needs the latter version for

Certkiller .com. Your administrator partition the hard drive into two drives named C
and D and install Windows XP Professional on one of the partitions. When Mia
Hamm starts Windows XP Professional and CK_Acc, she created a test account
application and exports it to the file. She then reboots in Windows 98 and starts
TerstAcc to import the files, but she was not successful. She cannot access the files.
What could be the problem?

A. The new data files were stored on an NTFS partition.
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B. The beta version of CK_Acc is not compatible with the former version.
C. Mia Hamm imported by using the beta version of CK_Acc.
D. Mia Hamm exported by using the former version of CK_Acc.

Answer: A

Explanation:

The administrator format the second partition with NTFS. Windows 98 does not
support NTFS, only FAT.

Incorrect answers:

B: The beta version is not incompatible. The scenario states that the two is compatible.
C: The importing is not the problem. The versions have Uls that differs them.

D: The exporting is not the problem. The versions have Uls that differs them.

QUESTION 188:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner's
computer is running Microsoft Windows 98 on dive C and Microsoft Windows XP
Professional on drive D: Ally Wagner moved the confidential encrypted files from
drive D to drive C. Ally Wagner's computer is part of a workgroup. She now has a
security problem. The other users in the workgroup can access and read the
encrypted files. Ally Wagner wants to know what is the problem.

What should you tell Ally Wagner?

A. Windows 98 can be installed on FAT16 and FAT32. FAT16 and FAT32 do not
support encryption.

B. When folders are moves to another, they forfeits there permissions.

C. You are not the owner of the file. Another user has changed the permissions.

D. When encrypted files are always decrypted when they are moving.

Answer: A

Explanation: It is true that FAT16 and FAT32 do not support encryption. Ally

Wagner did move the files from NTFS to a FAT partition.

Incorrect answers:

B: The statement in B: is misleading. It is only true if the destination folder resides on a
different partition from the source folder.

C: This is not true. If a user moves a folder, he will still be the owner of the folder.

D: Moving files will not decrypt it. It will only become decrypted if it is moved fro
NTFS to FAT.
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QUESTION 189:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Dean Austin has contacted you. Dean Austin has a
laptop that is running Windows 98. He wants to install another operating system,
Windows XP Home on the laptop. He wants to know if should be aware of anything.
What should you tell Dean Austin?

A. You cannot install service packs on Windows XP Home because it will affect
Windows98.

B. Make sure that all files that need to access from Windows 98 remains on the FAT
partition.

C. Windows 98 will become unstable due to registry merging.

D. Windows XP Home should be installed on a separate partition.

Answer: B, D

Explanation: Dean Austin should know that all files that need to access from
Windows 98 remains on the FAT partition. He should also know that Windows 98
cannot read files on NTFS.

Incorrect answers:

A: Windows XP Home is on a separate partition. It cannot affect Windows 98.

C: The two operating systems are on separate partitions, so it cannot become unstable.

QUESTION 190:

You work as a help desk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

A Certkiller .com user named Kara Lang needs to access resources on the Internet.
She also wants to store the user name and password information needed to access
two Internet resources, which she frequently accesses, so that she can access them
automatically in the future. You create a dial-up connection to your Internet Service
Provider (ISP) to enable Ally Wagner to access her required resources on the
Internet.

The following morning, Kara Lang complains that the user name and password
information of the two Internet resources are not stored. She has to manually
provide the user name and password information whenever she wants to access
either of the resources. Kara Lang's user account has no administrative privileges
assigned to it.

What should you instruct Kara Lang to do?
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A. Access the Properties sheet of Internet Explorer to define the user names and
passwords of the resources.

B. Access the Properties sheet of the dial-up connection to define the user names and
passwords of the resources.

C. Access the User Accounts applet in Control Panel to define the user names and
passwords of the resources.

D. Access the Phone and Modem Options applet in Control Panel to define the user
names and passwords of the resources.

Answer: C

Explanation: Kara Lang should use the User Accounts applet in Control Panel to

define the user names and passwords of the resources. This is where you access the
Stored User Names and Passwords feature of Windows XP Professional. If Ally Wagner
wants to automatically access an Internet based resource, she should define the user name
and password required to access the resource using the

Friendly Management User Interface. This is the interface that allows users who have
accounts with no administrative privileges assigned to it, to manage some features for
themselves.

Incorrect Answers

A: The Properties sheet of Internet Explorer is used to configure the digital identifiers
that are used with email addresses.

B: The Properties sheet of the dial-up connection is used to configure properties for

the actual dial-up connection, such as Internet Connection Sharing (ICS) settings.

D: The Phone and Modem Options applet in Control Panel is used to configure
properties for the modems that are installed on your computer.

QUESTION 191:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

Users that work in the Marketing department access confidential files that reside in
a shared folder on a client computer named Certkiller -WS008. No other users

must be able to access these files and data. You configure the necessary permissions
to ensure that only Finance department users have access to the files.

You have been instructed to perform monitoring, to ensure that no other users can
read the data in these files. You decide to use a user account that does not have the
Read permissions assigned for these files.

What should you do to ensure that this user account cannot access the financial
files?

A. Enable auditing for failed events in Privilege Use.
B. Enable auditing for failed events in Directory Service.

Actualtests.com - The Power of Knowing




070-272

C. Enable auditing for failed events in Object Access.
D. Assign the Generate security audits user right to the user account.

Answer: C

Explanation: The Object Access

audit policy will let you know when an individual failed to access the Finance
department's files.

Incorrect Answers

A: The Privilege Use audit policy tracks when a user affects a user right. You do not
want to track events for all rights.

B: The Directory Service audit policy tracks when users access Active Directory objects
which have system access control lists (SACLS).

D: You do not want to enable the Finance users to make entries in the security log for
object access auditing. You want to verify that no other users can access their files.
Brian Barber, Chad Todd, Norris L. Johnson, Jr., & Robert J. Shimonski, Configuring
and Troubleshooting Windows XP Professional, Syngress Publishing, Rockland MA,
2001, p. 561

Lisa Donald & James Chellis, MCSA/MCSE: Windows XP Professional Study Guide,
Third Edition, Sybex, Alameda, 2005, p. 251

QUESTION 192:

HOTSPOT

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. The Certkiller .com network contains a 300 Windows XP
Professional computers. All computers and users are members of the Certkiller .com
domain.

While adding new user accounts to the Certkiller .com domain, you find some user
accounts that have been assigned more permissions than what you recall assigning
to them. You remove the excessive permissions from the user accounts which you
are able to identify as being problematic.

You suspect that a security violation has occurred and decide to view the results of
your current auditing effort. You want to view the information contained within the
Security log. You open Computer Management.

Using the Exhibit; click the option, entry, or menu item that you should use to
access the information in the Security log.

Exhibit:
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LI Computer Management E”ﬁlg|
Q File Actlon \.I'IEIN Window  Help _—JQJJ
= = I' [y 2
ﬂg Computer Management (Local) Mame I
= ﬁ System Tools mSystem Tadls
@ Event Viegwer @Storage
LB Shared Folders e senices and Soplcations
- Local Users and Groups

[+ @] Performance Logs and Alerts
“- B Device Manager

= & Skorage

+ Removable Storage
- [B§ Disk Defragmenter

: Disk Management
+ -@ Services and Applications

Answer:
=) Computer Management E"ﬁ| El
g File  Action  MWiew  Window  Help _—,JQJJ
& - f&m| £
I@ Computer Management {Local) Hame I Type J Diescription ] Size II

= § -' i S stem Tools Application Lag Application Error Recards 512.0KE
: E rent Yiewer @ Internet Explorer Log Custom Lag Error Records
- [ Shared Folders Security Log  Securityfudit Records 64.0KB

: r
o ‘! Local Users and Groups Svetem Log Svetem Ewor Records S1Z.0KE
[+ -4 Performance Logs and Aletts

- B Device Manager
= @ Skorage

I3 Reemovable Storage

[ Disk Defragmenter
P Liisk Management
+ & Services and Applications

Explanation:

You need to view the audit trail on changes that were made to the user accounts. When
an event or action takes place that's configured for auditing, the action or event is written
to the security log. Security auditing events are written to the security log of the system,
and can be accessed and viewed from Event Viewer.

QUESTION 193:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

Rory Allen is a manager in the Human Resources department. Rory Allen uses a
client computer named Certkiller -WS009. Rory Allen frequently accesses files

that contain confidential information about Certkiller .com's employees. The files
reside in several shared folders on Certkiller -WS009. Both Rory Allen and
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employees working in the Human Resources department modify these files.

Rory Allen complain that this morning, when he attempted to access a file in one of
the shared folders on Certkiller -WS009, the shared folders and files were deleted.
You decide to use last nights backup to restore the files. You successfully restore the
latest available backup of these files. You must immediately determine who the
culprit is that deleted the files.

You suspect that someone deleted Rory Allen's files from across the network. You
log on to Certkiller -WS009. You want to configure local security policy, so that
you can determine who connected to Rory Allen's computer and deleted the files.
What should you do? Choose the two actions which you should perform. Each
correct answer presents only part of the complete solution. Choose two answers that

apply.

A. On Certkiller -WS009, enable the Privilege Use - Success audit policy.

B. On Certkiller -WS009, enable the Logon Events - Success audit policy.

C. On Certkiller -WS009, enable the Account Logon Events - Success audit policy.
D. On Certkiller -WS009, enable the Object Access - Success audit policy.

Answer: A, D

Explanation: The Privilege Use - Success audit policy will allow you to see who
deleted the files from Certkiller -WS009, and also when these files were deleted. The
Object Access - Success audit policy will let you know when an individual successfully
accessed Rory Allen's files.

Incorrect Answers

C, B: The Logon Events - Success and Account Logon Events - Success audit

policies would not work because the question states that Rory Allen's files were deleted
from over the network. These policies would inform you on who logged on to the local
computer, and whether a user account was compromised.

Lisa Donald & James Chellis, MCSA/MCSE: Windows XP Professional Study Guide,
Third Edition, Sybex, Alameda, 2005, p. 249-250

Brian Barber, Chad Todd, Norris L. Johnson, Jr., & Robert J. Shimonski, Configuring
and Troubleshooting Windows XP Professional, Syngress Publishing, Rockland MA,
2001, p. 552

QUESTION 194:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

A client computer named Certkiller -WS010 hosts a shared folder named
AccountsData. Only permanent employees working in the Finance department
should be allowed to access AccountsData and its contents. The Auditors group has
the Allow - Read & Execute NTFS permission, and the Finance group has the Allow
- Modify NTFS permission assigned.
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The Finance department employs a new contractor employee named Ally Wagner.
You must prevent Ally Wagner from accessing and viewing the files contained
within the AccountsData folder. You want to still allow Ally Wagner to access other
resources that do not reside in the AccountsData folder. Your solution must not
affect all current permissions assigned to security groups.

What should you do, while ensuring that all permanent employees working in the
Finance department can still open files in the AccountsData folder?

A. Assign the Deny - Read permission to the Auditors group.

B. Assign the Deny - Read permission to the Finance group.

C. Remove Ally Wagner's user account from the Finance group.

D. Assign the Deny - Read permission to Ally Wagner's user account.

Answer: D

Explanation: Ally Wagner's effective permissions for the AccountsDatafolder is
determined by which security groups she is a member of and the permissions

assigned for those groups to the folder, and the permissions defined for her specific
user account for the folder. Because Ally Wagner is a member of multiple security
groups, her effective permissions becomes important. When you assign an explicit
Deny permission, that permission overrides all associated Allow permissions. In this
case, you should assign the Deny - Read permission to Ally Wagner's user account

for the folder. This

Deny - Read permission overrides any implicitly assigned permissions that Ally
Wagner has to the folder by being a member of the Finance or Auditors security
groups.

Incorrect Answers:

A: If you assign the Deny - Read permission to the Auditors group, no users

belonging to the group will be able to view the files contained in the shared folder. You
must not affect other permissions when you deny Ally Wagner access to the files in the
folder.

B: If you assign the Deny - Read permission to the Finance group, no users belonging
to the group will be able to view the files contained in the shared folder. You must not
affect other permissions when you deny Ally Wagner access to the files in this specific
folder.

C: If you remove Ally Wagner's user account from the Finance group then Ally
Wagner will no longer have the permissions to resources that are assigned by being a
member of the group.

QUESTION 195:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
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Certkiller .com customer named Amy Wilson has contacted you. She did create a
shared folder on her computer and her colleague needs to access the content of the
files in the folder. Amy Wilson's colleague can open the files from her computer but
cannot delete the files. The problem is that if her colleague logs onto her computer,
she can delete those files.

Amy Wilson wants to know why her colleague can do this.

A. The colleague has Read share permissions

B. The colleague has Change share permissions

C. The colleague has Full Control share permissions
D. The colleague has no share permissions

Answer: A

Explanation: The colleague has Read share permissions because she can open the

files on Amy Wilson's computer.

Incorrect Answers:

B: The Change share permissions will allow the user to all the permissions in the Read
permissions. This will also allow the user to create, modify, and delete files and sub
folders that is in the shared folder.

C: The Full Control share permissions will allow the user to create, modify, and delete
files and sub folders that is in the shared folder. The user also than can change the NTFS
permissions.

D: This is not true, because the user can access the files on her computer.

QUESTION 196:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Mia Hamm has contacted you. All the client
computers in their company run Windows 2000 Professional. Mia Hamm then
upgrades her computer from Windows 2000 Professional to Windows XP
Professional. The research files of the company reside on her computer and she then
creates a share on the folder after the computer upgrade. The users need to change
or delete some of the facts on the files of the further research they did to the given
topic. The problem she has now is that no one can modify the files in the folder from
their computers.

Mia Hamm wants to know what could be the problem.

A. Windows XP Professional does not support deleting files across the network

B. The NTFS permissions were reset after the upgrade.

C. The default Share permissions which was granted to the Everyone group is Read in
Windows XP Professional.
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D. Simple file sharing service is disabled.
Answer: C

Explanation: In Windows 2000 Professional, the default Share permission granted

to the Everyone group is Full Control and in Windows XP Professional the default
Share permission granted to the Everyone group is Read.

Incorrect Answers:

A: This statement is correct, unless you are granted the appropriate Share and NTFS
permissions.

B: NTFS on folders are not reset that is configured for security. Further more the share
was created after the upgrade.

D: The Simple files sharing must be disabled. if not, then anyone can access these
folders.

QUESTION 197:

DRAG DROP

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Andy Reid has contacted you. Andy Reid is working
as a manager for their company. The employees that was hired, is deleting sensitive
files from a shared folder, from the lab computer. Andy Reid does not want the
deletion of the files in the shared folders. He now only wants the hired employees to
delete the files when they are working at the lab computer, which is now monitored
with cameras. He wants to catch the perpetrators.

From the list on the left, which permissions should be granted to the hired
employees?
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Permissions, place here

Modify Share: Place here, if any.
Change Place here, il any.
Full Control Place here, if any.
Read and Execute Place here, il any.
Read NTFS: Place here, if any.
Place here, if any.
Place here, if any.
Place here, if any.
Answer:
Permissions, select from these Permissions, place here
Modify Share: Read
Change Place here, if any.
Full Control Place here, if any.
Read and Execute Place here, if any.
Read NTFS: Modify
Place here, if any.
Place here, if any.
Place here, if any.

Explanation:

The Read permissions will only allow the hired employees to open the shared files from
their computers. The Modify NTFS permissions will allow the hired employees to delete
shared files on the lab computers.

Incorrect Options:

The Chang permissions will all the hired employees to add files and subfolders change
the data in the files over the network.

The Full Control share permissions will allow the hired employees to create, modify, and
delete files and sub folders that are in the shared folder. The hired employees also than
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can change the NTFS permissions.
The Read and Execute permissions will allow the hired employees to traverse and read
the content of the folder, the properties and the permissions of the content.

QUESTION 198:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. All client computers have Microsoft Office XP installed.
Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com user named Amy Walsh has contacted you. Amy Walsh has a printer
connected to the computer which is running Windows XP Professional. The printer
is connected through a universal serial bus port. Amy Walsh wants to share the
printer with the other users in her department. Amy Walsh does not want to grant
more rights than necessary. You need to setup the printer to share it to the other
users.

What should you do?

A. Add the user's account to the Domain Admins group.

B. Add the user's account to the Local Administrators group.
C. To the Everyone group, grant the Manage Printers right.
D. Add the user's account to the local Power Users group.

Answer: D

Explanation: The Power Users group will give the users the Manage Printers right.

This will not give the users unnecessary rights.

Incorrect Answers:

A, B: The Domain Admins group and the Local Administrators group will give the users
more rights than what is needed.

C: You shoulod not give the Manage Printers right. This will allow the users to pause
and restart the printer, change spooler settings, change permissions and printer properties.

QUESTION 199:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. She is the
administrator of there company. Ally Wagner has downloaded an Excel spreadsheet
from the Internet to perform a lot of calculations. When Ally Wagner opens the
Excel spreadsheet, it automatically runs Macro virus. Ally Wagner wants to ensure
that only signed macros from trusted sources are allowed to run in Excel
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spreadsheet. Ally Wagner does not want the other users to modify or change the list
of trusted sources.
What should you advice Ally Wagner to do on the Security dialog box in Excel?

A. Select a security level of High.

B. Select a security level of Medium.

C. Select a security level of High and establish a computer policy that blocks changes to
the Trusted Sources list.

D. Select a security level of Medium and establish a computer policy that blocks changes
to the Trusted Sources list.

Answer: C

Explanation: If you set the security level of High, it will disable all macros except

the ones that are from a trusted source. By blocking the changes will prevent the

user from adding or deleting the list of resources that is in the trusted sources list.
Incorrect Answers:

A: If you set the security level of High, it will disable all macros except the ones that are
from a trusted source. However, this is not enough because the user can still add or
change the list of resources that is in the trusted sources list.

B: A security level of Medium will still allow the user to open even when the Trusted
Sources list is blocked.

D: A security level of Medium will still allow the user to open even when the Trusted
Sources list is blocked. By blocking the changes, it will prevent the user from adding or
deleting the list of resources that is in the trusted sources list.

QUESTION 200:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server. All client computers run
Windows XP Professional and Office XP.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com user named Andy Reid works in the Sales department. He is still new
in the department and is not familiar with Microsoft Excel. Andy Reid has

contacted you to use Microsoft Excel with help readily available. You then tell for
Andy Reid to open Microsoft Excel.

What should you tell him to do next?

A. Click Help and then click Detect and Repair.

B. Click Help and then click Show Office Assistant.

C. Click Help and then click Microsoft Office Online.

D. Click Tools and then click Customize and enable the Office Assistant.

Answer: B
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Explanation: Andy Reid has to click Help and then click Show Office Assistant.

Click Help and then click Show Office Assistant will allow for help to be available
when he is using Excel.

Incorrect Answers:

A: When he clicks the Detect and Repair, it will repair any errors that are happening in
the Office programs.

C: When he clicks the Microsoft Office Online, it will launch the Microsoft Office Web
page. This action will not enable the Office assistant.

D: By clicking the Tools, will not make help available. He should click Help.

QUESTION 201:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Mia Hamm has contacted you. Mia Hamm is
working for a printing company. She is busy doing research for her book. Mia
Hamm uses a laptop and connects by modem to his personal Internet Service
Provider (ISP). She uses the company's network to access the Internet. When Mia
Hamm is at her home with the laptop, the laptop still wants to the Internet and
attempts to dial the ISP instead of using the network connection.

What should Mia Hamm do?

A. Select the Dial whenever a network connection is not present option.

B. Run from the command prompt the ipconfig /renew.

C. Select the Never dial a connection option in the Internet Connections dialog box.
D. Use the Alternate Configuration tab in the Internet Protocol (TCP/IP) Properties
dialog box.

Answer: A

Explanation: Mia Hamm should use the Select the Dial whenever a network

connection is not present. When she is then at work, it would use there Internet
connection and when she is at home it would use her own Internet connection.

Incorrect answers:

B: This command will let Mia Hamm renew the computer lease on the IP address.

C: This option will allow Mia Hamm to only use the network at her office and not the
one at home.

D: The Alternate Configuration tab is used for correct TCP/IP configuration on different
networks that does not use Dynamic Host Configuration Protocol to assign TCP/IP
configuration parameters.

QUESTION 202:
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You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. Kara Lang is visiting
a Web site regularly, but she is always presented with a page that indicates that she
should enable cookies before she can brows the site as seen on the exhibit.

What tab should Kara Lang click to visit those sites?

Internet Options

Home page

77

Higtory

General Seu:urit_l,l_!__F'rivac__l,l Eu:-ntent_‘__ Eu:unneu:tiu:un:s _F'ru:ugramg _#.dvanu:ed._:

E! Y'ou can change which page to uze for your home page

Address; fisapi/redi.dl?

rd=iefpver=agar=msnhome

I Ise Current ] | Usze Defaul I [ Use Blank,

Temporary Internet files

1 Fages you view on the Internet are stored in a special folder
& Y for quick viewing later.

[Delete Eu:u:ukies...] | Delete Files... I [ Settings... J

The Hiztory folder contains links to pages vou've wisited, for
quick access to recently viewed pages.

Dravs to keep pages in histony:

e

[ Colorz. ..

J |

Fonts...

] [ Languages... ] [.-’-‘-.u:u:essil:uility...]

Ok,

][ Cancel I Aol

Answer:
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Internet Options @@

General | Security| Privacy ||| Content | Connections | Programs | Advanced

Home page
E! Y'ou can change which page to uze for your home page
Addrezs: l'i::a ifredir, dll? prd=ietprver=5&ar=msnhome

I |Jze Current ] | |ze Drefault | [ Uze Blank,

Temporary Internet files

e

I Fages you view on the Internet are stored in a special falder
V@ % for quick viewing later,

[Delete Eu:u:ukies...] | Delete Files... I [ Settings... J

Higtory

The Hiztory tolder containg links to pages you've visited, for
quick acces: to recently viewed pages.

[rays to keep pages in histor; 2EI : | Clear Hiztary

[ Colorz. .. l | Fonts... I [ Languages... ] [.-’-‘-.u:u:essil::ility...]

[ ok, ][ Cancel I

Explanation:
The Private tab will allow her to set the default handling of cookies.

QUESTION 203:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner is the
administrator of her computer which is running Windows XP Home. Ally Wagner
has a third party graphics application, which she wants to share with a co-worker.
Ally Wagner and the co-worker have different user accounts to log on to the
computer. The third party graphics application resides in a folder on drive C and
copies the application's executables from a CD-ROM disk. The problem is that the
shortcut of the third party graphics application is not available to her brother. The
theme of both desktops is different. Ally Wagner needs her co-worker to also use
third party graphics application.

What should you do?

A. Change the co-worker's user account type to Computer Administrator.
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B. Copy the third party graphics application's shortcut to the Desktop folder in the All
Users profile.

C. The third party graphics application should be reinstalled for all users.

D. Configure the co-workers Theme the same as yours.

Answer: B

Explanation: When copying the third party graphics application’s shortcut to the
Desktop folder in the All Users profile will allow the shortcut to be available for the
co-worker.

Incorrect answers:

A: By changing the account type of the co-worker to Computer Administrator, will not
make the third party graphics application available on the desktop.

C: Ally Wagner does not need to reinstall the third party graphics application. She
already copy the executable files.

D: Even if you change the Desktop Theme, it will not make the shortcut available.

QUESTION 204:

You work as a desktop technician at Certkiller .com.

The Certkiller .com network contains a single Active Directory domain named
Certkiller .com. All servers on the Certkiller .com network run Windows Server 2003
and all client computers run Windows XP Professional.

Certkiller .com contains a Manufacturing department that has a client computer
named Certkiller -WS004. Certkiller -WS004 hosts a new shared folder named
CKTargets. The default share and NTFS permissions are in effect for CKTargets.
Certkiller .com appoints a user named Rory Allen as the manager of the
Manufacturing department. Rory Allen uses a workstation named

Certkiller -WS005. Rory Allen's user account is included in all default group
memberships.

You want Rory Allen to manage the CKTargets shared folder Certkiller -WS004.
You assign the Allow - Full Control NTFS permission for CKTargets to Rory
Allen's user account. You instruct Rory Allen to start handling requests for changes
that need to be made to CKTargets and its associated subfolders and files.

Two days later, Rory Allen complains that he cannot create new subfolders within
the folder. He also cannot add files to the folder. Rory Allen is attempting to make
these changes while logged on to Certkiller -WS005. You want to assign Rory
Allen with the least amount of permissions needed to effectively manage the
CKTargets folder.

What should you do?

A. Include Rory Allen's user account in the Server Operators group on

Certkiller -WS004.

B. Include Rory Allen's user account in the Accounts Operators group.

C. Include Rory Allen's user account in the domain local Server Operators group.

D. Grant Rory Allen's user account the Allow - Full Control share permission for the
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folder.
Answer: D

Explanation: The question states that Rory Allen is attempting to make these

changes while logged on to Certkiller -WS005. This indicates that he cannot make
changes to CKTargets from across the network, which in turn points to Rory Allen
having insufficient share permissions. To allow Rory Allen to make changes from

his workstation, you have to grant Rory Allen's user account the Allow - Full

Control share permission for the CKTargets folder. The

Allow - Full Control NTFS permission you have assigned to Rory Allen only allows
him full control permission for the folder when performing permission changes

locally at Certkiller -WSQ004.

Incorrect Answers:

A: The Server Operators group is not defined on member servers, such as

Certkiller -WS004. It is defined on domain controllers.

B: Members of the Account Operators group have the Allow logon locally and Shut
down the system user rights. Assigning this permission to Rory Allen will result in him
having the ability to create, modify and delete accounts for users, groups and computers
residing in organizational units (OUs), the Users container and the Computers container
in the domain. This is not required for Rory Allen.

C: Adding Rory Allen to this group will grant him the Allow logon locally, Back up
files and directories, Change the system time, Force shutdown from a remote system

, Restore files and directories, and Shut down the system default user rights in the
domain.

QUESTION 205:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. All client computers have Microsoft Office XP installed.
Certkiller .com contains a Desktop Support team which you are part of. A client
computer named Certkiller -WS010 is shared between the desktop technicians.

You have a sheared folder named CK_General. You want the employees to be able
to read, modify and delete files on the share folder. You need to assign the
appropriate permissions with the least amount of administration effort.

What permissions should be granted?

A. Specify the user account as the owner of the CK_General folder.

B. On the CK_General folder, grant the Users group the Full Control permissions.

C. On the CK_General folder, grant the Users group the Read & Execute permissions.
D. Format Certkiller -WS010 with the FAT32 file system.

Answer: B
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Explanation: The Full Control share permissions will allow the users to create,
modify, and delete files and sub folders that are in the shared folder. The users also
than can change the NTFS permissions.

Incorrect Answers:

A: You have created the shared file, so you are the owner.

C: The Read and Execute permissions in the NTFS file system will allow them to read
modify and delete files.

D: Changing to FAT32 will reduce the security risk.

QUESTION 206:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains 10 Windows 2000 Server computers, 5 Windows Server 2003
member servers, 500 Windows XP Professional client computers and 1,000
Windows 2000 Professional client computers.

Certkiller .com contains a Windows Server 2003 named Certkiller -SR10 which
hosts a shared folder named Certkiller Share. Certkiller Share has two subfolders
named TestSharel and TestShare2. The Certkiller Share folder is specified with the
Full Control share permissions for the Everyone group. TestShare2 is specified with
the Modify NTFS permission for the Everyone group. TestSharel is specified with
the Read & Execute NTFS permission for the Everyone group. TestSharel contains
a file named MyDocl and TestShare2 contains a file named MyDoc2.

A Certkiller .com user named Andy Booth is working on a client computer named
Certkiller -WS020. On Certkiller -WS020 you have mapped a network drive

named Z: to \\ Certkiller -SR10\ Certkiller Share folder. Andy Booth needs to
change the content of MyDoc1 with the least amount of permissions necessary.
MyDocl needs to gain access to MyDoc1 via the network drive.

What configurations should you do?

A. On Certkiller -SR10, move MyDocl to TestShare2.

B. Create a network drive on Certkiller -WS020 named X: and link it to

\\ Certkiller -SR10\ Certkiller Share folder.

C. Create a network drive on Certkiller -WS020 named X: and link it to

\\ Certkiller -SR10\ Certkiller Share\MyDoc?2 folder.

D. Create a network drive on Certkiller -WS020 named X: and link it to

\\ Certkiller -SR10\ Certkiller Share folder and copy MyDoc1 to TestShare2 on
Certkiller -SR10.

Answer: D
Explanation: The Certkiller Share folder is specified with the Full Control share
permissions for the Everyone group. You need to create a network drive on

Certkiller -WS020 named X: and link it to \\ Certkiller -SR10\ Certkiller Share
folder and copy MyDocl to TestShare2 on Certkiller -SR10. TestShare2 is
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specified with the Modify NTFS permission for the Everyone group. The user will
then be able to change the content.

Incorrect Answers:

A: Moving MyDoc1 to TestShare2 will not allow the user to gain access to MyDocl.
B: This is partly right; however you still need to copy MyDoc1 to TestShare2 on
Certkiller -SR10.

C: If you create a network drive on Certkiller -WS020 named X: and link it to

\\ Certkiller -SR10\ Certkiller Share\MyDoc2 folder, it would still need the user to use
drive Z: and he will only have the Read & Execute permissions.

QUESTION 207:

You work as a helpdesk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Development department and a Sales department. The
Development department manufactures scanners. A Certkiller .com employee named
Dean Austin works in the Development department. One morning Dean Austin was
testing a new driver for the scanner. Dean Austin is a member of the local Users
group on her computer named Certkiller -WS030. Dean Austin complains that he
receives an error message, when trying to install the scanner drivers. He said that
the error message is stating about that Windows XP Professional cannot install the
unsigned driver. Dean Austin has the approval to install drivers.

What should you do?

A. On the Power Users group on Certkiller -WS030, make Dean Austin a member.

B.On the local Administration group on Certkiller -WS030, make Dean Austin a member.
C. Install the print drive by using your local Administration account.

D. Give your name and password to Dean Austin so that use your account to install the
scanner driver.

Answer: B

Explanation: The drive sign option on the computer is set to Block - Never install
unsigned driver software. You have to make Dean Austin a member of the local
Administration group. The users group does not enough permission to do this task.
Incorrect Answers:

A: The Power Users group cannot change the diver signing settings.

C: You cannot give a user you administrative account information.

D: Usernames and password should be kept secret.

QUESTION 208:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
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Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Kara Lang has contacted you. Kara Lang belongs to
a workgroup in there department and works on a Windows XP Professional client
computer. She is sharing a folder named C:\Kara Lang\Docs to the users in there
department. She permits the users to read and to change the document over there
network. Later the users complain that they can read the folder but cannot change
the file. You then make sure that the NTFS permissions are correct. Kara Lang then
sends you the following exhibit.

Docs Properties
| General | Sharing | Sél:l.u_i-l;,I | Web Sharirg :__Ijustlﬁmize |
‘f'ou zan share this folder with ofer uzerz on your

network. Tao enable sharing far this folder, click Share this
folder.

{7 Do not ghare this folder
{%) Share thiz folder

Share name: Docs

Comment;

Llzer limt: (%) Mamrnumn allowed

{0 Allow thiz number of users: | ~ |
i

Tozet permizzions far users who acces: thiz
folder over the netwaork, click Permizssions.

To configure settings for offling access, click
Caching.

Permizzions

Windows Firewall iz configured to allows this folder to be shared
with other computerz on the network,

Wiew your Windows Firewall settings

[ k. ] I Cancel ] [ Apply

What should Kara Lang do?

A. Drag the folder to the Share Document folder.

B. Assign share permissions and turn off Simple File Sharing.
C. Pick the Allow network users to change my file option.

D. Log on as the Administrator and share the folder.

Answer: B
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Explanation: If Simple File Sharing is activated, she cannot share permissions. She
needs to turn off Simple File Sharing.

Incorrect Answers:

A: This will only allow the other users that use the computer to access the folder and not
the network users.

C: This option will allow all the users on the network to read and to modify the files.

D: Logging on as the Administrator will not help. She needs to turn off Simple File
Sharing.

QUESTION 209:

You work as a helpdesk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server.

Certkiller .com contains a Research department and a Sales department. The
Research department does research on and software and develops the software,
where the Sales department sells the applications, software and computers.
Certkiller .com also has a help desk team which helps the customers which has
problems with there software or computers that was bought at Certkiller .com.

The Research department has developed an in-house application that will allow the
employees to track their time worked on projects. The in-house application will
prompt the users for their domain user account and will run under the context of
that user. The manager named Andy Reid wants to know under which account the
in-house application should initially run to work as expected.

What is you reply?

A. Network Service
B. Local Service

C. Administration
D. Local System

Answer: D

Explanation:

The Local System is granted the Act as part of the operating system user right.
Simple File Sharing is activated, she cannot share permissions. She needs to turn off
Simple File Sharing.

Incorrect Answers:

A: The Network Service does not have the necessary rights.

B: The Network Service does not have the necessary rights.

C: The Network Service does not have the necessary rights.

QUESTION 210:

You work as a helpdesk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the

Actualtests.com - The Power of Knowing




070-272

Certkiller .com network run Windows Server 2003. All client computers run either
Windows XP Professional or Windows 98.

Certkiller .com contains a Research department and a Sales department. The
Research department does research on and develops software. All their work and
research is stored in a folder named CK_Research that resides on a client computer
named Certkiller -WS050. A Certkiller .com manager is suspecting that an
unauthorized user is trying to access the files on the CK_Research folder. The
manager would like to see all the unsuccessful attempts to gain access to the
CK_Research folder.

What should you configure?

A. Auditing

B. Encryption

C. Compression

D. Defragmentation

Answer: A

Explanation: All attempts would be recorded in a log file, if auditing is enabled.
Incorrect Answers:

B: Encryption is used so that unauthorized users not read the data.

C: Compression removes redundant bit from a file and it does not require must space on
a hard disk.

D: To Defragment, is to organize the files into contiguous clusters.

QUESTION 211:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

Certkiller .com has its headquarters in Chicago and a branch office in Dallas.
Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Sales department and a Development department, which
resides in both places. A Certkiller .com user named Andy Reidis a representative for
the Sales department. Andy Reid has a Windows XP Professional computer at home
which is connected to the Internet via cable modem. The Windows XP Professional
computer at home has ISP which allows him to access e-mail that comes to his home
computer. When Andy Reid is busy traveling, he establishes a remote desktop
connection from his laptop to his home computer. Andy Reid is leaving is computer
on 24/7 and is concern about the security. Andy Reid wants to prevent unauthorized
access over the Internet.

What should you do?

A. On the home computer, enable Allow this computer to be control remotely.
B. On the home computer, disable Allow this computer to be control remotely.
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C. On the home computer, enable Internet Connection Firewall (ICF) and open TCP port
3389.

D. On the home computer, enable Allow Remote Assistance invitations to be sent from
this computer.

Answer: C

Explanation: ICF offers packet filtering. This will protect the computer from
unauthorized entry. The TCP port 3389 is associated with remote desktop

connections.

Incorrect Answers:

A: The enable Allow this computer to be control remotely is enabled by default. This
option will allow the connected user to control the computer with your permission. In this
case it will be Andy Reid.

B: If this option is disabled, Andy Reid cannot access the home computer remotely. He
will then not have access to his e-mail messages.

D: Andy Reid needs to access the home computer at any time, not by invitation.

QUESTION 212:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Server 2003 and all client computers run
Windows XP Professional. All client computers have Microsoft Office XP installed.
Certkiller .com contains a Desktop Support team which you are part of. The
administrator of Certkiller .com named Rory Allen has configured a few Group
Policy objects on the domain controller named Certkiller -DC01. The GPO

contains policies which the other computers on the network must adhere to. During
a check up you discover that the GPO on your computer named

Certkiller -WS003 is not enforced. The policy must take effect as soon as possible.
What should you do?

A. On Certkiller -WS003, run Gpupdate /force

B. On Certkiller -DCO1, run Gpupdate /force

C. On Certkiller -WS003, run Secedit /refreshpolicy machine_policy.
D. On Certkiller -DCO01, run Secedit /refreshpolicy machine_policy.

Answer: A

Explanation: If you want the policy to take immediate effect, you should run the
Gpupdate /force. Other wise you should wait, because the group policies are refresh
every 90 minutes.

Incorrect Answers:

B: You should not run the Gpupdate /force on the domain controller. The other computer
needs to be refreshed.
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C, D: The Gpupdate /force did replace the Secedit /refreshpolicy machine_policy. This
was used in Windows 2000 Server.

QUESTION 213:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Server 2003 and all client computers run
Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Research department which does important work with
regards to in-house applications. Auditing is enabled as a domain-wide group policy
for the computers in the Certkiller .com computers. The Research department has a
client computer named Certkiller -WS090, which hosts critical information of the
research of the in-house applications. This critical information is kept in a network
share named CK_Daocs. You suspect that one of the users on the network is trying to
delete CK_Daocs.

What should you do?

A. For the Everyone group on the Auditing Entry for CK_Docs sheet, select the failed
check box for the Delete setting.

B. For the Everyone group on the Auditing Entry for CK_Docs sheet, select the
Successful check box for the Delete setting.

C. For the Everyone group on the Auditing Entry for CK_Docs sheet, select the failed
check box for the Create Files/Write Data setting.

D. For the Everyone group on the Auditing Entry for CK_Docs sheet, select the
Successful check box for the Create Files/Write Data setting.

Answer: A

Explanation: To monitor the unsuccessful attempt, you should select the failed

check box for the Delete setting.

Incorrect Answers:

B: If you select the Successful check box for the Delete setting, you will monitor the
successful attempt to delete CK_Docs.

C: The Successful check box for the Create Files/Write Data setting, will allow you to
see the successful attempt to delete and the creation of files in the CK_Docs.

D: The failed check box for the Create Files/Write Data setting, will allow you to see the
failed attempt to delete and the creation of files in the CK_Docs.

QUESTION 214:
You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the

Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.
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Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. Kara Lang's
computer at work has a dual boot configuration with Windows XP Professional and
Windows 2000 Professional. Kara Lang shares the computer with another employee
named Mia Hamm. Kara Lang and Mia Hamm are working shifts. Kara Lang uses
Windows XP Professional and Mia Hamm uses Windows 2000 Professional. Mia
Hamm has installed an accounting application that should be used by Kara Lang
and her self. Mia Hamm did register the accounting application using one license.
Whenever Kara Lang runs the accounting application, she receives an error, that
the accounting application is not registered.

What should you do to troubleshoot the problem?

A. The Program Compatibility Wizard should be run.

B. Copy the database registry from Windows 2000 Professional to Windows XP
Professional.

C. The Upgrade Advisor should be run.

D. Reinstall the application under Windows XP Professional.

Answer: D

Explanation:

You should reinstall the application in Windows XP Professional. There are two
operating systems. Each of them has their own database registry, and each

operating system is on a partition.

Incorrect answers:

A: This will allow the application to run in a specific operating system mode.

B: Copy the database registry to Windows XP Professional will make the operating
system unstable.

C: Thy should run the Upgrade Advisor before upgrading to Windows XP Professional
to see if the program is compatible with the operating system.

QUESTION 215:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

Certkiller .com contains a Research department, Sales department and a Quality
Assurance department. You have received instruction from the CIO to prepare a
computer for a tester. The tester is responsible for testing the latest version of a
product that was developed in the Research department, which works on Windows
2000 Professional. The Quality Assurance department contains a computer to run
the new applications. The manager wants all the testers to run the application. The
Quality Assurance department's manager has installed a 16-bit graphics application
on the computer in the Quality Assurance department, but no te4ster can run the
16-bit graphics application. They received the following error message: "The
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Software/TestDev/DocumentGenerator registry subkey is missing”. You then
connect to the registry on the computer remotely.
In the exhibit, what registry key should you examine?
= B My Computer

1-[Z7] HKEY (CLASSES ROOT
+-[_7] HKEY CURRENT _USER
121 HEEY_LOCAL MACHINE
1] HKEY LISERS

1] HKEY_CURRENT _COMFIG

Answer:

= =} My Computer
-] HEEY_CLASSES_ROCT
-] HKEY CURRENT LSER
(5 [] HKEY_LOCAL_MACHINE]
[ HKEY USERS
-] HKEY_CURRENT _COMFIG

[ B

I+ [+

-

Explanation:

You should examine the HKEY_LOCAL_MACHINE key. This key has the
computer-specific information. If the subkey is there, it will be available to the other
users.

Incorrect Options:

There is no need to examine the HKEY_CURRENT_USER key. When you connect
remotely, the key will not be available. The HKEY_ CURRENT_USER key contains the
registry entries that are specific to a user that is currently logged on.

There is no need to examine the HKEY_CURRENT_CONFIG key. When you connect
remotely, the key will not be available. The HKEY_CURRENT_CONFIG key contains
the settings for the current loaded hardware profile.

There is no need to examine the HKEY_CURRENT_ROOQOT key. When you connect
remotely, the key will not be available. The HKEY_CURRENT_ROOT key contains
registry entries for the registered dynamic link libraries and the Component Object
Model objects.

There is no need to examine the HKEY _USER key. When you connect remotely, the key
will not be available. The HKEY _USER key contains all the subkeys for all the users of
the computer system.

QUESTION 216:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Sales department. The Certkiller .com users named Mia
Hammand Kara Lang works in the Sales department. Due to the long hours, these
two employees work shifts. They both share a computer named Certkiller -WS050
which runs Windows XP Professional. Mia Hamm has contacted you because she
cannot access the application which they both use. Mia Hamm used to access the
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application by clicking the shortcut on the Desktop. When she accesses the
application it produces a Missing Shortcut error. Kara Lang does not have this
problem. She activates the application the same way Mia Hamm does.

What could cause the problem?

A. The application is still running in Kara Lang's session with Fast User Switching.
B. Kara Lang is the administrator and not Mia Hamm.

C. The executable of the application was moved from it location.

D. You cannot create two shortcuts for the same application.

Answer: C

Explanation: Mia Hamm and Kara Lang has there own separate Desktop. Kara

Lang can successfully access the application, which means she must have move the
executable and configure the shortcut to point to the new lactation. .

Incorrect answers:

A: It cannot be Fast Switching. Mia Hamm received a Missing Shortcut error.

B: This is not the issue here. Both of them did run the application.

D: You can create two shortcuts for one application. One shortcut cannot point to more
that one application.

QUESTION 217:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Graphics department. A Certkiller .com user named Mia
Hammwho works in the Graphics department has contacted you. Mia Hamm has a
meeting with her superiors and she uses a computer named Certkiller -WS120 to
do her presentation. Always during the presentation the computer's screen becomes
corrupt. She wants you to troubleshoot the problem. When you switch on the
computer, every thing was normal. Mia Hamm then said the problem occurs
regularly.

What should you do?

A. Replace the CRT of Certkiller -WS120.

B. Update the video driver of Certkiller -WS120.

C. On Certkiller -WS120, reinstall Windows XP Professional.
D. Make sure that the video card is fully seated in the slot.
Answer: B

Explanation: The screen becomes disrupted during the presentation. Mia Hamm
also said that it occurs frequently. It can be that the video driver is not compatible
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with the application. If she upgrades the video card, the problem will be rectified.
Incorrect answers:

A: You switch on the computer and there was nothing wrong. If it was the CRT, then the
problem will persist.

C: Reinstalling Windows XP Professional would not solve the problem.

D: If the video card was not properly seated then the screen would have stayed black..

QUESTION 218:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows Server 2003 and all client computers run
Windows XP Professional.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a client computer named Certkiller -WS001. You suspect
that Certkiller -WS001 is malfunctioning due to a bug. During the investigation
you learnt that the virus protection on Certkiller -WS001 did not detect the virus.
After you restoration of Certkiller -WS001, you do not want any of these viruses,
infecting Certkiller -WS001.

What should you do?

A. Reformat the hard disk.

B. Update the virus signature.

C. Reinstall the antivirus software.

D. Reinstall Windows XP Professional.

Answer: B

Explanation: Updating the virus signature, will allow the antivirus program to

detect any new viruses.

Incorrect Answers:

B: Reformatting will not stop viruses from coming to the computer in the future. You
need to update the virus signature.

C: Reinstalling the antivirus software will not allow the software to recognize new
viruses.

D: Reinstall Windows XP Professional will not ensure that a virus will infect the
computer.

QUESTION 219:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional. All client computers have Microsoft Office XP installed.
Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Wilson has contacted you. Amy Wilson works
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as a secretary at her company. Amy Wilson has downloaded a new screensaver that
was in a linked in an e-mail message. Amy Wilson said that after she put the
screensaver in use her colleagues received messages from her computer that she not
send. She removed the screensaver but her colleagues said that they still receive
messages from her computer. Amy Wilson also said the she ran the antivirus and no
infections was reported.

What should Amy Wilson do?

A. In the command line run GPupdate.

B. In the command line run Secedit.

C. Download the latest virus signatures and scan the computer.

D. Connect to the Windows Update Web site and scan for updates.

Answer: C

Explanation: An e-mail message was received and open. It can be that the computer

is infected with a virus. This is a new virus because his antivirus cannot recognize
anything. She has to download the latest antivirus and scan the computer. The virus
signature, will allow the antivirus program to detect any new viruses.

Incorrect Answers:

A: The GPupdate is used to refresh or update Groups Policy settings.

B: The Secedit allow you to analyze and configure security settings.

D: The updates in the Windows Update Web site are there to protect the computer, not to
disinfect a computer that has a virus. .

QUESTION 220:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Andy Booth has contacted you. He said that he
received an e-mail message in a ZIP format from an unknown person. Andy Booth
also said that there is a info.txt file in the ZIP files, which he extracted. Andy Booth
would like to know if this is a virus.

What should you tell him? (Select two)

A. Check that the Folder Options is specified to show file extensions of known file types.
B. ZIP files cannot have viruses

C. In Windows Explorer. Highlight the file and ensure that there is no trailing spaces

D. Run the file and see if there is a malicious action.

Answer: A, C

Explanation: You should check that the Folder Options is specified to show file
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extensions of known file types. The persons that write the viruses use executables.
The users should highlight the file in Windows Explorer. Windows Explorer will
show the flaw that exists, which are usably spaces.

Incorrect Answers:

B: ZIP files can have executables that host viruses.

D: You should not run files that you are not sure of.

QUESTION 221:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. Kara Lang has a
computer that is running Windows XP Home and Microsoft Internet Explorer 6.0.
One of her friends has used her computer, now there is something wrong. Kara
Lang said that the Web sites are very slow and it takes along time to scroll down to
the other pages. She also said that her computer looks different.

What could be the problem?

A. A service pack was installed.

B. A virus was installed.

C. Themes are being used.

D. A different hardware profile is used.

Answer: B

Explanation: This is a known virus that configures Internet Explorer to use a
malicious configures style sheet.

Incorrect Answers:

A: Service pack does not create problems, if solve problems.

C: Themes does not have a noticeable effect on the performance.

D: Hardware profiles define the device drivers that are enabled and loaded by the
operating system.

QUESTION 222:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Walsh has contacted you. Amy Walsh has
received a message that states that she should go the Web site on the messages and
download a patch. The patch will prevent the data of your computer to be deleted.
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Amy Walsh wants to know what she must do.

A. Do not delete the message because it s a virus.

B. Download the patch from the Web site and install it.

C. Download the patch from the Web site and install it. then delete the message
D. Delete the message because it is a hoax.

Answer: D

Explanation: This is a hoax. Amy Walsh should delete the message.

Incorrect Answers:

A: The user must delete the message because it s a virus.

B: The user should not go to the Web site and download the patch, it is a virus.

C: The user should not download the patch from the Web site and install it and then
delete the message, because it is a virus.

QUESTION 223:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a Sales department. A Certkiller .com user named Clive
Wilson works in the Sales department. Clive Wilson visits a lot of Web pages to do
research in the cost price of products. Clive Wilson wants to remove some of the
Web pages that he's not visiting regularly. He need to access the most needed site
quickly.

What should you tell Clive Wilson to do?

A. Increase the number of days to keep pages in history.

B. Add the pages that are visited often to the Favorites menu.
C. Store cookies for the pages that it regularly visits.

D. Decrease the number of days to keep pages in history.

Answer: B

Explanation: Clive Wilson should add the pages that he visited regularly, to the
Favorites menu.

Incorrect answers:

A, C: Increase or Decrease the number of days will not help. If the settings for the days
are over, he still then needs to access these pages.

D: This is not a cookies related issue.

QUESTION 224
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You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner has a
Windows XP Home computer and wants to configure the launching programs and
files in an IFRAME. Ally Wagner wants to know why this setting is disabled on her
computer.

What explanation can you give Ally Wagner?

A. This will prevent you from accessing the Internet from Windows Explorer.

B. This prevents a Web page from invisibly loading Web content from another site onto
the same page.

C. This will prevent Internet Explorer from using scrollbars so that Web pages are more
viewable.

D. It has no effect on Windows XP because of its security enhancements.

Answer: B

Explanation: The IFRAME is an invisible section of a Web page that contains

content from another location. If the setting is disabled, it will not load other content

of other invisible Web site.

Incorrect answers:

A: Windows Explorer and Internet Explorer use the same object model. Internet cannot
be browse from the Windows Explorer. This setting will not prevent you from accessing
the Internet from Windows Explorer.

C: This setting does not have an effect on the scroll bar.

D: This is effective in Windows XP Professional. it is set to be prompt.

QUESTION 225:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains 10 Windows 2000 Server computers, 50 Windows XP Professional
client computers and 1,400 Windows 2000 Professional client computers.

Certkiller .com contains a Finance department and a Research department. A
research group in the Research department uses 10 of the client computers that are
running Windows XP Professional. These 10 client computers are in an isolated
network. The 10 client computers are not directly connected to the Internet with no
e-mail and limited network access. You have been asked to make sure that the latest
operating system service packs, patches and updates are installed on the 10 client
computers.

Which tool should you use?

A. The Utility Manager
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B. Dr. Watson
C. Microsoft Baseline Security Analyzer tool.
D. The antivirus program with the latest virus signature file.

Answer: C

Explanation: With this tool, you can access the security on the computer to make

sure if the latest operating system service packs, patches and updates ate installed.
Incorrect Answers:

A: The Utility Manager is used to start or stop Accessibility Feature, e.g. Magnifier or
Sticky Keys.

B: Dr. Watson is used to record information about failures in applications and system
services.

D: The antivirus program with the latest virus signature file can be used to scan for the
latest viruses.

QUESTION 226:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Ally Wagner has contacted you. Ally Wagner is
working for a graphics company. Ally Wagner has installed a new graphics card to
finish a project she is busy with. Ally Wagner is having display problems and she
got a feeling that it could be the faulty drivers. The company has a high-speed
Internet connection via cable modem and uses Internet Explorer as the default
browser.

What should Ally Wagner do first?

A. Download and run the Microsoft Baseline Security Analyzer utility.

B. Scan for update in the Windows Update Web site.

C. Connect to the Windows XP Professional Web site and download the latest service
pack.

D. In the display properties, set the Hardware acceleration slider to Full.

Answer: B

Explanation: In the Windows Update Web site, you can scan for updates. The scan
will check the complete operating system and hardware for updates.

Incorrect Answers:

A: With this tool, you can access the security on the computer to make sure if the latest
operating system service packs, patches and updates are installed.

C: The user needs a driver update and not a service pack.

D: This will help, but the computer needs an updated driver.
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QUESTION 227:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Amy Wilson has contacted you. Amy Wilson wants
to keep her computer secure from the new viruses. She states that she regular visit
the update site to secure her computer. Amy Wilson is worried that she cannot
remember what she has downloaded and she do not want to download or install the
same update.

In the exhibit, what should Amy Wilson do?

) Microsoft.com Home | Site Map
= Search Misrosaft.com far:

Microsoft Update

- Welcome
- ¥ Turned O
to Microsoft Update
i ter is set o
: ‘our compu’ 15 sel receive
Review your update history notifications when new updates are
: Keep your computer up to date available.
Chedk to see IF you need updates for Windows, your programs, your
Change settings hardware or your devices, Pick a time to install updates.
FAQ
| I Gethigh-priority updates
Get help and support s { ded) e
\l) News
Use administrator options
Windows XP users: new security
Select from optional and high- updates are now avalable for
priority updates for Windows 5P1and SP2 only
and other programs
Concerned about privacy? When you check for updates, basic
information about your computer, not you, is used to determine which
updates your programs need. To learn more, see our privacy
statement,
Answer:

) Microsoft.com Home | Site Map
= Sanrch Microsoft.com foe

Microsoft Update

= Welcome

- . § Turned O

W to Microsoft Update
Spons ¥i ter is set to
- ‘our compuy’ i5 5e receve

: RobScatons when new Ldstes are
ek o Keep your computer up to date avaiable.

Chedk to see if you need updates for Windows, your programs, your
Change settings hardware or your devices. Pick a time to install updates.
FAQ

Express ,Get h;hfxuul‘y nﬁdales
Get help and support \l)
Use administrator options
Windows XP users: new secunty
Select from optional and high- Updates are now avalable for
priority updates for Windows 5P 1and SP2 only
and other programs

Concerned about privacy? When you chedk for updates, basic

information about your computer, not you, is used to determine which

updates your programs need, To learn more, see our privacy

statement.

Explanation:

Amy Wilson should click the Review your update history link. This will give a list of
what was installed and the date when it was installed.

QUESTION 228:
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You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Mia Hamm has contacted you. Mia Hamm wants to
secure her Windows XP Professional computer. She wants the latest critical updates
and hotfixes installed.

What should she do?

A. Apply the Hisecws security template.

B. Run GPupdate

C. Run Secedit

D. Go to the Windows Update Web site and scan for updates.

Answer: D

Explanation: She can go to the Windows Update Web site and scan for updates. The
Windows Update will determine the updates that are needed.

Incorrect Answers:

A: The Hisecws security template is used to analyze and modify the security settings on
the computer.

B: The GPupdate is used to refresh or update the Group Policy settings.

C: The Secedit is used to allow you to analyze and configure the security settings on the
computer.

QUESTION 229:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Kara Lang has contacted you. Kara Lang has a
Windows XP Professional computer has Service Pack 2 installed. Kara Lang wants
to ensure that her computer has the latest security updates installed. She is not sure
if the computer is setup for security.

What should she do?

A. Apply the Hisecws security template.

B. Enable Automatic updates.

C. Run Secedit

D. Go to the Windows Update Web site and scan for updates.

Answer: B
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Explanation: Kara Lang should make sure that the downloading of the updates is
enabled in the Automatic updates.

Incorrect Answers:

A: The Hisecws security template is used to analyze and modify the security settings on
the computer.

C: The Secedit is used to allow you to analyze and configure the security settings on the
compulter.

D: She can go to the Windows Update Web site and scan for updates. The Windows
Update will determine the updates that are needed.

QUESTION 230:

DRAG DROP

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A

Certkiller .com customer named Andy Reid has contacted you. Andy Reid is a
regular customer of Certkiller .com. Andy Reid wants to apply a critical update to his
computer because he is worried that his computer can become infected with a new
virus.

Using the exhibit, what should he do?

Steps, Select from these Steps, place here

Click the Critical Updates and

Service Packs link. SR

Click Express. Place here, if any.
Click Install Updates. Place here, if any.
Click Windows Update. Place here, if any.

Click the Start menu and point to

All Programs Place here, if any.

Open Microsoft Internet Explorer and
search for the Critical Updates.

Answer:

Place here, if any.
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Steps, Select from these Steps, place here
Click the Critical Updates and Click the Start menu and point to
Service Packs link. All Programs

Click Windows Update.

Click Express.

Click Install Updates.

Place here, if any.

Open Microsoft Interet Explorer and
search for the Critical Updates.

Explanation:

Andy Reid should apply the critical updates. He should click the Windows Update, opens
Internet Explorer and browse to the Windows Update Web site.

Incorrect Option:

Andy Reid should not use Internet Explorer and search for the Critical Updates. The
Windows Update is accessible from the Start menu.

Place here, if any.

QUESTION 231:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Rory Allen has contacted you. Rory Allen is the
manager for his company. Rory Allen has enabled Software Restriction Policies on
the client computer in their work group. A user named Mia Hamm at their
company that works on that computer is complaining that she cannot run any
applications on that computer. Rory Allen wants to know where to look to solve the
problem.

Which security level is set to Disallow?

A. A Path rule's security level

B. The Default security level

C. A Hash rule's security level

D. A Certificate rule's security level

Answer: B

Explanation: The default security level is set to Disallowed. This also defines the
behavior of the applications running. The user also needs to configure extra rules to
specify which applications can run.

Incorrect Answers:

A: It is improbable that the Path rule is set to disallow. The Path rule allow or disallow
software to run. This is based on the folder or drive where the files are located.
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C: The Hash rule allow or disallow software to run that is based on file content.
D: The Certificate rule allow or disallow software to run based on who digital signed the
software.

QUESTION 232:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of. A
Certkiller .com customer named Kara Lang has contacted you. Kara Lang has a
Windows XP Professional computer with Service Pack 2. Kara Lang said that she
regularly visits a remote Web site. The information in the Web site is provided via
pop-up windows. Kara Lang would like to view the information, but she does not
want to get additional prompts to open the pop-up windows. Your solution must not
affect the other Web site or her computer's Windows Firewall configuration.

What should Kara Lang do?

A. Remove Service Pack 2

B. Add the Web site to the Trusted Sites zone.

C. In Internet Explorer, click the Tools menu and click the Reset Web Settings.

D. Change the Internet Site properties to disable the Use Pop-up Blocker property.

Answer: B

Explanation: If the Web site is added to the pop-up zone, you can enable pop-ups.

This action will not affect the other Web sites.

Incorrect Answers:

A: The Firewall will be removed if she removes the Service Pack 2.

C: If you click the Reset Web Settings, you will reset the security settings to their
default.

D: If you change the Use Pop-up Blocker property to disable, you will enable pop-ups to
all the Web sites not listed in another zone.

QUESTION 233:

You work as a help desk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

A Certkiller .com customer named Kara Lang has contacted you. Kara Lang has a
computer running Windows XP Professional with Service Pack 2. She needs your
help with Outlook Express. Kara Lang said that she receives regular updates to a
custom application. Now Outlook Express stops her from receiving the attachment,
which has the .exe extension.
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What should Kara Lang do on the Security tab of the Outlook Express Option
dialog box?

A. Clear the Block images and other external content in HTML e-mail option.

B. Select the DO not allow attachments to be saved or opened that could be a virus
option.

C. Select the Internet zone.

D. Clear the DO not allow attachments to be saved or opened that could be a virus
option.

Answer: D

Explanation: Kara Lang should clear the DO not allow attachments to be saved or
opened that could be a virus option. This will stop Outlook Express from opening
files that can have a virus.

Incorrect Answers:

A: The clear the Block images and other external content in HTML e-mail option will
block the images, but not potential unsafe attachments.

B: This option will allow her to receive the executables attachments.

C: This will allow her to apply rules from the Restricted Sites zone or Internet zone to
HTML and ActiveX content in e-mail messages.

QUESTION 234:

You work as a help desk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
Windows XP Professional.

A Certkiller .com customer named Mia Hamm has contacted you. Mia Hamm said
that she cannot run the macros in a Microsoft Office Excel 2003, which is send by
there mother company. Mia Hamm would like to run the macros without being
prompt.

What should you tell her?

A. For macros, change the security setting to High.

B. For macros, change the security setting to Medium.

C. Add the mother company's Web site to the list of Trusted Sites.
D. For macros, change the security setting to Low.

Answer: D
Explanation: If the settings are low, then she will be able to run the macros without
any prompting.

Incorrect Answers:
A: This setting will disable macros that are not from trusted sources.
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B: This setting will prompt the user about whether to enable potential unsafe macros.
C: This feature is not related to macros functions.

QUESTION 235:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. The Certkiller .com
network contains ten Windows 2000 Server computers, 500 Windows XP
Professional client computers and 1,000 Windows 2000 Professional client
computers.

Certkiller .com contains a Development department. A Certkiller .com employee
named Mia Hamm works in the Development department. Certkiller .com contains a
Windows XP Professional workstation named Certkiller -WS111. Mia Hamm is
using this computer. Mia Hamm has contacted you to report the invoice
management application has problems. During the questioning you learned that

Mia Hamm has installed a customer relationship management application on
Certkiller -WS111. Before the installation of the customer relationship

management application, the invoice management application worked without any
problems. Mia Hamm needs her invoice management application.

What should you do?

A. Find out if the two applications can coexist by using the Program Compatibility
Wizard.

B. Use the Upgrade Advisor to find out the source of the problem.

C. Find out if the registry keys are overwritten, in the registry.

D. Find out if the Windows system dynamic link libraries (DLLS) were overwritten
during the installation process.

Answer: C

Explanation: You should check the registry and find out if the registry keys were

not overwritten.

Incorrect Answers:

A: To find out if the two applications can coexist, you should not use the Program
Compatibility Wizard.

B: You should have use the Upgrade Advisor to see if the two applications can coexist
before installing it.

D: Windows XP does not allow the Windows system DLLs to be overwritten.

QUESTION 236:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com. All servers
on the Certkiller .com network run Windows 2000 Server and all client computers

run either Windows XP Professional or Windows 98.

A Certkiller .com user named Kara Lang uses a Windows XP Professional client
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computer named Certkiller -WS018. Kara Lang has installed a new software
development framework on Certkiller -WS018. When Kara Lang needs to use the
Windows Explorer, the computer hangs. You need to find out if any components
were overwritten when installing the framework.

What tool should you use?

A. Dr. Watson

B. File Signature Verification
C. Regedit

D. Scandisk

Answer: B

Explanation: You should use the File Signature Verification to find out if the
correct versions of the system files are installed.

Incorrect Answers:

A: The Dr. Watson is used to log errors if application errors occur.

C: The Regedit is used to view and edit the system registry.

D: The Scandisk is used to check for hard disk errors.

QUESTION 237:

You work as a desktop support technician at Certkiller .com. The Certkiller .com
network contains a single Active Directory domain named Certkiller .com.

A Certkiller .com user named Kara Lang uses a Windows XP Professional computer
named Certkiller -WS170 that has two hard disks. Drive C: has 200 MB of free
space and has the Windows 95 operating system installed on it. Drive D: has 2 GB of
free disk space and has the Windows XP Professional operating system installed on
it and secure data files and other information which is encrypted. Kara Lang has
contacted you because she cannot install an accounting application on

Certkiller -WS170. She received the following error: "Disk requirement not been
met. Please adhere to the disk requirement before proceeding with the installation”.
Kara Lang installed the accounting application on drive D: which has 2 GB of
memory and the accounting application only needs 500 MB of free space for
installation. Kara Lang needs to install the accounting application.

What should Kara Lang do?

A. On Drive C, free up disk space
B. On Drive D, free up disk space
C. Format drive C with NTFS

D. Format drive D with FAT
Answer: A

Explanation: Kara Lang should free space in drive C. You do get applications that
need temporary disk space. Other applications do need disk space on drive C.
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Although drive C has only 200 MB; she should free the disk space on drive C.

Incorrect Answers:

B: Kara Lang does not need disk space on drive D. Drive D has enough disk space. Some
applications need disk space that requires drive C.

C: Drive C contains Windows 95. Windows 95 does not support NTFS.

D: Formatting drive D to FAT is not an option because Kara Lang has encrypted files on
that drive. Files can only be encrypted on drive which is formatted with NTFS.

QUESTION 238:

DRAG DROP

You work as a helpdesk technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server.

Certkiller .com contains a Research department and a Sales department. The
Research department does research on and software where the Sales department
sells the applications, software and computers. Certkiller .com also has a help desk
team which helps the customers which has problems with there software or
computers that was bought at Certkiller .com.

A Certkiller .com customer named Dean Austin which has a Windows XP
Professional computer has contacted you. Dean Austin has bought a 16-bit
accounting application at your company. He has problems with the 16-bit
accounting application which is d designed for Windows XP Professional. When
ever Dean Austin runs Microsoft FrontPage the 16-bit accounting application
crashes.

From the list on the left, select the tasks to troubleshoot the problem.
Steps, Select from these Steps, place here

Install Windows XP Home on the test

Place here.
computer

Install a copy of the application on the test

Place here, if any.
compulter.

Have the user open the log file and read its

: Place here, if any.
entries to you.

Have the user send you the loa file. Place here, if any.

Escalate the issue fo a software developer. Place here, if any.

Have the user locate the Dr. Watson file. Place here, if any.

Have the user open the registry. Flace here, if any.

Try to reproduce the problem. Place here, if any.
Answer:
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Steps, Select from these Steps, place here

Install Windows XP Home on the test

Have the user locate the Dr. Watson file.
computer.

Install a copy of the application on the test

Have the user send you the log file.
computer.

Have the user open the log file and read its

entries to you. Escalate the issue to a software developer.

Place here, if any.

Place here, if any.

Place here, if any.

Have the user open the registry. Place here, if any.
Try to reproduce the problem. Place here, if any.
Explanation:

Dean Austin should send the Dr. Watson log file. This file contains the information
needed for a higher-level technician. If the developer discovers the cause of the problem,
he could fix the 16-bit accounting application.

Incorrect Options:

Dean Austin should not alter anything in the registry. Any changes that are made to the
registry are permanent.

You should not use a test computer and install the 16-bit accounting application to
reproduce the problem. You should have the software developer debug the application.
Reading the DR. Watson log files is impossible. The debug symbols are not
human-readable.

QUESTION 239:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003. All the client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Mia Hamm is a member of the Research department.
One morning Mia Hamm complains that the dictionary does not contain several
industry-specific words that are used in her Microsoft Word document.

Mia Hamm wants Microsoft Word to automatically recognize these words when
they are spelled correctly, rather than highlighting them as misspelled words.
What should you do to ensure that Word does not highlight these industry-specific
words are misspelled?

A. Right-click the Spelling & Grammar Status icon at the bottom of the Word window.
Select Options from the context menu. Then click the Check Document button.

B. Create a text file that contains the desired words. Open the Options dialog box. Then
specify the text file's location in the Tools path on the File Location tab.

C. Open the Options dialog box. Ensure that the Suggest from the main dictionary only
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check box is selected on the Spelling & Grammar tab.
D. Open the Options dialog box. Create a custom dictionary. Then right-click the desired
words in a document and select Add to Dictionary from the context menu.

Answer: D

Explanation: The question tests your knowledge of how Word handles words not

found in its main dictionary. There is no way to know this other than to do it. The
answer listed is the correct way to do this. Microsoft creates a custom.dic file for

you when Word is installed. This is the custom dictionary file.

Incorrect Answers:

A. There is no such icon as "Spelling and Grammar Status.” Even if there were, clicking
Check Document will only compare the words in the document against the main
dictionary file. Since the custom words did not appear in the main dictionary, they will
still show up as misspelled.

B. There is no way to specify a custom dictionary from the File Location tab. This tab is
for items such as save location, template location, etc. Below is the File Location tab for
Office 2003, but office XP is exactly the same:

| Options 2 wl
Ve Genesal Edt Frint S Sapcurity
Sipaibng & Gramimar Tragk Changess Uiser Informattioe
Compatibdiny Fia Locations

Eite fypos: Location:

Documants .. \My Documents

Chipart pictures

User femplates CiiUser

‘iorigroup templabes Y Termpdates

AuleReciver fleg Ci\.Aappiication DakaiMicresoft iWerd

Tooks €4 \Microsaft Office | OFFICED

Stariup il MacresoltiWee S TART LI

odify_.

oK | Close

C. Ensuring that the Check from main dictionary only checkbox is checked is the exact
opposite of what needs to be done. If this box is checked, Word will never check for any
documents outside of the main dictionary, and the industry specific words will always be
marked as incorrect even if a custom dictionary is specified.

QUESTION 240:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
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servers on the Certkiller .com network run Windows Server 2003. All the client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Kara Lang is a member of the Research department.
Kara Langcomplains that when she scrolls through a Microsoft Word document
that contains graphics, the graphics display becomes corrupted.

What should you do first to ensure that the graphics do not appear corrupted when
Kara Lang scrolls through Word documents?

A. Create a new user profile.

B. Reduce the Display settings to 256 colors.

C. Adjust the mouse pointer acceleration to a lower settings.

D. Adjust the hardware accelerator of the video adapter to a lower setting.

Answer: D

Explanation: The settings are configured to rely too much on the processor on the
graphics card which seems to be a little too weak for the current settings.

Adjust graphics hardware acceleration by clicking Start, point to Settings, and then click
Control Panel. Double-click Display. On the Settings tab, click Advanced. Click the
Troubleshoot tab. Move the Hardware Acceleration slider two notches to the left of Full
(the Disable all cursor and advanced drawing accelerations setting). Click OK, and then
click OK again.

QUESTION 241:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003. All the client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Rory Allen is a member of the Sales department. Rory
Allencomplains that Office applications display animated characters when he
accesses Help. Rory Allen wants Office to permanently stop displaying the Help
character.

What should you instruct Rory Allen do to configure Office so that the character is
no longer displayed?

A. Right-click the character and select Hide.

B. Delete the Microsoft Agent DLL file located in the Windows System32 folder.

C. Select Hide the Office Assistant from the Help menu in each Office application.
D. Right-click the character and select Options from the context menu. Then clear the
Use the Office Assistant check box.

Answer: D

Explanation: The Office Assistant is a feature included in Microsoft Office starting
with Office 97, and has been dubbed "Clippy" or "Clippit" after its default
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animated paperclip representation. However, Clippit is actually the default
assistant's official name. Right-clicking on the character and selecting Hide will only
remove the assistant temporarily. Manually removing dll files from the system is
never a good way to solve a problem as this could cause more problems. Selecting
Hide the Office Assistant from the Help menu is the same action as right-clicking on
the assistant and selecting Hide. Clearing the Use the Office Assistant from the
Options menu when right-clicking the assistant is the correct way to permanently
remove the Office Assistant.

QUESTION 242:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003. All the client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Andy Booth is a member of the Research and
Development department. One morning Andy Booth complains that he receives a
document containing mechanical drawings for a new design, but the document will
not open on his computer.

What should you do to ensure that Andy Booth can open the document?

A. Open the document by using the Windows Photo and Fax Viewer.

B. Open a new Microsoft Paint document. Drag the file into the paint document.

C. Open a new Microsoft Word document. Drag the file into the new Word document.
D. Download and install the Microsoft Visio Viewer from the Microsoft Office
Download Center Web Site.

Answer: D

Explanation: .vsd files are created in Microsoft Visio. Microsoft offers free of charge
a Microsoft Visio Viewer that allows anyone to view Visio drawings and diagrams
inside their Microsoft Internet Explorer version 5.0 or later Web browser.

QUESTION 243:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003. All the client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Dean Austin works from home. Dean Austin upgrades
his computer named Certkiller -WS290, from Windows 98 to Windows XP
Professional. Dean Austin complains that a mission-critical custom application no
longer works on his computer. He states that the application will not start, but it
does not display any error messages.

During an investigation you discover that the custom application is a 32-bit
Windows application that does not use the Windows registry. You confirm that the
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application is compatible with Windows XP Professional.
What should you instruct Dean Austin to do to ensure that the custom application
can successfully run on the user's computer?

A. Instruct Dean Austin to start the application by using the Start command.

B. Instruct Dean Austin to modify the properties of the application's .exe file so that the
application runs in Windows 98 compatibility mode.

C. Ask an administrator to reset the domain computer account for the Dean Austin's
computer.

D. Remotely add the Dean Austin's user account to the local Administrators group on the
user's computer.

Answer: B

Explanation: Dean Austin upgraded the computer from Win 98 to Win XP. The
application will not start and doesn't display an error message. It must be run in
compatibility mode for it to work.

QUESTION 244:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications. You install a program which installs its own
Control Panel application.

What should you do if you want to change the category in which this Control Panel
application appears?

A. Make a registry edit
B. Use the Add / Remove Program Wizard
C. Define a new replacement group policy
D. This cannot be done

Answer: A

Explanation: Some programs and devices install their own Control Panel
applications. These applications should go into the proper category if you use
Category view, but applications not written to Windows XP specifications might
not. If you want to change the category in which a Control Panel application
appears, you can do so with a registry edit.

QUESTION 245:

You work as the network administrator at Certkiller .com. The Certkiller .com
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network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named Amy Walsh is a member of the Research and
Development department. One morning Amy Walsh complains that her research
application is not available.

During a routine maintenance, you discover that Amy Walsh has just changed jobs
and all of her previous applications are available and function properly. You also
discover that software for the research department is maintained manually.

All other departments use Group Policy to deploy and control software.

What should you do to ensure that the research application functions properly on
Amy Walsh's computer?

A. Run the secedit command on Amy Walsh's computer.

B. Run the gpupdate command on Amy Walsh's computer.

C. Install the research application on Amy Walsh's computer.

D. Configure a software restriction policy on Amy Walsh's computer.

Answer: C

Explanation: Is because the software for the research department is maintained
manually that is the only way to complete the task.

QUESTION 246:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named Clive Wilson works from home. Dean Austin uses
Microsoft Word, which runs Windows XP Professional and Microsoft Office XP.
One morning Clive Wilson complains that he frequently encounters problems with
specific Word features. During an investigation you discover that the problems have
been addresses in an Office XP service release.

What should you instruct Clive Wilson to do to ensure that he installs the correct
service release?

A. Visit the Microsoft Windows Update Web site. Scan for and install all available
updates.

B. Visit the Microsoft Office Product Updates Web site. Scan for and install all available
updates.

C. Select the Detect and Repair wizard from the Help menu in Word.

D. Repair Word by using Add or Remove Programs in Control Panel.

Answer: B
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Explanation: Customer has a problem in Word. This problem has been address in a
service pack release, so pick B is the only choice.

QUESTION 247:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Ally Wagner is a member of the Sales department.
One morning Ally Wagner complains that she is unable to install a new Microsoft
Word template to her computer by using Add or Remove Programs in Control
Panel. Ally Wagner states that she was first prompted for a CD, and she put the CD
in the CD-ROM drive. She then receives an error message indicating that the
Windows Installer package could not find the template.

During the troubleshooting of the computer you discover that Ally Wagner has just
installed a new hard drive on her computer.

What should you do to ensure that Ally Wagner can install the new template?

A. Change the prompted path drive letter to C:\.

B. Change the prompted path file extension to .msi.

C. Change the prompted path filename to Normal.dot.

D. Change the prompted path drive letter to point to the CD-ROM.

Answer: D

Explanation: The user has installed a new hard drive. This has caused the drive
letter that refers to the CD-ROM drive to change.

QUESTION 248:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications. You want to use the applications inside the
Control Panel.

Is the following statement TRUE or FALSE: You can invoke most control panel
applications via the command line.

A. True
B. False

Answer: A
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Explanation: Although Control Panel provides a suitable means of access to settings
you make only occasionally, in many cases you can use a command line to go
directly to a particular tab of interest, saving another click. You can use these
command lines at a command prompt too.

QUESTION 249:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications. You plan to purchase a new computer that is
OnNow capable.

Which of the following is a requirement?

A. ACPI
B. APM
C.RDP
D. ASR

Answer: A

Explanation: On computers that are fully compliant with the Advanced
Configuration and Power Interface (ACPI. specification-a requirement of
OnNow-capable computers-the operating system maintains efficient and reliable
control of the power supplied to your monitor, disk drives, peripherals, and
motherboard components, reducing power to those components appropriately when
your computer is inactive.

QUESTION 250:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications. You plan to purchase a new computer that is
OnNow capable.

Which of the following is a standard which puts power management completely in
the control of XP?

A. ACPI
B. APM
C.RDP
D. ASR
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Answer: A

Explanation: The advantage of ACPI over APM is that ACPI puts power
management completely in the control of the operating system. Because ACPI is an
operating-system specification, Windows XP can provide a consistent approach to
power management across all ACPI-compliant systems, thereby ensuring reliability
while reducing training costs and user perplexity. With applications that are
designed for ACPI, an ACPI-compliant system can also track the status of running
or scheduled programs and coordinate power transitions with applications as well
as hardware.

QUESTION 251:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You plan to use a BIOS update to upgrade your system from APM to ACPI
support. What should you do so that your XP can function properly?

A. reinstall Windows XP after performing the upgrade
B. reinstall Windows XP before performing the upgrade
C. modify the HAL after the upgrade

D. recreate a new tailor made HAL before the upgrade
E. None of the above.

Answer: A

Explanation: If you use a BIOS update to upgrade a system from APM to ACPI
support, you must reinstall Windows XP after performing the upgrade. That's
because ACPI support is dependent on an ACPI HAL, which you can get only by
reinstalling Windows. You can perform an upgrade installation.

QUESTION 252:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You are installing a new XP configuration and you like to specify which HAL to
install. What should you do?
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A. Boot from the Windows XP CD to initiate Setup. At the point in text-mode setup
where a message at the bottom of the screen reads "Press F6 if you need to install a third
party SCSI or RAID driver," press Fb5.

B. Boot from the Windows XP CD to initiate Setup. At the point in text-mode setup where a
message at the bottom of the screen reads "Press F6 if you need to install a third party
SCSI or RAID driver," press F6.

C. Boot from the Windows XP CD to initiate Setup. At the point in text-mode setup
where a message at the bottom of the screen reads "Press F6 if you need to install a third
party SCSI or RAID driver," press F8.

D. Boot from the Windows XP CD to initiate Setup. At the point in text-mode setup
where a message at the bottom of the screen reads "Press F6 if you need to install a third
party SCSI or RAID driver," press F10.

E. None of the above above.

Answer: A

Explanation: To specify which HAL to install, follow these steps:

1. Boot from the Windows XP CD to initiate Setup.

2. At the point in text-mode setup where a message at the bottom of the screen reads
"Press F6 if you need to install a third party SCSI or RAID driver," press F5.

QUESTION 253:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

What should you do to enabling APM on your computer?

A. install the NT Apm/Legacy Interface Node device
B. upgrade the bios and retry

C. at boot up press F6 and apply APM bios update
D. first disable ACPI and then retry

E. None of the above.

Answer: A

Explanation:

If you can't enable APM, installing the NT Apm/Legacy Interface Node device
might solve the problem. To do that, run the Add Hardware Wizard. In the wizard's
list of installed hardware, select Add A New Hardware Device. Select manual
installation and then, in the list of common hardware types, select NT Apm/Legacy
Interface Node.
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QUESTION 254:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com user named Amy Wilson requests that you install the NT
Apm/Legacy Interface Node device on his system. How do you proceed?

A. run the Add Hardware Wizard and select manual installation.
B. run the Add Hardware Wizard and select auto detect.

C. Edit the registry

D. You should not do this for him - this is never recommended

Answer: A

Explanation: If you can't enable APM, installing the NT Apm/Legacy Interface
Node device might solve the problem. To do that, run the Add Hardware Wizard. In
the wizard's list of installed hardware, select Add A New Hardware Device. Select
manual installation and then, in the list of common hardware types, select NT
Apm/Legacy Interface Node.

QUESTION 255:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You are configuring power management on your XP computer. For Windows XP
power management features to work properly, you should the power
management features in your computer's BIOS.

A. Disable
B. Enable
C. Install
D. Remove
Answer: A

Explanation: For Windows XP power management features to work properly, you
should disable all power management features in your computer's BIOS (Basic
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Input/Output System.. With ACPI, power management should be under the
exclusive control of the operating system. When the operating system and the BIOS
contend for control, problems often result.

QUESTION 256:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You are configuring power management on your XP computer. With ACPI, power
management should be under the exclusive control of:

A. the operating system.

B. the operating system and the BIOS.
C. the BIOS.

D. the motherboard chipset

Answer: A

Explanation:

For Windows XP power management features to work properly, you should disable
all power management features in your computer's BIOS (Basic Input/Output
System.. With ACPI, power management should be under the exclusive control of
the operating system. When the operating system and the BIOS contend for control,
problems often result.

QUESTION 257:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named Andy Reid is a member of the Research and
Development department. Andy Reid wants to install Microsoft Office XP on his
new computer. He runs Office setup. However, the setup fails and rolls back the
installation.

What should you do to re-run Office setup on Andy Reid's computer and observe
the installation process?

A. Instruct Andy Reid to visit the Microsoft Office Product Updates Web site, and to
select the option to scan the computer for updates.

B. Connect to Andy Reid's computer by using Remote Assistance. Instruct Andy Reid to
remove Office by using Add or Remove Programs in Control Panel. Use the Add and
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Remove Programs application on your computer to Office setup.

C. Connect to Andy Reid's computer by using Remote Assistance. In the Remote
Assistance window, rerun the Office setup by connecting to a network-based installation
point and double-click the appropriate .msi file.

D. Remotely stop and restart the Windows Installer service on Andy Reid's computer.
Use the Windows Installer command-line utility on your computer to rerun Office setup.

Answer: C

Explanation: To try to recreate the error you have to run the installation in the
users privileges so running the installation on your computer with your privileges
will not help you to solve the problem (answer B and D). Visiting the Microsoft
Office Product Updates Web site will not help the user in any way as long as he
doesn't have Microsoft Office installed on his computer.

QUESTION 258:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003. All the client
computers run Windows XP Professional and Microsoft Office XP.

Certkiller .com contains a Microsoft Exchange Server 2003 computer named
Certkiller -SR10 for a messaging. The Certkiller .com users access e-mail by using
Microsoft Outlook 2002.

A Certkiller .com user named Andy Reid is a member of the Marketing department.
Andy Reid will be on vacation and wants Outlook to automatically reply to
incoming e-mail messages. Andy Reid states that his computer will be turned off
while he is on vacation. He wants Outlook's reply to tell senders that he will be on
vacation for two weeks.

What should you do to ensure that Andy Reid successfully configures the automatic
reply to senders?

A. Enable the Out of Office Assistant.

B. Create a new rule that replies to all incoming e-mail.

C. Use the Scheduled Task Wizard to create a task that opens Outlook every morning.
D. Delegate permissions on his Inbox to a co-worker. Instruct the co-worker to open the
vacationing user's Inbox in Outlook.

Answer: A

Explanation: Enabling the Out of Office Assistant will allow the user to set a
message to automatically reply to users when on vacation. See the graphic below:
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| Out of Office Assistant X|
(@)[r.am currently Jn the Office

{11 am currently Qut of the Office

AutoReply only once to each sender with the following text:

These rules will be applied to incoming messages while you are out of the office:
Status Conditions Actions

Add Rule... [+] Shaws rules far all profiles

oKk | |  Cancel |

Incorrect Answers:

B. Creating a new rule is unnecessary. Since the Out of Office Assistant is designed to do
this very task, the rule is not the best solution. In addition, a rule will only determine how
incoming mail is handled, but will not automatically reply to users.

C. Opening Outlook will not reply to any users. Simply opening Outlook will not do
anything to the messages once opened, and if Outlook is not closed, will continue to open
every day while the user is gone. When the user returns, he would have fourteen copies
of Outlook open!

D. Delegating the Inbox to a coworker would work, but only if the Send on Behalf
permission is granted, and the coworker would have to reply to each email sent. This is a
large burden on a coworker, and is not the best solution to the question.

QUESTION 259:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

Multiple identities have been created on your OE. However, OE always returns to
the identity that was in use when the program was closed.

What should you do if you want to change this behavior?

A. Edit the registry

B. Edit the local settings of OE

C. Configure the mail server options for OE
D. Edit the mail reading settings of OE

E. There is nothing you can do about this

Actualtests.com - The Power of Knowing




070-272

Answer: E

Explanation: On opening, Outlook Express always returns to the identity that was
in use when the program was closed-regardless of how the Manage Identities dialog
box is filled out. To switch identities, choose File, Switch Identity.

QUESTION 260:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

The CI1O wants to know what feature of Outlook Express allows multiple users to
send and receive mail, each using a separate account.

A. Identities

B. Group Sharing

C. Fast user switching
D. Virtual account

Answer: A

Explanation:

Outlook Express's identities feature allows multiple users to send and receive mail,
each using a separate account. If your family shares a single Internet connection,
you can let each member manage his or her own mail using Outlook Express.

QUESTION 261:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Kara Lang is a member of the Research and
Development department. One morning Kara Lang complains that favorite Web
sites are too difficult to locate. Kara Langrecently added quite a few sites to her
Favorites list in Internet Explorer.

What should you do to help Kara Lang arrange her Favorite list?

A. Sort her Internet Explorer Favorites by name.

B. Select Show Related Links on the Tools menu in Internet Explorer to list her
Favorites.

C. Synchronize Kara Lang's current home page and make the file available when the user
is working offline.
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D. Export her Favorites to a file. Open the file in a word processing application and save
the file as an HTML file. Import the file into her Internet Explorer Favorites.

Answer: A

Explanation: The simple answer is the correct answer. Simply sort the Favorites by
name. Click Favorites, then right click on any of the favorites listed, and choose Sort

by Name.

Incorrect Answers:

B. There is no "Related Links" setting on the Tools menu.

C. Synchronizing folders affects offline web page viewing. It does not change how
anything, much less Favorites are displayed.

D. Exporting the Favorites to a file, opening them in a word processing program and then
re-importing them will not change anything. This could work if the favorites were
reordered in the word processing program, but would be labor-intensive and not the best
solution.

QUESTION 262:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Clive Wilson is a member of the Finance department.
One morning Clive Wilson complains that he is trying to establish a connection to
Web sites that have URLSs that start with https://. But, Internet Explorer does not
establish a connection, and the user receives the following error message: "The page
cannot be displayed".

You need to ensure that Clive Wilson can establish a secure connection to Web sites
that have URLSs that start with https://.

What should you instruct

Clive Wilson to do in Internet Options in Control Panel?

A. Select the Use SSL 2.0 and Use SSL 3.0 check boxes on the Advanced tab.

B. Select the Do not save encrypted pages to disk check box on the Advanced tab.

C. Click the Clear SSL State button.

D. Click the Certificates button and import a user certificate to the personal certificate
store.

Answer: A

Explanation: We need to enable SSL (Secure Sockets Layer) to access pages over
https.
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QUESTION 263:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Amy Walsh is a member of the Research department.
One morning Amy Walsh complains that she made some changes in Internet
Explorer. As a result, she is being prompted to either allow cookies or block cookies
for almost every Web site she visits.

You need to ensure that Amy Walsh can visit Web sites without being prompted to
allow or block cookies.

What should you do in Internet Options in Control Panel?

A. Click the Default command button on the Privacy tab.

B. Click the Default Level command button on the Security tab.

C. Click the Restore Defaults command button on the Advanced tab.
D. Click the Reset Web Settings command button on the Programs tab.

Answer: A
Explanation: The Default setting will allow most cookies.
QUESTION 264:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Dean Austin is a member of the Research and
Development department. One morning Dean Austin complains that the Address
bar in Internet Explorer does not retain any frequently used URLS. The user states
that the contents of the Address bar is always empty. Dean Austin wants to access
frequently used Web sites from the Address bar.

What should you do in Internet Options in Control Panel to ensure that the Address
bar stores frequently used URLs?

A. Configure the History settings to keep pages in history for 30 days.

B. Configure the Temporary Internet files settings to check for newer versions of stored
pages automatically.

C. Select the Enable Personalized Favorites Menu check box on the Advanced tab.

D. Increase the amount of disk space available in the Temporary Internet files settings.
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Answer: A
Explanation: User wants to access frequently used web sites from the address bar.
QUESTION 265:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional with Service Pack 2 (SP2).

A Certkiller .com user named Amy Wilson is a member of the Sales department. One
morning Amy Wilson complains that she cannot receive these files, and instead
receives the following error message: "To help protect your security, Internet
Explorer blocked this site from downloading files to your computer.”

What should you do to configure Microsoft Internet Explorer to automatically
download files?

A. In Internet Explorer, on the Tools menu, click Internet Options. On the General tab,
click Settings, and set Check for newer versions of stored pages to Every visit to the
page.

B. In Internet Explorer, on the Tools menu, click Internet Options. Set the home page to
the URL for the company's internal Web site.

C. In Internet Explorer, on the Tools menu, click Internet Options. On the Privacy tab, set
the privacy settings to Low.

D. In Internet Explorer, on the Tools menu, click Internet Options. On the Security tab,
select the Local intranet icon, click Custom Level, and set the security level to Low.

Answer: D

Explanation: This issue has nothing to do with cached files or current home page as
the error message clearly states that it is a security issue so Option A&B is invalid.
Changing the privacy settings to low is not a good idea as these settings are for
Internet not you local intranet. Changing the Security level for your local intranet to
Low is the correct answer assuming that you can trust your own network.

QUESTION 266:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional with Service Pack 2 (SP2).

A Certkiller .com user named Amy Wilson is a member of the Research department.
One morning Amy Wilson complains that when she connects to the company's
external Web site, she periodically receives reminders to update her in-house
software. The company reminds the users by using a small window that opens when
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the Web site loads.
What should you do to allow Amy Wilson to see these update reminders when she
connects to the company's external Web site?

A. In Microsoft Internet Explorer, on the Tools menu, click Internet Options. On the
Privacy tab, select Block pop-ups. Click Settings, and add the company's external Web
site to the list of exceptions.

B. In Internet Explorer, on the Tools menu, click Internet Options. On the Security tab,
click the Local intranet icon. Click Custom Level, and set the security level to Medium.
C. In Security Center, click Windows Firewall, and set it to Off.

D. Close Internet Explorer. Disable any antivirus software, and then access the Web site.

Answer: A

Explanation: When Windows XP Service Pack 2 is installed, Internet Explorer

provides a pop-up blocker for blocking pop-up windows and displays a notification

in the information bar when a pop-up is blocked. Clicking the information bar

allows you to show the blocked pop-up, allow all pop-ups on the current site, and
configure other settings. To manually add a site to the list of exception do as stated

in option A.

Changing the security level on the local intranet to Medium will not help as the External
Web site is probably located in a DMZ, uses a separate network and therefore will not be
included in the sites listed under local intranet.

To disable the Windows Firewall or antivirus software is generally a bad idea and should
never be done unless the computer is disconnected from the network or on a 100% secure
network.

QUESTION 267:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Andy Reid is a member of the Research
departmentfrequently accesses the Acme.com Web site. The user reports that
pop-up advertisements always appear when she views the Web site at
www.Acme.com.

What should you do in Internet Options in Control Panel to ensure that pop-up
advertisement do not appear when the user connects to www.fabrikam.com and to
ensure that any changes do not affect the appearance of other Web sites?

A. Configure the security level of the Internet security zone to High.

B. Add the URL www.acme.com to the restricted sites security zone, and disable Active
Scripting for this zone.
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C. Add the URL www.acme.com to the Privacy settings for Web sites, and block cookies
for this Web.

D. Add the URL www.acme.com to the Local intranet security zone, and configure the
security level to Medium.

Answer: B

Explanation: While it is possible to completely disable active scripting, there are
legitimate sites for which you want active scripting enabled so you should add the
Fabrikam.com Web site to the restricted zone and then apply the active scripting
restriction to this zone. Disabling active scripting for your intranet would probably
stop some internal Web sites from functioning as intended. Raising the security level
for the Internet security zone to high would not solve the problem and probably

stop a lot of legitimate sites from working. Cookies are mostly used to store session
specific data about the visitor and has nothing to do with pop-ups.

QUESTION 268:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Mia Hamm is a member of the Marketing department.
One morning Mia Hamm complains that whenever she types

http://www. Certkiller .com into the Address bar, she receives the following error
message: "Your security settings prohibit ActiveX Controls on this page.”

You confirm that access to www.contoso.com is not blocked by the company
firewall.

What should you instruct Mia Hamm to do in Internet Options in Control Panel?

A. Configure the Privacy settings to Low.

B. Add www. Certkiller .com to the Trusted sites list.

C. Select the Check for signatures on downloaded programs check box on the Advanced
tab.

D. Select the Override automatic cookie handling check box in the Advanced Privacy
Settings dialog box.

Answer: B

Explanation: Settings for cookies or downloaded programs has nothing to with
Active X settings. Configuring the Privacy settings to low is not a good idea as this
will affect all sites the user will try to connect to. The right solution in this case, if
Certkiller .com is a legitimate site, would be to add the site to the trusted sites list. On
the Internet Explorer Tools menu, click Internet Option. Click the Security tab,
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then click the Trusted sites security zone. Click the Sites button and type the
address to the site in the Add this Web site to the zone box and click the Add button.

QUESTION 269:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Kara Lang is a member of the Sales department. One
morning Kara Lang complains thatit takes much longer to view Web pages when
she clicks the Back button. You discover that the user recently changed some
Internet Explorer settings on his computer.

What should you do in Internet Options in Control Panel to increase the speed at
which Internet Explorer displays previously viewed pages?

A. Click the Clear History button.

B. Select the Enable page transition check box on the Advanced tab.

C. Clear the Reuse windows for launching shortcuts check box on the Advanced tab.
D. Configure the temporary Internet files settings to automatically check for newer
versions of stored pages.

Answer: D

Explanation: The "Check for newer versions of stored pages" is by default set to
Automatically which means that Internet Explorer checks for a newer version at the
first visit after Internet Explorer was started but if a page is rarely updated Internet
Explorer will learn this and will not check every time.

QUESTION 270:

Exhibit:
Encryption Problems E]

—

' Microsoft Office Outlook had problems encrypting this messags becaluse
3\ the following reciplents had missing or Invalid certificates, or conflicting
or unsuppatted encryption capabilities:

Continue il encrypt snd send the message bt the bsted recipients
may rot be abls to read it

| send unencrvpted | i Cancel i

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
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computers run Windows XP Professional and Microsoft Outlook 2002.

A new Certkiller .com security policy requires that all e-mail messages sent to the
financial auditor must be encrypted.

An administrator issues a digital certificate for encrypting e-mail messages. Each
user sends the user's digital certificate to the auditor by using an e-mail message.
A Certkiller .com user named Dean Austin is a member of the Research and
Development department. Dean Austin complains that when he attempted to send
an encrypted e-mail message to the auditor, he receives the error message displayed
in the exhibit.

During routine monitoring you discover that all users are experiencing the same
problem

What should you do to ensure that users can encrypt e-mail messages sent to the
auditor?

A. Ask an administrator to configure all client computers to use IPSec.

B. Ask an administrator to configure a data recovery agent in Encrypting File System
(EFS).

C. Instruct the auditor to send her digital certificate to all users by using an e-mail
message.

D. Instruct each user to use Encrypting File System (EFS) to encrypt the user's digital
certificate. Then instruct each user to resend the digital certificate to the auditor by using
an e-mail message.

Answer: C

Explanation: It is the auditor account that has a problem because of the error
message or screen shot that is given in the example.

QUESTION 271:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

Certkiller .com contains a Microsoft Exchange Server 2003 computer named
Certkiller -SR10 for all messaging. The Certkiller -SR10 is configured to accept
POP3, IMAP4, and SMTP connections from remote users. Certkiller -SR10 is also
configured to allow SMTP relaying from authenticated users only.

A Certkiller .com user named

Rory Allen is a member of the Research department. Rory Allenhas just received a
new portable computer. Rory Allen states that he can receive e-mail by using POP3,
but he cannot send e-mail.

You confirm that the user can make SMTP connections to the Exchange server. You
also confirm that Outlook is configured to have the proper SMTP server address.
What should you do to ensure that Rory Allen can use Outlook to send e-mail from
his new computer?
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A. Configure Outlook to act as an IMAP4 client.

B. Configure Outlook to work only with message headers.

C. Configure Outlook to use encrypted SMTP connections.

D. Configure Outlook to use his POP3 credentials to authenticate to the SMTP server.

Answer: D

Explanation: The server allows SMTP relaying from authenticated users only.
Therefore, we need to configure Outlook authenticate to the SMTP server by using
his POP3 login credentials.

QUESTION 272:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and run Microsoft Outlook Express as the
default e-mail client.

You deliver the user name and password required for POP3 access to each user.
You instruct each user to configure Outlook Express with his or her user name and
password.

A Certkiller .com user named Andy Booth is a member of the Research and
Development department. One morning Andy Booth complains that he must
provide his credentials each time he starts Outlook Express.

During maintenance, you discover that he must provide his credentials each time he
starts Outlook Express. You discover that all other users are immediately allowed
into Outlook Express without providing credentials.

What is the most likely cause of the problem?

A. A signature is not created.

B. An S/IMIME certificate is not present.

C. Outlook Express is not configured to remember passwords.

D. Outlook Express needs to be directed to the Inbox folder as startup.

Answer: C

Explanation: To remember the password, you need to check the checkbox to
remember the password in the account properties.

QUESTION 273:
You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All

servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.
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A Certkiller .com customer named Andy Booth is a member of the Research
department. Andy Booth running Windows XP Home Edition and Microsoft
Outlook Express reports that he can no longer send e-mail messages. You verify
that he can successfully receive e-mail messages.

What information should you provide to the customer?

A. the correct POP3 configuration
B. the correct NNTP configuration
C. the correct SMTP configuration
D. the correct IMAP4 configuration

Answer: C

Explanation:

POP3 - Post Office Protocol, Version 3. Used to fetch e-mail, usually without leaving a
copy of the e-mail on the mail server.

NNTP - Network News Transfer Protocol. The protocol used by client and server
software to carry USENET postings back and forth over a TCP/IP network.

SMTP - Simple Mail Transfer Protocol. Used to send e-mail to and between servers.
IMAP4 - Internet Message Access Protocol 4. Used to fetch e-mail and is richer in
functionality than POP and is designed to allow clients to access and manage mailboxes
on the server as if they were local.

QUESTION 274:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

What will happen if you press the computer's power button on your desktop there
are several applications running?

A. Windows XP Professional will notify applications that it's going to shut down
B. All information will be lost instantly

C. Windows XP Professional has the power button function completely disabled
D. The applications will have corrupted DLLs

E. None of the above above.

Answer: A
Explanation: You may want to shut down your computer completely on occasion.
You can do this in either of two ways:

On the Start menu, choose Turn Off Computer, Turn Off. (If your computer is part of a
domain, click Start, Shut Down, select Shut Down, and then click OK).
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Press the computer's power button. (If you've configured it to switch to standby or
hibernation, press and hold the button for several seconds to perform a complete
shutdown).

In Windows XP, these two methods perform a controlled shutdown in exactly the same
way: the operating system notifies applications that it's going to shut down (giving them
an opportunity to save unsaved work), waits for responses, and then shuts down.

QUESTION 275:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

What should you do if you want to perform an emergency shutdown when a frozen
application prevents you from shutting down in the normal ways?

A. press Ctrl+Alt+Del to display Task Manager, then open the Shut Down menu and hold
down the Ctrl key as you click the Turn Off command.

B. press Ctrl+Alt+Del to display Task Manager, then open the Shut Down menu and hold
down the Alt key as you click the Turn Off command.

C. press Ctrl+Alt+Del to display Task Manager, then open the Shut Down menu and hold
down the F3 key as you click the Turn Off command.

D. press Ctrl+Alt+Del to display Task Manager, then open the Shut Down menu and hold
down the F4 key as you click the Turn Off command.

E. None of the above above.

Answer: A

Explanation: If a frozen application prevents you from shutting down in the normal
ways, you can use the following procedure. To perform an emergency shutdown,
press Ctrl+Alt+Del to display Task Manager. Open the Shut Down menu and hold
down the Ctrl key as you click the Turn Off command.

QUESTION 276:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You are considering deploying Hibernation. Rate this comment: Hibernation is an
option on systems even if they're neither APM nor ACPI-compliant.
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A. True
B. false

Answer: A

Explanation: Hibernation is an option on many systems, even if they're neither
APM (Advanced Power Management. nor ACPI-compliant). When you hibernate,
Windows XP copies everything in memory to disk and then powers down all
components of your computer.

QUESTION 277:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You are considering deploying Hibernation on your desktop which is XP and ME
dual boot configured. What will happen if you boot into another operating system
while hibernating?

A. your stored data will be corrupted or destroyed
B. your stored data will be fine

C. both OS will be corrupted

D. the boot loader will be destroyed

E. None of the above.

Answer: A

Explanation: Never boot into another operating system while your computer is
hibernating. That is, if your computer is set up so that it can boot into an operating
system other than Windows XP, do not hibernate Windows XP and then boot into
another operating system. Doing so can corrupt or destroy your stored data.

QUESTION 278:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

When a Windows XP Professional desktop hibernates, the OS stores the contents of
memory on your computer's boot partition in a file.

The new technician wants to know the name of this file?
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A. Hiberfil.sys
B. Hibernate.sys
C. Hiberfil.dat
D. Hiberfil.reg
E. Hiberfil.ini

Answer: A

Explanation: When you hibernate, Windows stores the contents of memory on your
computer's boot partition in a file named Hiberfil.sys. As long as hibernation is
enabled, you can't delete it, rename it, or move it to another disk or partition.

QUESTION 279:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You want to configure your system for hibernation. In the Power Options
Properties dialog box, what option should you select?

A. Hibernate - Enable Hibernation

B. ACPI - Enable Hibernation

C. You must first enable APM before going to Power Options
D. You don't do it through Power Options

E. None of the above.

Answer: A

Explanation: To configure your system for hibernation, in the Power Options

Properties dialog box, click the Hibernate tab and select Enable Hibernation.

You can configure other hibernation options to set an inactive time limit to automatically
switch to hibernation (Power Schemes tab., assign a button on the computer to switch the
computer to hibernation (Advanced tab., or require a password to resume from
hibernation Advanced tab)). Although the check box mentions only standby, it affects
emergence from hibernation also.

QUESTION 280:
You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All

servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.
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You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You want to configure your system for hibernation. To configure your system for
secure hibernation, in the Power Options Properties dialog box which tab should
you choose?

A. Advanced

B. Security

C. Power Schemes
D. ACPI

Answer: A

Explanation: You can configure other hibernation options to set an inactive time
limit to automatically switch to hibernation (Power Schemes tab., assign a button on
the computer to switch the computer to hibernation (Advanced tab., or require a
password to resume from hibernation Advanced tab)). Although the check box
mentions only standby, it affects emergence from hibernation also.

QUESTION 281:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

The new technician wants to configure your system for hibernation. To assign a
button on the computer to switch the computer to hibernation, in the Power Options
Properties dialog box which tab should you choose?

A. Advanced

B. Security

C. Power Schemes
D. ACPI

E. None of the above.

Answer: A

Explanation: You can configure other hibernation options to set an inactive time
limit to automatically switch to hibernation (Power Schemes tab., assign a button on
the computer to switch the computer to hibernation (Advanced tab., or require a
password to resume from hibernation Advanced tab)). Although the check box
mentions only standby, it affects emergence from hibernation also.

Actualtests.com - The Power of Knowing




070-272

QUESTION 282:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

The new technician wants to log off, shut down, or restart a computer from the
command line, what command will he use (choose all that apply).

A. Shutdown

B. Logoff

C. Restart

D. This cannot be done via the command line

Answer: A

Explanation: Windows includes a command-line utility, Shutdown.exe that allows
you to log off, shut down, or restart a computer.

QUESTION 283:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professionaland Microsoft Office XP.

A Certkiller .com user named Dean Austin is a member of the Research and
Development department. Dean Austin has a computer that runs both Windows 98
and Windows XP Professional in a dual-boot configuration. Dean Austinreports
that an application is available on the Start menu when he runs Windows 98, but it
is not available on the Start menu when he runs Windows XP Professional.

What should you do to ensure that the application will run on either Windows 98 or
Windows XP Professional?

A. Ask an administrator to install the application when the computer is running Windows
XP Professional.

B. Ask an administrator to reinstall the application when the computer is running
Windows 98. Then instruct the administrator to select the option to install for All

users during the installation.

C. Instruct the user to start the computer with Windows XP Professional running. Instruct
him to create a shortcut to the application's .exe file located in the Windows 98 folder
structure. Then instruct him to select the Run in separate memory space check box.

D. Instruct the user to start the computer with Windows XP Professional running. Instruct
him to create a shortcut to the application's .exe file located in the Windows 98 folder
structure. Then instruct him to configure the Compatibility mode tab to run the
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application under Windows 98.
Answer: D

Explanation: Because Windows XP has no problems reading the Windows 98
partition but Windows 98 might have problems read the Windows XP partition its
better to keep the program in its original place. Create a shortcut within Windows
XP and configure the Compatibility mode to run the application in a Windows 98
environment. Although most programs run properly on Windows XP, some older
applications (especially games) that were written for a specific operating system
such as Microsoft Windows 95 or Windows 98 do not work as expected (or do not
install at all). When this happens, install or run the program using one of the
available program compatibility options in Windows XP. Choosing a program
compatibility mode for a program allows that program to run in its native
environment, which should cause the program to run properly and perform as
expected.

QUESTION 284:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

Certkiller .com contains a client computer named Certkiller -WS290 that runs both
Windows 98 and Windows XP Professional in a dual-boot configuration. Windows
XP Professional is installed on the D volume, which is NTFS. A custom application
is available when the user logs on to either operating system.

A Certkiller .com user named Mia Hamm is a member of the Research department.
Mia Hammcomplains that when she logs on to Windows 98, she is unable to access
files that were created when she was logged on to Windows XP Professional. You
discover that App1 stores files to the D:\App1\Data folder when logged into
Windows XP Professional.

What should you do to ensure that files created by using Appl, when the user is
logged into Windows XP Professional, are available to both Windows 98 and
Windows XP Professional?

A. Convert the C volume to NTFS.

B. Instruct the user to share the D:\App1\Data folder.

C. Instruct the user to store all files created by using Appl to C:\App1\Data.

D. Create a local user account for the user.

Instruct the user to log on by using the local user account.

E. Configure the access control list on the D:\App1\Data folder to grant the Everyone
group Full Control permission.

Answer: C
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Explanation: She is unable to access the file she created while in Win XP through
Win98 there is a file system problem (NTFS & FAT). Storing the files on her
C drive will enable her to access in them both OS.

QUESTION 285:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

Certkiller .com contains a network file server named Certkiller -SR11 where all
user data is stored.

The five Certkiller .com users in the company use a computer named

Certkiller -WS290. The Certkiller .com users' logs on to Certkiller -WS290 by
using a separate logon name. Certkiller -WS290 runs an application named Appl.
You create a shortcut to Appl in the All Users profile on Certkiller -WS290. Each
of the five users can access Appl by using the shortcut.

Some of the users report that one user deleted the shortcut to Appl. Now, the other
users cannot use Appl when they use Certkiller -WS290.

You need to ensure that one user cannot delete the App1l shortcut for other users.
Your solution must ensure that the shortcut is configured automatically for each
user. Your solution must not affect any other computers on the network.

What should you do?

A. Create one shortcut to Appl. Save the shortcut in the Default Users profile on
Certkiller -WS290. Delete all profiles on Certkiller -WS290.

B. Create a shortcut to Appl for each user. Save each shortcut in the All Users profile on
Certkiller -WS290. Delete all profiles on Certkiller -WS290.

C.

Ask an administrator to create one shortcut to Appl. Ask the administrator to save it in
the Default Users profile on a domain controller. Delete all profiles on

Certkiller -WS290.

D. Ask an administrator to create a shortcut for Appl for each user. Ask the administrator
to save the shortcuts in the All Users profile on a domain controller. Delete all profiles on
Certkiller -WS290.

Answer: A

Explanation: By placing the shortcut in the default users profile and then deleting
the users profiles you will force the creation of a new profile for each user that
contains the new shortcut. If a user deletes the shortcut after this it will only affect
the user who deleted it.

QUESTION 286:

You work as the network administrator at Certkiller .com. The Certkiller .com
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network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

Certkiller .com contains a network file server named Certkiller -SR11 where all
user data is stored.

A Certkiller .com user named Andy Booth is a member of the Research department.
Andy Boothcomplains that that his desktop is cluttered with too many shortcuts and
the Display settings are incorrect. He states that he wants to clean up his desktop
and configure his Display settings correctly. He also wants to return the Start menu
to its original default settings.

What should you do to ensure that Andy Booth's desktop, Display settings, and
Start menu are configured to have their original default settings?

A. Delete Andy Booth's profile.

B. Configure the computer by using System Restore.

C. Instruct Andy Booth to set the Start menu to Classic mode.

D. Instruct Andy Booth to start the computer by using the last known good configuration.

Answer: A

Explanation:
The user's data is stored on a file server. Therefore we can delete the user's profile.
A new profile with the default settings will be created next time the user logs in.

QUESTION 287:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

Due to company growth Certkiller .com has two operator shifts: morning and
evening. Both operator shifts share the same computer. The morning operator uses
an application named Appl, which is deployed by using Group Policy. The evening
operator does not use App1.

The evening operator reports that she can see a shortcut to Appl, but that the
application does not run. You log on to the evening operator's computer and see the
shortcut for App1l.

What should you do to ensure that only the morning operator can see the shortcut
to Appl?

A. Delete the evening operator's user profile.

B. Delete the shortcut from the All Users profile.

C. Delete the shortcut from the Default Users profile.

D. Create a new evening operator's user profile by copying the Default User's profile.
E. Create a new morning operator's user profile by copying the Default User's profile.
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Answer: B

Explanation: If the application is not meant for all users of a computer then you
should make sure the shortcut exist only in those users profiles that are allowed to
use the application.

QUESTION 288:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professionaland a proprietary application named
Appl.

A Certkiller .com user named Clive Wilson is a member of the Sales department.
One morning Clive Wilson complains that his desktop shortcut for Appl no longer
runs Appl. The user states that he recently moved the Appl program folder from
drive C to drive D. He states that he used the same folder structure to move the
contents to drive D.

You attempt to run Appl by using the executable file located in drive D, but the
application still fails to run.

What should you do to ensure that the application works with the program files
located on drive D of Clive Wilson's computer?

A. Instruct Clive Wilson to modify the shortcut to use the new folder structure located on
drive D.

B. Instruct Clive Wilson to delete the shortcut on the desktop. Then ask an administrator

to reinstall Appl on drive D.

C. Instruct Clive Wilson to delete the shortcut on the desktop. Then instruct Clive Wilson
to create a new shortcut that uses the new folder structure located on drive D

D. Ask an administrator to delete the current user profile. Instruct Clive Wilson to log on
to his computer and run App1l.

Answer: B

Explanation: As the application fails to execute, even when you try to run the
application from the new folder on the D drive, it will not help to modify or create a
new shortcut. The application probably needs registry entries that were written
during the installation of the application that points to the original location of the
application. Only way to correct this is by reinstalling the application.

QUESTION 289:
You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All

servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.
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Certkiller .com contains a client computer named Certkiller -WS100 which is used
by multiple users and has a new application that must be available to all users of the
computer.

A Certkiller .com user named

Andy Reid is a member of the Research department. Andy Reidthat also uses
Certkiller -WS100reports that he does not have access to Appl, nor can he run the
executable for Appl located in the program files. You discover that only the user
who installed Appl can run it.

What should you do to ensure that each user that logs on to the client computer can
run Appl?

A. Reinstall Appl by using the All Users option.

B. Repair Appl by using Add or Remove Programs in Control Panel.

C. Configure a software restriction for Appl on Certkiller -WS100.

D. Create a new user profile for each user by copying the Default User profile.

Answer: A

Explanation: Wrong answers - Repairing the application will not help as the
application itself is not broken as it works for the user that originally installed it.
Software restrictions are used to specify software that is or isn't allowed to run so
that you can protect your organization from untrusted programs (and prevent users
from distractions, too). Copying the default profile to all users will not help as the
shortcut and possibly registry values that where created during the installation will
be associated the installing users profile, not to the default profile.

Right Answer - You should use the All Users option to install the application so that
shortcuts, needed registry changes and permissions get associated to the All Users
"profile” that gets added upon every users profile on that computer.

QUESTION 290:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Rory Allenreceives a computer that had been
previously used by another user. Rory Allenhas no saved any documents or other
personal information on the computer.

Rory Allenreports that Office is configured with the former user's toolbar
customizations, spelling and grammar settings, and other preferences.

What should you do to reset Office to its default settings on the user's computer as
quickly as possible?

A. Instruct the user to select Delete and Repair... from the Help menu in an Office

application.
B. Instruct the user to remove Office and reinstall it by using Add or Remove Programs
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in Control Panel.

C. Create a new local user account on the computer for this user, and instruct the user to
log on by using this new account.

D. Remotely delete the HKEY _LOCAL_MACHINE\Software\Microsoft\Office registry
key on the user's computer.

Answer: C

Explanation: The user did not only get a previously used computer but also a
previously used user account. Office customizations such as the toolbar, spelling and
grammar and other preferences are all saved in the users profile in a subfolder in

the local settings\application data\Microsoft folder.

QUESTION 291:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Andy Booth is a member of the Sales department.
Andy Boothcomplains that that Microsoft Excel will no longer open on his
computer. When the user attempts to open Excel, he receives an error message
indicating that a required file or DLL is missing.

What should you do to ensure that Andy Booth can open Excel and to achieve this
goal as quickly as possible?

A. Repair Office by using Add or Remove Programs in Control Panel.

B. Copy the DLL files from a network-based Office installation point to his local
computer.

C. Visit the Microsoft Update Web site. Scan for and install all available updates.

D. Select Detect and Repair... from the Help menu in an Office application other than
Excel.

Answer: A

Explanation: You should not try to replace missing DLL files manually as there may
be different version of the DLL file and additional files missing. The easiest way to
correct this problem is by choosing Repair in the Add/Remove programs in Control
Panel

QUESTION 292:
You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All

servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office 2003.
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A Certkiller .com user named Dean Austin is a member of the Research and
Development department. Dean Austin complains that that his Microsoft Excel
spreadsheet is not working properly. You discover that he receives a message
stating that his security settings prevent him from running macros when he opens
the Excel file.

What should do to ensure that Dean Austin can open the Excel file and run the
macros?

A. Add Dean Austin to the computer's Power Users group.

B. Add Dean Austin to the computer's Administrators group.

C. In Excel, in the Macro option on the Tools menu, select Macros.

D. In Excel, change the Macro security settings to Medium and enable macros if
prompted.

Answer: D
Explanation: This is correct because the user will be prompted to open it or not.
QUESTION 293:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named Clive Wilson is a member of the Research and
Development department. Clive Wilson complains that that macros that previously
worked in Microsoft Excel do not run after he installed Windows XP Service Pack 2
(SP2). Clive Wilson receives the following error message: "Macros in this workbook
are disabled because the security level is high, and the macros have not been
digitally signed or verified as safe.

What should you do to configure Excel to automatically run macros that are
included in spreadsheets?

A. In Excel, on the Tools menu, click Options. On the Security tab, click Macros
Security, and then set the macro security level to Low.

B. In Excel, on the Tools menu, click Options. On the Security tab, click Macros
Security, and then set the macro security level to Medium.

C. In Excel, on the File menu, click Permission, and then select Unrestricted Access.
D. In Excel, on the Tools menu, click Protection, and then select Allow users to edit
ranges.

Answer: A
Explanation: Office XP offers three levels of macro security - High, Medium, and

Low. By default, all Office XP applications are installed with the macro security
level set to High, which means that if a user opens an Office document that contains
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suspicious macros, Office disables the macros before opening the file. (A suspicious
macro is any macro or other executable code that has not been digitally signed by a
certified source.) If the security level is set to Medium, users are warned when a
document contains suspicious code, but they can choose to open the file and run the
macros anyway. If the security setting is set to Low, no security check is performed.

QUESTION 294:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Mia Hamm is a member of the Research and
Development department. Mia Hamm complains that that when she attempts to
access Web pages on the Internet, she receives the following error message.

Microsofi Internet Explorer

' Your current security settings prohibit running ActiveX controls on this page. 45 a
» rasult, the page maw not display correckiy.

During a routine maintenance, you discover that that Mia Hamm recently changed
some Internet Explorer settings on her computer.

What should you do in Internet Options in Control Panel to ensure that Mia Hamm
can view all content on Internet Web sites?

A. Configure the security settings for the Internet zone to Medium.
B. Configure the security settings for the Local intranet zone to Low.
C. Configure the Privacy setting for the Internet zone to Low.

D. Configure the Advanced Privacy to always allow session cookies.

Answer: A

Explanation: The security settings are set too high. Lowering them to 'Medium' will
allow signed ActiveX controls.

QUESTION 295:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional with Service Pack 2 (SP2).

A Certkiller .com user named Kara Lang is a member of the Research and
Development department. Kara Lang complains that she frequently access a Web
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site that offers weather information that she needs to do their work. The content is
stored locally for offline use. Kara Lang says that they could view animated maps
before she installed new computers. Now she cannot view the animated maps.
What should you do to download dynamic content from the Web site?

A. Download the latest updates for Microsoft Internet Explorer by using Windows
Update.

B. In Internet Explorer, on the Tools menu, click Internet Options. On the Advanced tab,
under Security, select Allow active content to run in files on my computer.

C. In Internet Explorer, on the Tools menu, click Internet Options. On the Privacy tab, set
the privacy setting to Low.

D. In Windows Firewall, on the Exceptions tab, click Add a Program, and then add
Internet Explorer.

Answer: B

Explanation: Definition of active content - Refers to content on a Web site that is

either interactive, such as Internet polls or opt-in features, or dynamic, such as

animated GIFs, stock tickers, weather maps, JavaScript applications, embedded

objects, streaming video and audio or ActiveX applications.

To allow any Web site to run scripts and ActiveX controls on your computer - In Internet
Explorer, on the Tools menu, click Internet Options. On the Advanced tab, scroll down to
the Security section of the list. Select the Allow active content to run in files on My
Computer check box, and then click OK.

To accomplish this via the Registry, modify the following registry value:

HKCU \ Software \ Microsoft \ Internet Explorer \ Main \ FeatureControl \
FEATURE_LOCALMACHINE_LOCKDOWN

QUESTION 296:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Amy Walsh is a member of the Research and
Development department. Amy Walsh complains that she is unable to change the
address of her home page in Internet Explorer.

During a routine maintenance, you discover thatthe Address field in Amy Walsh's
Internet Options in Control Panel is unavailable and prevent the home page address
from being changed.

Which of the following is the cause of the problem?

A. A Group Policy object (GPO) is enabled to customize the home page URL.
B. The Privacy settings on the user's computer have been configured to High.
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C. The URL of the home page on the user's computer has been added to the Restricted
sites security zone.

D. The user only has the Allow - Read NTFS permission on the c:\Program Files\Internet
Explorer directory.

Answer: A

Explanation: Group Policy supports the administration and customization of
Microsoft Internet Explorer on computers running Windows 2000, Windows XP,
and Windows Server 2003. The GPO contains a Custom URLSs setting for specifying
the URLSs that appear on users' browsers, such as the Home page, Search page, and
customized Favorites and Links. High Privacy settings will not affect the possibility
to change Home page URL. Even if the URL of the home page had been added to
the Restricted sites security zone it would not stop the user from changing the home
page URL. A users home page settings are not stored in the C:\Program
Files\Internet ExIporer directory, it is stored in the users profile.

QUESTION 297:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named

Ally Wagner is a member of the Research and Development department. Ally
Wagner complains that she cannot access any of the previously saved e-mail
messages in Microsoft Outlook and that folders previously visible are missing.
What should you do first to ensure that Ally Wagner can access all of her previously
saved e-mail messages?

A. Configure Ally Wagner's Outlook profile to open the original .pst file.

B. Create a new .ost file on Ally Wagner's computer and resynchronize to the Exchange
server.

C. Configure Ally Wagner's Outlook profile to open the auto archive message store.

D. Run the Outlook Detect and Repair... utility on Ally Wagner's computer.

Answer: A

Explanation: During the setup of Outlook the program will create a new default .pst
file. You will have to copy the old .pst file from the old computer to the new
computer and the redirect Outlook to the new .pst file.

QUESTION 298:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All

Actualtests.com - The Power of Knowing




070-272

servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional with Service Pack 2 (SP2).

Certkiller .com is in the business of developing small applications for its customers.
For testing purposes, users in the development department and the testing
department send executable files to each other by using Microsoft Outlook Express.
A Certkiller .com user named Amy Wilson in the testing department reports that she
cannot receive e-mail attachments when she uses Outlook Express. The user needs
the attachments to conduct business, and she needs to receive them by using
Outlook Express.

What should you do?

A. In Outlook Express options, on the Security tab, clear Do not allow attachments to be
saved or opened that could potentially be a virus.

B. In Outlook Express options, on the Read tab, select Automatically download message
when viewing in the Preview pane.

C. In Outlook Express options, on the Security tab, set the Microsoft Internet Explorer
security zone to Internet zone.

D. In Outlook Express options, on the Security tab, clear Block images and other external
content in HTML e-mail.

Answer: A

Explanation: Service calls regarding attachments can be varied, but they likely

revolve around attachments that cannot be opened or attachments that cannot be

sent. Sometimes an attachment is unavailable or does not have a program associated
with it. Sometimes e-mail with attachments remains in the Outbox or causes error
messages on sending. The first problem is the most common; almost all service calls
regarding the inability to open attachments can be resolved by clearing a single

check box. When a user reports that attachments are unavailable and cannot be

opened, follow these steps:

1. From the Tools menu, choose Options, and select the Security tab.

2. Clear the Do Not Allow Attachments To Be Saved Or Opened That Could Potentially
Be A Virus check box. Click OK.

3. Close and reopen Outlook Express.

If this does not solve the problem, or if the problem is one of the others mentioned, you
have to delve a little deeper. If the user is a member of a domain, check domain policies
for dealing with attachments. In some instances, network policies will not allow
attachments to be opened. This policy is not common, however, as attachments are a
large part of corporate life; but if the preceding procedure does not resolve the problem,
you need to check on this.

QUESTION 299:
You work as the network administrator at Certkiller .com. The Certkiller .com

network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
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computers run Windows XP Professional and run Microsoft Outlook Express as the
default e-mail client.

A Certkiller .com user named Andy Booth is a member of the Finance department.
Andy Boothcomplains that he is not immediately receiving all of his e-mail
messages. Andy Booth states that when he clicks the Send and Receive All button,
he then receives the e-mail messages. He also states that when he restarts Outlook
Express, he receives e-mail messages.

What should you do to ensure that Andy Booth receives his new e-mail messages
more quickly?

A. Configure user authentication for the outgoing e-mail server.
B. Configure Outlook Express to remember the user's password.
C. Create an e-mail rule for processing all messages.

D. Reduce the interval for checking e-mail messages.

E. Reduce the Outlook Express process thread priority.

Answer: D

Explanation: Wrong answers - User authentication for outgoing e-mail server has
nothing to do with incoming e-mail. Configuring Outlook Express to remember the
user's password will not affect how often Outlook Express looks for new messages.
E-mail rules will only process messages once they are received. Reducing the
process thread priority will only change the priority of the Outlook Express
application when the computer is under heavy load.

Right Answer - This is how you change the time interval for Outlook Express to check
for new messages:

1. Launch Outlook Express

2. Select Tools, Options.

3. Set the desired time interval in the 'Send/Receive' area on the General Tab.

QUESTION 300:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

What should you do to the desktop that use power management features but both
standby and hibernate don't work?

A. install an updated driver for your display adapter.
B. install an updated driver for your BIOS.

C. install an updated driver for your SCSI BIOS.

D. install an updated driver for your NIC.
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Answer: A

Explanation: Power management features-in particular standby and
hibernation-rely on device drivers that support power management in addition to
compatible hardware. In particular, incompatible video drivers prevent these
features from working. The built-in VGA driver, for example, is a bare-bones driver
that doesn't support power management. If standby and hibernate don't work,

install an updated driver for your display adapter.

QUESTION 301:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Dean Austin is a member of the Research and
Development department. Dean Austin complains that when he attempts to run a
32-bit application, he receives an error message indicating that the computer must
have at least a 256-color display.

During an investigation you confirm that Dean Austin's computer is configured to
display millions of colors and is capable of running the application.

What should you do to ensure that Dean Austin can run the 32-bit application
without degrading the computer's performance or the appearance of the Windows
display?

A. Instruct the user to run the application from a command prompt.

B. Instruct the user to configure the Windows display settings to display only 256 colors.
C. Install a video driver capable of producing a 256-color display.

D. Configure application compatibility for the application so that Windows reports a
256-color display to the application.

Answer: D
Explanation: No other answer makes sense.
QUESTION 302:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com customer named Rory Allen is running Windows XP Home Edition
and Microsoft Outlook Express installs a new evaluation copy of a third-party

e-mail client on his computer.

Rory Allen complains that Outlook Express is not the e-mail client that starts when
he accesses saved e-mail messages.
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What should you do to ensure that Outlook Express is the e-mail client that starts
when Rory Allen accesses saved e-mail messages?

A. Define a new view in Outlook Express that shows all messages.

B. Customize the existing view in Outlook Express to show all messages.
C. Configure Outlook Express to be the default e-mail client.

D. Configure Outlook Express to send and receive messages at startup.

Answer: C
Explanation: User wants outlook as his default email client.
QUESTION 303:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

What should you do to be able to see the taskbar at all times except when a window
is maximized or placed over the taskbar?

A. from the Task bar And Start Menu Properties dialog box clear the Keep The Taskbar
On Top Of Other Windows option

B. from the Task bar And Start Menu Properties dialog box check the Keep The Taskbar
On Top Of Other Windows option

C. from the Task bar And Start Menu Properties dialog box clear the Auto-Hide The
Taskbar option

D. from the Task bar And Start Menu Properties dialog box check the Auto-Hide The
Taskbar option

Answer: A

Explanation: By default, the taskbar remains visible even when you're working in a
maximized program. If that's inconvenient for any reason, you can tell it to get out

of the way. The Taskbar And Start Menu Properties dialog box offers two options to
control this behavior.

Keep The Taskbar On Top Of Other Windows. Clearing this check box means you'll be
able to see the taskbar at all times except when a window is maximized or placed over the
taskbar.

Auto-Hide The Taskbar. With this option selected, the taskbar retreats into the edge of
the desktop. To display the taskbar, move the mouse pointer to the edge of the desktop
where the taskbar is located.
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QUESTION 304:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com user named Andy Reid has set options in the Taskbar And Start
Menu Properties dialog box. After that the taskbar becomes invisible.

What should you do? (Choose all that apply).

A. press the Windows logo key
B. press Ctrl+Esc.

C. press Alt+Esc.

D. press Shift+Esc.

Answer: A, B

Explanation: Regardless of how you set options in the Taskbar And Start Menu
Properties dialog box, you can make the taskbar visible at any time by pressing the
Windows logo key or Ctrl+Esc.

QUESTION 305:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com user named Clive Wilson want to edit the content of the Standard
Buttons toolbar of your IE.

What should you do? (choose all that apply)

A. choose View, Toolbars, Customize

B. right-click the toolbar and choose Customize from the shortcut menu
C. write a short script for execution with iexplore

D. you cannot do this

Answer: A, B
Explanation: To edit the content of the Standard Buttons toolbar, you may choose

View, Toolbars, Customize (or right-click the toolbar and choose Customize from
the shortcut menu.. To add a button to the toolbar, drag it from the Available
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Toolbar Buttons window of the Customize Toolbar dialog box to the location of
your choice in the Current Toolbar Buttons window.

QUESTION 306:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Mia Hamm is a member of the Research and
Development department. One morning Mia Hamm complains that she moved a
toolbar in Internet Explorer by mistake. She was able to move the toolbar back to
its original position, but she wants to prevent the toolbars from being moved in the
future.

What should you do on the View menu in Internet Explorer to ensure that Mia
Hamm can prevent toolbars in Internet Explorer from being moved?

A. Select Stop

B. Select Status Bar

C. Select Full Screen

D. Point to Toolbars and select Lock the Toolbars

Answer: D

Explanation: Locking the toolbars will prevent accidental movement or
modification. None of the other answers make sense, given the explanations below.
Incorrect Answers:

A. Pressing Stop will stop all loading of whatever web page is being sent at the time. If
the page is fully loaded, then this button has no effect. It has no effect on any toolbar.
B. Selecting the Status Bar is not possible. The most that can be done is to display it or
not. This is done under "View -> Status Bar". This shows the little bar at the bottom of
the screen that details thins like current web page, what zone you're in, and whether a
cookie has been blocked lately.

C. Selecting Full Screen will simply make IE fill the entirety of the screen, making the
toolbars disappear. This will neither get them back once they have been altered nor
prevent them from being changed again.

QUESTION 307:
You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All

servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.
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A Certkiller .com customer named Rory Allen running Windows XP Home Edition
reports that he cannot find several of the buttons that usually appear on the
Standard Buttons toolbar in Microsoft Internet Explorer.

What should you do to ensure that Rory Allen can return the standard buttons to
the Standard Buttons toolbar?

A. Click the Restore Defaults button on the Advanced tab in Internet Options in Control
Panel.

B. Click the Reset Web Settings button on the Programs tab in Internet Options in
Control Panel.

C. On the View menu in Internet Explorer, point to Toolbars and clear Lock the
Toolbars.

D. On the View menu in Internet Explorer, point to Toolbars, select Customize, and click
the Reset button.

Answer: D

Explanation: Resetting the toolbars will set them to their default configuration. Any
buttons that were added will be removed, and any that are missing will be readded.
Note that this will make the toolbars appear as they did when Internet Explorer was
originally configured.

Incorrect Answers:

A. Restoring the defaults from the Advanced tab will not reset the toolbars. These
settings affect things like image place holders, whether a site's certificate is checked for
revocation, and enabling the java compiler among other things.

B. Resetting the web settings will reset what program opens when a news link is clicked,
a web page is selected to be edited, or what program opens when an email link is clicked.
It will not affect the toolbars.

C. Locking the toolbars will prevent changes to the toolbars, but will not change the
toolbars back to their original configuration.

QUESTION 308:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Andy Booth is a member of the Research and
Development department. Andy Booth complains that that when he opened an
e-mail attachment named Resume.doc, it ran a script instead of opening the file in
Microsoft Word. Andy Booth than ran a virus scanner on his computer. The virus
scanner detected the Resume.doc file as a virus and deleted the file.

What should you do on the View tab of Folder Options in Control Panel to ensure
that Andy Booth can tell if a file he receives is actually a Word document or a
script?
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A. Select the Show hidden files and folders option button.

B. Select the Display the full path in the title bar check box.

C. Clear the Hide extensions for known file types check box.

D. Clear the Hide protected operating system files (Recommended) check box.

Answer: C

Explanation: Clearing the Hide extensions for known file types check box will show
the full file extension. For example, the resume.doc file was probably named
resume.doc.scr. The .scr shows that the file is actually a script file.

QUESTION 309:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named

Ally Wagner is working from home. Ally Wagner has a computer that is running
Windows XP Home Edition and Microsoft Internet Explorer. Ally Wagner
complains that her Favorites list is frequently altered. You discover that she shares
her computer with other family members.

What should you do for each family member to ensure that Ally Wagner's Favorites
list stays consistent when she logs on?

A. Create and use a user profile.

B. Create and use a Microsoft Outlook Express identity.

C. Create and use an Internet Explorer Address book identity.

D. Create a separate Favorites folder under the My Documents folder.

Answer: A

Explanation: The user favorites list keeps changing. You must make sure for the
user. Creating a user profile for each family member will stop this change from
happening.

QUESTION 310:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

You explained for the CI10 that when a Windows XP Professional desktop
hibernates, the OS stores the contents of memory on your computer's boot partition
inafile.
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What is the name of this file?

A. Hiberfil.sys
B. Hibernate.sys
C. Hiberfil.dat
D. Hiberfil.reg
E. Hiberfil.ini

Answer: A

Explanation: When you hibernate, Windows stores the contents of memory on your
computer's boot partition in a file named Hiberfil.sys. As long as hibernation is
enabled, you can't delete it, rename it, or move it to another disk or partition.

QUESTION 311:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications. Multiple identities have been created on the
OE.

What should you do to consolidate all messages into one identity?

A. Import and export the messages between identities

B. Copy and paste the messages folder by folder

C. Save all messages into a text file and then copy all content to the current identity
D. There is nothing you can do

E. None of the choices.

Answer: A

Explanation: You can use Outlook Express's Import command to import messages
from one identity into another. Choose File, Import, Messages, Microsoft Outlook
Express 6, and then specify the identity you want to import from

QUESTION 312:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications. You have received instruction from the CIO to
set up OE as your email client.
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In OE you need to setup several different email accounts which have similar
settings. What should you do if you do not want to do repeat typing for every
account?

A. Copy and paste the accounts

B. Export and import the accounts

C. Run an account creation script

D. Create the accounts form the command line

Answer: B

Explanation: If you don't ever want to be bothered re-creating an e-mail account,
choose Tools, Accounts, select the account name, and then click Export. Outlook
Express will save your account settings in an .iaf file. If you ever need to re-establish
the account-on this computer or another-you can import that .iaf file.

QUESTION 313:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications. You have received instruction from the CIO to
set up OE as your email client.

True or false: OE and Address Book are two separate applications.

A. True
B. False

Answer: A

Explanation: Outlook Express is tightly integrated with Address Book, a separate
application designed to be shared by other programs that use contact
information-fax clients, teleconferencing software, and the like. You can run
Windows Address Book from Outlook Express by simply clicking Addresses on the
toolbar.

QUESTION 314:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.
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Certkiller .com contains a client computer which has Outlook installed on it.
What should you do if you want to share contact information between Outlook and
Address Book?

A. Edit the registry

B. Configure Outlook's server option

C. Configure Outlook's mail reading option

D. Run wab -ex

E. Export the address book entries to Outlook one by one

Answer: A

Explanation: To share contact information between Outlook and Address Book,
open Registry Editor, and go to HKCU\Software\Microsoft\WAB\WABA4. Add the
DWORD value UseOutlook to this key (if it isn't already present., and set itto 1. To
return to the unintegrated state, return to this registry value and either delete it or
setitto 0.

QUESTION 315:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications. You have received instruction from the CIO to
set up OE as your email client.

If you export an existing account, what file format will OE use for this export?

A. .iaf
B. .irc
C. .dbx
D. .idx

Answer: A

Explanation: If you don't ever want to be bothered re-creating an e-mail account,
choose Tools, Accounts, select the account name, and then click Export. Outlook
Express will save your account settings in an .iaf file. If you ever need to re-establish
the account-on this computer or another-you can import that .iaf file.

QUESTION 316:

You work as the network administrator at Certkiller .com. The Certkiller .com

network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
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computers run Windows XP Professional.

A Certkiller .com customer named Rory Allen running Windows XP Home Edition
and Microsoft Outlook Express reports that he cannot access previously saved
e-mail messages. You verify that there are no e-mail messages when Rory Allen
opens Outlook Express.

What should you do to ensure that Rory Allen can access his previously saved
e-mail mess?

A. Import the Internet account settings into Outlook Express.

B. Import the e-mail account configuration settings into Outlook Express.

C. Search for files with the .pst extension. Import the e-mail messages from the .pst file.
D. Search for files with the .dbx file extension. Import the e-mail messages from the .dbx
file.

Answer: D

Explanation: The probable cause for this problem is that the user is not loading his
dbx files when Outlook Express launches. This is usually due to the user moving the
dbx files, and Outlook Express can no longer find them.

Incorrect Answers:

A. You can not import Internet Account Settings. Even if it were possible, the problem
does not lie in the internet account. The question states that he does not have access to
saved messages. This almost always indicates a PST file, and since PST files are almost
always local, the internet connection is not the issue.

B. There is no problem with email account settings. The question does not state that the
user can not log on. It merely states that he can not pull up previously saved messages.
C. PST files are used with Outlook, not Outlook Express.

QUESTION 317:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You are using OE as your mail client. You want to exchange electronic business
cards with other users via e-mail. What electronic business card standard does OE
support?

A. vCard
B. X700
C. X600
D. eCard
E. sCard

Actualtests.com - The Power of Knowing




070-272

Answer: A

Explanation:

Address Book supports the vCard format, which allows you to exchange electronic
business cards with other users via e-mail. To send your business card to another
user, first create an address book record for yourself. Then select your record in
Address Book, and choose File, Export, Business Card (vCard.. This creates a file
with the extension .vcf.

QUESTION 318:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Outlook Express.

A Certkiller .com user named Dean Austin is a member of the Research department.
Dean Austincomplains that he wants to copy contacts from his mobile phone to
Outlook Express. The mobile phone does not have a synchronization application
that is compatible with Outlook Express. However, the mobile phone does support
saving the contacts to a comma-delimited file.

Which file type should you to use to help Dean Austin select a file type that allows
him to import the contacts from his mobile phone to Outlook Express?

A. An LDIF file

B. A text file

C. An Excel spreadsheet file

D. A Windows address book file

Answer: B

Explanation: Since the mobile phone does not support Outlook Express, a common
format must be used. The only common format between the phone and Outlook
Express is the comma delimited (text) file. Outlook Express can then import the file
and saved as an Address Book.

Incorrect Answers:

A. A LDIF file is not supported by the phone, so there is no way to get the contacts from
the phone to this format.

C. An Excel Spreadsheet file can not be imported into Outlook Express, so this format
can not be used.

D. The phone can not put messages into this format, so this is not an option directly.
QUESTION 319:

You work as the network administrator at Certkiller .com. The Certkiller .com
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network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Outlook Express.

A Certkiller .com user named Kara Lang is a member of the Sales department. Kara
Langcomplains that she wants to import contacts from her home computer to
Outlook Express on her work computer. Kara Lang states that she has a copy of the
Windows address book file from her home computer that she has brought to the
office.

What should you do to ensure that Kara Lang can import the contacts from her
home computer to Outlook Express on her work computer?

A. Use the Import Wizard in Outlook Express.

B. Use the File and Settings Transfer Wizard.

C. Use the Synchronization option on the Start menu.

D. Use the Synchronize folder option on the Tools menu in Outlook Express.

Answer: A

Explanation: Importing the home address book into Outlook Express is the easiest
solution. To do this, click File -> Import Wizard -> Import Address Book.

Incorrect Answers:

B. The File and Setting Transfer Wizard is used to migrate Office settings from one
computer to another. It is not used to import address books.

C. There is no Synchronization on the Start menu. Even if there were, this answer would
be incorrect for the same reason "D" is oncorrect.

D. Synchronization is used to make the offline copies of folders the same as a server's
copies. If there are addresses stored on a server, it will synchronize those as well.
However, this is not used for a PC to PC transfer. It is used for a server to PC transfer.

QUESTION 320:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You are using OE as your mail client. You want to exchange electronic business
cards with other users via e-mail. What file format must you use for such exchange?

.vcf
.vdr
.vac
vrb

COow>

Answer: A
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Explanation: Address Book supports the vCard format, which allows you to
exchange electronic business cards with other users via e-mail. To send your
business card to another user, first create an address book record for yourself. Then
select your record in Address Book, and choose File, Export, Business Card (vCard..
This creates a file with the extension .vcf.

QUESTION 321:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.Users access their e-mail accounts from
work and from home.

A Certkiller .com user named Mia Hamm is a member of the Marketing department.
One morning Mia Hamm complains that the e-mail messages she reads from home
are not on the server when she accesses her e-mail account from the office.

What should you do to ensure that all messages stay on the server until the user
deletes them, regardless of whether she reads them from home or at the office?

A. Configure Outlook Express to use IMAP.

B. Configure Outlook Express to use POP3.

C. Configure Outlook Express on the user's work and home computer to use the same
SMTP server.

D.

Configure Outlook Express on the user's work and home computer to use the same POP3
server.

Answer: A

Explanation: IMAP leaves the e-mail on the server and instead manages the
mailboxes on the server as they were local, independent of where you access the
e-mail from. POP3 (by default settings) downloads the e-mail to the local hard drive
and deletes the message from the server. There is actually no need for the users
computers to use the same SMTP server as this is for sending messages and the
POP3 server is probably already configured to be the same, otherwise username

and password would not work at either home or office.

QUESTION 322:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003. All the client
computers run Windows XP Professional and Microsoft Office XP.

Certkiller .com contains a Microsoft Exchange Server 2003 computer named
Certkiller -SR10 for a messaging.
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A Certkiller .com user named Amy Walsh is a member of the Sales department. Amy
Walshcomplains that Microsoft Outlook is not working properly on her new
computer. Outlook did not work properly on her old computer. The user states that
she can send and receive e-mail normally, but she is unable to access her Calendar,
Tasks, Journal, or Contacts. The icons for these features are available, but none of
her data appears in Outlook.

Amy Walsh connects to her mailbox by using Outlook Web Access and verifies that
her calendar, Tasks, Journal, and contacts are available.

What should you do to ensure that all features of Outlook function on Amy Walsh's
new computer?

A. Configure the user's computer to access e-mail as an IMAP4 client.

B. Configure the user's computer to access e-mail as an Exchange client.

C. Instruct the user to copy the .ost file from her old computer to her new computer,
overwriting the .ost file on her new computer.

D. Instruct the user to copy the .pst file from her old computer to the new computer. The
instruct her to open the .pst file in Outlook on her new computer.

Answer: B

Explanation: The Calendar, Tasks, Journal and Contacts part of Outlook will not
work properly with IMAP4 or POP3, you'll have to use Exchange client mode. The
.ost file only exists if the client is running in Exchange cached mode and copying the
.pst file from the old computer, which didn't work either, will not solve the problem.

QUESTION 323:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You are configuring IE on an XP desktop. By default IE maintains connections with
which of the following programs related to the use of the Internet (choose all that

apply).

A. An HTML editor

B. An e-mail client

C. A newsgroup reader

D. An Internet conferencing program
E. A calendar program

Answer: A,B,C,D, E

Explanation: Internet Explorer maintains connections with six programs related to
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your use of the Internet:

An HTML editor

An e-mail client

A newsgroup reader

An Internet conferencing program
A calendar program

A contact manager

QUESTION 324:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

What should you do to cache server-based files and folders on your local system?

A. make sure offline files are enabled on your local computer.

B. make sure MS Office 2000 SP1 or above is installed on your local computer.
C. make sure MS Office 2000 SP2 or above is installed on your local computer.
D. Make sure you are granted the appropriate permissions for caching files

Answer: A

Explanation: Before you can cache server-based files and folders on your local
system, you have to make sure offline files are enabled on your local computer. And
to enable offline files, you must first disable Fast User Switching (if that feature is
currently enabled.. With Fast User Switching disabled, you will need to close any
running programs before switching user accounts.

QUESTION 325:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

What should you do if you want to enable offline files?

A. disable Fast User Switching
B. enable Fast User Switching
C. disable local caching

D. enable EFS
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Answer: A

Explanation: Before you can cache server-based files and folders on your local
system, you have to make sure offline files are enabled on your local computer. And
to enable offline files, you must first disable Fast User Switching (if that feature is
currently enabled). With Fast User Switching disabled, you will need to close any
running programs before switching user accounts.

QUESTION 326:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named Andy Booth is a member of the Marketing
department. Andy Boothwants to be able to open all .bmp files by using a custom
application.

Andy Booth complains that when he double-clicks .bomp files, they open in Microsoft
Paint, not in the custom application.

What should you do to ensure that all .omp files are opened by using the custom
application?

A. Create a software restriction policy for the custom application.

B. Configure the file association for .omp files to open with the custom application.
C. Instruct the user to right-click on the .bmp file and select the Open with option.

D. Instruct the user to move the .bmp file to the same folder as the custom application.

Answer: B

Explanation: You want to use a custom application for your .bomp files not MS
Paint which opens by default.

QUESTION 327:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You want to manage the web cache used by IE. By default where are the internet
content cached?

A. %UserProfile%Local SettingsTemporary Internet Files.

B. %UserProfile%Local SettingsTemporary Web Files.
C. %UserProfile%Local SettingsTemporary.
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D. %UserProfile%Local SettingsCache.
Answer: A

Explanation: Temporary Internet Files are stored by default in various subfolders
of the hidden system folder %UserProfile%\Local SettingsTemporary Internet
Files. By default, Internet Explorer reserves a maximum of about 3 percent of the
space on your system disk for the Web cache.

QUESTION 328:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

The CIO want to ensure that Internet Explorer always opens a Web shortcut in a
new window, rather than replacing the material he is currently looking at.

What should you do?

A. choose Tools, Internet Options and then click the Advanced tab. In the Browsing
section of the Settings list, clear the Reuse Windows For Launching Shortcuts option.

B. choose Tools, Internet Options and then click the Advanced tab. In the Browsing section
of the Settings list, check the Reuse Windows For Launching Shortcuts option.

C. You cannot do this

D. Encrypt the My Favorites folder

Answer: A

Explanation: To ensure that Internet Explorer always opens a Web shortcut in a
new window, rather than replacing the material you're currently looking at, choose
Tools, Internet Options and then click the Advanced tab. In the Browsing section of
the Settings list, clear the Reuse Windows For Launching Shortcuts option.

QUESTION 329:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You want to manage the web cache used by IE. By default how much space is
reserved for web caching?
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A. 3% of total disk space
B. 6% of total disk space
C. 10% of total disk space
D. 15% of total disk space

Answer: A

Explanation: Temporary Internet Files are stored by default in various subfolders
of the hidden system folder %UserProfile%\Local Settings\Temporary Internet
Files. By default, Internet Explorer reserves a maximum of about 3 percent of the
space on your system disk for the Web cache.

QUESTION 330:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

The CIO want to have Internet Explorer downloads a copy of the current page to
his Temporary Internet Files folder.

What should you do?

A. Add this page to your favorite list. Select Make This Page Available Offline on the
Web Document tab of the favorite's properties dialog box.

B. Choose Edit - Select All- Copy

C. Choose Edit - FrontPage

D. Press Ctrl PrtScr

Answer: A

Explanation: If you select Make This Page Available Offline on the Web Document
tab of the favorite's properties dialog box, Internet Explorer downloads a copy of
the page to your Temporary Internet Files folder (%UserProfile\Temporary

Internet Files. and updates that page at periodic intervals (every day at a particular
time, for example.. You can then read the page without having to reconnect to the
Internet.

QUESTION 331:

HOTSPOT

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.
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A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named

Andy Reid is a member of the Sales department. Andy Reidcomplains that he
always needs to reenter his user name and password on the Web page whenever he
logs onto any Web site. Andy Reid wants Internet Explorer to automatically enter
his user name and password when he logs on to Web sites.

How should the user configure the AutoComplete Settings dialog box on his
computer?

To answer, configure the appropriate option or options in the dialog box in the
answer area.

AuloComplete Settings ﬁ]ﬁ]

Autocomplete lists possible matches from entries you've
type before

Ll ;'-:‘11- "-'_lllr;: =tE e

[ web addresses
[ Eorms

[TJuser names and passwords on forms
] Promot me to save passwords

Chear sutoComplete hestory

Clear Forms i[ Claar Passwords |

To clear Web sddress entries, on the Gensaral bsb in
Internet Opbons, chick Clear History,

Answer:

Explanation: User names and passwords on forms
This is a dialog box answer. You must click in the correct place:
Place a check mark in the (user names and passwords on forms)

QUESTION 332:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Mia Hamm is a member of the Research and
Development department. Mia Hamm complains that she can no longer see graphic
images on any Web site. Instead, she just sees a placeholder for the intended
location of graphic images. You discover that the user recently made several
changes in Internet Explorer on her computer.

What should you do in Internet Options in Control Panel to ensure that Mia Hamm
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can view graphic images in Internet Explorer for all Web pages that display graphic
images?

A. Click the Restore Defaults button on the Advanced tab.

B. Click the Reset Web Settings button on the Program tab.

C. Clear the Show image download placeholders check box on the Advanced tab.

D. Select the Enable visual styles on buttons and controls in web pages check box on the
Advanced tab.

Answer: A

Explanation: One of the changes that was made was to show image placeholders
instead of actual images. This setting is made under the Advanced tab of IE
properties. This box exists to speed up web browsing by not downloading pictures.
Below is the offending checkbox:

ntarnet ptions BIX|

General | Secunty | Provacy | Costenl | Connecbons - Programs | Advanced

Setngs

2 Java (Sun) -~
[[] Use Java 2142 for <applats {requites restar)
(£} Microsct VI
[[] Java consola enabied (requires restar)
[ Java logging enabled
E JIT comipdir fod witual maching anablad (noqueres restart)
u Mulureadis
[] Don't display onine media content in the madia bar
|w] Enable Atamatic image Resizing
:?} Enabbis Inmage Toolyar {reguiies rastard
|_-| Plary aremabons mwab pages
|- I Play spunds inwab pages
v Play wideos in web pages
[w] Show pichoes
I:!'-: Smard image dthanng

¥ Printing -
‘I Nenthanlrascimd nalnim aed smanaa >
| Bestore Detauls _|
| O | l Cancal l Apply |
fncorrect Answers:

B. Resetting the Web Settings will reset the default application used to do things such as
edit web pages, mail, news, etc. Here is that screen:
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! Internet Options _"?ESI

General | Secunty | Privacy | Contand | Connechons . Programs | aAdvanced

You can specdy which pregram Windows aulomabeally uses fo

A
=5  eachimemel service

HTML editer v
E-mail Micrasoft Office: Dutook »
Mewsgroups WM w |
Inparnist call HatMaating L
Gatendar Micrasalt Ofice Ouklook e
Contactlist Microsaft Office Dutiock e

¥ou can resat inbsme! Explonr i the default home

BesatWab Sofings and soarch poges

[} Inteanat Exglores showld check 1o see whether it is the default buowser

0K ,| Gancel | | ; _ﬁp?'y _|
C. This is the exact checkbox that you want UNCHECKED. The reason the problem
currently exists is that this checkbox has been checked, and images are no longer being
displayed.
D. Enabling visual styles will simply allow Internet Explorer to display themes like the
rest of Windows XP. This will keep all the color schemes, pointers, etc in Internet
Explorer. This has nothing to do with the images that are displayed in Internet Explorer.

QUESTION 333:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Andy Booth is a member of the Research and
Development department. One morning Andy Booth complains that his Address bar
in Internet Explorer has disappeared. Now, he cannot type Web site URLSs to
connect to Web sites. You discover that the user has recently made some changes in
Internet Explorer.

What should you do to ensure that Andy Booth can type Web site URLS in the
appropriate toolbar?

A. Lock the toolbars.

B. Enable the Address bar.

C. Enable the Links toolbar.

D. Enable the Standard Buttons toolbar.

Actualtests.com - The Power of Knowing




070-272

Answer: B

Explanation: Enabling the Address bar is the simplest, most direct answer. It also
makes the most sense. Since she "made some changes™ to her environment, one of
the changes was in all likelihood the turning off of her Address bar. Simply
re-enabling it should resolve her issue.

Incorrect Answers:

A. Locking the toolbars will prevent her from changing them, but will not turn on the
needed toolbar.

C. The Links toolbar will show the items in the Links folder. It will not enable the
Address bar, or modify it in any way.

D. The Standard buttons toolbar will show all the standard buttons (Stop, Reload, Back,
etc.) It will not change the Address bar.

QUESTION 334:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You suspect that your Internet Explorer is reading from the cache when it should be
downloading afresh. What should you do (choose all that apply).

A. hold down the Shift key while you click Refresh
B. press Shift+F5

C. hold down the Ctrl key while you click Refresh
D. press Shift+F6

Answer: C

Explanation: If Internet Explorer appears to be reading from the cache when it
should be downloading afresh (for example, if you find yourself looking at
yesterday's headlines at a newspaper site., hold down the Ctrl key while you click
Refresh (or press Ctrl+F5).

QUESTION 335:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com customer named Andy Booth is a member of the Finance
department. Andy Booth running Windows XP Home Edition and Microsoft
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Outlook Express reports that when he uses his dial-up connection to access the
Internet, he has to enter his user name and password every time he connects.
What should you do to enter his user name and password every time he connects?

A. In Microsoft Internet Explorer, on the Tools menu, click Internet Options. On the
Connections tab, click the appropriate dial-up connection, and then click Settings. Select
Automatically detect settings.

B. In Internet Explorer, on the Tools menu, click Internet Options. On the Connections
tab, double-click the appropriate dial-up connection, and then enter the user name and
password.

C. In Network Connections, right-click the appropriate dial-up connection, and click
Properties. On the Options tab, select Prompt for name and password, certificate, etc.

D. In Network Connections, right-click the appropriate dial-up connection, and click Set
as Default Connection.

Answer: B

Explanation: The dial-up connection that the user to connect to the Internet is
probably already configure as the Default connection and to automatically detect
settings. To set the Dial-up properties > Options to Prompt for name and password
will actually bring up the prompt for username and password even if you configure
the connection to remember the username and password as stated in option B

QUESTION 336:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Clive Wilson is a member of the Sales department.
One morning Clive Wilson complains that he recently ran Internet Explorer on
another user's computer. When he began to type an address of a Web site in the
Address bar, Internet Explorer would automatically complete the entry he typed in
the Address bar. The user requests that this feature be enabled on his computer as
well.

What should you do in Internet Options in Control Panel to ensure that when Clive
Wilson types an address of a Web site in the Address bar, Internet Explorer
attempts to automatically complete the entry for him?

A. Select the Show friendly URLSs check box on the Advanced tab.

B. Select the Use inline AutoComplete check box on the Advanced tab.

C. Increase the number of days to keep Web pages in the History folder on the General
tab.

D. Disable the Do not search from the Address bar option on the Advanced tab by
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selecting the Display results, and go to the most likely site option.
Answer: B

Explanation:

Inline AutoComplete completes entries in the Address bar as you type (based on
entries you have used before) and offers a list of choices under the Address bar for
other links that start the same way. You can enable Inline AutoComplete using the
Advanced options of Internet Explorer by following these steps:

1. Open Internet Explorer, and from the Tools menu, select Internet Options.

2. From the Advanced tab, scroll down to the end of the Browsing section.

3. Select the Use Inline AutoComplete check bos. Click OK.

QUESTION 337:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com user named Kara Lang wants to display the IE Favorites Explorer
bar. What shortcut keys should you tell Kara Lang to press?

A. Ctrl+l

B. Ctrl+E
C. Ctrl+A
D. Ctrl+D

Answer: A

Explanation: To display the Favorites Explorer bar, you can do any of the
following:

Choose View, Explorer Bar, Favorites.

Press Ctrl+l.

Click the Favorites button on the Standard Buttons toolbar.

QUESTION 338:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com user named Mia Hamm wants to quickly add the current web page
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to the top level of the IE Favorites folder.
What shortcut keys should you tell Kara Lang to press?

A. Ctri+l

B. Ctrl+E
C. Ctrl+A
D. Ctrl+D

Answer: D

Explanation: Pressing Ctrl+D adds the current page to the top level of your
Favorites folder. Because most users quickly accumulate so many favorites that they
need to use subfolders to organize them (each folder representing a category of
favorites., you can think of this option as a fast but temporary method for adding a
favorite.

QUESTION 339:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You have been instructed to set up OE as your email client.

Rate this comment: By default, OE does not check addressees against entries in
LDAP servers.

A. True

B. False

C. True only if there are LDAP servers on the same subnet
D. False - LDAP is never supported by OE

Answer: A

Explanation: By default, the program does not check addressees against entries in

LDAP servers. But you can add this form of lookup as follows:

1. Choose Tools, Accounts.

2. On the Directory Service tab (or All tab. of the Internet Accounts dialog box, select the
name of a directory service, and then click Properties.

3. On the General tab of the directory service's properties dialog box, select Check
Names Against This Server When Sending Mail.

QUESTION 340:

You work as the network administrator at Certkiller .com. The Certkiller .com
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network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You need to set up OE as your email client. What are used by OE to organize
messages (choose all that apply).

A. Folders
B. Boxes
C. Units

D. Domains

Answer: A

Explanation: Outlook Express uses folders to organize messages. The program
creates one set of folders by default. Called Local Folders, these folders are used for
any POP3 e-mail accounts you have. It also includes Outbox and Drafts folders that
are shared by all your accounts.

QUESTION 341:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

Your user is using OE as the email client. By default, OE checks every

minutes to see whether a user has mail?
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Answer: D

Explanation: By default, Outlook Express checks every 30 minutes to see whether
you have mail. You can change that interval (or disable automatic checking. on the
General tab of the Options dialog box.

QUESTION 342:

You work as the network administrator at Certkiller .com. The Certkiller .com
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network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com user named Rory Allen is a member of the Marketing department.
Rory Allenis using OE as the email client.

What shortcut keys can Rory Allen press so that he can send and receive at any
time?

A. Ctrl+M
B. Ctrl+E
C. Ctrl+R
D. Ctrl+S

Answer: A

Explanation: Whether or not you fetch mail on a schedule, you can send and receive
at any time by pressing Ctrl+M. This keyboard shortcut checks all your e-mail
accounts. To check a particular account only, choose Tools, Send And Receive, and
then select the account you want to check.

QUESTION 343:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com user named Andy Booth is a member of the Sales department.
Andy Booth needs to use OE to send plain text emails.

What should you do to ensure that only plain text emails are sent to the intended
recipients?

A. You need to make changes to the recipients' records in the address book
B. You need to make changes to the sending options of OE

C. You need to make changes to the server options of OE

D. You need to make changes to the signature options of OE

E. You do not need to do anything.

Answer: A

Explanation: To ensure that a particular person receives plain-text mail from you,
open that person's record in Address Book by double-clicking the entry or by
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right-clicking it and choosing Properties. Select the Name tab and then select Send
E-mail Using Plain Text Only.

QUESTION 344:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You use OE on your desktop. Currently OE is the only handler for news on your
computer. What should you do to make OE the default handler?

A. You need to make changes to the recipients' records in the address book
B. You need to make changes to the sending options of OE

C. You need to make changes to the server options of OE

D. You need to make changes to the signature options of OE

E. You do not need to do anything.

Answer: E

Explanation: If you do not make Outlook Express the default handler for either
mail or news, but no other mail or news client is installed on your system, Windows
will treat Outlook Express as the default anyway.

QUESTION 345:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

Your CIO wants to use OE as your mail client. OE by default has how many
identities for use?

A. None

B. One

C. Two

D. One for each computer account
Answer: B

Explanation: Outlook Express initially uses a single identity, called Main Identity.
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You might want to replace this moniker with a real name-your own, perhaps. To do
so, select Main Identity in the Manage Identities dialog box and click Properties.

QUESTION 346:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications. Your CIO use OE as your mail client.
What should you do to change the default identity used by OE?

A. select Main ldentity - Properties in the Manage ldentities dialog box

B. select Default Identity - Advanced Properties in the Manage Identities dialog box
C. select Identity - Settings in the Manage Identities dialog box

D. The default one cannot be changed

E. None of the choices.

Answer: A

Explanation:

Outlook Express initially uses a single identity, called Main Identity. You might
want to replace this moniker with a real name-your own, perhaps. To do so, select
Main Identity in the Manage Identities dialog box and click Properties.

QUESTION 347:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named Dean Austin is a member of the Research and
Development department. One morning Dean Austin complains that e-mail
messages sent to him by a colleague do not appear in his Microsoft Outlook Inbox.
He can hear the notification tone, indicating that the e-mail messages are being
received.

During maintenance, you confirm that when the tone is heard, the unread e-mail
count for the user's Inbox does not increase.

What should you do to ensure that new e-mail messages appear in Dean Austin's
Inbox?

A. Run the Detect and Repair wizard.

B. Create and use a new Outlook user profile.

C. Disable the Outlook rule that is affecting the e-mail messages.
D. Change the Sort by option to include unread e-mail messages.
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Answer: C

Explanation:

In all likelihood, there is a filter that is preventing Outlook from receiving the messages.
If this is the case, there would still be an audible alert, as the message is delivered then
promptly deleted. That would explain why the message no longer exists.

Incorrect Answers:

A. Running a Detect and Repair is not necessary, as messages are indeed being delivered.
This is an indication that Outlook is performing as it should.

B. Creating a new profile would allow the messages to be delivered, but is not the best
option as all the user's other messages will not be accessible.

D. Changing the Sort By will not resolve the problem, as the messages do not exist
anymore, and sorting in any fashion would not change that fact.

QUESTION 348:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named Rory Allen is a member of the Research and
Development department. One morning Rory Allen complains that his computer
restarts several minutes after he logs on.

During monitoring you discover that the computer does not display a Stop error or
other system failures. The user did not recently install any new hardware or
software and he did not make any recent system changes. Other users in the
company also report the same problem is occurring on their computers.

Which tool should you run on Rory Allen computer to identify the source of the
problem?

A. Dr. Watson

B. A virus scanner

C. System Information
D. Network Diagnostics
Answer: A

Explanation: No other answer in the list is correct because Dr. Watson is the
correct tool to use here.

QUESTION 349:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
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servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

If you select Make This Page Available Offline on the Web Document tab of the
favorite's properties dialog box, Internet Explorer will download a copy of the
current page to which location?

A. %UserProfileTemporary Internet Files
B. %UserProfileApplication Data

C. %UserProfileLocal Settings

D. %UserProfileMy Documents

Answer: A

Explanation: If you select Make This Page Available Offline on the Web Document
tab of the favorite's properties dialog box, Internet Explorer downloads a copy of
the page to your Temporary Internet Files folder (%UserProfile\Temporary

Internet Files. and updates that page at periodic intervals (every day at a particular
time, for example.. You can then read the page without having to reconnect to the
Internet.

QUESTION 350:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professionaland Microsoft Office XP.

Each client computer has a CD-RW device, which is used to back up personal files
and to transfer large files to customers.

A Certkiller .com employee named Amy Wilson works in the Research and
Development department. Amy Wilson complains that she wants to use the CD-RW
device to put files from different folders on one CD.

What should you do to ensure that Amy Wilson can put files from different folders
on one CD?

A. Use the Files and Settings Transfer Wizard.

B. Right-click the files and use the Send to option.

C. Use the Synchronize option from the Start menu.

D. Create a shortcut for each file in the My Documents folder.

Answer: B
Explanation: The easiest way to copy files to a CD-RW is to right-click on the files

and select the Send to option. The Files and Settings transfer Wizard is used to
move files and settings from one computer to an other when upgrading the
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hardware. Synchronize (if available in the Start menu) is for offline folder or mobile
devices and creating shortcuts in the My Documents folder will not help her in any
way.

QUESTION 351:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named Andy Reid is a member of the Research and
Development department. Andy Reid wants to move a shortcut from his desktop to
the Start menu.

What should you do to ensure that the shortcut is moved to the Start menu?

E. Drag and drop the shortcut to the Start menu.

F. Configure the Start menu to use the Classic Start menu.

G. Increase the number of programs available on the Start menu.

H. Ensure that the recently used programs list is disabled.

Answer: A

Explanation: Drag and drop the shortcut is one way to move it.

Incorrect Answers:

B. Using the Classic Start Menu will not change shortcuts from the desktop in any way.
Using this in conjunction with dragging and dropping would work, but is not necessary.
C. Increasing the number of programs available on the start menu would only increase
the number of recently used programs, but would not add any shortcuts to it. By double
clicking a shortcut, Recently Used Programs will display the actual program, not the
shortcut, and only if the application is written correctly. (Not all applications will make
use of the Recently Used Programs.)

D. Disabling the recently used programs is the opposite of "C", but incorrect for the same
reason. Simply changing this will not add or remove shortcuts from the Start Menu.

QUESTION 352:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

Under the Windows XP Professional OnNow initiative, which of the following are
the valid design goals (choose all that apply).

A. Boot from power off to a usable state in 30 seconds.
B. Resume from hibernation in 20 seconds.
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C. Resume from standby in 5 seconds.
D. Never off

Answer: A, B, C

Explanation: OnNow is a Microsoft initiative to advance PC hardware so it
supports instant-on capability, yet appears to be off (that is, it's quiet and uses little
or no power. when it's not in use. Microsoft set the following design goals for a
typical consumer PC running Windows XP:

Boot from power off to a usable state in 30 seconds.

iResume from hibernation in 20 seconds.

Resume from standby in 5 seconds.

QUESTION 353:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

How should you proceed to configure the Windows XP power management
features?

A. open Power Options in Control Panel

B. define a power management group policy
C. edit the registry

D. define a custom startup script

Answer: A

Explanation: To configure any of the Windows XP power management features,
open Power Options in Control Panel. (If you use Category view in Control Panel,
you'll find Power Options under Performance And Maintenance..

QUESTION 354:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You want to configure the Windows XP power management features. In Control
Panel's Category view, under which category can you find the Power Options?
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A. Performance And Maintenance
B. Energy Saving

C. Accessibility

D. System Information

Answer: A

Explanation: To configure any of the Windows XP power management features,
open Power Options in Control Panel. (If you use Category view in Control Panel,
you'll find Power Options under Performance And Maintenance..

QUESTION 355:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You are considering the use of the Standby feature. Why is it preferable over
hibernation (choose 2).

A. it doesn't require free disk space

B. it allows nearly instant system reactivation
C. it supports all intel CPUs

D. it does not cost extra to activate

Answer: A, B

Explanation: Standby uses only enough power to preserve the contents of
memory-typically only a few watts. Its advantages over hibernation are that it
doesn't require free disk space and it allows nearly instant system reactivation.

QUESTION 356:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You are considering the use of the Standby feature. To be safe, which of the
following should be used along with this feature?

A. UPS
B. RAID 5
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C. Hibernation
D.RAID 1

Answer: A

Explanation: If the power goes out while your computer is on standby, you lose
whatever is in memory. If you have any unsaved documents, for example, they're
gone. With an uninterruptible power supply (UPS), however, you can prevent data
loss during blackouts.

QUESTION 357:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

You are studying the possibility of deploying the standby feature. How do you make
your system switch to standby (choose all that apply).

A. switch automatically after a period of inactivity
B. switch manually

C. switch based on script

D. switch based on local GPO

Answer: A, B

Explanation: On systems that support standby, you can allow the system to switch
to standby automatically after a period of inactivity or you can switch to standby
manually.

QUESTION 358:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

Your CIO are considering the use of the Standby feature. Why is it NOT preferable
over hibernation?

A. it requires free disk space

B. it does not allow nearly instant system reactivation
C. it does not support many intel CPUs
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D. it costs extra to activate
E. data loss during power outage

Answer: E

Explanation:

If the power goes out while your computer is on standby, you lose whatever is in
memory. If you have any unsaved documents, for example, they're gone. With an
uninterruptible power supply (UPS), however, you can prevent data loss during
blackouts.

QUESTION 359:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

The CIO of Certkiller .com wants to deploy the standby feature. Rate this comment:
standby simply shifts to a low-power state by shutting down hard drives, fans, the
CPU, and other power-hungry components, while hibernation saves the contents of
memory to the hard disk and then shuts off all power.

A. True
B. false

Answer: A

Explanation: Standby simply shifts to a low-power state by shutting down hard
drives, fans, the CPU, and other power-hungry components-but it continues to draw
some power to retain the contents of memory and to be ready to spring back to life
quickly. Hibernation saves the contents of memory to the hard disk and then shuts
off all power.

QUESTION 360:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named

Andy Reid is a member of the Research and Development department. One
morning Andy Reid complains that at times his taskbar is not visible but no other
users report any problems with their taskbar.

What should you do to ensure that the taskbar is visible at all times on Andy Reid's
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computer?

A. Enable the taskbar lock feature.

B. Remove the auto-hide feature for the taskbar.

C. Run the Accessibility Wizard from the Start menu.

D. Deselect the Hide inactive icons option for the taskbar.

Answer: B

Explanation: The question states that the user can not see the Task Bar. No other
users have problems, and he is not reporting any errors on the workstation.
Therefore, the simple explanation is that the taskbar has been set to either not
display or to autohide. Disabling the auto-hide feature is the correct solution.
Incorrect Answers:

A. Locking the taskbar will prevent changes from being applied. This would be a good
solution if the taskbar were constantly being changed or manipulated, but not in this
situation.

C. The Accessibility Wizard handles items like on screen keyboard, speech for text, and
Magnifier. It does not work with the tool bar in any way.

D. Hiding inactive icons will remove icons from view on the task bar that have not been
used. This affects icons next to the clock, but will not affect the Task Bar itself.
Remember that the Task Tray (where the icons are) and the Task Bar (where running
programs are shown) are two different things.

QUESTION 361:

HOTSPOT

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named Rory Allen is a member of the Marketing department.
Rory Allencomplains that he wants to clean up his taskbar. He wants fewer
applications to be displayed in the notification area without modifying any other
configurations.

What should you do to ensure that the taskbar is cleaned up and the solution must
not modify any other configuration?

To answer, configure the appropriate option or options in the dialog box in the
answer area.
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Taskbar and Starf Menu Properties

| Taskbar Start Menu

Tazkbar appetience

f '? , —E-‘:fﬂl:t- Welzorre...
[] Lok the taskbar
["] Auto-hide the taskbar
[ 1 Keap the taskbar on top of other windeows
(] Group simias taskbar buttons
|| Show Guack Launch

Mitificshion zras

L] Show thie clock
Answer:

Explanation: Group Similar taskbar buttons

This is a dialog box answer. You must click in the correct place:

You must check the (Group Similar taskbar buttons) in that menu and only
that one.)

QUESTION 362:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Andy Booth is a member of the Research and
Development department. Andy Booth complains that his taskbar has moved from
the bottom of his desktop to the right-hand side of his desktop. He states he wants
the taskbar to be back at the bottom of his desktop.

What should you do to ensure the taskbar is back at the bottom of Andy Booth's
desktop?

A. Lock the taskbar.

B. Drag and drop the taskbar.

C. Configure the taskbar to use the Classic Start menu.

D. Restart the computer by using the last known good configuration.
Answer: B

Explanation: The user dragged and dropped the taskbar to the right-hand side of
the screen. To place it back in its original location, the simplest thing to do is to drag
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and drop it back. As long as the task bar is not locked, this is not only possible, but
the best course of action.
Incorrect Answers:

A. Locking the taskbar will prevent the user from moving it at all. It will not allow him to
put it back in its original location. This answer will completely prevent the completion of
the request.

C. The Classic Start Menu will not move the task bar. It will only affect what happens
when the Start button is clicked. Configuring this presents the Windows 2000 and earlier
style interface when clicking Start. The XP Style has the two panels, color, PinTo, etc.

D. Restarting the computer with the last known good configuration will bring the
computer back to the state it is in currently, as there is nothing wrong with the
workstation or with Windows XP. The net affect of performing is action would be that
the computer would return to the same state it is in currently, and the taskbar will still be
on the right-hand side.

QUESTION 363:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Rory Allen is a member of the Research and
Development department. Rory Allen complains that when he runs the Spelling and
Grammar... utility on a Microsoft Word document, the French dictionary is used.
English is the language of the document, so he wants to use the English dictionary
when checking his document.

What should you do to ensure that Rory Allen can use the English dictionary when
running the Spelling and Grammar... utilit?

A. In Word, set the Spelling and Grammar language to English.

B. In Regional Options in Control Panel, choose English as the default language.

C. In Word, clear the Allow accented uppercase in French check box in the Edit options.
D. In Regional Options in Control Panel, add United States - International under
Keyboard Layout /IME in the Input Locals options.

Answer: B

Explanation: Word takes these settings from the Regional and Language options.
Changing these back to English will resolve the problem.
Incorrect Answers:

A. This is also a possible answer. In Word the following command would set the
preferred language: Tools->Language->Set Language.

C. Changing the allow accented uppercase in French will not change the language. It will
simply not display the uppercase accented words.
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D. Changing the keyboard layout will not change the default language. It will only
change what each keypress does. For example, using a Polish keyboard, the "z" will
display a "w" and vice verse. In English, a "z" displays a "z". The language does not
change; only what character is displayed when a particular key is pressed.

QUESTION 364:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com customer named Andy Booth is a member of the Finance
department. Andy Booth running Windows XP Home Edition and Microsoft
Outlook Express reports that he cannot compose an e-mail message by using the
Korean character set.

You verify that the computer has the Korean language pack installed. However, he
still cannot type Korean characters.

What should you do to ensure that Andy Booth can type Korean characters?

A. Reinstall the Korean language pack.

B. Download a Korean version of Outlook Express.

C. Select Auto Encoding from the View menu in Outlook Express.

D. In Regional Options in Control Panel, select the input locale that relates to the
regional settings.

Answer: D

Explanation: This answer is much like one below relating to a foreign language.
Understand that Windows gets its settings for languages from the Region and
Language Settings in the Control Panel. Changing to Korean in the Region and
Language Settings will enable him to enter in Korean.

Incorrect Answers:

A. The Korean Pack is probably correctly installed. This would not be the first thing to
check, and certainly not the best answer. Any time answers are presented that prompt you
to reinstall, look at them with extreme caution.

B. There is no need to download the Korean version of Outlook Express. The question
states that the user needs to type in Korean. It does not make any mention of needing the
menus and buttons to be in Korean.

C. Auto Encoding will allow the display of foreign language characters from incoming
messages on the screen It will not, however change what the user types from standard
text into Korean.

QUESTION 365:

You work as the network administrator at Certkiller .com. The Certkiller .com
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network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com

customer named Dean Austin is a member of the Finance department. Dean
Austinrunning Windows XP Home Edition and Microsoft Outlook Express reports
that he wants to compose an e-mail message in a foreign language character set.
What should you do to ensure that Dean Austin can compose an e-mail in a foreign
language character set?

A. Download the Outlook Express version for the foreign language he wants to use.

B. Install the Windows XP language pack for the foreign language he wants to use.

C. In the View menu in Outlook Express, select the option to encode the foreign language
he wants to use.

D. In the File menu in Outlook Express, select the option to import the appropriate
foreign-language folders from the international Web site.

Answer: B

Explanation: From Start menu, select Settings then Control Panel, Start Regional
Options, Click on Languages tab, In Supplemental language support box, check the
checkboxes of desired language collection(s) and click OK, Additional files will be
copied to your machine. You may need to provide the Windows XP CD or the
network share name, After reboot, support for new languages will become available.

QUESTION 366:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com user named

Amy Walsh is a member of the Research and Development department. Amy
Walsh complains that she recently made several changes in Internet Explorer. Now,
every Web site she visits displays Web page text in Times New Roman font. Amy
Walsh wants Internet Explorer to display text by using its default configuration-
What should you do to ensure that Internet Explorer displays text on Web pages by
using its default configuration?

A. Click the Restore Defaults button on the Advanced tab in Internet Options in Control
Panel.

B. Click the Reset Web Settings button on the Programs tab in Internet Options in
Control Panel.

C. Clear the Ignore font Styles specified on Web pages check box in Internet Options in
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Control Panel.
D. On the View menu in Internet Explorer, point to Encoding and select Unicode
(UTF-8).

Answer: C

Explanation: Clearing this checkbox will enable web pages to use the fonts that were
originally intended. With this box checked, all fonts are replaced with Times New
Roman by default.

Incorrect Answers:

A. Restoring defaults under the Advanced tab will not resolve the problem. The issue is
that all the fonts are being replaced. There is no setting under Advanced that will change
this. This must be done under Internet Options in Control Panel.

B. Resetting the web settings will not change the fonts. It will reset what application
opens when a particular action is performed. For example, what program opens when a
news link is encountered, a particular news reader opens, or when a web page is selected
for editing, what program will open to edit the document.

D. There is no need to change the encoding type. UTF-8 is a common and accepted
standard. Even if this were changed, it would not cause the fonts to be replaced with
Times New Roman.

QUESTION 367:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Andy Reid is a member of the Research and
Development department. Andy Reid complains that when he opens a Microsoft
Word document, Word does not display a toolbar that contains the Insert Comment
button.

What should you do to ensure that the appropriate toolbar is displayed when Andy
Reid runs Word on his computer?

A. Select Detect and Repair... from the Help menu.

B. Right-click one of the existing toolbars and select Reviewing from the context menu.
C. Copy a Normal.dot file from another computer to the My Documents folder on the
user's computer.

D. Open a document that was created by another user. Select Shared Workspace from the
Tools menu.

Answer: B

Explanation: The Insert Comment button appears on the Reviewing Toolbar.
Simply enabling this toolbar will show this button. To enable the toolbar, right click
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any open spot in the toolbar area. From the dropdown list, click Reviewing.
Incorrect Answers:

A. There is no need to do a Detect and Repair. Word is functioning as it should. The
toolbar is simply not being displayed. Don't get fooled into thinking that the "new
feature™ of Office is always the right answer. This should be a last resort-type option,
only to be tried when the simple solutions do not work.

C. Normal.dot contains all information used to start a blank document in Word. It
contains things like what is the default font, font size, color, etc. It does not contain
information about the toolbars.

D. The Shared Workspace will not resolve the situation. It is designed to allow users to
collaborate. Even though another user created the document, it is being edited on this
workstation, and as such will get this workstation's environment; including the toolbars.
Since the toolbar is not displayed when the user works alone, it will not display in a
collaborative environment, either.

QUESTION 368:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

Certkiller .com has its headquarters in Chicago and a branch office in Dallas. A
Certkiller .com user named Mia Hamm travels with a portable computer. Mia
Hamm is required to encrypt all company data that is stored on the portable
computer.

Mia Hamm reports that she has to view the properties of each file to find out
whether a file is encrypted or unencrypted.

What should you do to ensure that Mia Hamm can distinguish encrypted files from
unencrypted files without viewing the files' properties?

A. Ensure that the files are compressed.

B. Ensure that the files are not compressed.

C. Set the folder options to show encrypted files in color.

D. Set the folder options to show protected operating system files.

Answer: C

Explanation: Users must be able to distinguish between encrypted and unencrypted
files. The only way to do this is to have the encrypted files shown in color. Encryption is
the process of protecting files by making the files unreadable unless a key is provided.
Compression removes the "white space” in files; making them smaller on the hard drive
but not altering any data.

Incorrect Answers:

A. Ensuring the files are compressed won't make any difference to encryption settings.
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These are two different attributes. Do not confuse the two.

B. Incorrect for the same reason as "A". Compression has no bearing on Encryption.

D. Showing protected operating system folders will have no effect on how encrypted files
are shown. This setting will show files that are used by the OS, but not on files that the
user creates and wants to keep other users from viewing.

QUESTION 369:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP. The client
computers have also an application named Appl that is installed on it.

A Certkiller .com user named Kara Lang is a member of the Research and
Development department. Kara Lang complains that whenever she attempts to open
a file for Appl, she is directed to the C:\Program Files folder, not to her home
directory. You discover that the user runs Appl by clicking a shortcut on her
desktop.

What should you do to ensure that Kara Lang is directed to her home directory
when she opens a file for Appl?

A. Alter the target path for the My Documents folder.
B. Alter the Target setting for the shortcut properties.
C. Alter the Start in setting for the shortcut properties.
D. Alter the PATH system variable to include the home directory.

Answer: C

Explanation: She is directed to the C:/program files folder not her home
directory like she should be.

QUESTION 370:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP. The client
computers have also an application named Appl that is installed on it.

A Certkiller .com user named Rory Allen is a member of the Research and
Development department. Rory Allen complains that when he attempts to access a
shortcut to a Microsoft Access file on his desktop, he receives the following error
message: "File missing or not available".

During monitoring you discover that Rory Allen can access e-mail and the Internet.
The Access file is shared on a file server named Certkiller -SR24 on the network,
and you can access the file with no problem.

What is the most likely cause of the error?
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A. The user's network connection is faulty.

B. The user's shortcut is mapped to the incorrect network location.

C. The user does not have the latest Office updates on his computer.

D. The user does not have permission to read and execute on the network folder.

Answer: B

Explanation: The error message indicates that the file is not in the location that the
shortcut refers to. The file has probably been moved or deleted.

QUESTION 371:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Amy Walsh is a member of the Research and
Development department. Amy Walsh complains that that Microsoft Outlook
cannot contact the company's Microsoft Exchange Server computer, which is
named Certkiller -SR22. You are able to successfully ping Certkiller -SR22 from
your computer by using the name Certkiller -SR22.

You use Remote Assistance to connect to the Amy Walsh's computer and verify that
the computer can successfully ping Certkiller -SR22 by using its IP address.
What should you do to ensure that Amy Walshcan use Outlook?

A. Configure the correct IP address on Amy Walsh's computer.

B. Configure the correct DNS server IP address on Amy Walsh's computer.

C. Ask an administrator to configure the correct IP address on Certkiller -SR22.
D. Ask an administrator to configure the correct DNS server IP address on
Certkiller -SR22.

Answer: B

Explanation: As the computer is able to connect to the Exchange server with the IP
address but not through the DNS address ( Certkiller -SR22. Certkiller .com) it is
probably a problem with the DNS server settings on the client computer. If the
clients IP address was faulty you probably would not be able to connect to it with
Remote Assistance and if IP or DNS settings on the Exchange server was wrong
then you wouldn't be able to connect to it from you own computer.

QUESTION 372:
You work as the network administrator at Certkiller .com. The Certkiller .com

network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
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computers run Windows XP Professional.

Certkiller .com contains a DHCP server named Certkiller -SR20 that is used to
assign IP addresses to all client computers. A new Certkiller .com policy requires that
users use Microsoft Internet Explorer as their Web browser.

A Certkiller .com user named Andy Booth is a member of the Research and
Development department. Andy Booth complains that when he tries to connect to
any Web site on the Internet while he is using his computer at the office, Internet
Explorer displays the following error message: "The page cannot be found."
During maintenance you discover thatthat he followed instructions from his ISP to
make several changes in Internet Explorer on his portable computer so that he
could connect to the Internet from home.

You check that the Internet Explorer has the correct proxy settings. You instruct t
Andy Boothto ping a computer on the Internet by using its IP address. Andy Booth
reports that he can successfully ping the other computer.

What should you do to ensure that the user can connect to Web sites by using
Internet Explorer on his computer?

A. Use Internet Options in Control Panel to configure security level for the Internet
security zone to Medium.

B. Use Internet Options in Control Panel to add the URLs of the Web sites he needs to
access to the Trusted sites security zone.

C. Select the Automatic private IP address option button on the Alternate Configuration
tab of the TCP/IP properties page.

D. Select the Obtain DNS server address automatically option button on the TCP/IP
properties page.

Answer: D

Explanation: If the user can successfully reach computers on the internet by using
their IP address but not when using the DNS name (or URL) then it probably is a
DNS issue and the correct solution would be to make sure the DNS settings under
the TCP/IP properties page are right (in this case automatically assigned from
DHCP). Changing anything in the Internet Options would not help as the problem
is clearly outside the scope of Internet Explorers settings.

QUESTION 373:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Mia Hamm is a member of the Sales department. Mia
Hammcomplains that she cannot share a printer.

During maintenance, you discover that Mia Hamm is trying to share the printer

that is attached to a USB port on her computer. You also discover that she logs on to
the computer by using a domain user account.
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What should you do to ensure that Mia Hamm can share the printer?

A. Instruct the user to attach the printer to a parallel port.

B. Instruct the user to configure Windows Explorer so that simple file sharing is enabled.
C. Add the user's domain user account to the local Users group on her computer.

D. Add the user's domain user account to the local Power Users group on her computer.

Answer: D

Explanation: Must be added to the local Power Users group to be able to add a
printer to the computer. Local users group doesn't have enough rights.

QUESTION 374:

You work as a desktop technician at Certkiller .com. The Certkiller .com network
contains a single Active Directory domain named Certkiller .com. All servers on the
Certkiller .com network run Windows 2000 Server and all client computers run
either Windows XP Professional or Windows 98.

Certkiller .com contains a Desktop Support team which you are part of.

Certkiller .com contains a server named Certkiller -SR13 which contains files and
folders which are used by the users in Certkiller .com. A Certkiller .com user named
Kara Lang is a member of the Research department. She usually accesses files in a
folder named TK_Research which has a subfolder named ResearchDoc that resides
on Certkiller -SR13. Kara Lang has a network drive which maps to

Certkiller -WS050, with a shortcut to the TK_Research folder.

Kara Lang has contacted you to report that her short does not work. During the
investigation you find out that Certkiller -SR13 was replaced with

Certkiller -SR14, which specs are identical to Certkiller -SR13. You need to let

the shortcut work on Kara Lang computer.

What should you do?

A. Remove the old shortcut and map a new network drive to the ResearchDoc folder on
Certkiller -SR14 and create a new shortcut to the new network drive.

B. Map a new network drive to the ResearchDoc folder on Certkiller -SR14, right-click
the TK_Research shortcut, select the Properties and click Change Icon and then click
OK.

C. Map a new network drive to the ResearchDoc folder on Certkiller -SR14;
double-click the TK_Research shortcut to automatically change the path to the target
folder.

D. Map a new network drive to the ResearchDoc folder on Certkiller -SR14, right-click
the TK_Research shortcut, select the Properties and type the new path to the
TK_Research folder which will be in the Target address box.

Answer: D

Explanation Kara Lang has to Map a new network drive to the ResearchDoc folder on
Certkiller -SR14, right-click the TK_Research shortcut, select the Properties and type
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the new path to the TK_Research folder which will be in the Target address box.
Incorrect Answers:

A: Doing this she should also type the path to the object in the Target address box, click
Browse and browse to the new location.

B: The Change Icon allows Kara Lang to change the appearance of the icon and not the
path.

C: If you double click the shortcut, the shortcut search future will fail because the files
and folders are moved to a new location.

QUESTION 375:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com user named Andy Reid is a member of the Marketing department.
Andy Reidcomplains that his desktop at home sometimes will turn on by itself at
midnight.

Which of the following is the likely cause (choose all that apply).

A. the wake-on-LAN feature has been enabled
B. the wake-on-LAN feature has been disabled
C. the UPS has been set to always on

D. the UPS has been set to always off

E. you have an outdated BIOS

Answer: A

Explanation: Some broadband Internet providers periodically probe your computer
to see whether it's still connected. If your network interface card is configured to
wake the computer, one of these probes will do it. If you don't want to disable the
wake-on-LAN feature, you can ensure that probes from your Internet connection
don't rouse your computer by turning off the computer's power completely.

QUESTION 376:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com employee named Kara Lang works in the Research and
Development department. Kara Lang complains that her desktop uses APM for
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power management. Sometimes it fails to come out of standby.
What should Kara Lang do?

A. check the time-out settings in your BIOS Setup program.
B. update your BIOS.

C. disable APM in Windows XP Professional

D. disable APM in the BIOS

E. None of the above.

Answer: A

Explanation: If your computer uses APM for power management and sometimes
fails to come out of standby, check the time-out settings in your BIOS Setup
program. If these thresholds are lower than the ones set in the Power Options
Properties dialog box, you might sometimes be unable to emerge from standby. To
resolve the problem, set the BIOS time-out settings to their maximum values.

QUESTION 377:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com user named Rory Allen is a member of the Research and
Development department. Rory Allen complains that his desktop at home
sometimes will be turned on by itself at midnight.

Which of the following is the likely cause (choose all that apply).

A. the wake-on-LAN feature has been enabled
B. the wake-on-LAN feature has been disabled
C. the UPS has been set to always on

D. the UPS has been set to always off

E. you have an outdated BIOS

Answer: A

Explanation: Some broadband Internet providers periodically probe your computer
to see whether it's still connected. If your network interface card is configured to
wake the computer, one of these probes will do it. If you don't want to disable the
wake-on-LAN feature, you can ensure that probes from your Internet connection
don't rouse your computer by turning off the computer's power completely.

QUESTION 378:
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You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

Certkiller .com contains a network file server named Certkiller -SR16 which is used
to store the files of the Certkiller .com users.

A Certkiller .com user named Andy Booth is a member of the Research and
Development department. Andy Booth complains that he is having trouble moving
files from one folder to another. During routine monitoring you discover that Andy
Booth is attempting to move files from a child folder to a parent folder. When he
double-clicks the parent folder to view its contents, the child folder appears instead.
The only way he can move the files is to open two instances of My Computer.
What should you do to ensure that

Andy Booth can open multiple folders from one instance of My Computer?

A. Select the Simple File Sharing check box.

B. Select the Open each folder in its own window radio button.

C. Select the Launch folder windows in a separate process check box.

D. Select the Display simple folder view in Explorer's Folders list check box.

Answer: B

Explanation: The problem here is that the browser is reusing the folders to show
subfolders. Enabling this setting from Tools -> Folder Options -> View -> Open
each folder in its own windowwill allow the folder to open a new window when
double clicked.

Incorrect Answers:

A. Simple File Sharing allows users to share files without having to worry about ACL's
(Access Control Lists). It has nothing to do with how a folder is displayed.

C. There is no such checkbox as "Launch folder windows in a separate process". The
closest match to this would be to launch each application in its own space, but this has
not been used since Windows NT. This answer tests knowledge of the options available.
D. This answer is incorrect for the same reason as "A". How folders are shared has no
bearing on what happens when a folder is double clicked.

QUESTION 379:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

Certkiller .com uses a third-party virtual private network (VPN) device that is not
configured to accept IPSec VPN connections.

A Certkiller .com user named Amy Walsh is a member of the Research and
Development department. Amy Walsh complains that every time she attempts to
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remotely connect to the company network, she receives the following error message.

Error Connecting to virtual private Metwork [Zunnect...Elg]

' Connecting to 192 168102
LI

Error 786 The L2TP connection atismpt falled because there is no
wakd maching ceilihcate on your compuber o secunty
Authentication

| Redal=54 || cancet || Moelnfo |

During a routine maintenance, you discover that Amy Walshused the New
Connection Wizard on her client computer named Certkiller -WS100 to create a
VPN connection to the new company network. Amy Walsh then changed some of
the VPN connections settings.

What should you do to ensure that Amy Walsh can always establish a VPN
connection to the company's VPN device?

A. Select PPTP VPN as the type of VPN on the VPN connection properties page.

B. Select the Use preshared key for authentication check box in the IPSec settings on the
VPN connection properties page.

C. Ask an administrator to create additional PPTP ports on the VPN device.

D. Ask an administrator to install a computer certificate from Certkiller .com's
certification authority (CA) on the VPN device.

Answer: A

Explanation: IPSec is not used, so L2TP connections should not be used either.
Instead reconfigure to use PPTP VPN.

QUESTION 380:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named

Dean Austin is a member of the Research and Development department. Dean
Austin complains that he used the New Connection Wizard on his portable
computer to create a virtual private network (VPN). When he attempts to establish
a VPN connection to the company VPN server, he receives the following error
message:
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Error Connecting to VPN Server

': Connecting to 198.168.1 .2
L]

Error 800 Unable to establizh the LAN connection. The WPN ; sereer
may be unieachable, o security paramebers may not be configured
propeiy for this cormechion

| Redal=64 || Cancel || Mol |

During an investigation you find out that Dean Austin did not change any of the
default settings for the VPN connection. No other users report problems connecting
the VPN server by using the default VPN connection settings. You also discover that
Dean Austin's computer is connected to the Internet before he attempts to establish

a VPN connection.

What should you do to ensure that Dean Austin can establish a VPN connection to
the company VPN server?

A. Instruct Dean Austin to enter the IP address of the company VPN server in the VPN
connection properties page.

B. Instruct Dean Austin to select the Include Windows logon domains check box on the
VPN connection properties page.

C. Ask an administrator to select the Allow access option button for the dial-up
permissions on the Dean Austin's user account.

D. Ask an administrator to configure the logon hours for Dean Austin's account to allow
him to log on seven days per week, twenty-four hours per day.

Answer: B
Explanation: Confirmed the error on the knowledge base pages with MS.
QUESTION 381:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to configure one dial-up connection on
a user's portable computer. You test the dial-up connection and verify that it
successfully establishes a connection to the Internet.

One morning the user complains that the modem on his portable computer will not
dial. You verify that the user is using Microsoft Internet Explorer to connect to the
Internet.

What should you do in Internet Options in Control Panel to ensure that Internet
Explorer on the user's computer automatically establishes a connection to the
Internet?

A. Configure the LAN settings to automatically detect settings.
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B. Configure the connection settings to always dial the default connection.

C. Configure the dial-up connection settings to automatically detect settings.
D. Configure the dial-up settings to enter the address and port numbers of your
company's proxy server.

Answer: B

Explanation: We only have one dial-up connection so this will be the default
connection. We can configure the connection settings to always dial the default
connection so the modem will dial up whenever the user attempts to access an
internet resource.

QUESTION 382:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional. The client computers are configured as
DHCP clients.

A Certkiller .com user named

Ally Wagner is a member of the Research and Development department. Ally
Wagner complains that her portable computer is not able to access any Web sites
now that she is in the main office.

During routine monitoring you discover that the computer was able to access all
Web sites this morning while at the branch office.

You verify that the computer is properly connected to the network and that it can
ping its loopback address and that the computer is unable to ping any Web site by
using the IP address.

What should you do first to ensure that the computer can access Web sites?

A. Run the netsh command from a command prompt window.

B. Run the ipconfig /renew command from a command prompt window.
C. Modify the default gateway in the user's network configuration.

D. Modify the DNS server IP address in the user's network configuration.

Answer: B

Explanation: The computer has a active lease on the IP address offered from the
DHCP at the branch office. To release and request a new IP address you type
ipconfig /renew.

QUESTION 383:

You work as the network administrator at Certkiller .com. The Certkiller .com

network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
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computers run Windows XP Professional and Microsoft Office XP.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Clive Wilson is a member of the Research and
Development department. Clive Wilson complains that he cannot connect to the
Internet while at the office.

During routine monitoring you discover thatwhenever Clive Wilson opens Internet
Explorer while at the office, the Dial-up Connection dialog box appears. The
Dial-up Connection dialog box is configured to connect to the dial-up account that
he uses to connect to the Internet from home. He created a dial-up Internet
connection and configured Internet Explorer to connect to his ISP.

What should you do in Internet Option in Control Panel to ensure that Clive Wilson
can connect to the Internet at the office and at home when opening Internet
Explorer?

A. Select the Automatically detect settings check box in the LAN settings.

B. Select the Never dial a connection option button on the Connections tab.

C. Select the Bypass proxy server for local addresses check box in the LAN settings.
D. Select the Dial whenever a network connection is not present option button on the
Connections tab.

Answer: D

Explanation: Selecting the Automatically detect settings check box will not help as
this is a setting for Internet connection over LAN and the computer is trying to
connect to a dial-up connection. The Never dial a connection not help at this
moment as the computer is configured to use a Dial-up connection and if you
prohibit it from dialling you wont be able to connect to the Internet. The Bypass
proxy server for local addresses is another LAN only setting that will not solve this
particular problem. The Dial whenever a network connection is not present option
will solve this problem and this setting should be enabled on all mobile computers
that are allowed to connect to the Internet from outside the company network.

QUESTION 384:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Andy Reid is a member of the Research and
Development department. Andy Reid complains that he cannot access any network
resources. You discover that he can log on to his computer without errors. When the
user tries to access network resources, he receives the following error message:
"Windows cannot reach the network resource.”

You ask Andy Reid to run the ipconfig /all command on his computer. The results
are shown below.
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What is the most likely cause of the problem?

A. A DHCP server is unavailable.

B. The TCP/IP Node Type is incorrect.

C. The TCP/IP subnet mask is incorrect.

D. The computer's host name has a conflict with another computer name.

Answer: A

Explanation:

The computer is using an IP address from the APIPA (Automatic Private IP

Address) Class B network (169.254.0.0/16) witch is automatically assigned to a

computer, using DHCP for dynamic IP address allocation, when the computer is

unable to contact a DHCP server. It is possible to disable the use of APIPA on a

Windows XP computer by editing the
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters\Interfaces\adapter
registry value

QUESTION 385:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

The CIO's desktop is connected to the internet through a DSL line directly. To
protect this desktop, which of the following should you deploy?

A. ICF
B. ICS
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C. ARS
D. ASR

Answer: A

Explanation: Internet Connection Firewall (ICF. is a software component that
blocks unsolicited traffic from the Internet. It does this by monitoring all inbound
and outbound communication involving the computers it protects.

QUESTION 386:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

Certkiller .com has its headquarters in Chicago and a branch office in Dallas. The
Dallas branch office is connected to the Internet by a persistent cable modem
connection.

The branch office contains a client computer named Certkiller -WS101. A
Certkiller .com user named Amy Wilson is a member of the Sales department in the
Dallas branch office. Amy Wilson complains that she is unable to find the log
generated by Internet Connection Firewall (ICF) on Certkiller -WS101. You
discover that Certkiller -WS101 is configured to have ICF log all dropped packets.
What should you do to ensure that Amy Wilson can find the log generated by ICF
on Certkiller -WS101?

A. View the security.log file.

B. View the pfirewall.log file.

C. View the system log in Event Viewer.

D. View the application log in Event Viewer.

Answer: B

Explanation: If you search the help on your local computer for ICF. Then view
security log file you will see pfirewall.log file. This is the default name for the
firewall.log, which is located in the Windows folder.

QUESTION 387:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

The CIO's desktop is connected to the internet through a DSL line directly. To
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protect this desktop, you configure the connection firewall to log dropped packets.
What format does this log use?

A. W3C

B. W3C Extended
C.BIN

D. ISC2

Answer: B

Explanation: The log uses the W3C Extended Log format, a standard logging
format that allows you to analyze data using third-party utilities. To understand
what the columns mean, look at the column headers in line 4.

QUESTION 388:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

On a desktop computer you have enabled ICF. After you have enabled ICF the
small web service no longer works according to the users who are expected to view
the pages.

What should you do?

A. Configure ICF to allow incoming web traffic

B. Configure ICF to allow outgoing web traffic

C. Configure the TCP/IP filter to explicitly allow port 80 traffic
D. Install 1S on your desktop

Answer: A

Explanation: By default, ICF blocks all unsolicited incoming data packets. If you
run a Web, FTP, or Telnet site, or if you want to enable contact from the outside on
some particular TCP port, you need to take some additional setup steps. To enable a
service, such as HTTP Web Server, click the Services tab in the Advanced Settings
dialog box.

QUESTION 389:
You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All

servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.
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You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications.

A Certkiller .com user named Rory Allen is a member of the Sales department. You
have enabled ICF on his desktop computer.

After you have enabled ICF, no one from outside the internal network can ping the
desktop. What should you do?

A. Configure the relevant ICF settings

B. Map the ICMP port to the LAN interface

C. Release and renew your DHCP configuration
D. Check your network connection and retry

Answer: A

Explanation: Error correction and diagnostic commands, such as Ping and Tracert,
use Internet Control Message Protocol (ICMP. rather than TCP or UDP. These
functions are also disabled by default on an ICF-protected network. To enable
them, click the ICMP tab of the Advanced Settings dialog box.

QUESTION 390:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

You have received instruction from the CIO to assist in the configuration and
maintenance of desktop applications. You enabled ICF on the CIO's computer.
What ICF setting allows you to inspect outgoing traffic?

A. Configure the relevant ICF settings

B. Map the outgoing traffic port to the LAN interface
C. Release and renew your DHCP configuration

D. Check your network connection and retry

E. There is nothing you can do about it with ICF.

Answer: E

Explanation: ICF is concerned only with blocking unwanted inbound traffic.
However, some viruses and Trojan horses do their mischief by lodging themselves
on your system, reading your address books, and then using your computer to
launch attacks.

QUESTION 391:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
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servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Amy Walsh is a member of the Marketing department.
Amy Walshcomplains that when she tries to purchase an airline ticket online, she
receives the following error message: "Cannot load the page, please contact your
system administrator".

During a routine maintenance, you discover that she can access other sites without
receiving the error message.

What is the most likely cause of the error?

A. The network connection is faulty.

B. The TCP/IP stack has been corrupted.

C. Port 80 (HTTP) on the firewall is disabled.
D. Port 443 (HTTPS) on the firewall is disabled.

Answer: D

Explanation: He is on a secure web site purchasing airplane tickets. Thus port 443
(https) closed on the firewall.

QUESTION 392:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

Certkiller .com has its headquarters in Chicago and a branch office in Miami. The
computers in the Miami branch office is configured with static IP address.

A Certkiller .com user named Dean Austin is a member of the Marketing department
in the Miami branch office. Dean Austin uses the New Connection Wizard to create
a broadband connection to the Internet. The connection requires a user name and
password. Dean Austin enables Internet Connection Sharing (ICS) on the Internet
connection. Dean Austin tests the connection and is able to view Web sites on the
Internet.

Now Dean Austin complains that after enabling ICS he cannot connect to any other
computers at the Miami branch office. The other computers at the branch office
cannot connect to his computer or access the Internet by using his computer.

What should you do to ensure that all computers in the Miami branch office can
connect to each other and connect to the Internet by using Dean Austin's computer?

A. Tell the other users in the branch office the user name and password for the Internet
connection on his computer. Instruct all these users to create a broadband connection to
the Internet by using the user name and password.

B. Clear the Allow other network users to control or disable the shared Internet
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connection check box on the Advanced tab of the Internet connection properties
page.

C. Select the Obtain an IP address automatically and the Obtain DNS server address
automatically option buttons on the TCP/IP properties page.

D. Run the ipconfig /renew and the

ipconfig /flushdns commands on all computers in the branch office.

Answer: C

Explanation: When ICS is enabled, all computers must use DHCP to obtain
addresses. ICS will install by default a mini-DHCP server, and assign all computers
that need to use ICS an ip in the range of 192.168.0.1-192.168.0.254. Since all the
workstations are using static IP addresses, the connection can not be made.
Incorrect Answers:

A. Instructing all users to create a broadband connection will not work principally due to
the fact that none of the users have a broadband connection on their workstation. The
whole intent of this question is to allow all other users to utilize this connection and not
have to create one of their own. Therefore, this can not be the correct answer.

B. Other users can not currently see the workstation, and especially not the ICS
connection. Until the users can see the workstation, there is no need to change the
permissions on the ICS. Therefore, this can not be the best answer.

D. Running ipconfig /renew will not have any effect on the computers in the office since
they all use static IP addresses. Ipconfig /renew is only valid for workstations using
DHCP.

QUESTION 393:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

The Certkiller .com users use the client computers at both the office and at home.
The office computer is connected to the Certkiller .com network which is connected
to the Internet by a T1 line. The home computers are configured with static IP
address and connect to the Internet by using a persistent cable modem connection.
A Certkiller .com user named Andy Reid is a member of the Marketing department.
Andy Reid complains that he wants to use a Remote Desktop connection from his
office computer to control his computer at home. You verify that the company's
Internet firewall permits Remote Desktop connection traffic. But, Andy Reid cannot
make a connection by using Remote Desktop.

Which should you do to ensure that

Andy Reid can make a Remote Desktop connection from his office computer to his
home computer and your solution must prevent any other Internet traffic from
reaching the home computer? (Each correct answer presents part of the solution.
Choose two)
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A. On Andy Reid's office computer, enable Internet Connection Sharing (ICS).

B. On Andy Reid's office computer, add his domain user account to the Remote Desktop
Users group.

C. On Andy Reid's home computer, enable Internet Connection Firewall (ICF).

D. On Andy Reid's home computer, enable the Remote Desktop option in the Internet
Connection Firewall (ICF) services.

Answer: C, D

Explanation: To keep the home computer secure you should start by enabling the
ICF. By default if you're running Windows XP Service Pack 2 (SP2) and you enable
Remote Desktop, Windows Firewall will be automatically configured to allow
Remote Desktop connections to your computer. If you or someone else has removed
the Remote Desktop exception then you'll have to manually add it by open the
Security Center, click Windows Firewall and click the Exceptions tab, and select
Remote Desktop.

QUESTION 394:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP. Certkiller .com
has its headquarters in Chicago and a branch office in Dallas.

A Certkiller .com user named Rory Allen is a member of the Sales department. Rory
Allencomplains that he cannot use Remote Desktop to connect to his computer at
the main office while he is on his computer at the branch office in Dallas.

During a routine maintenance, you discover that Rory Allen has a computer at the
Chicago office and a computer at the branch office. He runs Internet Connection
Firewall (ICF) on both computers.

You verify that Remote Desktop is enabled on the

Rory Allen's computer at the Chicago office. You run the ping command between
the Rory Allen's two computers and find that they communicate with each other.
You also ensure that the firewall between the Chicago office and the Dallas office
allows for Remote Desktop connections.

What should you do to ensure that Rory Allen can connect to his computer at the
Chicago office by using a Remote Desktop connection while working at the Dallas
office?

A. Instruct Rory Allen to disable ICF on his computer located at the Chicago office.
B. Instruct Rory Allen to disable ICF on his computer located at the Dallas office.

C. Enable Internet Connection Sharing (ICS) on the user's computer located at the
Chicago office.

D. Enable Internet Connection Sharing (ICS) on Rory Allen's computer located at the
Dallas office.
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Answer: A

Explanation: ICF will prevent Remote Desktop Connections from working by

default. In order to allow this, the ICF must be set to allow RDC connections (Port
3389). Since there is no mention that this is done, this is the most likely problem.
Disabling the ICF on the receiving computer (in this case the work computer)

should resolve the problem.

Incorrect Answers:

B. Disabling the ICF of the branch office will not help Rory Allen to connect to the work
office. ICF needs to be disabled on the workstation that is RECEIVING the request.

C. ICS is not relevant here. Rory Allen is not trying to share his internet connection. He
is trying to connect from one computer to another. Since there is already a connection
established (known because the two computers can ping each other), there is no need for
ICS.

D. Incorrect for the same reason as "C". Remember to know the difference between ICS
and ICF.

Note: By default, with the ICF enabled, the two computers would not be able to ping
each other, as ICMP (ping) requests are dropped! Unless the ICF has been modified
already, this situation will not exist in real life. However, for the purposes of this exam,
answer "A" is still the best answer.

QUESTION 395:
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You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named Mia Hamm is a member of the Research and
Development department. Mia Hamm complains that she is unable to use Remote
Desktop connection from her work computer to her computer at home.

During a routine maintenance, you discover that Mia Hamm's home computer runs
Windows XP Home Edition and uses a static IP address to connect to the Internet
by using a persistent cable modem connection. You also notice that Mia Hamm
configured her office computer to use a Remote Desktop connection and configured
Internet Connection Firewall (ICF) on both computers.

Your solution needs to ensure that each computer is as secure as possible.

What should you do to allow only the Remote Desktop connection from the Mia
Hamm's office computer to her home computer?

To answer, configure the appropriate option or options in the two dialog boxes.

Answer:

Explanation: Remote Desktop (on the Home Computer)
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Explanation

If you use ICF in Windows XP, follow these steps on the remote machine (the machine
you want to connect to using Remote Desktop):

1. Open the Network Connections folder (located in the Control Panel).

2. Right-click on the firewall connection and select Properties.

3. Click the Settings button on the Advanced tab.
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4. Check the Remote Desktop box on the Services tab.
5. Close all of the dialog boxes.

QUESTION 396:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional with Service Pack 2 (SP2).

A Certkiller .com user named Dean Austin is a member of the Research department.
He recently set up an FTP server named Certkiller -SR10 as part of an Internet
Information Services (11S) solution.

Dean Austin complains that when people attempt to send files to him by using FTP,
he cannot receive them. The user has only one network connection.

What should you do to allow Dean Austin to receive files that are sent by using
FTP?

A. In Security Center, click Windows Firewall. On the Advanced tab, under Service
Settings, select FTP server.

B. In Security Center, click Internet Options. On the Advanced tab, select Enable folder
view for FTP sites.

C. In 1IS, open the Default FTP Site Properties dialog box, and select Enable Logging.
D. In IS, open the Default FTP Site Properties dialog box, and click the Home Directory
tab. Under FTP Site Directory, verify Local Path, and select Read, Write, and Log Visits.

Answer: A

Explanation: In ICF, services refer to applications that run on your computer and
provide a resource that can be accessed by other computers on the network or the
Internet. Examples of services include a Web server, File Transfer Protocol (FTP)
server, mail servers, and so on. If you are running a service that you want people to
be able to access, you must configure ICF to allow traffic that is related to the
service through the firewall.

QUESTION 397:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional with Service Pack 2 (SP2).

Certkiller .com contains a client computer named Certkiller -WS290 which
includes Windows Firewall and is configured with Internet Connection Sharing
(ICS). The firewall is configured to log all dropped packets.

A Certkiller .com user named Andy Reid is a member of the Finance department.
Andy Reidcomplains that the Windows Firewall log file does not save the older
logged events.
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During an investigation you discover that the log file is not large enough to register
all the events that Andy Reid wants to have available.

What should you do to ensure that a single log file for Windows Firewall on Clientl
can store up to 10 MB of data?

A. In Event Viewer, configure the maximum log size for the security log to greater than
10,000 KB.

B. In the properties for the Pfirewall.log file, on the General tab, click Advanced, and
ensure that Compress contents to save disk space is cleared.

C. In Event Viewer, configure the maximum log size for the application log to greater
than 10,000 KB.

D. In the security logging for Windows Firewall, set the log file options to 10,000 KB.

Answer: D
Explanation: Firewall Log settings are not managed through the Event viewer and

compressing the log file will no help as it is the uncompressed size that counts. The
size of the log file is set at the same location where you enable logging (se figure).
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QUESTION 398:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Home Edition with Service Pack 2 (SP2).

Certkiller .com contains a computer that does not have file and print sharing
enabled.

A Certkiller .com user named Rory Allen is a member of the Sales department. Rory
Allencomplains that he cannot successfully use the ping command to connect to
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another computer on his home network. You discover that Rory Allen has two
computers that run Windows XP Home Edition on the network. Windows Firewall
is enabled on both computers.

What should you do to ensure that Rory Allen can receive a ping response from the
computers that run Windows XP?

A. In Windows Firewall, on the Advanced tab under ICMP, click Settings, and select
Allow redirect.

B. In Windows Firewall, on the Advanced tab under ICMP, click Settings, and select
Allow incoming echo request.

C. In Windows Firewall on each computer, on the Advanced tab, click Restore defaults.
D. In Windows Firewall, on the Advanced tab under ICMP, click Settings, and select
Allow incoming router request.

Answer: B

Explanation:

Allow Incoming Echo Request - Controls whether a remote computer can ask for and
receive a response from the computer. Ping is a command that requires you to enable this
option. When enabled (as with other options), attackers can see and contact the host
computer.

QUESTION 399:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional with Service Pack 2 (SP2).

A Certkiller .com employee named Andy Booth uses computers that run Windows
XP Professional both at the office and at home. The office computer is connected to
the company network. The company network is connected to the Internet by a T1
line.

The home computer of Andy Booth uses a static IP address and connects to the
Internet by using a persistent cable modem connection. Andy Booth wants to use a
Remote Desktop connection from his office computer to control his home computer.
You confirm that the company's Internet firewall permits Remote Desktop
connection traffic. You instruct Andy Booth to enable Remote Desktop on his home
computer. But, he cannot make a connection by using Remote Desktop.

What should you do to ensure that Andy Booth can make a Remote Desktop
connection from his office computer to his home computer and still ensure security
against incoming threats?

A. On Andy Booth's home computer, in Security Center, click Windows Firewall. On the
Exceptions tab, select Remote Desktop.

B. On Andy Booth's office computer, enable Windows Firewall.

C. On Andy Booth's home computer, enable Windows Firewall.
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D. On Andy Booth's office computer, in Security Center, turn off Windows Firewall.
Answer: A

Explanation:

Wrong Answer - Option B, C, D this problem has nothing to do with if the ICF is enabled
or disabled. The problem is connected to how ICF is configured.

Right Answer - By default if you're running Windows XP Service Pack 2 (SP2) and you
enable Remote Desktop, Windows Firewall will be automatically configured to allow
Remote Desktop connections to your computer. If you or someone else has removed the
Remote Desktop exception then you'll have to manually add it by open the Security
Center, click Windows Firewall and click the Exceptions tab, and select Remote Desktop.

QUESTION 400:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional with Service Pack 2 (SP2) and have
Microsoft Internet Explorer configured as their Web browser.

A Certkiller .com user named Mia Hamm is a member of the Research department.
Mia Hammcomplains that she cannot receive files by using Windows Messenger
after she installs SP2.

What should you do to ensure that Mia Hamm can receive files by using Windows
Messenger?

A. Add Windows Messenger to the Startup folder, and restart the computer.

B. In Network Connections, change Mia Hamm's network connection properties to
enable Internet Connection Sharing (ICS).

C. In Windows Messenger, on the Tools menu, click Options. On the Preferences tab,
select Allow this program to run in the background.

D. In Security Center, click Windows Firewall. On the Exceptions tab, under Programs
and Services, select Windows Messenger.

Answer: D

Explanation:

Wrong Answers: Option A - will not achieve anything more than automatic startup of the
Windows Messenger when the computer logs in.

Option B - ICS is used to create small SOHO networks where all computers on the
network connect to the Internet through one computer that is equipped with some kind of
hardware to make the real connection to an ISP.

Option C - This is a default setting, it only enables the Windows Messenger to stay active
in the activity field.

Right

Answer: The exception for Windows Messenger has probably been removed and
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therefore you will have to add it manually by it by open the Security Center, click
Windows Firewall and click the Exceptions tab, and select Windows Messenger under
Programs and Services.

QUESTION 401:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional with Service Pack 2 (SP2).

A new Certkiller .com policy requires that users use Microsoft Internet Explorer as
their Web browser.

A Certkiller .com user named Dean Austin is a member of the Marketing
department. Dean Austincomplains that he cannot use Remote Desktop to connect
his office computer to his home computer.

During monitoring you discover that the user's home computer runs Windows XP
Professional with SP2 and is connected to the Internet. The home computer has
Windows Firewall and Remote Desktop enabled.

What should you do to ensure that Dean Austin can use Remote Desktop to connect
his office computer to his home computer?

A. In Windows Firewall on the home computer, click the Exceptions tab, and select
Remote Desktop.

B. In System Properties on the office computer, click the Remote tab. Click Select
Remote Users, and add the name of the home computer to the list.

C. In Windows Firewall on the home computer, click the Advanced tab. Under Network
Connection Settings, click Settings, and enable Secure Web Server Services.

D. On the office computer, create a VPN connection to the home computer.

Answer: A

Explanation: By default if you're running Windows XP Service Pack 2 (SP2) and
you enable Remote Desktop, Windows Firewall will be automatically configured to
allow Remote Desktop connections to your computer. If you or someone else has
removed the Remote Desktop exception then you'll have to manually add it by open
the Security Center, click Windows Firewall and click the Exceptions tab, and select
Remote Desktop.

QUESTION 402:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Kara Lang has a computer that connects to her Pocket
PC by using a USB cable. Her computer also has a USB keyboard, a USB mouse,
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and a USB camera attached. All of the devices are attached to a bus-powered USB
hub.

Kara Lang reports that she cannot synchronize her Microsoft Outlook contacts with
her Pocket PC device. The Pocket PC ActiveSync software tells her that it cannot
communicate with the device. During an investigation you find out that she also has
keyboard and mouse problems, such as dropped keystrokes or a frozen mouse
pointer. She reports that unplugging the camera usually solves these problems.
What should you do to ensure that Kara Lang can use ActiveSync with her Pocket
PC?

A. Reinstall the device drivers for the camera.

B. Replace the USB hub with a self-powered model.

C. Uninstall the ActiveSync software, and then reinstall it.

D. Update the device drivers fro the computer's USB controller.

Answer: B

Explanation: User has too many devices attached to the computer including a bus
power USB hub. Replacing it with a self powered model will fix the problem

QUESTION 403:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Andy Reid is a member of the Sales department. Andy
Reid is attempting to connect a new USB keyboard to his computer. The computer
has two USB ports, and both ports are being used by other devices. Andy Reid
complains that he cannot connect the USB keyboard to his computer. During a
routine maintenance, you discover that the computer's available ports are a parallel
port, a serial port, and two PS/2 ports.

What should you do to ensure that Andy Reid can use the new keyboard and the
two existing USB devices without any hardware expense?

A. Obtain a USB-to-PS/2 adapter. Attach the keyboard to an open PS/2 port by using the
adapter.

B. Obtain a serial port version of one of the two existing USB devices. Then connect that
device to the open serial port to free up a USB port for the keyboard.

C. Obtain a self-powered USB hub. Connect all three USB devices to the hub. Then
connect the hub to the computer.

D. Obtain a bus-powered USB hub. Connect all three USB devices to the hub. Then
connect the hub to the computer.

Answer: A
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Explanation: It states you must minimize additional hardware expense. You have
your PS/2 connectors for your mouse and keyboard on your motherboard, so
buying an adapter is the cheapest thing to do and will solve the problem.

QUESTION 404:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Amy Walsh is a member of the Research department.
Amy Walshwants to connect a digital camera to the only serial port on her
computer. The computer also has a free USB port, a free parallel port, and a free
IEEE 1394 port.

Amy Walsh complains that when she tries to use the camera, she receives a message
indicating that the camera is not found. During investigating you find out that the
Pocket PC is attached to the serial port, but that she disconnected it to open up the
port for the camera. She synchronizes the Pocket PC with Microsoft Outlook by
using special software that came with the Pocket PC.

What are two possible ways to achieve this goal to ensure that Amy Walsh can use
the camera on the serial port without stopping Amy Walsh from later reattaching
and using the Pocket PC? (Choose two. Each correct answer presents a complete
solution)

A. Instruct Amy Walsh to temporarily disable the Pocket PC's synchronization software.
B. Instruct Amy Walsh to connect the camera to a USB port by using a serial-to-USB
adapter.

C. Instruct Amy Walsh to open Device Manager and delete the serial port. Then instruct
the user to run Add or Remove Hardware in Control Panel.

D. Instruct Amy Walsh to uninstall the camera software. Then ask an administrator to
reinstall the camera software by using an account that has local Administrator privileges.

Answer: A, B

Explanation:

The problem is that Windows XP believes the serial port is still occupied even

though the PocketPC has been removed. This is most likely due to the PocketPC
software still holding the port. Disabling the software TEMPORARILY will allow

the user to use the serial port for the camera, and allow the user to re-enable the
software when the PocketPC is needed. Another solution is to obtain a serial to USB
converter, and plug the camera into the USB port. This will allow the camera and
PocketPC to run simultaneously, and thereby resolve the problem.

Incorrect Answers:

C. Deleting the serial port violates the requirement that the user be able to reattach the
PocketPC. The user would have to reset the software each and every single time this was
done, as the system would believe that a new serial device was attached, and render the
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software for the PocketPC device incorrect. This is far more work than is required.

D. Uninstalling the camera software will not resolve the problem, as the PocketPC device
still has use of the serial port. This must be worked around before the camera will
function. Remember that just because a serial device is no longer attached does not mean
that the drivers that use the port are not active.

NOTE ON THIS QUESTION: It can be argued that "B" is incorrect since it violates the
requirement that the user must be able to use the camera ON THE SERIAL PORT. If this
logic is correct, then the correct answers must be "A" and "D". | believe that the best
answers are above, but if this question is on your examination, you will need to decide
the best answer for yourself. This is a GUIDE, and not necessarily the end-all of end-alls.

QUESTION 405:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Ally Wagner is attempting to connect a new Pocket PC
to her portable computer. The Pocket PC requires a USB port and her keyboard use
the only USB port on her computer. The only available port on the computer is a
serial port.

What should you do to ensure that Ally Wagner can connect the Pocket PC to her
computer and still have her external keyboard with minimizing new hardware
expenses?

A. Use a USB-to-PS/2 adapter plug for the keyboard.

B. Install a PC card that provides additional USB ports.

C. Upgrade to a computer with additional built-in USB ports.

D. Obtain a USB-to-serial port adapter. Attach the keyboard to the available serial port.
E. Install a self-powered USB hub. Connect both the Pocket PC and the keyboard to the
hub.

Answer: A
Explanation: The keyboard will work in the PS/2 port.
QUESTION 406:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

Certkiller .com contains a Windows Server 2003 print server named

Certkiller -PRO1. A Certkiller .com user named Amy Wilson is a member of the
Research and Development department. One morning Amy Wilson complains that
she cannot print documents.
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Amy Wilson can connect to Certkiller -PRO1 by using its IP address, but she
cannot connect to Certkiller -PR0O1 by using its name. The user states that
currently she is not using any other network resources.

You run the ping command to try to connect to Certkiller -PR01 by name, but the
attempt fails. You then run the ping command to try to connect to

Certkiller -PRO1 by using its IP address, and the attempt is successful.

What should you do to ensure that all users can connect to Certkiller -PRO1 by
using its name?

A. Ask an administrator to repair the Hosts file on Certkiller -PRO1.

B. Ask an administrator to correct the DNS records for Certkiller -PRO1.

C. Instruct Amy Wilson to run the ipconfig /flushdns command from her computer.
D. Instruct Amy Wilson to run the ipconfig /registerdns command from her computer.
E. Configure Amy Wilson's computer to have a Hosts file containing an entry for
Certkiller -PRO1.

F. Configure Amy Wilson's computer to have an Lmhosts file containing an entry for
Certkiller -PRO1.

Answer: B

Explanation: Amy Wilson is having problems connecting to a Windows 2003 Print
Server named Certkiller -PRO1 by name. She can connect by ping the IP address,
but not the name. Therefore, getting the administrator to correct the DNS records
for Certkiller -PRO1 is a possible.

Alternatively, but not as good, is to Instruct the user to run the ipconfig /flushdns
command from her computer.

QUESTION 407:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Mia Hamm is a member of the Sales department. One
morning Mia Hamm complains that she cannot access any network resources.
During an investigation you discover that Mia Hamm can log on to the computer,
but she cannot access her e-mail messages or her mapped drives.

You run the ping command on your client computer named Certkiller -WS190,
but you cannot connect to Mia Hamm's computer. You instruct the user to run the
ipconfig command from her computer. You discover that the computer is using IP
address 169.254.117.54.

What should you do first to ensure that Mia Hamm can access network resources?

A. Instruct Mia Hamm to run the netstat command.

B. Instruct Mia Hamm to run the ipconfig /renew command.
C. Instruct Mia Hamm to remove the user profile on the computer, restart the computer,
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and log on again.
D. Ask a network administrator to remove Mia Hamm's computer account from the
domain and then add it to the domain.

Answer: B

Explanation: There is a network problem with the computer is using a windows
private ip address of 169.254.117.54. You must run the ipconfig /renew
command to obtain a new ip address.

QUESTION 408:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

Certkiller .com has its headquarters in Chicago and a branch office in Dallas.
Certkiller .com contains a Exchange server named Certkiller -SR24.

A Certkiller .com user named Clive Wilson is a member of the Research department.
One morning Clive Wilson complains that when he attempts to use Microsoft
Outlook, he receives a message stating that the computer cannot connect to the
company's Microsoft Exchange Server 2003 computer.

During an investigation you discover that Clive Wilson just relocated from one
branch office to another branch office. Clive Wilson was able to connect to the
Exchange server from his old office. You run the ping command to connect to
several IP addresses on your network. Some of the IP addresses are located in
branch offices. Each attempt is successful.

What should you do to ensure that Clive Wilson's computer can connect to
Certkiller -SR24?

A. Configure the computer to have the correct subnet mask.

B. Configure the computer to have the correct default gateway address.

C. Configure the computer to have the correct IP address for the company DNS server.
D. Configure the computer to have the correct IP address for the company WINS server.

Answer: C
QUESTION 409:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

Certkiller .com contains a DNS server named Certkiller -SR24 that accepts
dynamic updates and a file server named Certkiller -SR10.

A Certkiller .com user named Kara Lang is a member of the Research and
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Development department. One morning Kara Lang complains that she can no
longer connect to a file server named Certkiller -SR10. You discover that Kara
Lang can connect to other file servers, and she was able to connect to
Certkiller -SR10 a few hours ago.

You run the ping command from your computer and successfully connect to
Certkiller -SR10 by name. Another technician informs you that Certkiller -SR10
failed earlier today. This technician also informs you that the server currently
responding as Certkiller -SR10 is a replacement server that was placed online a
few minutes earlier.

What should you do to ensure that Kara Lang can connect immediately to the
replacement server named Certkiller -SR10?

A. Instruct the user to run the netstat -a command.

B. Instruct the user to run the ipconfig /flushdns command.

C. Configure the user's computer to have the correct subnet mask for the subnet to which
it is connected.

D. Configure the user's computer to have an Lmhost file that contains both the NetBIOS
name and IP address for Certkiller -SR10.

Answer: B

Explanation: You must do a flushdns command because the server was replacement
online a few minutes so the dns information is old.

QUESTION 410:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com employee named Ally Wagner works in the Sales department. Ally
Wagner is attempting to synchronize her new cellular telephone with her portable
computer. The telephone connects to the portable computer by means of infrared.
One morning Ally Wagner complains that the telephone cannot contact the
computer. She state that she has installed the telephone's software and configured it
to use infrared.

You instruct Ally Wagner to open the infrared application in Control Panel. The
application reports that no infrared ports are available. You confirm that the
computer has an infrared port installed and that the infrared port is compatible

with Windows XP Professional.

What should you do to ensure that Ally Wagner can synchronize her cellular
telephone with her computer?

A. Uninstall and reinstall the cellular phone's software.

B. Obtain an updated infrared device driver from the computer manufacturer.
C. Open Device Manager and delete all existing ports. Then run Add or Remove
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Hardware in Control Panel.
D. Restart the computer and enter the BIOS setup screen. Then select the option to enable
the onboard IrDA port.

Answer: D

Explanation: By default the IrDA port is disabled in the hardware on most new
computers. You enable the IrDA port through BIOS.

QUESTION 411:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional with Service Pack 2 (SP2).

A Certkiller .com user named Andy Reid works in an office that uses different
wireless networks for different departments. He usually connects to the Accounting
department's wireless network, but he often mistakenly connects to other
department networks instead.

What should you do to make the Accounting department's wireless network to be
his default wireless connection?

A. In Network Connections, click the wireless connection icon. Under Network Tasks,
click Related Tasks, and then click View available wireless networks. Click Change the
order of preferred networks, and then move the Accounting department's wireless
connection to the top.

B. In Network Connections, click the wireless connection icon. Under Network Tasks,
click Related Tasks, and then click View available wireless networks. Click the
Accounting department's wireless connection, and then click Connect.

C. In Network Connections, right-click the Accounting department's wireless connection,
and click Properties. On the Wireless Networks tab, select Use Windows to configure my
wireless network settings.

D. In Network Connections, right-click the Accounting department's wireless connection,
and click Properties. On the Wireless Networks tab, clear Use Windows to configure my
wireless network settings.

Answer: A

Explanation:

Wrong answers: B - Manually connecting to the Accounting wireless network will not
make this network the preferred network.

C, D - The Network Connections will only display you network cards, not specific
connections.

QUESTION 412:
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You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional and Microsoft Office XP.

A Certkiller .com user named Rory Allen is a member of the Research
departmentconnects an external IEEE 1394 (FireWire) hard disk to his computer.
One morning Rory Allencomplains that when he attempts to use the external hard
disk, the hard disk will not turn on. The user states that the hard disk is supposed to
be powered by the IEEE 1394 port. He further states that he followed the directions
that came with the hard disk, and that he connected the hard disk to his computer's
four-pin IEEE 1394 port by using a six-pin to four-pin adapter cable.

What should you do to ensure that Rory Allen can use the hard disk?

A. Obtain an external power adapter for the hard disk.

B. Uninstall and reinstall the device drivers supplied with the hard disk.

C. Obtain a bus-powered IEEE 1394 hub. Connect the hard disk to the hub. Then connect
the hub to the computer.

D. Use a six-pin to six-pin cable that has a six-pin to four-pin adapter plug to connect the
hard disk to the computer.

Answer: A

Explanation: If the computer has a four-pin IEEE 1394 (FireWire) port it will never
be able to power the external hard disk as the 4-pin connectors are not powered.

QUESTION 413:

You work as the network administrator at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All
servers on the Certkiller .com network run Windows Server 2003 and all client
computers run Windows XP Professional.

A Certkiller .com user named Andy Bootha member of the Finance departmentis
attempting to install a new printer on his computer. Andy Booth complains that he
was able to connect the printer to the computer, but Windows displays a message
indicating that he does not have permission to install the printer drivers.

During an investigation you discover that the user usually logs on to his computer
by using a domain user account. His computer does have a local user account that
he can use. Both accounts are members of the local User group on his computer, and
no other local groups. You confirm that the user is allowed to have a locally
connected printer.

What should you do to ensure that the printer is installed on the computer without
giving Andy Boothunnecessary privileges on his computer?

A. Make Andy Booth a member of the local Administrators group. Instruct Andy Booth

to install the printer.
B. Log on to Andy Booth's computer by using an account that has administrative
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privileges. Install the printer.

C. Instruct Andy Booth to search Windows Update for copies of the necessary device
driver. Instruct Andy Booth to download the device driver and install the printer.

D. Instruct Andy Booth to log on to the computer by using local user account instead of
domain user account. Instruct Andy Booth to install the printer.

Answer: B

Explanation: Without administrative rights on the local computer the user will not
be able to install the printer. In order to get the printer installed without giving the
user unnecessary privileges you have to install the printer for him. Once the printer
is installed the user will be able to use it with user privileges.

QUESTION 414:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional and make

use of Microsoft Internet Explorer as their Web browser.

A user named Andy Reid would like to have the highest degree of protection against
cookies. This protection must still allow him to log on to Web sites and store

personal data. He would also like to prevent cookies from advertisers on third-party
Web sites from being stored on his computer.

Of the following options, which is the one that you should take to ensure that the
Andy Reid's Internet options are configured properly?

A. Instruct Andy Reid to enable the Content Advisor in Internet Options in Control
Panel.

B. Instruct Andy Reid to configure the Privacy setting to Medium-High in Internet
Options in Control Panel.

C. Instruct Andy Reid to configure the custom security setting to High for the Internet
security zone in Internet Options in Control Panel.

D. Instruct Andy Reid to add all third-party Web sites to the Restricted sites security
zone in Internet Options in Control Panel.

Answer: B

Explanation:

Setting the Privacy to Medium-High is the best answer. This is another question where
being able to eliminate the incorrect answers leaves the best choice. See below.

Incorrect Answers:

A: Enabling the Content Advisor will block sites that contain offensive content. It does
not have any effect on cookies for web pages that are allowed to load. Therefore, this
answer can be eliminated.

C: Setting the custom security settings to High for the Internet zone looks like a good
answer. However, this setting matches the settings used in the Restricted Sites zone. This
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disallows almost anything from running on a web site. This is far more restrictive than is
required for this question.

D: Adding third party web sites to restricted sites is more restrictive than necessary, all
sites outside the company are "third-party", and in addition, adding each site to the
Restricted Sites would be time consuming, and would result in adding every site visited
to the Restricted Sites list! Certainly not the best answer.

QUESTION 415:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional and
Microsoft Office 2003. A Certkiller .com, user named Clive Wilson, hooks a printer
up to his computer and shares it with other users on the Certkiller .com network.
You then receive a report from

Clive Wilson that the other network users are able to view the printer in a list of
available printers on the Certkiller .com network, but they are unable to print to it.
Clive Wilson informs you that it is essential for Certkiller .com network users to be
able to print to the printer.

Which of the following is the option that you should take?

A. You should instruct Clive Wilson to enable simple file sharing in Windows Explorer.
B. You should instruct Clive Wilson to add the Domain Users group to his computer's
Power Users group.

C. You should instruct Clive Wilson to modify the permissions on the shared printer so
that the Users group has only Print permission.

D. You should instruct Clive Wilson to modify the permissions on the shared printer so
that the Users group has only Manage Documents permission.

Answer: C

Explanation:
Users must be able to print to the printer so the print permissions are fine. The manage
documents permission to too much right for what is needed.

QUESTION 416:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional and
Microsoft Office 2003.

A Certkiller .comuser named Amy Wilsonis attempting to read documents that are
located in \\ Certkiller -SR01\Docs. When Amy Wilsonreports that she is unable to
access any of the documents located in \\ Certkiller -SR01\Docs, you investigate

and discover that the permissions for \\ Certkiller -SR01\Docs are configured as

shown in the dialog box below.
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You then verify that Amy Wilsonhas the necessary permission to read documents on
\\ Certkiller -SR0O1\Docs.

Which of the following is the action that you should carry out to ensure that Amy
Wilsoncan read these documents?

A. Instruct Amy Wilson to map a network drive to \\ Certkiller -SR01\Docs.

B. Instruct Amy Wilson to copy the files from \\ Certkiller -SR01\Docs to his computer.
C. Ask an administrator to modify the share permissions on \\ Certkiller -SR01\Docs.
D. Ask an administrator to modify the NTFS permissions on the documents in

\\ Certkiller -SRO1\Docs.

Answer: D

Explanation:

The share permissions are correct and the user has the appropriate permissions to read
documents through the share. Instructing Amy Wilson to map a network drive to the
share, asking an administrator to change the share permissions will not help as long as the
NTFS permissions are wrong on the content in the shared folder. Neither will the user be
able to copy the files as long as he can't read them.

QUESTION 417:
You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the

variety of windows computers that Certkiller .com uses, Windows XP Professional is
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one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. After setting up your computer for offline files, you now want to make
individual files and folders available for offline use.

To accomplish this, you need to work on which of the following?

A. The client

B. The server

C. Both the client and the server
D. The network connection

Answer: A

Explanation:

After you have set up your computer for offline files, you make individual files and
folders available for offline use by right-clicking them in Windows Explorer and
choosing Make Available Offline. You select files and folders that reside on the server
computer while working from the client computer (the one that will go offline), not the
server.

QUESTION 418:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You have already configured offline files, and you now want to alter
the caching property.

Which of the following is the tool that you should utilize?

A. Shared Folders management console

B. Control Panel - System Information - Performance and Maintenance
C. Control Panel - System Information - Hardware Driver

D. Control Panel - Hardware Wizard

Answer: A

Explanation:

To adjust the caching property, do the following on the server computer:

1. Type%systemroot%\system32\fsmgmt.msc at a command prompt. This runs the
Shared Folders management console.

2. In the console tree (the left pane), select Shares.

3. In the details pane (the right pane), right-click the share whose property you want to
set and then choose Properties.
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QUESTION 419:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You have already configured offline files, and you now want to alter
the caching property.

Which of the following is the tool that you should utilize to call up the relevant
management console?

A. %systemroot%system32fsmgmt.msc

B. %systemroot%system32admgmt.msc
C. %systemroot%system32hwmgmt.msc
D. %systemroot%system32sdmgmt.msc

Answer: A

Explanation: To adjust the caching property, do the following on the server

computer:

1. Type%systemroot%\system32\fsmgmt.msc at a command prompt. This runs the
Shared Folders management console.

2. In the console tree (the left pane), select Shares.

3. In the details pane (the right pane), right-click the share whose property you want to
set and then choose Properties.

QUESTION 420:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You have setup your computer to use offline files and also have
automatic caching enabled. For some or other reason your network connections are
very unstable.

In this instance, should you keep automatic caching enabled?

A. YES, you should
B. NO, you should have it disabled

Answer: B

Explanation:
If you use automatic caching as a means of maintaining continuity in an environment
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where network connections are sometimes broken, you can disable this functionality on
particular client computers.

QUESTION 421.:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You have setup your computer to make use of offline files.

Which of the following would adequately describe how you would rate the
comment: "When you open a cached document from a client computer, the original
document on the server is opened"?

A. True

B. True only if someone else is also using the document
C. True only if automatic caching is not enabled

D. False

Answer: A

Explanation:

When Automatic Caching Of Documents is selected, Windows caches a server-based file
or folder automatically as soon as you access it from the client computer. When you open
a cached document from a client computer, the cached copy is used, but the original
document on the server is also opened to prevent other people from changing the file
while you have it open.

QUESTION 422:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You have setup your computer to make use of offline files.

Which of the following would adequately describe how you would rate the
comment: "With automatic caching it is guaranteed that your server resources

remain in the cache™?

A. True

B. True only if you have enough local drive space

C. True only if you have applied the relevant hot fixes
D. False
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Answer: D

Explanation: Because it doesn't require the separate step of copying a server
resource into your cache, automatic caching is more convenient and easier to use
than the default manual caching. On the other hand, with automatic caching,
Windows doesn't guarantee that your server resources remain in the cache

QUESTION 423:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You are currently planning to set up application caching.

Is it true that even application programs can be cached?

A. Yes, readable and changeable

B. Yes, readable but not changeable

C. No

D. No unless you use Terminal Service on the server side

Answer: B

Explanation:

You can use the Automatic Caching Of Programs setting for folders that contain
programs and documents that are read but not changed. (In fact, you should restrict
permissions on such folders to read-only. Automatic caching of programs can speed up
access to programs and documents, because after a file is cached, your system does not
have to retrieve it from the server again; only the local copy is opened.

QUESTION 424:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You have setup your computer to make use of offline files.

Which two of the following options describes the default setting for synchronizing
your offline files and folders? (Choose two)

A. when you log off
B. when you log back on
C. every 15minutes
D. every 30 minutes
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Answer: A, B

Explanation:

By default, your offline files and folders are synchronized when you log off your account
and synchronized again when you log back on. This means that your work is current
when you leave the office, and your server is brought up to date when you return.

QUESTION 425:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You need to be capable of starting Internet Explorer as quickly as
possible.

Which of the following is the command that you should utilize so that you could
have Internet Explorer open without a home page?

A. iexplore -nohome
B. iexplore -nh

C. iexplore -n

D. iexplore -blank

Answer: A

Explanation:

To start Internet Explorer as quickly as possible, have it open without a home page. You
can create a shortcut with the following command string: iexplore -nohome, but when
you start Internet Explorer this way, some of the menu commands are unavailable until
you actually load a page.

QUESTION 426:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications.

Which of the following is the folder that the shortcut will be stored in, when you add
a shortcut of any kind to your IE's Links toolbar?

A. %UserProfile%FavoritesLinks
B. %UserProfile%Local SettingsLinks
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C. %UserProfile%My DocumentsFavoritesLink
D. %UserProfile%FavoritesApplication DataLinks

Answer: A

Explanation:
When you add a shortcut of any kind to your Links toolbar, Internet Explorer stores the
shortcut in the folder %UserProfile%\Favorites\Links.

QUESTION 427:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. There is an address book on your desktop that contains contact
information of multiple identities.

Which of the following is the command that you should use if you want to see the
contacts of all the identities defined in Outlook Express?

A. wab /a

B. wab /all
C.wab *.*
D. wab OE.*

Answer: A

Explanation:

Address Book normally shows only the current identity's contacts and the shared
contacts. You can see the contacts of all the identities defined in Outlook Express by
starting Address Book from a command line-type the command string wab /a.

QUESTION 428:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional.

A user named Rory Allen reports that he can log on to his computer, but he is
unable to access the Certkiller .com network.

When you run the ping command from your computer, you find that you cannot
access the Rory Allen's computer. Rory Allen confirms that his network cable is
attached and that the lights on the back of the network adapter are blinking.

You then decide to run the ipconfig command from the Rory Allen's computer, and
discover that the IP configuration does not match the network's IP information.
Which of the following is the task that you should complete FIRST to help Rory
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Allen gain network access?

A. Run the virus scan on the user's computer.

B. Replace the network adapter on the user's computer.

C. Instruct the user to plug his network cable into another port on the switch.

D. On the user's computer, run the ipconfig /release command and then run the ipconfig
Irenew

Answer: D

Explanation:

Rory Allen must run ipconfig /release and ipconfig /renew. The IP address that the user
currently has is not the same one that the DHCP server has issued. This is why the
workstation can not be pinged, but there is activity on the network card (shown by the
flashing lights). Asking for a new IP address should resolve the problem.

Incorrect Answers:

A This type of problem is not a symptom of a virus. This problem presents itself when
the network and the workstation can not agree on where the PC resides. (Its address is
incorrect.) Running a virus scanner is always a good idea, but it would not be the first
thing to try in this case.

B Replacing the network adapter is a possibility. However, since it involves time, effort,
and work, it is not the BEST solution. The best solution is to always try the simplest
things first. Releasing and renewing the address is far simpler that powering down the
station, cracking open the case, replacing the NIC, and then loading the drivers for the
new NIC.

C The user should never be plugging his own cables into the switch. Ideally, the cable is
going to a wall outlet and from there to a switch. In any event, since there is activity on
the NIC, there is a strong probability that the switch port is functioning as it should.

QUESTION 429:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional.

When a user named Amy Walsh reports that she is unable to browse the network or
access her e-mail messages, you discover that Amy Walsh's mapped network drives
are not accessible.

You then search for the proper default gateway address for Amy Walsh's subnet,

but you are unable to ping to the gateway address from her computer.

Which of the following adequately describes the most likely reason for this

problem?

A. Amy Walsh's computer does not have a valid DNS server address.

B. Amy Walsh's computer does not have a hardware connection to the network.
C. Amy Walsh's computer does not have a valid computer account in the domain.
D. The DHCP server is not renewing the client computer's IP address lease.
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Answer: B

Explanation:
No network connection, or email access. No mapped drives and can't ping the default
gateway hardware connection problem

QUESTION 430:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional.

When a user namedAmy Wilson reports that she is unable to connect to the

Internet, you find that the she is able to connect to all internal network resources.

You also discover that she can connect to external resources via IP address, but not

by name.

Of the following tasks, which is the one that you should complete to make sure that
Amy Wilson can connect to internal and external resources by name?

A. Configure Amy Wilson's computer to have the correct Lmhosts file.

B. Configure Amy Wilson's computer to have the correct subnet mask.

C. Configure Amy Wilson's computer to have the correct DNS server IP address.
D. Configure Amy Wilson's computer to have the correct default gateway address.

Answer: C

Explanation:
User is having problems connecting to any external resources by
name, so this is a DNS problem.

QUESTION 431:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional and
Microsoft Office 2003.A manager at Certkiller .com named Andy Boothuses a client
computer called Certkiller -WSO001.

Andy Boothreports that he is unable to modify the files in a shared folder located on
his computer, named MyDocs. After a brief investigation, you discover that a folder
named C:\Docs on Andy Booth's computer is shared as MyDocs and that he is able
to modify the files when accessing them via C:\Docs.

Andy Boothinforms you that other users will need to access and modify the
documents contained in MyDocs, and that these users will be connecting through a
domain user account.

The CIO instructs you to make sure that Andy Boothand all other required users

are able to modify the files by accessing them through MyDocs.
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Which of the following is the option that you should take to achieve this objective?

A. Instruct all users to map a network drive to \\ Certkiller -WS001\MyDocs when they
need to modify a file.

B. Instruct the manager to create a local user account for each network user that needs to
modify the files in MyDocs.

C. Instruct the manager to modify the share permissions on MyDocs so that the Users
group has Read permissions and Change permissions.

D. Instruct the manager to modify the share permissions on MyDocs so that the Guest
group has Read permissions and Change permissions

Answer: C

Explanation:

The fact that the manager can modify the documents when accessing them through
C:\Daocs points towards faulty share permissions on the shared folder

\\ Certkiller -WS001\MyDaocs. Instructing users to map a network drive to

\\ Certkiller -WS001\MyDocs would not help as long as the share permissions are
wrong. Creating local users on Certkiller -WS001 would not help as the users will use
their domain accounts to access the files. Giving the Guest account Read and Change
permissions on the share would allow more than the required users access to the shared
folder.

QUESTION 432:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional and
Microsoft Office 2003.

After a Certkiller .com user attempts to modify documents that are located in

\\ Certkiller -SR01\Docs, she reports that she is unable to update any of these
documents. She states that she can, however, open all of the documents in

\\ Certkiller -SR01\Docs. While viewing the NTFS permissions on the documents,
you confirm that the user has the permissions required to modify these documents.
You have been given the responsibility of ensuring that the user can update the
documents on \\ Certkiller -SR01\Docs. In addition to this, your solution has to
guarantee that the updated documents are saved in \\ Certkiller -SR01\Docs.
Which of the following is the task that you should complete to achieve this
objective?

A. Ask an administrator to modify the share permissions on \\ Certkiller -SR01\Docs.

B. Ask an administrator to disable Volume Shadow Copy on the volume that contains

\\ Certkiller -SRO1\Docs.

C. Instruct the user to map a network drive to \\ Certkiller -SR01\Docs.

D. Instruct the user to copy the documents from \\ Certkiller -SR01\Docs to her
computer, instruct her to modify the documents on her computer, and then instruct her to
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copy the documents back to \\ Certkiller -SR0O1\Docs.
Answer: A

Explanation:

The user is accessing a network share, so you have NTFS permissions and

share permissions that apply to the directory. You must change the share permission for
that user to be able to update the documents as needed.

QUESTION 433:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional and
Microsoft Office 2003.

A user at Certkiller .com shares a computer with two other Certkiller .com users.
These three Certkiller .com users exchange documents by placing them in the local
Shared Documents folder.

Currently, each of the three users who share the computer only has Full Control
permission on the files and folders that he or she placed in Shared Documents. One
of the users asks you to make sure that they have the required permissions to read,
write, and manage all files and folders in Shared Documents.

Which of the following is the task that you should complete to comply with this
request?

A. Modify the permissions on Shared Documents so that the Users group has Full
Control permission.

B. Modify the permissions on Shared Documents so that the Users group has Change
permission and Read permission.

C. Instruct each user to modify the permission on the folders they create so that the
Creator Owner user has Full Control permission.

D. Instruct each user to modify the permission on the folders they create so that the
Creator Owner user has Change permission and Read permission.

Answer: A

Explanation:

If manage is read as being able to decide on the ability to remove files, then the Users
need Full Control Permission.

QUESTION 434:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client

computers on the Certkiller .com network run Windows XP Professional and all
users use Microsoft Internet Explorer as their Web browser.
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A user named Dean Austin calls you from a client's office and reports that he is
unable to access the Certkiller .com Web site from his portable computer. He also
reports that Internet Explorer displays the error message: "Cannot find server or
DNS Error”, when he tries to access the Web site.

Dean Austin confirms that the staff at the client's office does not receive this error
message and are able to view Web sites on the Internet.

After verifying that the Dean Austin's computer is connected to the customer
network, you instruct him to ping the IP address of the Certkiller .com Web server
on the Internet. Andy Booth later informs you that the ping command reported a
successful reply.

What should you do to make sure that Andy Booth is able to access the

Certkiller .com Web site from the client network?

A. You should instruct Andy Booth to configure the Privacy setting to Medium.

B. You should instruct Andy Booth to configure the security level for the Internet zone to
Medium.

C. You should instruct Andy Booth to select the Repair option on the user's Local Area
Connection.

D. You should instruct Andy Booth to select Automatically detect settings check box for
the LAN connection settings in Internet Options in the Control Panel.

Answer: D

Explanation:

Automatically detect settings allows the client to automatically receive proxy server
configuration from a properly configured Dynamic Host Configuration Protocol (DHCP)
or Domain Name System (DNS) server.

QUESTION 435:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional and
Microsoft Office 2003.

A user named Ally Wagner reports that she needs to share the C:\Documents\Sales
folder on her computer with other specific network users and that she would like
only members of the domain Sales group to be capable of reading or modifying the
files. This means that besides the users mentioned, no other user should have access
to the files.

You are given the task of making sure that Ally Wagner has the ability to properly
share the files.

Which of the following is the option that you should take to complete this task
instruct Ally Wagner to do?

A. Instruct Ally Wagner to add the domain Sales group to the local Power Users group
on her computer.
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B. Instruct Ally Wagner to first enable simple file sharing, to share the folder that
contains the files next, and to then select the check box to allow network users to change
the files.

C. Instruct Ally Wagner to first disable simple file sharing, to share the folder that
contains the files next, and to then configure the share permissions so that only the
domain Sales group has Read permission and Change permission.

D. Instruct Ally Wagner to first move the files into the Shared Documents folder on her
computer, and then configure the NTFS permissions on the files so that only the domain
Sales group has Read permission and Change permission.

Answer: C

Explanation:
You are giving the sales group the correct permission needed to the folder. You need to
disable Simple File Sharing in order to configure permissions on the shared files.

QUESTION 436:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional and
Microsoft Office 2003.

A user at Certkiller .com recently received a computer, which was not reformatted
before he started using it, from another Certkiller .com user.

The current user now reports that he is unable to delete a file that was created by

the computer's original user, named C:\Test\Test.doc. He informs you that when he
attempts to delete the file, he receives the following error message: "Access denied".
He also reports that this problem does not arise for any other files in the same
folder.

Which of the following is the action that you should take to ensure that the current
user is able to delete this file?

A. Instruct the user to move the file to the My Documents folder and delete the file.

B. Instruct the user to move the file to the Shared Documents folder and delete the file.
C. Connect to the computer by using an account that has local Administrator privileges.
Modify the NTFS permissions on the file so that the Users group has Read permission.
D. Connect to the computer by using an account that has local Administrator privileges.
Modify the NTFS permissions on the file so that the Users group has Full Control
permission.

Answer: D

Explanation:
Permission problem user needs full control to access the files.
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QUESTION 437:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional and
Microsoft Office 2003.

A user named Dean Austin reports that he is unable to access the documents on

drive Z of his computer. Dean Austin also informs you that that a different

Certkiller .com technician recently mapped drive Z to a file share on \\FilesO4.

You discover a single shared folder named Docs when you utilize the Run option

from the Start menu to open \\FilesO4. The share permissions on Docs are

configured as shown in the dialog box below.

Permissions for Docs E‘EI&

Share Permissions

. .- e S i

[ add. ][ Remove | |
r:e.'rrnimn: ot E W‘fj'l'hnl.'.:l (il L’w _—
Full Cortiol [] L]
Chanigs ] O]
Read [#] [l

l_ (K J| Cancel |

You then decide to view the NTFS permissions on all files in Docs, and observe the
information displayed in the following dialog box.
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For special pemessions or for advanced setings.
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[ ok ][ camee || aApob |
Which of the following is the option that you should take should you do to make
sure that Dean Austin can read the documents in \\FilesO4\Docs?

A. Instruct Dean Austin to map drive Z to \\FilesO4\Docs.

B. Instruct Dean Austin to copy the documents from drive Z to local computer.

C. Ask an administrator to modify the share permissions on \\FilesO4\Docs.

D. Ask an administrator to modify the NTFS permissions on the files in \\FilesO4\Docs.

Answer: A

Explanation:

The driver is incorrectly mapped. The question states that a technician changed the
mapping to \\Files04. It should be mapped as: \\Files04\Docs.

It is not a permission problem because the NTFS and Shared permissions both have the
allow read permission and there is no deny permissions of any kind.

Copying the documents to the local computer is not possible because you can't access the
documents off the network.

QUESTION 438:

Given the statement below:
"Outlook Express is set by default to prevent you from saving any attachment that
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could possibly be a virus."
Which of the following adequately describes how you would rate the above
statement?

A. True

B. True only when Windows XP Professional SP1 is applied
C. False

D. True only if ICF is running

Answer: A

Explanation:

Outlook Express is set by default to prevent you from saving or opening any attachment
that could possibly be a virus. If a message arrives containing such an attachment,
Outlook Express notifies you that it has blocked access to the attachment.

QUESTION 439:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional and have an
antivirus application installed.

When a user named Mia Hamm reports that files in a shared folder on her

computer are being deleted, the first thing you do is confirm that the Mia Hamm's
computer has the most recent virus signature file and that no viruses are detected

on her computer.

You have to find out who is deleting files from Mia Hamm's computer.

Which of the following is the option that would allow you to achieve this goal?

A. View the system log in Event Viewer.

B. Enable successful object access for the shared folder.

C. Run the File Signature Verification tool and view the contents of the sigverif.txt file.
D. Run the Microsoft Baseline Security Analyzer (MBSA) tool and scan for Windows
vulnerabilities.

Answer: B

Explanation:
You must identify who is deleting files; auditing is the only way.

QUESTION 440:
You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client

computers on the Certkiller .com network run Windows XP Professional and
Microsoft Office 2003.
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A Certkiller .com user reports that she constantly receives e-mail messages stating
that she has sent a virus. She works from home and has a broadband Internet
connection.

During your investigation, you discover that the user bought an antivirus
application and installed it on her computer. When she ran the virus scanner on her
computer, no virus was detected and yet she continues to receive e-mail messages
stating that she sent a virus.

You have to find out why these e-mail messages are being sent. You then tell the
user to log on as an administrator.

Which of the following would you advise the user to do prior to running the virus
scanner again?

A. To download the most recent virus signature file.

B. To run Network Diagnostic to scan her computer.

C. To connect to the Microsoft Windows Update Web site and scan her computer.

D. To run the Microsoft Baseline Security Analyzer (MBSA) tool and scan for Windows
vulnerabilities.

Answer: A

Explanation:
Before the user reruns the virus scanner again she must download the most recent virus
updates.

QUESTION 441:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com.

You receive a call from a Certkiller .com user named Clive Wilson that has Windows
XP Home Edition running on his computer, with an antivirus application installed.
Clive Wilson informs you that he recently downloaded a program from the Internet
and installed it on his computer. He also reports that soon after installing the
program, he started receiving e-mail messages from people he does not know. The
e-mail messages state that he sent them an e-mail message. Clive Wilson then
reports that even though he uninstalled the program, he still receives e-mail
messages with the same message content from people he does not know.

You have to find out why these e-mail messages are being sent.

Which of the following would you advise Clive Wilson to do?

A. To connect to the Microsoft Windows Update Web site and scan his computer.

B. To download the most recent virus signature files and scan his computer for viruses.
C. To run the Microsoft Baseline Security Analyzer (MBSA) tool and scan for security
updates.

D. To run the Security Configuration and Analysis tool and analyze his computer by
using the hisecws.inf security template.
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Answer: B

Explanation:
Update the anti virus software on the computer because this is some
type of worm virus spread through email.

QUESTION 442:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional with
Service Pack 2 (SP2) and Microsoft Office XP. All users on the Certkiller .com
network make use of Microsoft Outlook as their e-mail client.

You receive a complaint from a user named Kara Lang, who reports that in the past
day she has received an automated response e-mail message from every e-mail
address in her Outlook Contacts folder, stating that she sent an e-mail message.
Kara Lang also states that she has not sent a single e-mail message in the past. You
then confirm that other Certkiller .com users are experiencing the same problem.
You have to find out why Kara Lang's computer has automatically sent e-mail
messages to all the e-mail addresses in her Outlook Contacts folder.

Which of the following would you advise Kara Lang r to do?

A. To enable Windows Firewall and then select "Don't allow exceptions™ on the General
tab.

B. To ensure that virus protection is monitored in Security Center, and then run an
antivirus application

C. To run Network Diagnostics.

D. To enable Automatic Updates in Security Center and then restart the computer.

Answer: B

Explanation:

The computer has probably been infected by a e-mail worm (virus) that uses the Outlook
address book to find new potential victims. Recently some viruses also uses a random
address from the address book as a faked sender to draw attention away from the actually
infected computer but the right thing to do here is to run a full antivirus scan of the users
computer to verify if it is here computer sending the messages or if it is a other computer
sending them in her name.

QUESTION 443:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional with

Service Pack 2 (SP2).

You receive a complaint from a user named Andy Reid, who reports that his
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computer is performing more slowly than usual. When you display the processes in
Windows Task Manager, you notice that the CPU usage is 99 percent and that
Msblast.exe is running as a service.

You need to.

Which of the following is the action that you should execute to optimize the
performance of Andy Reid's computer?

A. Restart Andy Reid's computer by using the Last Known Good Configuration option.
B. Install updated antivirus signatures, and scan for known viruses.

C. Use Windows Task Manager to end the Msblast.exe process.

D. In Security Center, click Change the way Security Center alerts me, and select Virus
Protection.

Answer: B

Explanation:

The Msblast.exe is strongly associated with the RPC Worm called MSBlaster (it is also
known under some other names). This work causes a heavy load on the computer once
infected and on Non-English operative systems it sometimes also causes a reboot every
60 seconds. The correct way to disinfect is to disconnect the computer from the network,
install a antivirus software with recent virus definition database, scan and clean the
computer, and finally patch the RPC vulnerability before connecting it to the network
again

QUESTION 444:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. Currently, your biggest concern is web browsing safety.

Which of the following statements are TRUE? kinds of active content (choose all

that apply).

A. By default, Internet Explorer 6 on Windows XP Professional can download ActiveX
controls.

B. By default, Internet Explorer 6 on Windows XP Professional can download Java
applets.

C. By default, Internet Explorer 6 on Windows XP Professional can download Scripts.
D. Internet Explorer 6 does not download active content, by default

Answer: A, B, C

Explanation:
Internet Explorer can download the following kinds of active content:
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ActiveX controls
Java applets
Scripts

QUESTION 445:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. Currently, your biggest concern is web browsing safety.

Which of the following is a TRUE statement?

A. ActiveX controls pose the greatest potential threat for Internet Explorer 6 on Windows
XP Professional, by default.

B. Java applets pose the greatest potential threat for Internet Explorer 6 on Windows XP
Professional, by default.

C. Scripts pose the greatest potential threat for Internet Explorer 6 on Windows XP
Professional, by default.

D. IE 6 by default does not download active content

Answer: A

Explanation:

Of the three types of active content, ActiveX controls constitute the greatest potential
threat because they have complete access to your system. They're also, for the same
reason, the most useful and versatile kind of active content. Java applets and scripts are
much less likely to be harmful.

QUESTION 4486:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. Currently, your biggest concern is web browsing safety. Which of the
following are the three default options you are given when Internet Explorer 6
displays a Security Warning dialog box, while you are attempting to download an
active content file? (Choose three)

A. download and install

B. not to download

C. display a help message about these choices
D. download but not install
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E. download and scan
Answer: A, B, C

Explanation:

By default, Internet Explorer displays a Security Warning dialog box, like the one shown
in Figure 20-8, before downloading an ActiveX control or Java applet. Your choices are
to download and install (Yes), not to download (No), and to display a boilerplate help
message about these choices (More Info).

QUESTION 447:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional.

A user named

Rory Allen reports that he received an automated response e-mail message stating

that he sent a message containing a virus. Rory Allen says that when he ran a virus
scanner on his computer, he did not detect any virus. Rory Allen also reports that he
has just received four more of these messages.

You must make sure that Rory Allen can detect whether a virus is on his computer.
Which of the following would you advise Rory Allen to do?

A. To reinstall the virus scanner from the original product CD-ROM.

B. To connect to the Microsoft Windows Update Web site and scan his computer.

C. To download the most recent virus signature file on his computer and run the virus
scanner again.

D. To run the Microsoft Baseline Security Analyzer (MBSA) tool and scan for Windows
vulnerabilities on his computer.

Answer: C

Explanation:
Rory Allen must be able to find out if a virus is on the computer. Downloading the recent
codes is the only way.

QUESTION 448:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com.

A Certkiller .com user named Amy Walsh has a portable computer running
Windows XP Home Edition with Service Pack 1. Amy Walsh uses her portable
computer to work from home four days a week and connects to the Internet via a
broadband connection. Amy Walsh would like to make sure that her computer files
are not damaged by a virus.

You have been given the task of ensuring that Amy Walsh's computer is always kept
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up to date with the most current Windows security updates.
Which of the following would you advise Amy Walsh to do, after she has logged on
to her computer as an administrator?

A. To connect to the Microsoft Windows Update Web site and scan her computer.

B. To configure Automatic Updates to automatically download the updates and install
them on a specified schedule.

C. To run the Security Configuration and Analysis tool to configure her computer by
using the hisecws.inf security template.

D. To create a scheduled task to run the Microsoft Baseline Security Analyzer (MBSA)
tool and scan for security updates on a specified schedule.

Answer: B

Explanation:
The customer's computers must always be kept up to date with the most current security
updates, so configuring Automatic Updates is the best way.

QUESTION 449:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professionaland have an
antivirus application installed.

A Certkiller .comuser named Ally Wagner, who works from home and has a
broadband connection to the Internet, reports that she has received an e-mail
message from the Certkiller .comIT department stating that she needs to apply the
most current Windows security patches to her computer.

You have been given the task of ensuring that Ally Wagnerapplies the most current
Windows security patches to her computer.

Which of the following would you advise Ally Wagner to do, after she has logged on
to her computer as an administrator?

A. To download the most recent virus signature file and run the virus scanner.

B. To connect to the Microsoft Windows Update Web site and scan her computer.

C. To run the Microsoft Baseline Security Analyzer (MBSA) tool and scan for security
updates.

D. To run the Security Configuration and Analysis tool to configure her computer by
using the hisecws.inf security template.

Answer: B
Explanation:
The Microsoft Windows Update Web site is the correct way to run a manual security

update of a computer. Virus signature files will trigger on malicious code but has nothing
to do with security patches. MBSA will help you detect any missing security patches, ut
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it will not download them for you. The Security Configuration and Analysis tool will
help you configure the computer so that it will be generally more secure but it will not
help against known exploits (more than possibly by turning of the service affected or by
configuring Automatic Updates) and it will not help you download or install security
patches.

QUESTION 450:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional with
Service Pack 1 and have an antivirus application installed.

A Certkiller .comuser named Andy Booth, whoworks at home and has a broadband
connection to the Internet, reports that he recently read an article on the Internet

that describes viruses that can potentially exploit vulnerabilities in Windows.

You have been given the task of ensuring thatAndy Booth's computer is kept
protected against known Windows vulnerabilities. You instruct the user to log on to
her computer as an administrator.

Which of the following would you advise Andy Booth to do, after she has logged on
to her computer as an administrator?

A. To run the Microsoft Baseline Security Analyzer (MBSA) tool and scan for Windows
vulnerabilities and security updates.

B. To run the Security Configuration and Analysis tool to configure his computer by
using the hisecws.inf security template

C. To configure Automatic Updates to automatically download updates and install them
according to a specified schedule.

D. To configure the antivirus application on his computer to automatically download
most recent virus signature file on a weekly schedule.

Answer: C

Explanation:

Exploiting vulnerabilities is only possible as long as the vulnerabilities are not "closed"
by a security update from Microsoft therefore you should instruct the user to Enable
Automatic Updates at a specific schedule so that any future vulnerabilities gets patched
as soon as possible. Running MBSA would only show any known vulnerabilities at the
moment that you run MBS

A. The Security Configuration and Analysis tool will help you

to configure you local computer to be more secure, for example by turning of services,
but it will not detect any vulnerabilities. The antivirus will probably detect the virus to
late if it is using a known vulnerability for replication, by the way, one week between
virus signature files is way to long.

QUESTION 451:
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You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a Windows 2000 Active Directory domain named Certkiller .com.
All client computers on the Certkiller .com network run Windows XP Professional
and Microsoft Office 2003.

A department manager at Certkiller .com named Amy Wilson reports that some of
the files on drive D on her computer were deleted and other data was modified.
Certkiller .com requires you to track unauthorized attempts to modify or delete data
from drive D on Amy Wilson's computer.

Which of the following is the task that you should carry out FIRST to achieve this
objective?

A. Run the secedit command on the client computer.

B. Run the gpupdate command on the client computer.

C. Configure the security access control list for drive D on the client computer to audit
the Everyone group.

D. Configure the access control list for drive D on the client computer to assign the Deny
- Change permission for the Everyone group.

Answer: C

Explanation:
You must track unauthorized attempts to modify or delete the files so auditing the
Everyone group is the correct choice.

QUESTION 452:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional and
Microsoft Office 2003.

A software developer at Certkiller .com named

Mia Hamm informs you that that she needs to be able to install new software,
updates, and device drivers on her computer. Mia Hamm also has to be able to
manage her computer's event logs. Mia Hamm also informs you that she normally
logs on to her computer with a domain user account.

You verify that the Certkiller .com written policy permits Mia Hamm to carry out
these tasks on her computer. However, the written policy also states that the user
account used to execute these tasks should not have access to network resources that
require authentication.

Which of the following is the task that you should complete to make sure that Mia
Hamm's computer is configured to meet her requirements?

A. Add the Mia Hamm's domain user account to the computer's local Power Users group.
B. Add the Mia Hamm's domain user account to the computer's local Administrators
group.

C. Create a new local user account on the computer, and add it to the local Power Users
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group.
D. Create a new local user account on the computer, and add it to the local
Administrators group.

Answer: B

Explanation:

Adding the developer's domain account to the computer's local

administrators group is correct because she mustmanage computer event logs

in addition, to the updates, install new software etc. The local power's users group does
not have the required permissions.

QUESTION 453:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional.

Certkiller .com has its headquarters in Chicago and a branch office in Dallas. The
Dallasoffice has a wireless network that has a Service Set Identifier (SSID) named
CoBranch. Static Wired Equivalent Privacy (WEP) keys are used to protect data on
the Dallas wireless network.

A user named

Dean Austin, whose portable computer contains a wireless network adapter that
supports the Wireless Zero Configuration service, travels from the headquarters in
Chicago to the Dallasoffice. The wireless network connection icon in the taskbar
notification area shows that the wireless adapter is connected to CoBranch and has
a signal strength of Excellent.

When Dean Austin reports that he cannot access his e-mail messages or connect to
any Web sites on the Internet, you find that the IP address displayed in the Wireless
Network Connection Status dialog box is 169.254.66.227.

You then confirm that the Dallas office DHCP server is running and configured
properly, and that the other Dallasoffice users can connect to the wireless network,
access their e-mail messages, and view Web sites on the Internet.

You have been given the task of ensuring that Dean Austin can access his e-mail and
connect to Web sites on the Internet.

Which of the following would you advise Dean Austin to do?

A. Clear the Enable network access control using IEEE 802.1x check box on the
Authentication tab of the Wireless Network Connection properties page.

B. Select the Data encryption (WEP enabled) check box on the Wireless Networks
Properties tab of the Wireless Network Connection properties page, and then manually
enter the network key assigned to the wireless access points.

C. Select the Network Authentication (Shared mode) check box on the Wireless
Networks Properties tab of the Wireless Network Connection properties page.

D. Enter the SSID of the branch office wireless network on the Wireless Networks
Properties tab of the Wireless Network Connection properties page.
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Answer: B

Explanation:

The IP address on the computer is a so called APIPA address (Automatic Private IP
Address) that the computer has assigned to itself when it failed to contact the DHCP
server. This point towards that even the most basic functions of networking is not
working with this computer. The most natural place to start troubleshooting this issue is
by verifying that the Data encryption (WEP enabled) settings are correct and that the
preshared secret key is correct.

QUESTION 454:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You are currently trying to help Certkiller .com users to secure their
files.

Which two of the following are files that will be created if you make use of the
cipher command to generate a recovery agent certificate? (Choose two)

A. .pfx file
B. .cer file
C. .idx file
D. .Ire file

Answer: A, B

Explanation:

To generate a recovery agent certificate, follow these steps:

1. Log on as Administrator.

2. At a command prompt, type cipher /r:filename.

3. When prompted, type a password that will be used to protect the files you create.
This generates both a .pfx file and a .cer file with the file name you specify.

QUESTION 455:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You are currently trying to help Certkiller .com users to secure their
files.
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Which of the following best describes the recommended method of encryption?

A. On a per folder basis.

B. On a per file basis.

C. On a per user basis.

D. On a per application basis.
E. None of the above.

Answer: A

Explanation:

Always encrypt folders, not files. When a folder is encrypted, all files created in that
folder are encrypted. Many editing programs save a new copy of the document you are
editing. This copy will be encrypted if you encrypt the folder, but it will be plain text if
you only encrypt the original file.

QUESTION 456:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications.

Which of the following is the program that you would recommend when a user asks
you what program can be used to open and read a cookie file?

A. Notepad
B. Photo Editor
C. Regedt32
D. NetDom

Answer: A

Explanation:

A cookie is a small text file that enables a Web site to personalize its offerings in some
way. The Web site downloads the cookie to your hard disk (Internet Explorer stores it in
the folder %UserProfile%\Cookies., and then reads the cookie from your hard disk on
your subsequent visits to the site.

QUESTION 457:
You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the

variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
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important task is to assist in the configuration and maintenance of desktop
applications.

Which of the following is the directory that you should look into when you want to
clean up the cookies inside your computer?

A. %UserProfile%Cookies

B. %UserProfileTemporary Internet Files
C. %UserProfileApplication Data

D. %UserProfileLocal Settings

E. %UserProfileMy Documents

Answer: A

Explanation:

A cookie is a small text file that enables a Web site to personalize its offerings in some
way. The Web site downloads the cookie to your hard disk (Internet Explorer stores it in
the folder %UserProfile%\Cookies., and then reads the cookie from your hard disk on
your subsequent visits to the site.

QUESTION 458:

You are the desktop application support specialist for Certkiller .com. Certkiller .com
uses a variety of windows computers. Windows XP Professional is one of the
mainstream OS deployed. Your major duty is to assist in the configuration and
maintenance of desktop applications. You are in the process of configuring the
privacy level of your Internet Explorer (IE) and would like certain cookies to be
blocked by IE.

Which of the following describes how you can tell if IE is blocking a cookie for you?

A. Check the corresponding icon on your status bar.

B. Choose View, Status Bar, and View Status.

C. Choose View, Status Bar, and View Cookies.

D. Check the security event log.

Answer: A

Explanation:

When Internet Explorer blocks or restricts a cookie, it displays an icon on your status bar.
(Choose View, Status Bar, if your status bar is not visible.

QUESTION 459:

Which of the following is a standard supported by Internet Explorer 6 that is able to
filter cookie transactions on the basis of the cookie's content and purposes?

A. P3P
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B. PGP
C.RDP
D. ASP

Answer: A

Explanation:

Internet Explorer 6 supports the emerging Platform for Privacy Preferences (P3P
standard). This enables Internet Explorer to filter cookie transactions on the basis of the
cookie's content and purposes, in accordance with your stated privacy preferences.

QUESTION 460:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You would like to fine tune your IE to express your preferences with
regard to cookies.

Which of the following are applicable options found in the Privacy tab of the

Internet Options dialog box of IE6? (Choose all that apply)

A. Block All Cookies
B. High

C. Medium High

D. Medium

E. Low

Answer: A, B,C,D, E

Explanation:

To express your preferences regarding cookies, choose Tools, Internet Options, and then
click the Privacy tab. On the Privacy tab of the Internet Options dialog box, you may use
the slider to choose one of the following settings:

Block All Cookies

High

Medium High

Medium

Low

Accept All Cookies

QUESTION 461:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
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variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You are in the process of configuring the privacy level of your Internet
Explorer (IE).

Which three of the following statements are adequate descriptions of a LOW

privacy level? (Choose three)

A. Blocks third-party cookies from sites that do not have a compact privacy statement.
B. Accepts cookies from third-party sites that use personally identifiable information
without your explicit consent, but deletes those cookies when you close Internet
Explorer.

C. Accepts all first-person cookies.

D. There is no such level.

Answer: A, B, C

Explanation:

Low

1. Blocks third-party cookies from sites that do not have a compact privacy statement.
2. Accepts cookies from third-party sites that use personally identifiable information
without your explicit consent, but deletes those cookies when you close Internet
Explorer.

3. Accepts all first-person cookies.

QUESTION 462:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You are in the process of configuring the privacy level of your Internet
Explorer (IE).

Which of the followings are three suitable descriptions of a Medium High privacy
level? (Choose three)

A. Blocks cookies from third-party sites that do not have a compact privacy statement.
B. Blocks third-party cookies that use personally identifiable information without your
explicit consent.

C. Blocks first-party cookies that use personally identifiable information without your
implicit consent.

D. Accepts cookies from third-party sites that use personally identifiable information
without your explicit consent, but deletes those cookies when you close Internet
Explorer.

E. Accepts all first-person cookies.
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Answer: A, B, C

Explanation:

Medium High

1. Blocks cookies from third-party sites that do not have a compact privacy statement.
2. Blocks third-party cookies that use personally identifiable information without your
explicit consent.

3. Blocks first-party cookies that use personally identifiable information without your
implicit consent.

QUESTION 463:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You are in the process of configuring the privacy level of your Internet
Explorer (IE).

Which of the following is the default privacy level configured for Internet Explorer
(1E)?

A. High

B. Medium High

C. Medium

D. Low.

E. Accept All Cookies.

Answer: C

Explanation:

The valid levels in IE 6 are:
Block All Cookies

High

Medium High

Medium (Default.

Low

Accept All Cookies

QUESTION 464:
You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the

variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
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important task is to assist in the configuration and maintenance of desktop
applications. You are in the process of configuring the privacy level of your Internet
Explorer (IE) and would like certain cookies to be blocked by Internet Explorer

(IE).

Which of the following options can you use to check whether IE is blocking a cookie
for you?

A. Check the corresponding icon on your status bar.
B. Choose View, Status Bar, and View Status.

C. Choose View, Status Bar, and View Cookies.

D. Check the security event log.

Answer: A

Explanation:
When Internet Explorer blocks or restricts a cookie, it displays an icon on your status bar.
(Choose View, Status Bar, if your status bar is not visible..

QUESTION 465:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. Currently, your biggest concern is web browsing safety.

Which of the following are the four valid security zones specified by Internet
Explorer (IE)? (Choose four)

A. Local Intranet

B. Internet

C. Trusted Sites

D. Restricted Sites

E. None of the choices.

Answer: A,B,C, D

Explanation:

Internet Explorer's security zones let you divide the universe of Internet sites into four
categories, according to sites' perceived level of trustworthiness. Internet Explorer calls
the categories "zones" and gives them the following names:

1. Local Intranet

2. Internet

3. Trusted Sites

4. Restricted Sites
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QUESTION 466:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. Currently, your biggest concern is web browsing safety.

Internet Explorer (IE) populates the Local Intranet zone with which of the

following, by default? (Choose all that apply)

A. All intranet sites that you haven't moved into either the Trusted Sites zone or the
Restricted Sites zone.

B. All sites that bypass your proxy server.

C. All network servers accessed via UNC paths.

D. There is no such zone.

Answer: A, B, C

Explanation:

By default, Internet Explorer populates the Local Intranet zone with the following:
1. All intranet sites that you haven't moved into either the Trusted Sites zone or the
Restricted Sites zone.

2. All sites that bypass your proxy server.

3. All network servers accessed via UNC paths.

QUESTION 467:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications.

Which of the following is a task that you should complete to ensure that Internet
Explorer won't show the page if a user tries to go to a Web page that is beyond the
limits you set?

A. Set up Content Advisor
B. Enable ICS

C. Enable ICF

D. Configure security zones
Answer: A

Explanation:
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When Content Advisor is enabled, if a user tries to go to a Web page that is beyond the
limits you set, Internet Explorer won't show the page. Instead it displays a warning
message. Users who know the supervisor password (you supply this password when you
first enable Content Advisor. can bypass the warning and view the page.

QUESTION 468:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You have recently set up Content Advisor on desktop of a user at
Certkiller .com.

Which of the following is the option that you should take if the user wants to bypass
the content advisor warning while viewing a page?

A. Give him the supervisor password.

B. This is not possible

C. Tell him to refresh the browser and delete the existing cookies and then retry.
D. Tell him to download the page for offline viewing.

Answer: A

Explanation:

When Content Advisor is enabled, if a user tries to go to a Web page that is beyond the
limits you set, Internet Explorer won't show the page. Instead it displays a warning
message. Users who know the supervisor password (you supply this password when you
first enable Content Advisor) can bypass the warning and view the page.

QUESTION 469:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You are currently installing Internet Explorer's (IEs) Content

Advisor.

Which of the following is the default content rating system that Internet Explorer
(IE) comes with?

A. RSACi
B. RBAC
C.RICS

D. REDT
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Answer: A

Explanation:

By default, Internet Explorer comes with one system, RSACi-the Recreational Software
Advisory Council's Internet rating system. This system has four categories: language,
nudity, sex, and violence. Each category has five levels, numbered 0 through 4. A higher
number indicates more explicit or intense content.

QUESTION 470:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You are currently installing Internet Explorer's (IEs) Content

Advisor.

Which of the following is the default number of categories defined for the content
rating system that comes with Internet Explorer (IE)?

CoOw>
oo s

Answer: A

Explanation:

By default, Internet Explorer comes with one system, RSACi-the Recreational Software
Advisory Council's Internet rating system. This system has four categories: language,
nudity, sex, and violence. Each category has five levels, numbered 0 through 4. A higher
number indicates more explicit or intense content.

QUESTION 471:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You are currently installing Internet Explorer's (IEs) Content

Advisor.

Which of the following are the valid categories defined by default the content rating
system that comes with Internet Explorer (IE)? (Choose all that apply)
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A. Language
B. Nudity

C. Sex

D. violence

Answer: A, B, C,D

Explanation:

By default, Internet Explorer comes with one system, RSACi-the Recreational Software
Advisory Council's Internet rating system. This system has four categories: language,
nudity, sex, and violence. Each category has five levels, numbered 0 through 4. A higher
number indicates more explicit or intense content.

QUESTION 472:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the
variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
important task is to assist in the configuration and maintenance of desktop
applications. You are using Outlook Express as your mail client.

Which two of the following are configured by defaults in Outlook Express' security
section? (Choose two)

A. Restricted Sites Zone

B. Warn Me When Other Applications Try To Send Mail As Me
C. Filter attachment

D. Block spam

E. None of the choices.

Answer: A, B

Explanation:

Before you begin using Outlook Express, you should choose Tools, Options, and then
select the Security tab in the Options dialog box to review your security settings. Make
sure that the following options are selected:

1. Restricted Sites Zone (More Secure.

2. Warn Me When Other Applications Try To Send Mail As Me

3. Both are selected by default, but it's a good idea to check anyway.

QUESTION 473:
You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. Of the

variety of windows computers that Certkiller .com uses, Windows XP Professional is
one of the mainstream Operating Systems that have been deployed. Your most
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important task is to assist in the configuration and maintenance of desktop
applications. You are using Outlook Express as your mail client.

For which two of the following security zones that is available in Internet Explorer
does Outlook Express share the settings by default? (Choose two)

A. Internet zone

B. Restricted Sites zone
C. Danger zone

D. High secure zone

E. None of the choices.

Answer: A, B

Explanation:

Outlook Express shares the settings for the two most restrictive security zones available
in Internet Explorer-the Internet zone and the Restricted Sites zone. By setting Outlook
Express to follow the security restrictions observed in the Restricted Sites zone, you get
the maximum protection that you have set for this zone in Internet Explorer.

QUESTION 474:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional with
Service Pack 2 (SP2) and are part of the domain.

When two users in the Research department at Certkiller .com reports that one of
their testing applications is no longer working, you trouble shoot the problem and
notice that an administrator configured security on the computers in the Research
department by implementing a new security template. You then confirm that all the
other Research department users are able to run their testing applications.

You now have to discover the reason why these two users are unable to run the
testing application.

Which of the following would you advise these users to do?

A. To run the gpupdate command on their computers.
B. To run the gpedit.msc command on their computers.
C. To run the netdiag command on their computers.

D. To run the gpresult command on their computers.

Answer: D

Explanation:

A single computer can be affected by Local Security Policy and any number of Group
Polices at different levels. Policy settings are cumulative, so all settings contribute to
effective policy. The effective policy is called the Resultant Set of Policy (RSoP). You
can view the RSoP for a computer by using the command-line tool gpresult.exe. To
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display RSoP, open the command prompt on a computer running Windows XP and type
gpresult. Windows calculates the RSoP for the computer and displays the results, as
shown in Figure.
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QUESTION 475:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com. All client
computers on the Certkiller .com network run Windows XP Professional with

Service Pack 2 (SP2) and are part of the domain.

A new Certkiller .com security policy requires that all portable computers in the
company have to be configured to monitor essential security settings.

You have received a request from a user named Mia Hamm, to configure her
computer to monitor essential security settings.

Which of the following is the task that you should complete to achieve this

objective?

A. In the Group Policy editor, under Computer Configuration\Windows Settings\Security
Settings\Software Restriction Policies\Security Levels, set the default to Disallowed.

B. In the Group Policy editor, under Computer Configuration\Administrative
Templates\Windows Components\Security Center, select Turn on Security Center.

C. In Security Center, click Automatic Updates, and then select Turn off Automatic
Updates.

D. In the Group Policy editor, under Computer Configuration\Administrative
Templates\System\Windows File Protection, set Set Windows File Protection scanning to
enabled.
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Answer: B

Explanation:

When the Security Center is turned on, it monitors essential security settings (firewall,
antivirus, and Automatic Updates), and notifies users when their computers might be at
risk. Software restrictions are used to specify software that is or isn't allowed to run so
that you can protect your organization from untrusted programs (and prevent users from
distractions, too). Turning off Automatic Updates will not help you to monitor essential
settings, in fact, all you do is turn of one of the components that Security Center
monitors. Windows File Protection (WFP) prevents programs from replacing critical
Windows system files. Programs must not overwrite these files because they are used by
the operating system and by other programs. Protecting these files prevents problems
with programs and the operating system.

QUESTION 476:

You work as the desktop support technician at Certkiller .com. The Certkiller .com
network consists of a single Active Directory domain named Certkiller .com.All client
computers on the Certkiller .com network run Windows XP Professional and all
Certkiller .comusers make use of Microsoft Internet Explorer as their Web browser.

A new Certkiller .com security policy prohibits Web sites from saving cookies on
Certkiller .comclient computers if the Web sites do not have a Platform for Privacy
Preferences (P3P) privacy policy, but allows Web sites that do have a P3P policy to
save cookies.

Which of the following is the task that you should do in Internet Options in Control
Panel to configure all client computers to abide by the new security policy?

A. Configure the Privacy setting to High.

B. Configure the security settings to Medium.

C. Configure the custom security setting for the Trusted sites security zone to High.

D. Configure the custom security setting for the Restricted sites security zone to Medium.

Answer: A

Explanation: A Web site's privacy policy tells you what kind of information the site
collects, to whom it gives that information, and how it uses the information. Many
Web sites provide a privacy statement or a Platform for Privacy Preferences (P3P)
policy that you can view with Internet Explorer. Changing Privacy settings to High
will have the following effect:

- Cookies from all Web sites that do not have a compact policy (a condensed
computer-readable privacy statement) will be blocked

- Cookies from all Web sites that use your personally identifiable information without
your explicit consent will be blocked
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